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Chapter 1 – Getting Started

In this Chapter we will look at the basics of Myriad; including what it is, what is 
included in the standard package, and what you can add to the Myriad Suite 
to expand its functions.

We will then look at how to get Myriad installed, licensed and set up using the 
standard (default) settings.

Finally, we will look at the general layout of all of the major screens in Myriad 
and see the information and tools that they offer. This Chapter provides a 
useful introduction and overview to the system as well as a handy reference 
for future use; however, all subjects will be covered in more detail in 
subsequent Chapters.

General Overview

Myriad is an audio playout system designed for use in broadcast radio 
environments, production studios and almost any situation where ‘on demand’ 
audio playback is needed. The system is designed to be used in live 
situations when the operator controls the flow of audio as well as in
automated environments with the system performing a number of tasks 
without human intervention.

The most common application for Myriad is as a playout system in a 
broadcast radio studio and this User Guide will concentrate on using Myriad in 
this way, however, many of the tools and techniques we will look at are 
applicable to a broad range of applications.

What Is Myriad?

Myriad is actually a single software program that forms part of a larger 
package known as the Myriad Suite which is designed to provide a complete 
solution for radio stations of all types and sizes. Myriad’s job is to store all the 
music, jingles, adverts, promos and any other audio that the station needs, 
and to provide fast and simple access to this audio for playback ‘on air’, either 
manually by the DJ, or automatically when the station is unattended. 

In general, software packages that perform this role are known as ‘playout 
systems’ and whilst playout systems by different manufactures differ in the 
level of functionality they offer and how they work, the general concepts 
behind most playout systems are the same. 

The list below very briefly outlines Myriad’s key functions:
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 Audio Wall – provides access to audio stored on the system. Each 
individual piece of audio is known as a Cart and is assigned a unique 
Cart Number. The Carts are arranged numerically up to a maximum of 
99,999 and this forms the Myriad Audio Wall. The Audio Wall is central 
to all of the products in the Myriad Suite.

 Instant Carts – These are shortcuts to particular Carts and can be 
accessed with a single key press (or click) making then act like ‘hot 
keys’. Instant Carts can be arranged into sets of 20 and can be linked 
to specific Users or available to all Users on the system.

 The Database – This provides an alternative way of browsing the 
audio or Carts that you have on your Myriad system by displaying a 
copy of the Songs and Links that you have added to your AutoTrack or 
AutoTrack Pro music scheduling system. This allows you to browse the 
Songs and Links on your system by Category, Artists or Type as well 
as perform more thorough searches. If you do not use AutoTrack or 
AutoTrack Pro, you will still be able to use The Database function but 
to a more limited capacity.

 The Log Screen – The Log Screen (known as Q-NXT in Myriad v2.6) 
displays a manually or automatically scheduled ‘log’ of Songs, Links, 
Adverts, Commands and Events that make up a typical radio show. In 
a Live Assisted show, Myriad will run through the items in the Log and 
automatically load them into the Cart Player for playback ‘on air’. The 
presenter controls when items are played, and where they appear in 
the Log, and by combining the Log Screen with the Audio Wall and 
Database screens can make alterations to the Log as necessary. The 
presenter can also elect to make Myriad automatically start the next 
item when the current one has finished. This is commonly referred to 
as a ‘segue’ and forms an important part of Myriad’s functionality.
In an automated environment, Myriad can playback the items in the 
Log automatically, allowing you to operate your station unattended for 
extended periods of time. In addition to audio items (such as Songs 
and Links), Myriad can also handle a number of additional commands 
or events in the Log to allow your automated programming to interact 
with external sources, back-time to time critical events, and include 
pre-recorded voice links (sometimes called Voice Tracking) to your 
automation to make it sound as ‘live’ as possible.

 Cart Player – The Cart Players are used to actually play audio items 
and Carts using the PCs’ sound cards. In general, Myriad requires a 
minimum of three Cart Players to function correctly and each Cart 
Player is usually configured to use an individual sound card output. 
This is most commonly achieved using multi-channel sound cards such 
as the Echo Layla 3G or the Midiman Delta 10/10 each of which has 
four individual stereo outputs. These individual outputs are usually 
connected to separate faders on your mixing console so you end up 
with four Cart Players in Myriad that appear on four faders on your 
mixing desk and you can use them just like normal CD or Mini Disc 
players.

As you can see, even on a very basic level, Myriad provides a great deal of 
diversity and functionality. In the coming Chapters, we will examine each area 
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within Myriad in a lot more detail and you will learn how to use Myriad to get 
the best results for your station and make your life as easy as possible but 
before we look at Myriad in any more detail, let’s look at the wider Myriad 
Suite of products and their general role.

The Myriad Suite of Products 

As discussed in the previous section, Myriad itself is actually part of a Suite of 
products designed to combine to offer stations of all sizes a complete solution 
for all their broadcast software needs. It is possible that your station will only 
need to use some of the products in the Myriad Suite and combine these with 
other 3rd party applications. 

The Standard Myriad Suite

Myriad – Provides playout and automation facilities as well as acting as the 
primary way to add, access and manage the audio on your system. Myriad is 
the product the presenters will use in the studio to help present their radio 
programs.

AutoTrack – Provides Song and Link scheduling facilities to produce a
‘Schedule Log’ for either Live Assisted or Automated playout. The Schedule 
Log that AutoTrack produces is imported into the Log Screen in Myriad.

Advanced Advert Manager – This application allows you to either manage 
Clients and Adverts for yourself or import pre-scheduled advert breaks for 3rd

party advert scheduling systems (often called Traffic systems). If you are 
using the Advanced Advert Manager to manage adverts, it can also be used 
to schedule the advert breaks and guard against the clashing of unsuitable 
adverts.

CD Ripping Module – This expansion to the Audio Wall found within Myriad 
allows you to ‘rip’ audio from compatible audio CD’s as if the audio were 
standard data files. This means that the digital quality of the audio on the CD 
is preserved and the audio on the CD can be transferred at a faster than ‘real 
time’ rate. The CD Ripping Module can even look up Title and Artist details for 
a track on the web.

OCP – The Online Content Processor allows you to add and control additional 
information (such as text and pictures) to compliment the audio, for delivery 
on compatible digital platforms such as DAB and the Web. Want to send ‘now 
and next’ information to your web site? No problem!

Log Importer – This tool is only necessary when you are using a 3rd party 
music scheduling system (such as Selector™ by RCS™) to generate the 
schedule that you want to import into the Log Screen in Myriad.
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SmoothEdit – SmoothEdit is a simple Audio Editor utility that is built in to 
most studio-based Myriad systems to allow simple editing and manipulation of 
audio. Not all Myriad terminals need Myriad.

Optional Additions to The Myriad Suite

AutoTrack Pro (optional) – This optional addition to the standard Myriad 
Suite expands the scheduling capabilities of AutoTrack to offer greater 
flexibility and control over the generated schedule. AutoTrack Pro is 
recommended for use in commercial radio stations or stations that have 
specialised music formats.

Myriad STS (Split Transmission System) – As the name suggests, Myriad 
STS is used when you wish to use Myriad to deliver program content to 
different geographical areas or transmission chains. If you want play different 
adverts and jingles on the different transmission paths then you will need 
Myriad STS.

Voice Tracking (Local & Remote) – This adds voice tracking capabilities to 
your system. You can voice track either locally using Myriad or remotely using 
the Remote Voice Tracking software.

The Advanced Tools Pack – Offers a range of additional tools and utilities 
that some users may find very interesting. The Advanced Tools Pack 
includes:

 Audio Wall Linkifier & De-linkifier - Exports all of the Carts on your
Audio Wall to a specified file location and format and then links the 
Carts on the Audio Wall back to the freshly exported files. Example use 
- need to have common audio file storage between Myriad and another 
playout system? The Delinkerfier does the same in reverse.

 Audio Wall Lister - Command line tool for exporting a text list of all the 
Carts in a specific range on your Audio Wall. Example use - export a 
list of Carts for a 3rd party system such as Broadnet(tm).

 Audio Wall Information Importer - Allows you to import a Cart’s title, 
artist and timing information from a CSV (comma separated variable) 
text file. 

 Audio Wall Title Compactor - Works through an Audio Wall moving 
description lines around on the Carts. Example use - in your Myriad v2 
system, you used to have Title on line 1, nothing on line 2 and Artist on 
line 3. Now you have Myriad v3 you need to move all the line 3 info on 
to line 2. 

 Audio Wall Title Re-mapper - Similar to the Title Compactor but this 
utility allows you to shift stuff around in a more flexible way. Example 
use - need to switch the Title and Artist fields over on your Audio Wall, 
this will do it for you.

 Configuration Removal Tool - Removes all previous configuration 
data from the PCs’ registry so that you can ensure you have a clean 
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slate to start again with. Example use - want to reinstall with a totally 
clean sheet. 

 Station Log Exporter / Importer - A really powerful tool! This allows 
you to select a section in your scheduled Station Log (formerly known 
as the Q-NXT log in Myriad v2) and export it as a file. This would not 
be much use unless you could import it again later. Luckily the Station 
Log Exporter allows you to do just that. Example use - take a Voice 
Tracked show, export it and then re-import a few days later into the log 
to reuse it. 

 Log Importer (music & advert log importer) - This tool is used to 
import music and advert logs from 3rd party scheduling systems such 
as RCS Selector(tm) or Broadnet(tm). This tool is included with all 
Myriad licenses but if you want your Program Controller or Traffic 
Manager to be able to import their respective logs from their desktop 
PCs, but you don’t want to pay for a Myriad license for them, then the 
Advanced Tools Pack is the way to go. 

 Multiple Audio Format Import Utility - This stand alone import utility 
allows you to import single or multiple audio files directly into your 
Myriad Audio Wall. The difference is that this baby can import files in a 
range of linear and compressed formats including MP2, WMA, Ogg 
Vorbis and MP3. The import utility will import the files, convert them to 
your standard Myriad format, trim any silence from the beginning and 
normalise them to your standard Myriad level. You can also import 
linear files and rip tracks from CD even if you do not have Myriad 
installed on the machine. So if you regularly need to import WMA or 
MP3 files then this tool may be for just what you need.

More tools are being added all the time so please visit www.psquared.net for 
more up to date details.

For more details on the individual components in the Myriad Suite, please 
refer to the appropriate documentation. You can also find additional 
information at www.psquared.net

Installing Myriad

To install the software, place the CD in your computer’s CD drive and the 
installation page should automatically open. Choose the Product installation
from a menu similar to this:
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Click on the hyperlink to start the installation and click on Open when the 
Open / Save screen appears.

For Windows 2000

For Windows XP
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For Windows XP Service Pack 2 (SP2)

This will start the InstallShield installation process. Follow the on-screen 
instructions to install the software.

NB: Please read the EULA (End User License Agreement) fully before 
installing any product.

When you are given the option, select Complete setup type.
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Click on Next again to start the install process. After a couple of minutes, your 
installation should be complete and you will be ready to run Myriad for the first 
time. Next we need to deal with licensing.

NB: AutoTrack Pro installation screen shots have been used in this section as 
no Myriad installer screen shots were available at time of writing. The 
procedure is the same for both products.

Licensing Myriad

Myriad v3 uses an advanced licensing system to prevent software piracy and 
to safeguard the future of Myriad™ and other P Squared Ltd products.

The advanced licensing procedure generates a special code (called a 
PSQUISH) that is unique to your computer. The first time that you activate 
Myriad you will need to provide this code to P Squared Ltd in order to 
complete the licensing process. Subsequent codes can be obtained 
automatically (assuming you have web access) but you may have to contact 
P Squared Ltd periodically in the future. 

Manually Obtaining a License Code

The standard licensing procedure for manually obtaining a license code is:

1. Select the License Code option from the Tools menu. The License 
Wizard will run automatically the first time that you run Myriad, or if you 
run Myriad once your license has expired.

2. If this is the first time that you have licensed Myriad (or you have not 
ticked the option to skip the introduction screen the last time you 
entered a license code), the introduction screen will be displayed.



25

3. Read the screen and then tick the “Skip this screen in the future” option 
unless you want to read this introduction each time. Then click Next.

4. You will then see a summary of the current license status of Myriad. In 
the example below, you can see that we currently have a valid license 
that is not due to expire for some months. If you are entering a license 
for the first time then this information will be blank. If you wish to 
proceed, click the Next button.
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5. If you do not need to license Myriad, the License Wizard will warn you 
before you proceed to the next screen, if you want to proceed anyway 
then click on OK.

6. The next phase is to enter your registration details. You will only have 
to do this the first time; the information will be loaded automatically on 
subsequent license procedures.

The first thing that you have to enter is your P-SQUID (P Squared 
Unique ID) which is your P Squared unique customer ID and will be 
provided by P Squared. Your P-SQUID will be at the top of all quotes, 
or purchase orders that you receive from P Squared and should be 
quoted whenever you contact P Squared. To enter or alter your P-
SQUID, click on the Change button and type in the new P-SQUID.

Next add in your contact details by clicking on the Change button by 
the contacts summary window.
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You are required to enter your name and a valid email address; these 
details will be used when processing requests for ‘online’ license 
renewals in the future. You may also fill in the additional information if 
you wish. Once you have finished, click on OK to return to the main 
wizard and then click on Next to move on to the next step.

7. The next step in the license wizard allows you to enter the License 
Name and Features Code for the product. Both of these will be 
provided by P Squared with the purchased product, or we can give you 
the details over the phone.
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Type in the License Name exactly as it is given to you by P Squared 
and then click on the Set button. Repeat the same procedure for the 
Features Code.

NB: It is possible to obtain a Features Code ‘online’ by clicking on the 

 button. When you select this option, the progress of the ‘online’ 
Features Code generation is shown on screen and if a code is 
successfully generated, it will be added to the Wizard window. Please 
note that this option will generally only be available to existing 
customers who have licensed Myriad previously.
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Once the License Name and Features Code have been set, you can 
alter them by clicking on the appropriate Change button. If you are 
happy however, click on Next to proceed.

8. The next screen allows you to choose the method that you want to use 
to obtain your Myriad license code.
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Each option is explained on screen as you can see from the image 
above.

In this case, let’s assume that we want to manually enter the code and 
we intend to phone P Squared to give them the details needed to 
activate the product. Select ‘Manually enter a New License Code’ and 
then click on Next.

9. The next screen displays the P-SQUISH code which is a unique code 
that is used to generate your Myriad license. The P-SQUISH is unique 
to your contact details, the PC you are working on, and the time and 
date that you generate it.
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The P-SQUISH is only valid for a few days so you should contact P 
Squared as soon as possible to let them have your P-SQUISH code. 
You can do this either by:

 Telephoning: +44 1482 383700
 Emailing: licenses@psquared.net
 Faxing To: +44 1482 383701

Once P Squared has a valid P-SQUISH code, they will then provide 
you with a License Code that you need to type into the New License 
Code part of the screen before finally hitting Finish.

10.Clicking on Finish will end the licensing process. A short summary 
screen will be displayed before you can proceed on to using Myriad.
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Automatically Obtaining a License Code

In general, the first license code that you receive will have to be processed 
manually but once all your details are registered with P Squared, subsequent 
licenses can be obtained ‘online’ without the need to contact us. This means 
that you can renew your license at your convenience provided your PC has a 
web connection. 

To obtain a license code ‘online’ follow these steps:

1. Select the License Code option from the Tools menu.
2. The introduction screen is usually skipped when renewing a license. In 

this case, the first screen you will see is the Current License Details 
screen which shows you when the current license was entered and 
when it is going to expire.
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3. Click on Next to move on to the P-SQUID and Personal Details screen. 
You only need to alter the information on this screen if it has changed. 
If not, click on Next to move on to the next screen.

4. Next you will see the License Details screen. Again, unless you need to
alter any of this information, you can click on the Next button to move 
on to the next window.
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5. The License Method window allows you to select the way in which you 
want to obtain your License Code. In this case, we want to renew the 
license online so we need to make sure ‘Obtain a License Code Online’ 
is ticked and then click on Next.

6. Finally, you will see a brief summary screen before Myriad attempts to 
obtain a license ‘online’. Click on Finish to begin the process.
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At the end of the process, you will be told whether your license code 
was successfully renewed or whether you need to contact P Squared
to continue the licensing process.

For more information on P Squared product licensing, please refer to 
www.psquared.net/support as well as your P Squared Software 
License Agreement.
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Setting Up Myriad Using the Configuration Wizard

In this section we will go through the initial setup phase of Myriad and see 
how the Configuration Wizard for Myriad is able to configure your system to 
your needs simply by asking a few questions.

In this section, we will be working from the assumption that this is the first time 
that Myriad v3 has been installed on this PC. If you re-install Myriad v3 at a 
later date or you upgrade to a later version in the future, all of your Myriad v3 
settings will be retained.

If you are setting up Myriad v3 on a PC that has previously had Myriad v2.6 
on it then the Myriad v2.6 file locations and some of the settings will be 
automatically detected and suggested as part of the wizard process, but you 
will have the option to use alternative locations as you are setting up.

In this walkthrough, we have already installed Myriad v3 on a new PC (see 
Installing Myriad) and have just run Myriad for the first time. The system 
detects that you have not configured Myriad before and the Configuration 
Wizard starts automatically.

Introduction
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The first screen of the wizard introduces the Configuration Wizard and 
prompts you to click on Cancel if you wish to configure Myriad manually.

You can opt to skip this screen in future by ticking the ‘Skip This Screen In 
Future’ option. 

Click on the Next button to move on to the next phase of the Configuration 
Wizard.

General Information

What is your Station Name?

The first section of this window asks you to type in your station’s name. This is 
used in numerous places in Myriad and is specifically important if you are 
running two or more stations from a single Myriad system. In this case, each 
station has its own Profile and the Station Name setting here dictates the 
name of the Profile for the station. The Station Name is also used by Myriad 
as it creates the Station Database (if you want it to). Use the box to type in 
your radio station’s name or the name you wish to use within Myriad.
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If you are installing Myriad on several PCs it is worth sticking with the same 
Station Name on all of the PCs. If you have already created a Station 
Database on another PC then the Station Name will not be used (but you 
should still type it in anyway!).

Is this the only Station that you broadcast to using this Computer?

This question is used by Myriad to determine how the system will work each 
time you start it. 

Basically, if you only broadcast one radio station from your Myriad system and 
this PC is not used for training then you should tick the ‘Yes this is the only 
station’ option. If you tick this option then Myriad will automatically load the 
Station Database each time Myriad is started. This setting is ideal for a 
broadcast studio where only one station output is broadcast.

If you want to be able to switch between more than one radio service using 
this PC or if you wish to be able to switch between a ‘live’ Station Database 
and a training Station Database (that will not affect ‘on air’) then you should 
tick the ‘No, this broadcasts to different stations or is used for training’ option.

If you tick this option then when Myriad starts, it will not automatically load a 
specific Station Database but will allow you to open the Station Database that 
you wish to work on at that time. 

NB: You can create as many Station Databases as you wish. Each Station 
Database can be configured differently and contains independent Schedule 
Logs to allow you to use a single Myriad workstation to work with and 
broadcast different station content, although it should be noted that you can 
only work with one Station Database at a time and Myriad cannot be used to 
broadcast more than one station output from a single computer at the same 
time.

What Name Best Describes Your Computers Location?

The final option on this page of the wizard allows you to type in a description 
for the PC that you are installing Myriad on. This description is used by Myriad 
in Play Log and Copy Right reports and also whenever Myriad refers to an 
individual Workstation.
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Once you are happy with the settings on this page, click on the Next button to 
move on to the next page in the wizard.

Data Locations

The Data Locations page of the Configuration Wizard allows you to set the 
data location for all the files and folders that Myriad will use. These are split 
into three main areas.

 Data Locations: Used to store all the databases, settings, schedule 
and general Myriad data and information.

 P Squared Directory: This is a special database that is used to store 
and manage User details, settings and access rights. The P Squared 
Database is common across all third (or higher) generation P Squared 
products so you can have a single Users Directory for organising 
access to Myriad, Scoop, Powerlog, AutoTrack Pro and other P 
Squared products.

 Audio Wall Locations: This final location is where all the audio and 
data files that make up the Myriad Audio Wall are stored. With this 
setting, you have the option to have a single folder for all of your audio 
files or to specify independent locations for the first ten thousand Carts 
in blocks of one thousand.
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The Configuration Wizard will automatically examine all of the drives that you 
have available on the PC and will select the most likely locations for the three 
different data types. Myriad will examine all drives (local and network) and 
look for previous or established Myriad data locations, if it locates any that 
have already been configured then it will use them, if not then it will set to the 
default locations listed below.

Data Location – D:\PSQUARED\MYRIAD\SYSTEM
Directory Location – D:\PSQUARED\DIRECTORY
Audio Wall Location – D:\PSQUARED\AUDIOWALL

(Where Myriad has detected that the D drive is the drive with the largest 
amount of free space available.)

Alternatively, if it locates some previously set locations, it will use them 
instead.
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Mapped Drive vs UNC Locations

WARNING: Here comes the science bit!

There are two different ways that you can specify a file or folder location in 
Windows, you can either use a drive letter (i.e. D drive) or a UNC (Universal 
Naming Convention) path. The following two examples are both valid and 
both point to the same location.

Drive Location –
M:\Myriad\System

&

UNC Location –
\\My_Server\Myriad\System

NB: Please note the format of the UNC, this is the format that must be used 
when working with UNCs.

In this example, the Drive Location refers to a mapped network drive (the M 
drive) that is mapped to a specific folder on the server. The UNC location 
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points directly to the same folder but instead of a mapped network drive, the 
server name (My_Server in this case) is used instead.

Mapped Drives are much simpler to work with in practice as you do not have 
to remember a long location path each time you want to browse a folder or 
file, but if the mapping is lost or disconnected then Myriad will not be able to 
locate any data that uses the mapped drive. UNCs, on the other hand, will 
always work as long as the server is available but because you do not have a 
mapped drive, the User would have to type in the location or browse to the 
server each time they wanted to import, export or save files within Myriad.
One potential solution would be to use UNCs for the key Data Locations but 
then map the drives anyway to make life easier for the system users.

Myriad will work either way but you should consider carefully which 
convention to use as both have advantages and disadvantages. If you are 
unsure, you should consult with your network IT manager.

Data Location

Myriad will do its best to configure the Data Locations to the best place but 
you can always alter it to another location if you prefer. To do this either type 
the location directly into the Data Location box or click on the Browse button 
and then select the location that you wish to use.
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P Squared Directory Location

As mentioned above, the P Squared Directory is a new Contacts database 
that can be used to store contact details and User information for Users of 
your Myriad System. The Directory is also used by a range of other P 
Squared products to provide a common platform for access to all of your 
station’s software systems.

The P Squared Directory takes the place of the Users database in Myriad v2.6 
although it offers far more comprehensive control and tools when compared 
with the older system.

To set the P Squared Directory Location, either type the location directly into 
the box or click on the Browse button to browse for the location.

NB: Because the P Squared Directory is used by a range of P Squared 
products, it is a good idea to set the location to a place that can be accessed 
by all the PCs that may need to use it. 

Audio Wall Locations

Unlike the Data and Directory Locations, the Audio Wall Locations can 
actually be spread over multiple locations if you want. In the example below, 
the Data and Directory settings have been set, but the Audio Wall Locations 
are configured using the Advanced option.
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To access the Advanced options, click on the Advanced button.

The Advanced Audio Wall Locations Window allows you to set a different 
location for the first ten thousand Carts in blocks of one thousand Carts. To 
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set the location of each block of 1000 Carts, either type the location into each 

box or click on the Browse  button for each.

If you want to use the same location for each block of 1000 Carts then tick the 
‘Store all Carts in the same location’ option.

You will also notice that there is a small configuration button on this window. 
This is used to access the Audio Wall Settings options that are also available 
on the Settings menu in Myriad. These allow you to alter a number of settings 
with regard to how Myriad works with the Audio Wall. 
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These are covered in detail in the Settings Menu > Audio Wall File Settings 
later in this manual and do not usually need adjusting at this stage.

Once you are happy with all of your Data Locations, click on the Next button 
to proceed to the next page of the Configuration Wizard.
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Select Role

The next phase of the Configuration process allows you to specify the Role of 
the Myriad PC you are configuring. 

Myriad v3 introduces a new On Air Control system that provides a fast and 
simple system to allow you to assign which Myriad PCs are ‘on air’ at any one 
point in time. The basic idea is that by informing Myriad that it is currently ‘on 
air’ then the PC will be able to make a note of the fact when it is creating Play
Logs and also change the way it interacts with the Scheduled Log 
accordingly. This has been done to enable you to restrict access to the 
Schedule Log so that only the ‘on air’ PC will be able to alter the currently 
running hour. It also allows you to preview Carts and the Log on ‘off air’ PCs 
without affecting the schedule log or providing erroneous data in your Play 
Log and Copy Right reports. 

The On Air Control system in Myriad has three levels of complexity.

1. No On Air Control – Simplest method with no On Air Control system in 
place.

2. Simple On Air Control – The default method offers very simple On Air 
Control. Only one PC can be ‘on air’ at any one time and ‘on air’ status 
is represented by a ‘token’ that is passed from workstation to 
workstation. You can configure Simple On Air Control so that PCs can 
take control at any time or such that the ‘on air’ PC has to release 
control before another can take it.

3. Full On Air Control – This offers full two way communication between 
the PCs in your Myriad system and can be used in conjunction with 
OCP and Myriad STS for switching On Air Control. This option offers 
the most flexibility but is also harder to set up.

The Select Role screen is designed to help you configure the PC you are 
working on to have the correct On Air Control settings simply by asking you 
what the PC will be used for.
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Simply select the option that best describes the role that the PC will be used 
for.

On Air Studio – Always On Air

This option should be selected if the PC you are working on is the only PC 
that will be ‘on air’. This would normally be used on a workstation in a primary 
studio. If this option is selected, the PC will always be set to ‘on air’. Users will 
not have the option to switch other PCs to ‘on air’ status.

Myriad will also be configured to do the following:

 On-Air Control is set to 'Always On Air'
 If the User specified that this computer is only used for one station, 

then Myriad automatically loads that Station Database at start up, 
otherwise prompts User to select a Station Database at start up.

 In Mini-SegEdit mode, when the Play button is pressed Myriad warns 
the User before starting play back.

 If a log is running, Myriad can only be closed while a User is logged in.
 Prompts to setup Auto Login option.
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On Air Studio – Not Always On Air

This option should be selected if the PC will sometimes need to be ‘on air’ but 
other Myriad workstations will also need to be ‘on air’ at times. This is most 
commonly used on studio workstations where you need to switch different 
studios ‘to air’ at different times.

When this option is selected, Myriad will be configured to have ‘off air’ and ‘on 
air’ buttons on the Log screen. This allows Users to manually switch which PC 
has ‘on air’ status.

Myriad will also be configured to do the following:

 On-Air Control is set to Simple Mode
 If the User specified that this computer is only used for one station, 

then Myriad automatically loads that Station Database at start up, 
otherwise prompts User to select a Station Database at start up

 In Mini-SegEdit mode, when the Play button is pressed Myriad warns 
the User before starting play back.

 If a log is running, Myriad can only be closed while a User is logged in.
 Prompts to setup Auto Login option.

Production Use – Never On Air

This option should be selected on PCs that will never be used to broadcast 
‘on air’ but will be used for adding and editing the Audio Wall and Log 
screens. This would typically be in production only studios or key staff offices 
(such as Program Controller etc).

When this option is selected, Myriad will be configured to never have ‘on air’ 
control and not give the User the option to manually do so.

In addition, Myriad will be configured to do the following:

 On-Air Control is set to Never On-Air
 Myriad does not prompt User to select a Station Database at start up.

Administration Computer

This final option should be selected for PCs that will not be used ‘on air’ or in 
a studio capacity but will be used to administer the system and occasionally 
add and edit audio.

When this option is selected, Myriad is configured to do the following:

 On-Air Control is set to Never On-Air
 Prompts User to select a Station Database at start up.
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 Attempts to login to the P Squared Directory using the windows 
username.

It is important to remember that the Roles outlined here provide a fast and 
simple way of selecting the default Myriad settings that best suit the role that 
the PC will be used for. All of the settings can be configured manually using 
the Settings menu within Myriad.

When you are happy with the Role that you have selected, click on the Next
button to move on to the next phase.

Summary 

Once you have finished selecting the Role for your PC, the next screen 
provides a summary of all the options you have selected using the 
Configuration Wizard. Take a second to review these and if you need to, hit 
the Back button to move back through the wizard to make any changes.

Once you are happy, click on the Next button and Myriad will be configured 
according to the information provided over the past few pages of the Wizard. 
This may take a few seconds but once finished, the final screen of the wizard 
will be displayed.
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Click on the Close button to close the Configuration wizard and proceed in to 
Myriad for the first time.

The Station Database Settings Window

Although we have configured Myriad using the Configuration Wizard, if no 
Station Database was already located at the Data Location provided, Myriad 
will automatically create one when it runs for the first time. As the Station 
Database is fundamental to the operation of Myriad, you will be given the 
opportunity to review the Station Database settings that Myriad has used to 
create the new Station Database, as Myriad loads for the first time.
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Myriad automatically sets the Station Database settings to the most 
commonly used values when it is created so unless you wish to change any of 
those settings at this stage, click on the OK button to close the Database 
Settings window and continue into Myriad for the first time.

NB: If you do wish to alter any of these settings, it is advisable to check out 
the Settings Menu > Station Database Settings section of the documentation 
prior to doing so as some of the options in this screen can have a very big 
effect on how Myriad operates.
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And there you have it. Myriad installed, configured and ready to go. So let’s 
get stuck in and have a look around!

The Audio Wall Screen at a Glance

The diagram below shows the standard Audio Wall screen layout when 
Myriad is running on a single monitor configuration PC.
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The list below gives a brief overview of what each item on the diagram is for. 
All of these are covered in more detail in later sections of this manual.

Tab Strip

This allows you to switch the view between the Audio Wall, Instant Carts, 
Database and Log Screens. When you are editing one or more Carts in 
Myriad, a SmoothEdit tab is added to the Tab Strip to allow you to switch 
between the Carts you are editing and the other main screens in Myriad.

NB: When in dual screen mode, the Log Screen is normally displayed on the 
other monitor so does not appear on the Tab Strip.

Find Cart

The Find Cart button opens the Find Cart window which allows you to search 
the Audio Wall for a particular Cart.

Move Cart

The Move Cart button opens the Move / Copy Cart window which allows you 
to move a Cart from one Cart Number slot to another or to copy the contents 
of one Cart to another Cart Number slot.
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Edit

The Edit button opens the SmoothEdit window to allow you to edit the details 
or audio for the Cart highlighted on the main Audio Wall. You can edit more 
than one Cart at a time by opening the first Cart, then clicking on the Audio 
Wall tab, highlighting the second Cart that you want to edit and then clicking 
on the Edit button again. You can switch between the open SmoothEdit
windows by clicking on the Cart Number buttons on the SmoothEdit tab.
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Jump to Cart

The Jump to Cart button opens the Jump to Cart window which allows you to 
type in a specific Cart Number that you want to jump to on the Audio Wall.

Type in the Cart Number that you want to Jump to and click on the OK button.

Home

The Home button takes you directly to the first Cart in your defined User Edit 
Range.

Page Up / Down

The Page Up / Down buttons scroll the Carts visible in the main Audio Wall up 
or down a page at a time. The number of Carts on each page is determined 
by the configurable size of the Carts themselves and the resolution that you 
are running your computer monitor in.

Cart Number

The Cart Number indicator shows the Cart Number of the Cart currently 
highlighted on the Audio Wall. If you click in this area, it will open the Jump to
Cart window.
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Cart Players

The Cart Players are used to play audio Carts in Myriad and are the interface 
that the presenter uses to control audio playback. The number of Cart Players 
displayed will depend on how many you have configured (and how many 
sound card outputs you have) as well as whether you are running in single or 
dual screen mode. In dual screen mode, the Cart Players are spread across 
the two monitors.

The Cart Players and Record Cart Player are displayed on screen at all times, 
regardless of which screen you are viewing.

Record Cart Player

As the name suggests, the Record Cart Player is a special Cart Player that is 
used for recording audio into Myriad. If you click on a blank Cart, and then 
click on the record button, Myriad will start to record the designated audio 
input into that Cart. If no Cart is selected then Myriad will automatically select 
the next free Cart from your defined personal edit range, if none is available 
then you will be asked to confirm which Cart you want to record into.
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Once recording, click on the record button again to stop recording.

The Cart Players and Record Cart Player are displayed on screen at all times, 
regardless of which screen you are viewing.

Carts 

The Carts themselves make up the main part of the Audio Wall screen with 
each Cart having a unique number and containing a single piece of audio. 

There is a large range of information that can be stored on a Cart and this 
information is covered in detail in the next Chapter.

Date

Displays the current date.

Jump Buttons

The Jump Buttons provide up to five ‘quick jumps’ to configurable Carts on the 
Audio Wall. The most common way of organising Carts on the Audio Wall is to 
group them in specific areas so you might have all your jingles starting at Cart 
Number 1 and your music starting at Cart Number 3000. If this is the case 
then you can set up the Jump Buttons to provide a fast and convenient 
shortcut to these areas. You can set up five major Jump Buttons which are 
displayed on the Audio Wall screen at all times. Clicking on these buttons 
automatically jumps the highlighted Cart to the Cart Number specified on the 
button. There is also a More button that opens the More Jumps window which 
allows you to configure the five major Jump Buttons as well as add an 
unlimited amount of personal and shared additional Jump Buttons (see More 
Jump Buttons).
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For more information on how to work with Jump Buttons, please refer to the 
Jump Buttons section of the main Audio Wall documentation.

More Jumps Button

The More Jumps button opens the More Jumps window which provides 
shortcuts to specific places on the Audio Wall. You can set up Jumps on a per 
User (personal) basis as well as for the Local PC and Shared access.

You can also access this window using the More button located on the Jump 
Buttons section of the main Audio Wall screen.

Clock

The Clock displays the current PC system clock time. If your PC is configured 
to set it’s time from an external source (such as radio clock or NTP time 
server) then this is the time that is displayed.

The Instant Carts Screen at a Glance

Instant Carts in Myriad are shortcuts to specific Carts on the Audio Wall and 
they can be fired at any time using a single keyboard button press or mouse 
click. In this way, they can be used as ‘hot keys’ to fire different Carts or as a 
convenient way of grouping Carts that are located in different areas of the 
Audio Wall. The Instant Carts are arranged in groups of twenty called Sets 
and these can be added to the system for either personal or shared use.
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The diagram below shows the general layout of the Instant Carts screen.

Each of these areas on the Instant Carts screen are explained in brief below. 
They are also covered in more depth in later Chapters.

The Cart Players and Record Cart Player are displayed on screen at all times, 
regardless of which screen you are viewing.

Tab Strip

As with the Audio Wall screen, the Tab Strip is used to change the principle 
view between the Audio Wall, Instant Carts, Database and Log screens. 
When you are editing Carts, a SmoothEdit tab is also added to the Tab Strip.

Refresh Button

The Refresh button will check both the Instant Cart Set list and the Instant 
Carts displayed on screen to make sure that they have not been altered on a 
different workstation. If they have been altered then the screen will be
updated to reflect the change.

New Set

Instant Carts are arranged in groups of twenty and each of these is called a 
Set. Instant Cart Sets can be added as either personal (only available when 
you are logged in) or shared (available to all Users).

The New Set button adds a new Instant Cart Set to the system. Whether this 
Set is added as a ‘personal’ or a ‘shared’ Set depends on which of the two 
options is highlighted in the Instant Carts Set section (see below).
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The New Set is initially marked as ‘untitled set’ but you can over-type this with 
a more useful name for your Set.

This option is also available on the right click menu on the Instant Cart Set 
area.

Rename

The Rename button allows you to rename an existing Instant Cart Set by 
highlighting the Set name and then clicking on the Rename. You can then 
over-type with the new Set name.
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This option is also available on the right click menu on the Instant Cart Set 
area.

Delete

The Delete button allows you to remove an Instant Cart Set by highlighting it 
in the Instant Cart Set section and then clicking on the Delete button.

You will then be asked to confirm whether you wish to continue. If you click on 
Yes then the Instant Cart Set will be deleted from the system (but the Carts 
will still be on the Audio Wall).

This option is also available on the right click menu on the Instant Cart Set 
area.
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Set Name

Displays the name of the Instant Cart Set currently in use.

Instant Carts

The main part of the Instant Carts screen is the twenty Instant Carts 
themselves. Each Instant Cart carries the Cart Number of the Cart that will be 
played when it is triggered along with the Cart’s description. 

To trigger an instant Cart, either press the corresponding key on the keyboard 
or click on the screen.

NB: Use keys 1-0 for Instant Carts 1 to 10 and <shift> + Keys 1-0 for Instant 
Carts 11 to 20.

Instant Cart Sets

The Instant Carts are arranged in groups of twenty called Sets and these can 
be added as personal (only available when you are logged in) or shared 
(available to all Users on the system). The Instant Carts Set area is used to 
display the Sets on the system and whether they are personal or shared. You 
can use this to select the Instant Cart Set displayed on screen as well as 
adding new Sets, changing the name of Sets and deleting Sets.

The Instant Cart Sets are arranged in a ‘tree view’ to make navigating them as 
intuitive as possible.

You can hide the Instant Cart Sets area by clicking on the Pin button located 
at the top of the window. In this situation, the Instant Carts take up the whole 
screen and Instant Cart Set list is hidden at the top of the screen. To access 
it, click on the Available Sets panel to expand the list.
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The Database Screen at a Glance

The Database screen shows a copy of the AutoTrack or AutoTrack Pro Song 
and Link databases to allow you to view Songs and Links by Category as well 
as Artist and Title. You can also perform a more advanced search from this 
screen but it will only encompass Songs and Links that are in your schedule 
database.
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If you are not using AutoTrack or AutoTrack Pro then you can still use the 
Database screen to a limited extent by exporting your scheduling system 
database in a specific format that the Log Importer (the program that imports 
Selector™ and Powergold™ logs into Myriad) can understand.

Tab Strip

As with the other screens in Myriad, the Tab Strip allows you to switch 
between the Audio Wall, Instant Carts, Database and Log screens as well as 
SmoothEdit when editing one or more Carts.

Search Criteria

The Search panel allows you to enter search criteria that you wish to use to
search the Database for matching items.
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Type in the criteria you wish to use, set any options that you wish to include in 
your search and then click on the Find button.

The results are listed in the Song Link List Area section of the window.

Song / Link List Area

This main section of the Database screen shows a list of all the Songs or 
Links in the Database that match the search criteria or are contained within 
the Song Link Category highlighted on the left hand Category Navigation 
Tree.

The Song / Link List Area is divided into a series of columns that are used to 
describe the Database entries. You can re-order the items in the Song / Link 
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List Area by any of the column attributes by clicking on the appropriate 
column title (like a spread sheet).

Details

The Details button opens the details for the selected Song or Link including 
the general Cart information, Notes and AutoTrack / AutoTrack Pro 
information.

You can also double click on Songs / Links in the Song Links Results window 
to access this information.
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Cue
This button will cue the highlighted Song or Link into one of the free Cart 
Players.

Edit

The Edit button will open the highlighted Song or Link for editing (see Edit on 
the Audio Wall screen).

Song / Link Navigator

The Song / Link Navigator provides a ‘tree’ like view of the Songs and Links 
stored in your AutoTrack or AutoTrack Pro databases. You can use the Song / 
Link Navigator to view Songs and Links by Artists and Category by clicking on 
expanded folders. The results are listed in the Song Link Results window.

The Legacy Button

This button is only visible if Myriad has been configured to allow Users to 
manually import Database information from legacy AutoTrack v2 databases.

When you click on this button, Myriad automatically imports the Database 
information from your AutoTrack v2.6 database. AutoTrack v3 and AutoTrack 
Pro v3 users need not configure this option as the Database is updated each 
time AutoTrack or AutoTrack Pro ‘pushes’ a schedule into the Schedule Log.
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The Log Screen at a Glance

The Log screen is arguably the most important screen in Myriad as it contains 
the scheduled programming for your station’s output for both live assisted and 
automated broadcasts. 

The Log screen primarily consists of a list of items for each hour along with 
the tools needed to play these items and control the way Myriad runs through 
the log.

All of the Log screen options are covered in greater detail in later Chapters 
but the following outlines the general features of the screen.

The Power Button

The Power button is a bit like the on/off switch on your TV. If you click the 
Power button then Myriad automatically switches to the default playout mode 
for the hour of the Log currently in use, loads the first Log Item to be played, 
enables the Go button and then sits and waits for you to start playback by 
pressing the Go button either on screen or on your keyboard.
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When you press Go, Myriad starts playing through the Log in whichever 
playback mode was set for the current hour.

If you click on the Power button again, Myriad switches from whichever 
playout mode it was in, back into Standby mode.

If you are using On Air / Off Air control, Myriad can also be set to take control 
automatically when the Power button is pressed.

Date

This shows the current date, along with the current hour that is highlighted in 
the Log, and the show name as defined by the scheduling system.

Playout Mode

These buttons allow you to select the current playout mode for Myriad as well 
as indicating the current mode when it is running. 

If you click on one of the Playout Mode buttons, Myriad automatically switches 
to that mode. If it was in standby prior to you clicking, it will load the first item, 
enable the Go button and then wait for you to tell it to start playback by 
pressing go.

The current Playout Mode is displayed by the corresponding button remaining 
depressed. You can switch to a different mode at any time by clicking on one 
of the alternate Playout Mode buttons. If you click on the depressed Playout 
Mode button, it pops back out and Myriad switches back to Standby mode
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where no further action will take place (but any playing Carts will continue
playing until they reach their end).

There are five possible options for Playout Mode and they are outlined below.

Preview Live (off air only)

This mode is only available when the workstation is not On Air and allows you 
to preview the log as if it were in ‘live assist’ mode without making any 
permanent changes to the timing information log. This allows you to practice a 
‘live assisted’ show without affecting the on air log. In Live mode, the User 
controls whether items are automatically or manually segued (mixed) by using 
the Segue Type indicator (green – auto, red – stop).

Preview Auto (off air only)

This mode is only available when the workstation is not On Air and allows you 
to preview a show in automation mode without permanently changing the 
timing information on the log. In Automation mode, all items in the log will 
automatically be segued (mixed) into the next.

Live (on air only) 

The Live mode is only available if the workstation you are working on is 
currently On Air. In Live mode, the presenter controls when Myriad 
automatically segues on to the next item and when it stops and waits to be 
told to continue. This is controlled by the Segue Type control on each item 
(red – stop, green – go) and can be toggled by clicking on the Segue Type 
icon.

Live mode is the most commonly used mode for presenting live shows as 
Myriad will load each item as you need it but you control how the action flows.

Auto (on air only)

In Auto mode, Myriad will turn all of the Segue Types green (automatically 
segue from one to next) within a given hour and then play through all the 
items in the Log for that hour in an automated fashion.

Auto Fade (on air only)

Auto Fade mode is similar to Auto mode in that it is used to switch all of the 
Segue Types green to play through the hour in automation but the difference 
is that whilst Auto will just play all the items in the Log for the hour, Auto Fade 
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will automatically back time the hour so that it ends at the correct time (i.e. the 
end of the hour). It will also work around time critical events (called Absolute 
Time Markers) which allow you to have automated output that can interact 
with time critical events such as external news etc.

For more details on Auto Fade mode and how Myriad works with time critical 
events, please refer to the Chapter 6 – The Log Screen section of the 
documentation.

On Air / Off Air Toggle

In most cases, stations will have more than one Myriad workstation in 
operation and in such cases, it is desirable to have a way of indicating which 
of the workstations is ‘on air’ at any one time. This is important as it allows 
you to apply control over people editing the currently running Log and also 
provides accurate play logs for reports to advertisers and copyright report 
bodies. Myriad offers three levels of On Air / Off Air Control.

1. No On Air Control: The terminal is either always set as On Air or 
never On Air.

2. Simple On Air Control: Only one workstation can be On Air at a time 
and On Air control is taken by clicking on the On Air button. This option 
requires no special configuration.

3. Advanced On Air Control: This provides a more complicated 
mechanism for On Air control and allows Myriad to interact with 
external systems such as OCP and Myriad STS. This option requires 
additional configuration.

If you are using option 1 then the On Air / Off Air button is not visible on the 
Log screen, but, if you are using options 2 or 3 then the On Air / Off Air 
buttons act as both the indicator as to the status of the workstation you are 
working on as well as the button to switch state.

Basically, if the On Air / Off Air button is displaying On Air then this 
workstation is currently ‘on air’. If you click on the button, the status will 
change to Off Air indicating the workstation is no longer ‘on air’. You can now 
set an alternate workstation to On Air (to make studio 2 the live studio for 
example).

You can set both Simple and Advanced On Air control so that On Air control 
must be released before it can be taken by another workstation, or if you 
prefer you can have it so any workstation can take On Air control at any time. 
These settings can be found on the On Air Control tab on the Settings> 
Myriad Settings menu, there are more details on this later.

Clock
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The Clock in the top right hand corner of the Log screen shows the PC 
system clock time. If you have a radio receiver clock attached, or your PC is 
updating it’s time from a network time server then this correct time will be 
displayed here.

Start Button

The Start button will automatically move the cursor in the main Log window to 
highlight the Hour Start for the hour that you are currently working on.

This can be useful if you wish to return to the start of the hour to change the 
Playout Mode for the hour (using the right click menu) or you just want to 
double check which hour you are looking at (although this is also covered in 
the Date section above).

Page Up

As you would expect, this button moves the view up the Log a page at a time. 
The amount of Log Items displayed on a page will depend on the monitor 
resolution and the size you have set the text on the Log Items to be. You can 
also use the <Page Up> key on the keyboard or the ‘wheel’ on some mice to 
move up and down the Log.

Home
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Clicking on the Home button will move the Log display to highlight the Log 
Item that is either playing right now or should be playing if nothing is actually 
playing. This button has two main functions.

1. Find your way back to the currently playing item if you are lost or have 
been editing the Log for another hour.

2. Find the item that should be playing when you are starting a Live 
Assisted or Automated show.

You can also press the <Home> key on your keyboard.

Page Down

Page down does the opposite to Page Up in that it allows you to scroll down 
the Log a page at a time.

Next

Just as the Start button jumps back to the Hour Start for the current hour you 
are looking at, the Next button moves the highlighted Log Item to the Hour 
Start for the next hour in the Log.

Trash Can

The Trash Can icon is used to permanently remove Log Items from the Log. 
Simply drag a Log Item from the Log into the Trash Can and it is deleted from 
the Log. You can also use the right click menu to permanently delete a Log 
Item.

Segue Type

The Segue Type indicator shows what will happen at the end of each Item in 
the Log. 

 Red indicates that when this Log Item finishes, Myriad will cue the next 
one but will not start to play it until the user says so.

 Green indicates that Myriad will automatically segue in to the next Log 
Item when the current one finishes.

 Yellow, this is a special case where Myriad will ‘sweep’ the Item into the 
Intro of the following item. The most common use for this is pre-recorded 
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Voice Links or jingles that you want to be ‘back timed’ up to the Intro end on 
the next Song.

You can toggle between Red and Green Segue Types on a per item basis by 
clicking on the Segue Type for each item. You can only do this in Live or Live 
Preview modes (or standby mode) as the Segue Type is automatically 
changed to Green for all items when in Auto, Auto Preview and Auto Fade 
modes.

In general, the Segue Types are originally set in the scheduling system (such 
as AutoTrack Pro) when setting up templates or Clocks for shows.

Once a Log Item has been played, the Segue Type icon also has a tick 
graphic added to it to indicate that it was played successfully.

If a Log Item is Soft Deleted from the Log (i.e. it is marked so that it does not 
play but remains in the Log) then a red cross graphic is added to the Segue 
Type icon.

The item is also ‘greyed out’ to indicate that it has been Soft Deleted.

Segue Editor

The Segue Editor performs two roles and can be viewed in two different ways.

Mini Segue Edit Mode

The Segue Editor is visible at all times in the Log screen in Mini Segue Edit 
mode and the primary role of the Segue Editor in this mode is to alter and ‘fine 
tune’ the way that Myriad will perform an automated segue.

In this mode, you can drag the lower Log Item to the left or right to change the 
way Myriad will perform the segue between the two items.
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You can review the new segue by clicking on the play button and when you 
are happy, click on the save button to commit the new segue.

Tip: You can even segue the end of the item that is currently playing as long 
as it is not too close to the end!

Full Segue Edit Mode

You can also expand the Segue Editor to Full Segue Edit Mode by clicking on 
the SegEdit button on the Main Tab Strip.

This expands the Segue Editor to it’s full height which not only allows you to 
perform the type of segue editing outlined above, but also allows you to adjust 
the ‘fade’ period of the outgoing item.
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Recording Voice Links (in brief)

You can also use this mode to record Voice Links (sometimes called voice 
tracks) into automated programming. The procedure is very simple.

1. Highlight the Song / Link that you want to be playing at the end of your 
voice link.

2. Click on the SegEdit button to enter Full Segue Edit mode.
3. Press the <space bar> key and the end of the last Song / Link will start 

playing.
4. Put up the mic channel fader on your desk and start speaking, Myriad 

will automatically start recording. Alternatively, press the <space bar> 
again to start recording.

5. Press the <space bar> to start the next Song Link playing when you 
are ready.

6. At the end of your vocal link, press the <space bar> to stop recording. 
You will then be asked whether you wish to save the Voice Link.
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7. Hit <space bar> one final time to confirm that you want to save and you 
have finished recording a Voice Link.

You can now edit this segue and fade points of this Voice Link in the normal 
way.

To return to Mini Segue Mode, click on the SegEdit button again.

Overrun

The Overrun indicator shows whether the Log Items in the current hour are 
set to over run the top of the hour (shown in black) or under run to the top of 
the hour (shown as a minus number in red).

When you are running in Auto Fade mode, this number will normally be 
00:00.00. If it is a minus number then you will need to add some more Log 
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Items in order to avoid the automated hour running out of content before the 
end of the hour. 

NB: this is flagged up as a report by AutoTrack, AutoTrack Pro and the Log 
Importer when using 3rd party music schedulers.

Time Remaining

The Time Remaining indicator shows the total remaining duration of all the 
Log Items left in the current hour. In the example above, the Time Remaining 
is 00:09.25 which means that the remaining duration the Daniel Bedingfield 
song added to the total length of the Britney Spears and Billy Ocean songs is 
9 minutes and 25 seconds. Obviously, the number is continually counting 
down when Log Items are playing.

Intro Time

The Intro Time indicator on audio based Log Items (usually just Songs) shows 
the duration of the beginning section that has been set as the Intro. The Intro 
to a Song is usually defined as the part of the Song that it is possible to speak 
over before the main body of the Song kicks in. You set the Intro duration on a 
Song by Song basis using SmoothEdit (See SmoothEdit in the main Audio 
Wall Chapter). Not all Songs have an Intro so some Song Log Items will not 
have Intro times displayed.

Technically, you can set Intros on any audio based Cart on the Audio Wall so 
you could set them on Links, Adverts or just about anything else but you 
would not normally do so unless you had a specific use in mind.

Length / End Type

This indicator shows the overall duration of the Log Item as well as the Ending 
Type for the item. 

The duration is normally the total length of the audio from the beginning to the 
Extro point or if no Extro point has been set, the end of the audio file.

The End Type is used to indicate to the presenter, how the audio Log Item will 
end. The options are:

 Ends – Comes to an abrupt ending.
 Fades – Has a discernable fade out.
 Sustain – The end is sustained.
 Slow Fade – Has a longer fade out.
 Non Specific – Has a non-descript ending.



80

This is also important to the automation process as Myriad considers the End 
Type of Songs when it is deciding what Songs it can fade out early in Auto 
Fade mode in order to run to time. 

Under certain circumstances, Myriad may need to alter the Length of a Song 
so that it can fade it out early to hit an Absolute Time marker or because the 
segue has been manually edited using the Segue Editor. In this circumstance, 
the original Length is crossed out and the new Length takes its place.

(NB: In the show above, the Length has been shortened by 1 second using 
the Segue Editor).

It is also worth noting that the Length and end Type have changed to red text 
which indicates that the items are now not droppable so Myriad cannot 
automatically drop them in order to run to time.

Description

This field shows the description for the Log Item in question. When dealing 
with Song, Link and Cart Log Items, the Description is usually the Title and 
Artist or the description used on the Carts themselves. For non Cart based 
Log Items (such as Hardware Events and Hour Start Markers) the Description 
is used to convey key information about the Log Item.

Cart Number

Shows the Cart Number of Cart based Log Items.

Next Segue

The Next Segue counter counts down the time to the next segue in the Log. If 
Myriad is in Auto or Auto Fade mode or if the Segue Type is set to green for 
the current item in Live mode then this will be the count down to when the 
next Log Item will start. If Myriad is in Live mode and the current Log Item has 
a Red Segue Type then it is the countdown to when that item will end.
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Start Time

The Start Time is listed on all Log Items and is the estimated time that the Log 
Item will be played based on best current information. The Start Time is 
calculated assuming that there will be no pauses in playback so each time 
you stop between Log Items to speak or use an external source; the Start 
Times are recalculated automatically when the next Log Item starts.

Start Times are very useful for looking at hours that will be played in the future 
and are especially handy when recording Voice Links using the Segue Editor 
although it should be kept in mind that they are an indication only and are 
subject to external factors such as Songs being dropped or vocal links being 
added.

The Go Button (not shown on diagram)

The Go button is fundamental to using Myriad in a Live Assisted show and to 
a lesser degree in automated environments as well. 

The Go button is only enabled when Myriad is in an active Playout Mode 
(Live, Auto or Auto Fade) and is used to either start the Log running, move on 
to the next Item or start the next Log Item after a pause. 

The exact function of the Go button can be configured to a certain extent but 
by default, if you click on the Go button when Myriad is playing a Log Item, 
that Item will be faded out and the next will start (regardless of whether it has 
been cued up or not). If playback has either not yet started or you are in Live 
mode and you have paused (using a red Segue Type) to do a Vocal Link or 
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external source, pressing the Go button will start playback of the next Item in 
the Log.

Basically, you can run your entire show from the Go button.

Item Type Indicator

The Item Type Indicator is a graphical icon that can be used to determine the 
Item Type of each Log Item. The Item Type Indicator options are as follows:

 Song

 Link

 Advert Break

 Absolute Time

 Cart

 Command

 Hardware Event

 Split Advert Break

 Split Cart Group

 Voice Link

When a Log Item is playing (or in operation), Myriad locks it to prevent it from 
being moved, or deleted from the Log. This also happens to the next Log Item
about 3 seconds before it is needed. When a Log Item is locked, a padlock 
icon appears on top of the Item Type Indicator as seen below.
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Soft Deleting Items Using the Item Type Indicator
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In addition to indicating the type of Log Item, the Item Type Indicator can also 
be used to Soft Delete Log Items which means that Myriad will not play them 
and their duration will be removed from the Start Time and Overrun time 
calculations but they will physically remain in the Log just in case you want to 
reinstate them at a later time. To Soft Delete a Log Item, click on the Item 
Type Indicator.

To reinstate a Soft Deleted Log Item, click on the Item Type Indicator of the 
Soft Deleted Item.
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NB: The Item Type Indicator includes a red cross on Soft Deleted Log Items 
and the Log Items appear to be ‘greyed out’ as well. 

You can also Soft Delete Log Items using the right click menu.

Info Panel

The Info Panel is used to display any additional text information associated 
with the highlighted Log Item.

If there are several lines of text to display, Myriad will automatically scroll 
through the text after pausing for a few seconds initially.

You can also open the text information in a separate window by clicking on 
the Info icon within the Info Panel.

Hook Icon

The Hook Icon indicates whether the Log Item has a Hook defined on the Cart 
that it refers to. Usually, only Songs have Hooks defined but technically, any 
Cart on the Audio Wall can have a Hook set. Log Items without the Hook Icon 
do not have Hooks set.
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Info Icon

Like the Hook Icon, the Info Icon indicates that the Log Item has some 
additional text information set. This information will be displayed in the Info 
Panel when the Log Item is highlighted (see above).

Preview

The Preview button on the Tab Strip is used to load the highlighted Log Item 
into the Preview Cart Player to allow you to review the Cart without affecting
the actual playback from the Log.

The Preview Cart Player can be defined as any of the Cart Players. The 
difference is that when a Log Item is reviewed as a Preview, it becomes 
completely independent from the Live or Auto playback from the Log, indeed, 
if you Preview a Log Item and then leave it in the Preview Cart Player, when 
the time comes to play that Log Item, Myriad will actually load a new version 
into one of the other free Cart Players, totally ignoring the Preview version. 

You can also Preview a Log Item using the right click menu.
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PreCue

The PreCue button is used to force Myriad to cue up the next Log Item in the 
Schedule Log regardless of whether it needs to or not.

When you click on this button, Myriad will cue the next Log Item to play in the 
next free Cart Player.

Suggest

The Suggest button is used to open a list of alternative Songs or Links that 
are in the same Song or Link category in the Database screen. To use this 
facility, highlight the Song or Link that you want Myriad to suggest alternatives 
for and then click on the Suggest button.

You will then see a list of alternative Songs or Links that are in the same 
category. If you double click on one of these, it will replace the Log Item 
originally highlighted.

Carts
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The Carts button on the Tab Strip opens Myriad’s mini Cart Browser which 
you will find is used throughout the Myriad Suite to allow you to browse, 
search and select Carts from the Audio Wall without accessing the main 
Audio Wall screen.

SegEdit

We have already covered the Segue Editor in both Mini and Full modes. The 
SegEdit button on the Tab Strip allows you to switch between these modes 
easily. For more detail, see the Segue Editor covered earlier in this Chapter 
and in Chapter 5.

In the context of the Log screen, the primary role of the Carts Browser is to 
allow you to browse the Audio Wall and drag Carts directly from the Cart 
Browser into the Log. This is especially useful when running in single screen 
mode as you cannot (normally) have the Audio Wall screen and Log Screens 
visible at the same time.

The Cart Browser has all the main features of the standard Audio Wall 
including Find Cart and Jump. The Cart Browser is covered in more detail 
later.
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GoTo

The GoTo button allows you to specify a time and date in the Log that you 
want to view or work with. Click on the GoTo button to open the GoTo window 
and the type in the time and date that you are interested in.

Click on OK to go to the selected time and date.

Tab Strip

As with all the other screens we have looked at, the Tab Strip allows you to 
switch between the major screens in Myriad which are Audio Wall, Instant 
Carts, Database, Log and SmoothEdit.

The Tab Strip for each of these also contains a number of buttons to allow 
you to access the primary functions for that screen.

The SmoothEdit Screen at a Glance

The SmoothEdit screen (also sometimes called the Edit Cart) is used to view 
and edit the details and settings for Carts and also edit the actual audio 
should you wish to. 

A good working knowledge of SmoothEdit is essential for getting the most 
from your system but as the SmoothEdit screen plays a big role in adding 
Carts to your system, you are likely to be familiar with it fairly quickly. The 
picture below shows the standard SmoothEdit screen layout.



90

We will now look at these items in brief; they will also be covered in greater 
detail in Chapter 2 – The Audio Wall.

Edit Cart Tool Bar

The Edit Cart Tool Bar offers a range of tools designed to help you when 
working with Carts in general. The Edit Cart Tool Bar differs from the 
SmoothEdit Tool Bar (see below) in that the Edit Cart tool Bar tends to deal 
with the Carts as a whole (text, audio, pictures etc) as opposed to the 
SmoothEdit Tool Bar which concentrates on offering audio editing tools.

Cart Number

The Cart Number box shows the Cart Number of the Cart that you are 
currently working on.
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External Audio Editor

Whilst Myriad v3 does offer the ability to edit the audio in Carts because it has
P Squared’s SmoothEdit audio editor built in, there may be times when you 
need a more powerful audio editor or you would prefer to work with an audio 
editor that you are familiar with. In these circumstances, Myriad can be 
configured to launch a 3rd party external audio editor by clicking on the 
External Audio Editor button.

Link to Wave File

There are two ways that Myriad can deal with the audio that is associated with 
a Cart. The audio file can either be imported into Myriad in which case a copy 
of the original audio file is made and stored in the Audio Wall Location. The 
alternative way is to Link to the original audio file which does not duplicate the 
file and Myriad uses a reference to that file instead. This method is potentially 
more efficient in terms of hard drive resources but does offer more potential 
for problems in that the Audio Wall is not centrally located and it is easy to 
delete a file that it is linked to without realising it. 

The Link To Wave File option has a drop down menu.

The options are:

 Select the file to link to.
 Stop linking to the current file.

Export Cart Info

The Export Cart Info option on the Edit Cart Tool Bar allows you to export the 
Cart that you are working on as either a Transport File or an Audio File.

If you select Transport File then all of the Cart details will be added to a ‘.zip’ 
file in such a way that other Myriad systems will be able to import them. 
Transport Files contain all information about Carts including copyright details, 
notes, timing information and pictures.
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If you select Audio File then the Cart will be exported as a ‘.wav’ file which can 
be used by most software systems. When Myriad creates an audio file, it also 
embeds some key information about the Cart into the ‘header’ of the actual 
audio file using a convention called Cart Chunk. This means that key 
information such as description lines, and timing information will be retained 
and can be extracted by other Cart Chunk compliant software (and other 
Myriad systems) but some information such as pictures, notes and copyright 
information will be lost.

In both cases, once you have selected the format, all you have to do is set the 
name and location that you want the Cart to be exported to.

Save Cart

The Save Cart option is only enabled once you have altered the audio or data 
for the Cart you are working on. You can click on the Save Cart button at any 
time to save the changes to the Cart you are working on. If you attempt to 
close a Cart (that you have altered) without saving, you will be prompted to do 
so. You can then decide whether to save your changes or not and keep or
discard the changes you have made.

Delete Cart
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The Delete Cart button will delete all audio and data from the Cart Slot you 
are working on, leaving it blank.

If you click on the Delete Cart button, you will be asked to confirm your 
actions before the Cart is deleted. 

Caution: Once a Cart is deleted, it cannot be recovered so please be careful.

Import Audio File

This option allows you to import either an audio (wav) file, or a transport (zip) 
file, into the Cart you are working on. You can either start with a blank Cart or 
a populated Cart depending on whether you want the imported audio to be a 
new Cart or replace an existing Cart on the system. 

When you click on the Import Cart option, you will first be warned that 
importing over an existing Cart will erase all previous data. Once you have 
confirmed this, simply use the explorer window that opens to locate the audio 
(wav) or Transport (zip) file that you want to import.

Toggle Cart Description

The Toggle Cart Description option allows you to toggle the Cart Description 
information area between visible and hidden. This is useful if you are working 
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on audio editing and want the edit window to be larger. The two screen shots 
below show Edit Cart in both states.

The General Tab

The General Tab is used to set the most general information about the Cart 
you are working on such as the Title and Artists, the End Type and the colour 
of the Cart as it appears on the Audio Wall. Crucially, the General Tab also 
includes the Timing Info Panel which includes all the Timing information such 
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as Intro and Extro points, as well as information about hardware points, Hooks 
and Loops.

Title, Artist & Description Lines

These are used to add the primary description that is displayed on the Audio 
Wall and all places in Myriad where the Cart is used. 

In general, the first description line is used for Title whilst the second and third 
are used for Artists one and two.

This can be important as there are areas in Myriad where only the first 
Description line is displayed and more importantly, if you are using AutoTrack 
or AutoTrack Pro, the first Description line is typically imported as Title whilst 
the second and third are imported as Artists one and two.

When you are adding the descriptions for Carts that are not Songs, you can 
use the Description lines in whichever way suits your needs best.

You do not have to use all description lines, although it is a good idea to fill in 
at least one on each Cart. Each description line is limited to 50 characters.

End Type

This option allows you to select the type of ending that best describes the Cart 
you are working on. There are five options:
 Ends (E) – The Cart comes to an abrupt end.
 Fades (F) – The Cart fades out at the end.
 Sustain (S) – The Cart’s ending is sustained for a period at the end.
 Slow Fade (SF) – The Cart fades out over a longer period at the end.
 Not Specific (blank) – The ending has not been specified.

The End Type is used to let the presenter know how a Cart is going to end but 
is also used by Myriad to determine which Songs in an Auto Fade hour can be 
faded early in order to hit time critical markers (Absolute Times). The logic is 
covered in greater detail in Chapter 2 but in brief:

Ends – Cannot be faded early.
Fades – Can be faded early.
Sustain – Cannot be faded early.
Slow Fade – Can be faded early.
Not Specific – Cannot be faded early.

Custom Colours
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The Custom Colours section allows you to set a specific colour for the 
background and text for a Cart as it appears on the Audio Wall. Tick this 
option to enable it, and then click on the following buttons:

To change the background colour of the Cart.

To change the text colour for the Cart.

In either case, select the colour you want to use with the colour pallet window.

Time Info Panel

The Time Info Panel is an essential part of the Cart information as it contains 
the Timing information that Myriad will use when playing Carts. It also 
includes additional information about Looping Carts and also Hardware 
Events that can be associated with certain Timing events.

The Timing Tab

The Timing tab contains the main Timing information for the Cart you are 
working on.
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The key Timing events are:

 Intro Start – The beginning of the Intro (the bit you can talk over). This 
is usually set to zero (beginning of the song) unless the song has a 
specific start that you do not want presenters or sweepers to clash 
with.

 Intro End – This is normally defined as the place in the song where 
you would want your DJ’s to stop talking or your sweepers to finish 
playing. Typically it is when the vocals start or maybe a drum beat 
kicks in.

 Extro – This is the point that Myriad will start the next item when it is 
performing an automated segue. It is typically very close to the end of 
the song, maybe as it is fading out.

 Hook Start – The Hook is the most recognisable part of the Song and 
is often used as a ‘teaser’ for what is going to be played soon. Myriad 
has the ability to play Hooks as part of an automated run so this is a 
useful addition to the Cart. The Hook start marks the beginning of the 
Hook.

 Hook End – This marks the end of the Hook.

Setting these timing events is covered in detail in Chapter 6 but in general, if 
you click on the play button on SmoothEdit (see Smooth Edit Audio Controls) 
you can then click on the ‘Set’ button at the appropriate time to set each of the 
Timing events. You can fast forward and rewind using ‘<’ and ‘>’ keys on the 
keyboard or by clicking in the Audio Editing Area. Finally, you can adjust the 
Timing events by using the Audio Editing Area.

The Looping Tab

Myriad also allows you to mark a section of a Cart to be looped when it is 
played. This is most commonly used to create dynamic ‘music beds’ and is 
covered in greater detail in Chapter 2 but in brief, you can mark a section to 
be looped using the Loop tab. When Myriad plays this Cart, it will repeat the 
looped section for either a set amount of iterations or until the presenter 
presses the Play button on the Cart Player that is playing the Cart. 

The Looping information and settings are set on the Loop tab.
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The Loop start and end times can be either typed in or set using the Set 
buttons during playback (see Timing tab). Once they have been set, it is worth 
reviewing the Loop using the Play button and if necessary, fine tuning the 
Loop start and end using the Edit Audio Area.

Once you have set the start and end, decide how many times you want the 
loop to happen (e.g. 10 times) and finally whether you want playback to jump 
to the Loop End point when a User clicks the Play button on the Cart Player 
(tick option) or whether you would prefer for the Cart to continue normally 
from the point that the Play button is ticked (leave option un-ticked).

The Hardware Tab

The Hardware tab allows you to add special Hardware Events to the Timing 
Events described earlier (in the Timing tab section).

For each of the Timing events, you can use the drop down list to select a 
Hardware Line that you want to perform an action on, and then use the 
second drop down list to select the action that you want to take. The options 
are:

 Set – Turn on.
 Clear – Turn off.
 Flash – Flash on and off continuously.
 Pulse – Turn on for a short time, and then turn off.
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Hardware and its uses can be considered a more advanced Myriad feature 
and is covered later in this manual so there is not too much to worry about if 
the above means nothing to you at this stage.

The most common use for attaching hardware events to timing events is to 
use a single Cart to control the automated switching of external events such 
as a satellite news service.

The Notes Tab

The Notes tab allows you to add a range of additional notes to the Cart. 
Switching to the Notes tab shows the additional notes that you can add.

The notes fields on the Notes tab are outlined below.

 Studio Notes for the presenter – As the title suggests, these are 
notes that will be displayed on the Log screen when the Cart is played 
and are intended to aid the presenter.

 DAB Notes to be transmitted to compatible DAB transmitters –
These notes can be used by OCP (see The Standard Myriad Suite 
earlier in this Chapter) to feed DAB transmitters with text information 
about the Cart being played.

 Information displayed on the web – Again, these notes can be used 
by OCP to update your website in real time, with information about the 
Cart that is playing or playing next.

 Artist / Performer webpage – This can be used by OCP but also may 
be useful for the presenter.

 Online store reference – This can be used to add unique IDs to Carts 
to allow you to link them to external music stores (such as 
www.amazon.co.uk).

The above is intended as a guide only. The Notes fields can be very personal 
to each station so use them in a way that is most appropriate to you.

The Copyright Tab
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The Copyright tab is used to add copyright details to the Cart you are working 
on. This in turn, can be used by Myriad to generate accurate reports for the 
copyright agencies in your country (PRS/PPL/MCPS in the UK).

Each country has slightly different definitions for the fields that need to be 
included in the reports submitted to them by radio stations so it may be that 
some of the fields listed below are not relevant to your situation.

 Product Title - The title of the Cart you are working on. Clicking on the 
Copy button will copy the Title of the Cart from the General tab.

 Music Title – The title of any music that is used in the Cart (like music 
used in a promo). Clicking on the Copy button will copy the Title of the 
Cart from the General tab.

 Recording Number – The unique reference for the original recording 
that you are using. These can usually be found on the spine of 
commercial CDs etc.

 Composer/Arr – The names of the composer or arranger if known.
 Performer – The name of the artist performing the music. Clicking on 

the Copy button will copy the Artist from the General tab.
 Publisher – The name of the company who published the music used.
 Record Label – The name of the record label promoting the music.
 Rights Manage Reference – The rights manage reference if known.
 Copyright Code – This drop down option allows you to select the 

copyright code that best describes the Cart you are working on.

 Total Duration – This allows you to set the total length of the Cart. 
Clicking on the Copy button will copy the total length of the Cart from 
the General tab.

 Music Duration – This option allows you to set the total duration of 
music used in the Cart. This is useful if you have a promo that is made 
up of speech and music as you can exclude the speech duration when 
calculating the copyright reports.
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The Other Tab

The Other tab is used to add and display pictures that have been associated 
with Carts and also to show the last five times the Cart has been played to 
provide an instant recent history for the Cart.

Pictures

The left side of the Other tab is dedicated to adding and viewing pictures that 
have been associated with the Carts. 

Why would you do this? 

The answer is that OCP (see The Standard Myriad Suite) can be used to do a 
variety of things, one of which is update your stations website, in real time, 
with information about the Carts that are playing and Carts that will be playing 
soon. This information includes text, hyperlinks, online store references (click 
to buy this track etc) and of course pictures. So this means that you have to 
have a way to attach pictures to the Carts.

You can add new pictures to the Carts by clicking on the ‘+’ button. You can 
remove pictures from the Cart by clicking the ‘X’ button.

The ‘<<’ and ‘>>’ buttons are used for changing the order that the pictures are 
arranged in on the Cart. Pressing the ‘<<’ or ‘>>’ buttons will move the visible 
picture in the selected direction in relation to the other pictures associated 
with the Cart.

The ‘<’ and ‘>’ buttons allow you to scroll through the available pictures 
attached to the Carts.
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Pictures associated with Carts in Myriad must be in the JPEG (jpg) format.

Last 5 Plays

The rest of the Others tab shows a brief history of the Cart including the date 
and time of the last five times that the Cart was played. It also shows the 
Myriad workstation name of the PC that played them.

You can clear this recent history by clicking on the Erase This Last Play 
Information button which will clear this history but will not affect the overall 
play logs that Myriad keeps so it will not impact on your copyright reports or 
scheduling system reconciliation.

Audio Edit Tool Bar

The SmoothEdit Tool bar offers a range of tools that you can use when 
working with audio in the Audio Edit Area.

These are covered in more detail in the SmoothEdit screen Chapter later in 
this manual.

VU Bars

The VU Bars show a graphical representation of the volume of the audio 
being played back in SmoothEdit. It should be regarded as a guide only as the 
VU Bars have not been calibrated.

Time Info

The Time Info panel in the Audio Edit Area shows the overall length of the 
audio being edited. It also shows an estimate of the free disk space left 
available to the Audio Wall.
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Extro Marker

The Extro Marker offers a visual representation of the Extro point on the Audio 
Edit Area (see The Timing Tab). The Extro Marker can be repositioned from 
within the Audio Edit Area by moving your mouse cursor to the top of the 
Extro Marker (until the hand icon cursor appears) and then dragging it left or 
right using the left mouse button.
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Playback Time

The Playback Time panel in the Audio Edit Area displays the time of the 
current play point when audio is playing or the last place that you clicked in 
the Audio Edit Area when no audio is playing.
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Hook Markers

The Hook Markers show a visual representation in the Audio Edit Area, of the 
Hook Start and End points that have been set on the Timing Tab (see The 
Timing Tab). 

Using the Audio Edit Area, you can move the Hook Start and End points by 
moving your mouse cursor to the top of either marker until the cursor turns to 
a hand icon (see below). Then use the left mouse button to drag the Hook 
Start or End Marker to the left or right.

NB: You can just play the Hook by clicking on the Hook button on the Smooth 
Edit Audio Controls.
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SmoothEdit Audio Controls 

The SmoothEdit Audio Controls include all the controls you need to control 
audio playback in SmoothEdit. The buttons on the Audio Control Tool Bar not 
only allow you to control the playback of audio but also to control the way in 
which SmoothEdit deals with playing audio.

Intro Marker

The Intro Marker shows a visual representation of the Intro Start and End 
points as set in the Timing Tab.
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As with Hook Markers, you can use the mouse to ‘drag’ these points around in 
the Audio Edit Area by moving the mouse cursor to the top of the Intro Marker 
(start or end) until the cursor changes to a hand icon, then using the left 
mouse button drag the Intro Markers left or right (see picture in Hook Markers 
section for more detail).

Wave Form Edit Area

This is the section of the SmoothEdit screen where the audio wave form for 
the audio recorded into the Cart is displayed. The wave form represents a 
series of ‘samples’ that are used to describe the audio digitally. This
information is then used by Myriad to reproduce the sound perfectly every 
time the Cart is played. 

The Audio Edit Area allows you to view the audio wave form and manipulate it 
using the tools provided on the Smooth Edit Tool Bar. 

Key Timing events (such as Intro, Extro, Loop and Hooks) are also visually 
displayed in the Audio Edit Area.

Audio Editing is covered in much greater detail later in this manual and also in 
the SmoothEdit manual which is available to download from the P Squared 
website.

Tab Strip

The Tab Strip is used to switch between the major screens in Myriad which 
are: Audio Wall, Instant Carts, Database, Log and SmoothEdit.

To switch to another screen, click on the appropriate tab on the Main Tab 
Strip.

Open Carts (working with multiple SmoothEdit screens)

With Myriad v3, it is possible to open multiple Carts for editing at the same 
time. To do this, open the first Cart by highlighting it in the Audio Wall and 
click on Edit, for example, this will open the SmoothEdit screen for that Cart. 
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Next, click on the Audio Wall tab on the Main Tab Strip to go back to the 
Audio Wall and open another Cart for editing (by repeating the process). 

You will see that the SmoothEdit tab then has two Cart icons on it, one for 
each of the open SmoothEdit windows. You can now switch between these 
SmoothEdit windows by clicking on the Icons on the SmoothEdit tab.

This is really useful as it allows you to copy and paste information between 
Carts easily.

Myriad v3 Keyboard Shortcuts Reference Guide

The following table shows a list of the keyboard shortcuts that are available in 
Myriad and when and where they apply.

NB: Many of these combinations may seem cumbersome but that is because 
unique combinations are needed for each function. Most of these 
combinations can be programmed into the special Myriad keyboards to make 
life as easy as possible for the presenters.

 Keyboard Shortcuts  Description
 
 Global Keys
 These keys work no matter which section or window in Myriad is active or 

has focus.

 Number Keys 0-9  Instant Carts 1 – 10
 <Shift> + Number Keys 0-9  Instant Carts 11 – 20
 <Ctrl> + 1  Switch to the Audio Wall tab
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 <Ctrl> + 2  Switch to the Instant Carts tab
 <Ctrl> + 3  Switch to the Database tab
 <Ctrl> + 4  Switch to the Log Screen tab
 <Ctrl> + 5  Switch to the SmoothEdit tab
 Pause/Break  Toggle Log Playback Mode (the Power 

button on Log screen)
 <Ctrl>+<Insert>  Record into highlighted cart on Audio

Wall
 <Ctrl>+<Shift>+<Insert>  Record into first available cart in 

personal area
 <Ctrl>+<Home>  Jump 'Home' on the Log Display 

screen
 <Ctrl>+<Backspace>  Toggle the Stop/Go at the end of the 

currently playing Log Item
 <Ctrl>+<Up>  Scroll up the Station Log 1 item
 <Ctrl>+<Down>  Scroll down the Station Log 1 item
 <Ctrl>+<PageUp>  Scroll up the Station Log 1 page of 

items
 <Ctrl>+<PageDown>  Scroll down the Station Log 1 page of 

items
 <Ctrl>+<Shift>+<PageUp>  Scroll up to the previous hour start in 

the Scheduled Log
 <Ctrl>+<Shift>+<PageDown>  Scroll down to the next hour start in the 

Scheduled Log
 <Ctrl>+<Space>  If in SegEdit mode, do the highlighted 

action in the Segue Editor
 <Ctrl>+F  Open/Close the Find window on the 

Audio Wall
 <Ctrl>+J  Open the Jump to Cart window for the 

Audio Wall
 <Ctrl>+L  Play the highlighted cart on the Audio

Wall
 <Ctrl>+Q  Starts the next item in the Station Log 

('Go')
 <Ctrl>+<Shift>+Q  Pre-Cue the next item in the Station 

Log
 <Ctrl>+<Shift>+<Alt>+Q  Preview the next item in the Station 

Log in the Preview Player
 <Alt>+Q  Display the Q-Audio Engine for the 

Station Log
 <Ctrl>+S  Show/Hide the Segue Editor
 <Ctrl>+U  Cue the highlighted cart on the Audio

Wall in the first available player
 <F1> to <F4>  Controls Cart Player 1 (See Notes 

below)
 <F5> to <F8>  Controls Cart Player 2 (See Notes 

below)
 <F9> to <F12>  Controls Cart Player 3 (See Notes 
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below)
 <Shift>+<F1> to <F4>  Controls Cart Player 4 (See Notes 

below)
 <Shift>+<F5> to <F8>  Controls Cart Player 5 (See Notes 

below)
 <Shift>+<F5> to <F12>  Controls Cart Player 6 / Cart Recorder 

(See Notes below)
 <Ctrl>+<Shift>+<Up Cursor 

Key>
 Move highlight up one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Down 

Cursor Key>
 Move highlight down one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Left Cursor 

Key>
 Move highlight left one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Right 

Cursor Key>
 Move highlight right one Cart on the 

Audio Wall.
 Notes: The keys for each cart player are: Play, Pause, Cue, Eject - i.e. 

<F2> is the Pause key for Cart Player 1 and <Shift>+<F7> is the Cue key 
for Cart Player 5.

 Holding down the <Ctrl> key while pressing the Play key for a Cart Player 
rewinds that player by 5 seconds

 Holding down the <Ctrl> key while pressing the Cue key for a Cart Player 
rewinds that player back to the start 

 Holding down the <Ctrl> key while pressing the Eject key for a Cart Player 
forward winds that player by 5 seconds

 Holding down the <Alt> key while pressing the Play or Cue keys for a Cart 
Player will Play or cue the highlighted cart in the active window in that cart 
player, ejecting what is already in that player.

 If you have less than 6 Cart Players, the controls for Cart Player 6 are 
used for the Cart Recorder instead.


 <Shift>+<F9>  Start recording
 <Shift>+<F10>  Pause recording
 <Shift>+<F12>  Stop recording and prompt for further 

action
 <Shift>+<Ctrl>+<F12>  Stop and save the current recording 

immediately
 <Shift>+<Alt>+<F12>  Stop and abandon the current 

recording
 
 Audio Wall Only Keys
 These keys only apply to the Audio Wall screen when it is active or has 

focus.

 <A>  Add the highlighted item to the Pad
 <C>  Copy the highlighted item to another 

Cart
 <Ctrl>+E  Export the highlighted Cart to a WAV 

File
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 <Ctrl>+<Shift>+E  Export the highlighted Cart to a 
Transport File

 <Ctrl>+H  Play the hook of the highlighted Cart in 
the Hook Player

 <Ctrl>+<Shift>+H  Cue the hook of the highlighted Cart in 
the Hook Player

 <Ctrl>+I  Import a WAV File into the highlighted 
Cart

 <Alt>+I  Display extended information about the 
highlighted Cart

 <M>  Move the highlighted item to another 
Cart

 <Insert>  Edit the highlighted Cart
 <Ctrl>+<Insert>  Record into the highlighted Cart
 <Ctrl>+<Delete>  Delete the highlighted Cart
 <Return>/<Enter>  Cue the highlighted item in the first 

available player
 
 Log Screen 
 These keys apply only when the Log screen is active and has focus.

 <Space>  In SegEdit mode, do the highlighted 

action in the Segue Editor
 In normal mode, Starts the next item in 

the Station Log (Go)
 <Home>  Jumps 'Home'
 <Delete>  Soft Deletes/Restores the highlighted 

log item
 
 SmoothEdit Display keys
 These keys only apply when the SmoothEdit screen is active and has 

focus.

 <Ctrl>+C  Copies the selected audio/text to the 

clipboard
 <Ctrl>+V  Pastes the audio/text from the 

clipboard
 <Ctrl>+X  Cuts the selected audio/text to the 

clipboard
 <Delete>  Deletes the selected audio/text
 <Left>  Rewinds the audio by 1 second
 <Ctrl>+<Left>  Rewinds the audio by 1/4 of a second
 <Shift>+<Left>  Rewinds the audio by 5 seconds
 <Right>  Forward winds the audio by 1 second
 <Ctrl>+<Right>  Forward winds the audio by 1/4 of a 

second
 <Shift>+<Right>  Forward winds the audio by 5 seconds
 <Insert>  Edit the audio with an external audio 
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editor
 <Space>  Starts/Stops the audio playing

 Note: This only works when the 
waveform editor has 'focus'

Please note that when you have configured Myriad to operate in Limited 
Myriad v2 Keyboard Support mode, some of the keyboard shortcuts outlined 
above are replaced with the keyboard shortcuts from Myriad v2.

Chapter 1 Summary

In this Chapter, we have looked at what Myriad consists of in general, as well 
as what programs combine to make up the Myriad Suite, and how it can be 
expanded for additional functionality.

We also looked at how to get Myriad installed, licensed and set up using a 
basic (default) configuration.

Finally, we looked at the layout of each of the major screens in Myriad and 
looked briefly at what information they display and the tools they offer. 

In subsequent Chapters, we will look at the major elements of Myriad in more 
detail and examine how to use Myriad to its full potential.

Chapter 2 – The Audio Wall

In this Chapter we will look at the Myriad Audio Wall in more detail and see 
how it is the framework that the entire Myriad Suite works around. We will look 
at the various tools available when using the Audio Wall, the Carts 
themselves and the different ways in which Carts can be played.

Finally, we will look at the role that the Audio Wall plays in other areas of the 
Myriad Suite and how the Cart Browser can be used to act like a mini Audio 
Wall when you need to search and select Carts from elsewhere in the suite.

What Is The Audio Wall?

The simplest way to understand the Audio Wall is to use the following analogy 
that we should all be familiar with. Imagine you had a shelf that has space for 
up to 100 CDs on it. Now imagine that all of your station’s audio material is 
available on CD (e.g. songs, links, adverts, jingles etc), and each individual 
piece of audio was recorded onto its own CD. In that case, you would have 
100 ‘slots’ on your shelf onto which you could place your CDs. You could just 
put them on the shelf in a random order, but then it might be hard to find CDs 
that contain different types of audio (like songs and jingles), so instead you 
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might group CDs of similar content together to make it easier to browse the 
shelf and find what you are looking for, like a library.

Now let’s replace the shelf with an empty Audio Wall and make it a lot bigger 
(anywhere from 10,000 to 100,000 slots or more), and instead of CDs we will 
use Carts to fill the empty slots. Just as before, each Cart contains a single 
audio item but as well as the audio, we can add a whole bunch of additional 
information including text information, pictures, copyright details and timing 
information about the audio contained in the Cart. The Carts also have a 
unique reference number called the Cart Number which determines where 
they appear on the Audio Wall because the Audio Wall uses a simple numeric 
system.

This means that in Cart Number 1 you could have a jingle and in Cart Number 
2, a song or pre-recorded show, but as with a library, it makes a lot of sense 
to group Carts of a similar nature together to make it easier to find what you 
need, so you might say “the first 500 Carts are Jingles and the next 1000 
Carts are adverts” to make finding Carts on the Audio Wall more intuitive 
(there will be more details on planning the Audio Wall later).

So to recap, we have an Audio Wall which is made up of Cart Slots numbered 
from 1 to (typically) 10,000 or more, and each Cart Slot can contain one single 
piece of audio or a ‘Cart’. The Carts themselves also contain a range of 
additional information such as text, pictures and timing information that is 
used by both Myriad and the presenter. Finally, it is common practice for 
Myriad Audio Walls to be set up so that Carts that contain similar types of 
audio (such as jingles, promos, songs etc) are grouped together in different 
places on the Audio Wall to make navigation and finding Carts simpler.
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Hopefully, the analogy above will help but it might also help to look at the 
empty Audio Wall in the screen shot below. 

Here we can see a totally empty Audio Wall with the first 30 Cart Slots in view. 
The Audio Wall is arranged in numerical order and even once you start to 
populate it with Carts, any empty Cart Slots remain in place so you can fill 
them at a later date.

We will look at the Carts themselves in much greater detail later in this 
Chapter, but first, let’s touch on typical Audio Wall layout.
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Planning Your Audio Wall

As covered in the previous section, the Audio Wall is actually a long list of 
single audio items called Carts, and the Audio Wall itself is made up of Cart 
Slots that that Carts go into. 

There is no reason why you can’t just start with Cart Number 1 and work your 
way across the Audio Wall recording or importing all of your audio randomly 
and, as we will see later, Myriad’s powerful Find utilities would still make it 
workable, but the more common approach is to group Carts that contain 
similar content into the same areas on the Audio Wall. This makes it easier for 
a User to locate the Carts that they are looking for as they can go to a general 
area and view a number of Carts of a similar nature.

In practice, this usually means that you need to plan your Audio Wall when 
you set up the system to encompass all of the different types of audio that you 
are going to add. Because the Audio Wall is a numerically based system, it is 
also important to consider how many Carts you assign to each different type 
of audio, leaving enough space for each type of audio, because whilst you 
can perform ‘mass moves’ further down the line, it is better to get it right from 
the beginning if possible.

The best way to illustrate a typical Audio Wall layout is by example.

Let’s assume that broadly speaking we want to include the following types of 
audio in our system:

 Songs
 Jingles
 Promos
 Adverts
 Pre-recorded Voice Links
 News Cuts
 Pre-recorded Interviews & Events

NB: This may not cover every type of audio you want to add to the system but 
as long as it covers the basics then that will be OK. Your list may be very 
different depending on the type of station that you are setting Myriad up to run 
with.

For each of the above, we need to plan which section of the Audio Wall they 
will use. There is no right or wrong way to do this, you can use whatever 
scheme you like. The example below shows just one possible solution.

Audio Type Cart Range
Jingles 1-1000
Promos 1001 – 2000
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Adverts 2001 – 4000
Pre-recorded Voice Links 4001 – 5000
Pre-recorded Interviews 5001 – 6000
News Cuts 6001 – 8000
Songs 8001 and above

NB: This is just meant as an illustration, you can lay out your Audio Wall in 
whichever way will suit your station best.

Whilst the majority of the Cart Ranges used in the above illustration have 
been assigned arbitrarily, the ranges assigned to Jingles and Songs have 
been done for specific reasons. The reason Jingles have been assigned to 
the first 1000 Carts is that whenever Myriad starts up, it will automatically 
display Cart 1 onwards which means that in this case, the station’s Jingles will 
be displayed by default. 

The Songs have been assigned to the other end of the Audio Wall but this has 
been done to avoid putting a cap on the amount of Songs that we can add to 
the system. If we wanted to, we could add 50,000 Songs because there is 
nothing else on the Audio Wall above the Songs area (although you would 
probably run out of disk space long before then!).

In general, planning the layout of your Audio Wall at this early stage is a very 
good idea as it offers a clear definition of where the audio you add to the 
system needs to be put, and makes finding your way around the Audio Wall a 
lot easier. A bit of thought now can save you a lot of headaches later, but if 
you do make a mistake, don’t worry, Myriad includes a range of tools to help 
you mass move, copy or delete Carts on the Audio Wall so you can always 
have a bit of a shuffle around later!

Tip: Remember, if you move a Cart that is also referenced in a music or 
advert scheduling system then you will need to update the reference within 
the music or advert scheduling system. If you are using AutoTrack or 
AutoTrack Pro then you can move Carts from within those systems and they 
will be moved both on the Myriad Audio Wall and in the music scheduling 
database.

The Audio Wall Layout at a Glance

Chapter 1 provided a brief outline of the main Audio Wall screen and its 
layout, and also covered the major features and their functions. 

In this Chapter we will cover all of these areas in much greater detail but first, 
let’s take another look at the general layout of the Audio Wall.
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 Tab Strip – Used to switch between the major screens in Myriad which 
include Audio Wall, Instant Carts, Database, Log and SmoothEdit.

 Find Cart – Search the Audio Wall for a Cart with a particular 
description or length.

 Home – Takes you to the first Cart in your User Edit Range.
 Jump To Carts – Let’s you ‘dial’ in a Cart Slot Number that you want 

to jump to.
 Move Cart – Allows you to move or copy Carts from one Cart Slot to 

another.
 Edit Cart – Used to open the SmoothEdit (sometimes called Edit Cart) 

screen which allows you to edit audio, text and timing information for a 
Cart.

 More Jumps – Opens the More Jumps window which allows you to set 
up and manage additional shortcut buttons to Carts on the Audio Wall.

 Page Up / Down – Allows you to scroll up or down the Audio Wall a 
page at a time.

 Cart Number – Displays the Cart Slot Number of the Cart that is 
currently highlighted.

 Cart Players – The Cart Players are used to play all audio in Myriad. 
Think of them as virtual CD players.

 Record Cart Player – This is used to record audio into a Cart Slot 
when the audio is being recorded from the soundcard input channel.

 Carts – The central focus of the Audio Wall. A Cart is a single piece of 
audio that can also be enhanced with additional text, picture and timing 
information.

 Jump Buttons – Allows you to setup up to five shortcut buttons that 
Jump to specific places in your Audio Wall.

 Clock – Shows the current PC system’s time. If your PC is fitted with a 
radio clock or is getting the time from an accurate source over the 
network then this time should be exactly correct.

Carts 
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Carts are essential to all operations in Myriad so a good grasp of what a Cart 
is and what the information displayed on a Cart means will be essential for 
you to get the most from your system.

Overview

A Cart in Myriad refers to a single piece of audio or information. Each Cart 
has a unique Cart Number which is used to refer to that Cart throughout the 
Myriad Suite. Carts themselves consist of the following information:

 Audio
 3 Lines Of description
 Intro Start Time
 Intro End Time
 Extro Time
 Loop Start / End Time
 Hook Start / End Time
 Hardware Triggers For Time Events
 End Type
 Studio / Presenter Notes
 DAB Notes
 Internet / Web Notes
 Artist / Performer Web Site
 Online Store Reference
 Copyright Information
 Multiple Pictures

In addition, each Cart can be colour-coded using both the background and 
text colour.

Most of this information is accessed via the Edit button which loads the Cart’s 
details into the SmoothEdit screen but most of the key information is 
displayed on the Carts themselves on the Audio Wall. This is what we will look 
at first.

The Cart Layout

The diagram below shows the layout of a typical Cart. In the example below, 
the Cart in question contains a song but the same layout is used for all Carts 
on the Audio Wall, no matter what their audio content is.
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Description Lines

The bulk of each Cart is taken up with displaying the three description lines 
that are used to describe the audio on the Cart for the user to identify it. For 
most Carts on the Audio Wall, the description lines can be used in any order 
and in any way to best describe the Cart, but when you are dealing with Carts 
that contain songs, it is advisable to use each description line for the following 
information.

1. Song Title
2. Artist 1
3. Artist 2 – if needed!

The reason for this is twofold, firstly, there are places in Myriad where only the 
first description line is visible (like the Cart Browser) and under these 
circumstances, the song title is often more use than the artist. The second 
reason is more important. If you are using AutoTrack or AutoTrack Pro then 
all of the information on a Cart is copied into the music database when the 
Cart is imported as a Song. This includes the description lines, and when this 
happens, the first description line is imported as the Song Title and the 
second and third description lines are imported as Artists 1 & 2. Obviously, if 
you get this information the wrong way around in Myriad, you may cause 
yourself more work further down the line.  In short, it is generally easier to 
input the information as listed above.

NB: AutoTrack Pro does not usually have this problem as the import 
description lines can be routed to different fields, but this will only help you if 
you are consistent across the entire Audio Wall.

Intro Time

The Intro Time is most commonly defined as the section at the beginning of 
the audio that can be used to talk over, or play jingles over. Obviously this is 
usually applied to songs but you can also have Intros on other types of audio.
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The reason you may want to set Intros is to provide a visual indicator to 
presenters of the time they have at the beginning of songs that they can 
speak over. In this way, presenters can time their vocal links such that they 
stop speaking just as the song ‘kicks in’. This is a very common practice in 
radio, although not all stations do it.

The diagram below may help to explain this principle in more detail.

As you can see, the Intro is usually the part at the beginning of the song 
before the vocals or the drum beat kicks in. It is a very personal thing and 
there is no right or wrong policy on Intro’s but it is often best to keep the 
Intro’s short.

When a Cart that has an Intro set is played using the Myriad Cart Players, the 
Intro time is counted down using the large square count down panel, the 
progress through the Intro is displayed in the progress bar.

The Intro Time is displayed on the bottom left hand corner of the Carts:
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If no Intro has been set, the Intro time is displayed as zero:

Cart Number

The Cart Number is the unique number that is used to identify the Cart. The 
Cart Number can be anything from 1 to 100,000 (or more) and the Audio Wall 
displays Carts numerically.

Overall Length

The Overall Length displays the overall length of the audio on a Cart from the 
beginning of the audio file to the Extro point or if no Extro point has been set, 
to the end of the audio file.

As explained in the diagram at the top of this sub-section (see Intro Time), the 
Extro is a point that you mark on the Cart signifying when Myriad can start the 
next item playing when playing two Carts back to back. When being used 
manually by a presenter, it can be considered to be the end of the audio.
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It is important to set Extros on all Carts that may appear in automated segues,
as it ensures that they will sound as smooth as possible. The diagram below 
should help to illustrate how Myriad deals with automated segues.

End Type

The End Type indicator shows the End Type that has been set for the Cart in 
question.

The available options are:

 E – Ends – The Cart comes to an abrupt end.
 F – Fades – The Cart fades out at the end.
 S – Sustain – The Cart’s ending is sustained for a period at the end.
 SF – Slow Fade – The Cart fades out over a longer period at the end.
 Blank – Not Specific – The ending has not been specified.

The End Type is useful for the presenter but it is also used by Myriad when it 
is working out the items in the Log that it can fade out early in order to hit 
Absolute Time Markers (such as the top of the hour news etc). The logic 
works as outlined below.

Ends – Cannot be faded early.
Fades – Can be faded early
Sustain – Cannot be faded early
Slow Fade – Can be faded early
Not Specific – Cannot be faded early.

So basically, if it is a Song (this only applies to Songs anyway), and it has a 
Fade or a Slow Fade End Type then if Myriad needed to fade it early in order 
to hit a time marker in Auto-Fade mode then it can do so. If it is anything other 
than a Song or if it is a Song with an End, Sustain or Non Specific End Type 
then Myriad cannot fade it early.
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Hook

The Hook markers on Carts are usually used to mark the most recognisable 
section of a Song. This can then be played by Myriad using the Hook Player 
which is a simple and powerful way of promoting what is going to be played 
soon. Hooks are usually used on Songs but you can set a Hook on any Cart 
on the Audio Wall so you could set a Hook on a jingle or promo or to mark a 
section of an interview that you want to play in order to provide a ‘teaser’ for 
the whole interview.

Hooks are set using SmoothEdit and are usually set on the Song’s chorus or 
most well known ‘hook’. 

When a Cart has a Hook set, the Hook indicated appears in white on the Cart.

If a Cart does not have a Hook set then the Hook indication appears in pale 
blue.
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For details on how to set Hooks, please refer to the SmoothEdit section of the 
documentation.

Loop 

The Loop indicator on the Cart acts in a similar way to the Hook indicator in 
that if it is white, it indicates that the Cart has a Loop section set and if it is in 
pale blue, it indicates that the Cart does not have a Loop section set.

But what is a Loop section?

A Loop section is a specially marked area of the Cart that Myriad will repeat 
whenever the Cart is played. When a Cart with a Loop section is played, 
Myriad will play the Cart normally until it reaches the end of the Loop section 
for the first time, at which point it jumps back to the beginning of the Loop 
section and plays it again.

This continues until either the maximum number of Loops is reached (set in 
SmoothEdit) or the presenter ends the Loop by clicking on the Play button on 
the Cart Player that is playing the Loop Cart. When this happens, Myriad will 
either jump directly to the end of the Loop section and then play the rest of the 
Cart normally, or continue to play from the point the presenter pressed the 
Play button, but when it reaches the end of the Loop, it will continue to play 
the rest of the Cart normally. This is determined on a Cart by Cart basis in the 
Loop section of SmoothEdit.

Information

The Information icon will appear on a Cart whenever there are any additional 
Notes that have been added. These may be text notes in the main Notes field 
as well as Web notes and DAB notes. 

To view the Notes for a Cart, right click on the Cart, and then select More 
Information.



125

If the Information icon appears as pale blue; there are no additional Notes for 
the Cart.
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There are three different types of Notes in Myriad:

 Show Notes – designed for use by the presenter.
 DAB Notes – designed to be passed on to a DAB (digital radio) 

transmitter.
 Web Notes – designed to be passed on to OCP (Online Content 

Processor) to be displayed on your website.

The Cart Information window allows you to switch between these notes by 
clicking on the appropriate Notes button (as seen in the picture above).

Please note that Notes buttons are only displayed when Notes of that specific 
type have been added to the Cart. If no Notes buttons are displayed then 
there are no Notes associated with that Cart.
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Audio / Extro Status

The Audio / Extro Status shows you the status of the Cart in regards to
whether there is audio recorded into the Cart and if there is audio, whether the 
Extro point has been set.

There are three possible states for the Audio / Extro Status icon:

- The Cart has no audio.

- There is audio recorded into the Cart but the Extro has not been set.

- There is audio recorded into the Cart and the Extro has been set.

But what does this mean? 

Obviously if a Cart does not have any audio recorded into it then you cannot 
play it in the Cart Players. This could mean that the Cart is awaiting audio 
being added or it could be that the Cart is being used as a ‘marker’ Cart to 
effectively label a section of the Audio Wall.

Once audio has been added to a Cart, the Audio / Extro Status changes to 
have a white speaker icon but with an exclamation mark (audio recorded but 
no Extro has been set). This means that the audio is now available and the 
Cart can be played in the Cart Players, but because no Extro has been set, 
Myriad will play the Cart in it’s entirety (right the way to the end of the audio 
file even if there is silence at the end). This means that if the Cart is played in 
an automated segue, it is likely to sound less smooth. 

If you set the Extro (see SmoothEdit) then the Audio / Extro Status icon 
changes to have a green tick and this means that the Cart can be played in 
both live and automated situations and the segue should work.

Extros are covered independently in above sections of this documentation, 
but to re-cap briefly: 
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To understand where best to set Extro points, it is worth considering how 
Myriad uses them and how it relates to the ‘real world’. When you are 
manually doing a segue between two songs on CD, you would normally press 
play on the next track just before the last one finished, in order to get a 
smooth transition between the two. The best way to think of the Extro point is 
as exactly the same point, just before the first track finishes. Myriad will then 
use this to start the next item whenever the Cart is used in an automated 
segue.

The Extro is usually set as the song is fading out or a fraction of a second 
before a hard ending.

For more details on Extros and how to set them, please refer to the 
SmoothEdit section.

Recently Played Cart Icon

Myriad can be configured so that Carts that have been played recently will be 
marked as played on the Audio Wall to try to help avoid playing things too 
often on manually scheduled or ‘free choice’ stations.

The idea is very simple. You set a duration within which you would deem a 
Cart to have played recently. This duration can be in terms of time or as a 
multiple of the duration of the Cart in question. Whichever method you 
choose, as each Cart on the Audio Wall is played, it is marked with a special 
icon that will remain until the set time (or number of possible iterations) has 
elapsed.
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To tell if a Cart has been played within the specified ‘recent’ period, keep an 
eye out for Carts that carry the ‘recent play’ marker which is a yellow 
exclamation mark directly to the left of the Cart Description lines.

If you hover above the icon with your mouse, then the most recent play (on 
this machine) is displayed. If the Cart has been played five or more times on 
another machine since it was last played on this machine, then no recent play 
information will be available.

The Cart Right Click Menu

To access the right click menu, simply right click on a Cart:
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The range of options available on the right click menu is examined in detail 
below.

NB: The right click menu is context sensitive so not all of the options will be 
available all of the time. Only relevant options will be available.

Play Cart

As you would expect, if you right click on a Cart and select the Play Cart 
option from the right click menu then the Cart you right clicked on will be 
loaded into the first free Cart Player and playback will begin immediately.

Cue Cart

As with Play Cart, if you select this option from the right click menu then the 
Cart that you right clicked on will be loaded into the first free Cart Player but 
playback will not begin. Instead, the Cart will be cued ready to be manually
played by the presenter (by clicking on the Play button on the Cart Player).

Find Cart

The Find Cart option on the right click menu will switch the Audio Wall screen 
to display Find Cart which allows you to search for Carts on the Audio Wall, 
matching your criteria.
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To use Find Cart, type in a word or phrase you want to search for in the 
Search For box, select any options that you want to include in your search 
using the Options section and then click on the Find button.

The results are then listed in the Search Results window. From here you can 
drag Carts to the Cart Players or directly into the Log Screen (dual screen 
mode). You can also double click on an item in the Search Results window, 
the Search Results window closes, and the Cart that you double clicked on 
will be highlighted. Find Cart is covered in more detail in the Find section later.

Find Similar

The Find Similar right click option menu expands to offer a range of context 
sensitive Find options.
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Basically, this option allows you to perform a Find for other Carts on the Audio 
Wall that are by the same Artist, have the same Title or have the same 
Description (line 3 on the Carts). It can also be used to Find Carts that have a 
similar length to the one you right clicked on.

To use this feature, select the option you want to use for your search by 
clicking on it. In the above example, we will find other Carts that include the 
phrase Dannii Minogue by selecting the appropriate menu option.

The Find Carts window appears and Dannii Minogue is automatically added to 
the Search For box. The Find starts immediately and the results should be 
available in a matter of seconds.

Let’s try that again but this time we will select Carts with a Similar Length.

First right click on the Cart you want to use as the basis for the search, and 
then expand the Find Similar menu option, before finally selecting Find Carts 
with a Similar Length.

The Find Carts window will appear with the Time Rules option ticked and the 
duration of the selected Cart already filled in. The search results will list all the 
Carts to within 10 seconds in length of the original Cart. The lengths are listed 
at the right hand side of the search results window.
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NB: You can also combine Find Cart criteria for more specific search results,
so, for example, you could do a search for all Carts that contain the word 
‘love’ in the Description Lines and whose duration is between 2 minutes 50 
seconds and 3 minutes 10 seconds – if you really wanted to!

Suggest Similar From Database

This option is linked to the Database screen which shows a copy of your 
music scheduling database if you are using either AutoTrack or AutoTrack Pro 
as your music scheduling system. If you are using a 3rd party music 
scheduling system such as RCS Selector™ then you can still import the song 
database information into the Myriad Database screen but the import process 
is less automatic than when using AutoTrack or AutoTrack Pro.

If you have looked at the Database screen section in Chapter 1, you will 
already know that the Database shows Songs and Links as categorised in 
your scheduling system. This provides an alternative way of looking for Songs
and Links using Category information that is not available otherwise. The 
Database screen also allows you to view Songs by Artist and so offers a very 
powerful tool for working with Carts in a real world environment.

The Suggest Similar from Database option on the right click menu does two 
things. Firstly it looks up the Cart you have right clicked on and works out 
which Song or Link Category the Cart is in. It then displays a list of all the 
other Songs or Links that are in the same Category so that you can choose 
one of them to play instead.
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The results are listed in a floating Database window and you can drag Carts 
from the results directly into Cart Players or the Log, you can also double click 
on a Song or Link to close the floating Database window and jump to the 
selected Cart.

NB: The Suggest Similar from Database option is only available on Carts that 
are already listed in the Database.

Jump to the Next Empty Cart

Selecting this item will move the highlight on the Audio Wall to the next empty 
Cart following the Cart that you right clicked on to access the right click menu.

Let’s say for example that you right clicked on Cart 15 on the Audio Wall and 
selected this option. Myriad would then scan through the Audio Wall from Cart 
15 onwards and locate the next Cart that had nothing in it (was empty). The 
Audio Wall view would then automatically jump to this area and the located 
empty Cart would be highlighted.

Hook

A Hook is a small section of a Cart that is marked as the most recognisable or 
memorable section of the Cart. Hooks are most commonly used on Songs to 
mark the section of the chorus that everyone will know, but you can also set 
Hooks on any other type of Cart if you wish.
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The principle reason for doing this is to allow Myriad to play the Hook from 
Carts that you intend to play in the near future. This acts as a ‘teaser’ for what 
is coming next and is a common feature used in radio. Myriad does this using 
a Hook Player, which is a special mode applied to the standard Cart Players 
where only the Hooks from the Carts are played. When in Hook Player mode, 
several Carts can be ‘stacked’ to play in sequence allowing you to quickly 
compile a ‘promo’ of what is coming up in your show.

There are three options on the expanded Hook section of the right click menu:

 Play Hook – This will load the selected Cart into the first free Cart 
Player and begin playback immediately. The Cart Player will play from 
the beginning of the marked Hook until the end of the Hook, at which 
point the Cart will be ejected.

 Cue Hook – This option will load the selected Cart into the first free 
Cart Player and will cue the Cart Player at the beginning of the 
specified Hook area, but will not start playback until the presenter tells 
it to (by manually clicking on the Cart Player’s Play button). Once the 
Hook Cart Player reaches the end of the Hook area, the Cart will stop 
and be ejected automatically.

 Add To Hook Player – The final option loads the Cart into the Hook 
Cart Player and cues it to the beginning of the Hook area (just like Cue 
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Hook) but also allows you to add additional Carts to the Hook Cart 
Player to be played in sequence. 

As you can see from the screen shot, you can add multiple Carts to the 
Hook player to create a ‘stack’ of Carts to be played. When you click on 
the Play button on the Hook Player, the Hook from the first Cart is 
played but when it finishes, Myriad will automatically start the Hook on 
the next Cart in the ‘stack’. This will continue until the end of the Hook 
area in the final Cart in the ‘stack’.

To build this ‘stack’ of Carts to play using the Hook Player, right click  
and select the Hook>Add To Hook Player option on each Cart that 
want to add. You can also remove Carts from the Hook Player ‘stack’ 
by double clicking on them. They will then be removed from the Hook 
Player stack. 

NB: You cannot remove the item that is currently playing.

The Hook right click option only becomes available when Carts have Hooks 
set. This is indicated by the ‘H’ icon on the Carts themselves.

Preview Cart

This option loads the selected Cart into a Cart Player and cues it at the 
beginning. The only difference from the Cue Cart option is that the Cart Player 
is set to play in preview mode. This is noted in the play logs for the system. 
These previews can then be excluded when generating reconciliation files or 
copyright reports.

NB: Preview Cart is not shown on all of the screen shots in this section as it 
was a relatively late addition to Myriad v3.
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Preview Extro

This option loads the selected Cart into the first free Cart Player in ‘preview’ 
mode and automatically cues the Cart to a few seconds before the Extro point 
to allow you review the Extro (last few seconds) of the Cart.

As with previewing entire Carts, the relevance of the Cart Player being in 
preview mode is that a note is made in the play logs which are used to 
generate reconciliation files and copyright reports. Carts that were played 
under ‘preview’ conditions can be excluded from these reports.

Add To Pad

This option will add the Cart that you right clicked on to the Pad for playout. 
The Pad is a simple playout system that allows you to manually build up a list 
of Carts to be played (see The Pad). The Add to Pad option on the right click 
menu offers an alternative to dragging Carts into the Pad. You can also use 
this option to add Carts to the Pad even when it is not visible on screen.

Move Cart

The Move Cart option allows you to Move the selected Cart to a new location 
on the Audio Wall. Selecting this option will open the Move/Copy window in 
Move mode.
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Using this screen, you can select the destination Cart that you want to move it 
to by typing the number into the Destination Cart field. If a Cart is already in 
that destination, it is shown on the right hand side of the screen. The button to 
the right of the Destination Cart allows you to scan for the next empty Cart 
along from the proposed destination.

If you select a Destination Cart that already has a Cart in it and then click on 
OK, you will be asked whether you wish to overwrite the Cart, swap the two 
Carts over or cancel the Move operation. When you are happy with the 
destination, click on OK to begin the move. 

CAUTION – If you move Carts on the Audio Wall that are linked to Songs or 
Links in your scheduling system (no matter what it is) then you will have to 
manually update your scheduling system with the new Cart location. If you 
have AutoTrack or AutoTrack Pro it is recommended that you use AutoTrack 
or AutoTrack Pro to move Carts on the Audio Wall as the database 
information will be updated automatically at the same time.

You can switch to Copy mode by ticking the Copy option.

This option will only be open to Users with sufficient User Rights to allow them 
to Move and Copy Carts. Move is covered in more detail in the Move / Copy
section of the documentation.

Copy Cart

The Copy Cart option opens the Move / Copy window in Copy mode to allow 
you to copy the selected Cart to another destination on the Audio Wall.

To use this feature, type the Cart Slot Number into the Destination Cart box
that you want to copy to. You can use the button to the right of this field to find 
the next empty Cart along from the typed destination. If there is a Cart already 
in the Destination Cart Number Slot then its details are displayed to the right 
of the window. Once you are happy with the Destination Cart, click on the OK 
button and the Cart will be copied to the new location.
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You can switch to Move mode by ticking the Move option.

This option will only be open to Users with sufficient User Rights to allow them
to Move and Copy Carts. Copy is covered in more detail in the Move / Copy
section of the documentation.

More Information

The More Information option displays the More Information window for the 
Cart that you right clicked on. The More Information window is a summary of 
information stored on the selected Cart from the Cart itself and the Database 
entry for the Cart. The More Information screen is used in many places in 
Myriad so a good understanding of what information is on offer will be 
invaluable.

The Information displayed is covered in more detail below:
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 Cart Information Section
o Title – Description line 1 on the Cart
o Artist – Description line 2 on the Cart
o Description - Description line 3 on the Cart
o Intro Start – Start time of Intro section
o Intro End – End time of Intro section
o Hook Start – Start of Hook section
o Hook End – End of Hook section
o Cart Number – The Cart Slot Number for the Cart
o Ending – The End Type for the Cart
o Length – The Extro point on the Cart (or end of file if no Extro)
o Cue Cart - Cues the Cart in to the first free Cart Player 

 Database Information Section
o Title – Title in music scheduling system (AutoTrack or AutoTrack 

Pro )
o Artist(s)– Artist(s) in music scheduling system
o Category – The Song / Link Category the Cart is in
o Type – The Type (sub Category) that the Song / Link is in
o Gender – The Gender of the Song / Link according to the music 

scheduling system
o Year – The year the Song / Link was released / made

 Notes
o Notes – The text notes added to the Cart using Edit Audio
o Note Type Selector – There are three different Note Types that 

can be added to Carts in Myriad (Notes, Web Notes & DAB 
Notes). Each icon in the Note Type Selector section represents 
one of the different Note Types. In the example above, the Cart 
has Notes and Web Notes (but not DAB Notes) so only two 
icons are visible. You can switch between the different Notes 
Types by clicking on the Icons.

It is important to keep in mind that the information displayed in the Database 
section is the most recent information Myriad has received from your music 
scheduling system. If you are using AutoTrack or AutoTrack Pro then this will 
happen each time you schedule. If you are using a 3rd party scheduling 
system (like Selector™ by RCS) then you will need to manually import this 
information periodically.

Send This Cart’s Information to OCP (only available when using 
OCP)

This option will only be available when Myriad is configured to work with OCP. 
Selecting this option will send the Cart’s details to OCP as the currently 
playing item. OCP can then use this information to update a range of digital 
platforms including websites and DAB radios.
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Import Audio

The Importing Audio option on the right click menu is only available when you 
have right clicked on an empty Cart. Once it is enabled, there are three 
options on the expanded Import Audio Menu:

 Import Wizard – This opens a wizard that guides you through 
importing Audio.

 Import From A CD Track – This allows you to ‘rip’ audio directly from 
an audio CD in your PCs CD-ROM drive.

 Import A Wav or Transport File – This allows you to import audio files 
(wav or transport .zip file) directly into Myriad.

All of these options are covered in detail in the following section.

Export Audio

The Export Audio option is only enabled when you right click on a Cart that 
already contains audio and it allows you to export the audio and additional 
Cart information to a file for either backup purposes or for importing onto
another Myriad system.

The Export Audio menu expands to offer two options:
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 Export As A Transport File – This option exports the audio and all 
additional Cart data (including Notes, Pictures and Copyright 
information) as a single zipped (.zip) file. Other Myriad systems can 
then import these zipped files and restore all of the Cart’s audio and 
additional data.

 Export As A Wav File – If you select this option then a standard 
windows audio WAV (.wav) file will be generated from the audio 
contained within the Cart. A standard WAV file only contains audio 
information but WAV files exported by Myriad also contain some of the 
additional information from the Cart, embedded into the WAV file itself 
using an international standard known as CartChunk. Not all the 
additional Cart information can be embedded however, the list below 
shows the information that is included in the WAV file Myriad 
generates.

o Title – Cart Line 1
o Artist – Cart Line 2
o Description – Cart Line 3
o Intro Start & End
o Extro 
o End Type
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o Cart Background Colour
o Cart Text Colour
o Notes (standard only, not Web or DAB)
o Copyright Product Title
o Copyright Music Title
o Copyright Composer
o Copyright Performer

We have added as much information as the CartChunk standard will 
allow us. In theory, CartChunk is support by a number of different 
playout system manufacturers so you should be able to take a 
CartChuck compliant WAV file generated by Myriad and import it into a 
CartChuck compatible 3rd party playout system (and vice versa). There 
is however, room for interpretation on the implementation so there may 
be some issues arising from this. You can however generate a WAV 
file in Myriad and email it to another station using Myriad. When they 
import it, the information above will automatically be imported along 
with the audio.

Whether you are exporting to a WAV or Transport file, the procedure is the 
same. Right click on the Cart that you want to Export and select Export as a
Transport File or Export to a WAV File from the Export Audio section of the 
menu.

You will then be asked to provide the file name and location of the file you 
want to export. Note that by default, the file name contains the Artist and Title 



144

information to make future identification simple. When you are happy with the 
file name and location, click on the Save button to finish exporting the audio.

If you are exporting as a WAV file, the export should be very quick. If it takes 
more than a few seconds, a progress bar will appear. If you are exporting as a 
Transport file, the information has to be zipped first so it takes a fraction 
longer. The progress window above represents what happens when you 
export as a Transport file.

Record into This Cart

This allows you to record audio directly into a specific Cart. Myriad records 
audio using the Record Cart Player (bottom right by default) and the sound 
card input specified in the Settings>Audio Settings Menu.

Basically, the Record Cart Player can be used to record whatever audio is 
being played into the input on the selected sound card. Typically, this would 
be connected to either the mixing desk output or (preferably) a record or AUX 
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channel on the mixing desk. That way you can record into Myriad from any 
source in your studio.

The Record into This Cart allows you to record the audio input into the 
specified Cart. To use this feature, right click on the Cart that you want to 
record into and select Record Into This Cart from the right click menu. 

If the Cart already has audio or information in it, you will be asked whether 
you want to continue, as doing so will overwrite all previous information.

If you say No at this stage the recording will be abandoned. If you say Yes 
then the recording will proceed.

Next you will be asked whether you wish to use ‘trigger level recording’ which 
basically means that Myriad will not start recording until it detects that audio 
has started. This allows you to start Myriad recording and then press ‘play’ on 
the source material to record without the need to trim any silence from the 
beginning.

If you select No then recording will start immediately, if you select Yes then 
the Record Cart Player will go into stand-by mode and wait for the incoming 
audio level on the default record sound card to exceed the configurable 
‘trigger’ level.
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As soon as the trigger level has been reached, the Record Cart Player 
immediately switches into record mode and records the incoming audio to the 
selected Cart.

While a Cart is being recorded into, it changes to a red colour on the Audio 
Wall and the description lines change to indicate that it is being recorded into, 
who it is being recorded by and on which workstation. This prevents other 
users from trying to use the same Cart for something else.

To stop the recording, click on the Record button on the Record Card Player 
(red flashing symbol) and you will be asked whether you want to save the 
recorded Cart onto the Audio Wall.

If you answer Yes then the Cart will be saved and can be played from any 
Myriad workstation immediately. If you say No then the recording is discarded 
and all the recorded audio is lost.

Finally, you will be asked whether you want to ‘jump’ to the Cart you have just 
finished recording so that if you have been working elsewhere on the Audio 
Wall while recording, you can get back to the Cart you have just recorded 
quickly.
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Once a Cart has been recorded, highlight it, and click on the Edit button to 
label it and set the timing information (such as Intro and Extro points).

Record into this Cart Using Default / Different Format

If Myriad is configured to allow Users to set the audio format and quality (see 
Settings Menu > Audio Settings > Record / Edit Settings Tab > Allow Users to 
Choose a Different Format), then the Record into Cart option is replaced by 
two record options on the right click menu:



148

The options are:

 Record Into This Cart Using The Default Audio Format – If this 
option is selected then Myriad will record using the default audio format 
and quality as set on the Settings Menu > Audio Settings > Record / 
Edit Tab.

 Record Into This Cart Using A Different Format – This option allows 
you to select the format and quality that you wish to use for the 
recording you are doing.



149

For more details on how to use the Choose Audio Format window, please 
refer to the Settings Menu > Audio Settings > Record / Edit Tab > New Audio 
Will Be Recorded Using the Audio Format section of the documentation.

Delete Cart

The Delete Cart option on the right click menu allows you to delete a Cart 
from the Audio Wall. 

Right click on the Cart that you want to delete and select Delete Cart.

You will then be asked to confirm that you want to delete the Cart. If you 
select Yes then the Cart will be deleted from the Audio Wall and all associated 
data will be lost.

CAUTION – Once a Cart has been deleted, there is no way to recover either 
the audio or the data for the Cart so use this feature with caution. You should 
also consider that if you delete a Cart in Myriad, you need to remove it from 
your scheduling system (music or advert) as well. If you are using AutoTrack 
or AutoTrack Pro then it is recommended that you delete Carts from within 
these programs instead, as the Cart will then be deleted from both the 
Database and Myriad at the same time.
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Edit Cart Audio & Details Using SmoothEdit

As the name suggests, the Edit Cart Audio & Details Using SmoothEdit option 
will open the SmoothEdit window for the selected Cart. This allows you to 
record and edit the audio for the Cart as well as alter the title and timing 
information, notes and pictures associated with the Cart.

The SmoothEdit window is covered in detail in the SmoothEdit section of the 
documentation.
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Edit Cart Details Using SmoothEdit

This option differs from the previous one in that it opens the SmoothEdit 
Screen and loads the Cart’s Title; Timing & Notes details etc but does not 
load the audio wave form into SmoothEdit for editing. This option is useful as 
it allows you to alter the timing or title information quickly, without waiting for 
SmoothEdit to load the audio wave form (which can take a several seconds 
depending on the size of the file).
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If you use this method to Edit the Cart, you can still set the Timing Information 
in the normal way (by listening to the Cart and clicking on the corresponding 
Set button at the appropriate time). You can also load the audio wave form at 
any time by clicking on the wave form icon in the Audio Wave Form Edit Area.

Playing Carts from the Audio Wall

Ok so now we know what a Cart is, it’s time to see how we can use the Carts 
to play audio in Myriad. This section will concentrate on the various ways in 
which Carts can be cued into the Cart Players ready to be played. We will 
also look at the Live Assisted and Automated methods available from the 
Audio Wall. 

This section will not cover playing Carts from the other major sections of 
Myriad and in particular how Carts are played when using the Log screen. 
This will be covered in the Log Screen section of the documentation.

Playing / Cueing Carts

There are a number of methods that you can use to manually play a Cart in 
Myriad. The primary methods are outlined below:

Drag n Drop

One of the most commonly used methods for manually playing Carts in 
Myriad is to drag the Cart you want to play directly into the Cart Player that 
you want to use to play it, holding down the left mouse button.
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Click and hold the left mouse button on the Cart that you want to play, and 
drag the mouse cursor to the Cart Player you want to use. The mouse cursor 
will change as you hover over the Cart Players; release the left mouse button 
to ‘drop’ the Cart into one of the Cart Players. 

You can then use the Cart Player’s play button to start playback of the Cart.

Using the Right Click Menu

The right click menu provides an alternative way of manually playing a Cart on 
the Audio Wall.

To play (or Cue) a Cart using the right click menu, right click on the Cart that 
you want to play and select Play Cart.
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The Cart will be loaded into the first free Cart Player (usually lowest number 
first but this is configurable) and playback starts immediately.

If you prefer, you can select Cue Cart and the Cart will be loaded into the first 
free Cart Player and the Cart will be cued ready to be played manually by 
clicking on the Play button on the Cart Player.

Double Click

You can also double click on a Cart to play it in Myriad. This method is not 
recommended for use in a live environment due to the imprecise nature of 
double clicking. 
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When you double click on a Cart, the Cart is automatically loaded into the first 
free Cart Player (again, usually the lowest number but this is configurable) 
and playback starts immediately.

Using the Keyboard (Myriad Keyboards & Standard QWERTY 
Keyboards)

In addition to using the mouse, you can also use the keyboard to either cue or 
play Carts on the Audio Wall. There are actually two different keyboard 
shortcut methods that can be employed. This may sound confusing (because 
it is) but it is to allow legacy users to continue to use Myriad in the way they 
are accustomed, whilst offering an alternative method for stations that have 
dedicated Myriad Keyboards (pictured below) that can be used reliably on 
non-dual screen systems.

Earlier versions of Myriad used the following keyboard short cuts to allow you 
to play and cue Carts on the Audio Wall. To use the following short cuts, 
highlight the Cart that you want to play / cue and press the appropriate key.

 <ENTER> Key – This will load the highlighted Cart into the first free 
Cart Player and start play back immediately.

 <Space> Bar Key – This will load the highlighted Cart into the first free 
Cart Player in a cued state but will not start the Cart playing until the 
presenter clicks on the Play button (on the Cart Player).
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Both of these commands work well in single screen mode but when you are 
working in dual screen mode, you can run into difficulties with ‘focus’ issues 
because the <SPACE> bar is also used to initiate a Go on the Log screen (i.e. 
start the next item in the Log). This has been addressed to a certain extent 
with the inclusion of an option that stops the <SPACE> bar key from playing 
Carts or initiating a Go when in dual screen mode. It is recommended that the 
<SPACE> bar key should be turned off when you have a dual screen system 
combined with a Myriad Keyboard.

In addition to the <SPACE> and <ENTER> keys, the following keyboard 
shortcuts can also be used:

 <Ctrl> + L - This will load the highlighted Cart into the first free Cart 
Player and start playback immediately.

 <Ctrl> + U - This will load the highlighted Cart into the first free Cart 
Player in a cued state but will not start the Cart playing until the 
presenter clicks on the Play button (on the Cart Player).

The key thing here is that these keyboard shortcuts work from every screen in 
Myriad so it does not matter whether you are looking at the Log screen or  the 
Database screen, <Ctrl> + L will load the highlighted Cart into the first free 
Cart Player and start playback immediately. This is very important as it means 
that the Myriad keyboards can be set up to include buttons to play and cue 
Carts from the Audio Wall regardless of what screen is visible or has focus.

Hardware & Command Methods

You can also use hardware inputs or Log Commands to play / cue specific 
Carts on the Audio Wall. Although a presenter would not use these methods 
under normal circumstances, they can provide useful solutions to specific 
problems or situations.

Hardware inputs refer to physical signals (or logic) presented to a compatible 
hardware I/O (usually PCI 1750 by Advantech) card installed on the Myriad 
workstation. In this situation, a specific hardware line input is assigned (using 
the Hardware Manager) to play or cue a specific Cart from the Audio Wall. 
Then whenever that hardware line is activated, Myriad will automatically play 
the Cart. This is very useful if you want to set up a bank of buttons on your 
desk which play specific Carts such as jingles or news beds etc. For more 
details, please refer to the Hardware Manager section of the documentation.

Commands are special items in the Log that can be used to make Myriad 
execute one or more specific events. These may include launching external 
programs, communicating with external devices or executing a list of tasks in 
Myriad. The tasks that a Command can execute include playing and cueing 
specific Carts and Commands can be very useful if you wanted to play or cue 
a list of Carts or a specific sequence. For more details, please refer to the 
Command section of the Log Screen Chapter.
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Live Assist & Automated Playing / Cueing of Carts

This method of playing Carts is covered in much greater detail later in the 
documentation but it is worth touching on how it works while we are 
discussing Carts in general.

In a Live Assisted environment, Myriad will work its way through a list of Carts 
that it needs to play. As each Cart approaches its end, the next in the 
sequence is cued ready to play and presenter decides whether to manually 
start it when they are ready, or to have Myriad automatically start it when the 
previous Cart reaches its Extro point.

The Log

By far the most common form of Live Assisted playout is when you are 
running in Live (or Preview Live) Playout Mode on the Log Screen. In this 
mode, Myriad works it’s way through the scheduled Log and cues each Cart 
in sequence, as it is needed. Whether Myriad automatically plays the next 
Cart as the last finishes, or waits for the presenter to manually play the next 
Cart is determined by the Segue Type indicator on the Log screen (green for 
automated segue, red for manual). When Myriad is using Auto, Auto Fade (or 
Preview Auto) Playout mode, each Cart in the Log will be cued in sequence 
and automatically played as the previous Cart reaches its Extro point.

The Pad

The second scenario where Live Assist or Automated playout occurs is when 
you are using the Pad on the Audio Wall. This is less commonly used than the 
Log but can still be a very useful tool.

The Pad allows you to manually build a sequence of Carts to be played by 
dragging Carts from the Audio Wall onto the Pad. You can then click on the 
Play button on the Pad and Myriad will run through the Carts listed on the 
Pad, cue and play them in turn. You can also insert <PAUSE> commands into 
Pad runs to create a pseudo-Live Assist environment.



158

The Hook Player

The final way that Carts can be played in an automated fashion is when the 
Hook player is used. The Hook Player is a special mode for a Cart Player that 
‘stacks’ a number of Carts to be played in sequence but instead of playing all 
of the Carts, it only plays the Hook from the Carts. Hooks can be manually 
cued from the Audio Wall (using the right click menu), manually cued from the 
Log Screen (using the right click menu) or automatically played as part of the 
Scheduled Log by using an AutoHook Log Item.
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Adding Carts to the Audio Wall

In this section we will look at the various methods that can be used to add 
Carts (audio) to the Audio Wall.

As discussed in previous sections, all of the audio that Myriad plays is in the 
form of Carts; this means that there is likely to be a wide variety of different 
types of Cart stored on your Audio Wall. It is not uncommon for stations to use 
several different methods for getting audio onto their system depending on 
their needs and of course the source material for the audio. The key is really 
to be aware of the different methods available and find the ones that will suit 
your situation best.

Here we will look at how to physically get audio onto the system but we will 
not cover how to title it, edit it or add in timing and notes. This will be covered 
in the SmoothEdit section later in this manual.

Adding Carts Overview

There are a number of ways to get audio onto your system in the form of 
Carts. Each is suited to a particular circumstance and you may not need to 
use them all. The methods are outlined in brief below:

 Manually Record Audio – This method must be used for audio that is 
not already in a digital format. So unless it is on a computer disk or a 
CD, you have to record it manually.

 Importing Files – This method allows you to import digital audio files 
of the right format, directly onto the Audio Wall. This method allows you 
to work on any PC to convert (or rip) the audio and then you can 
transfer it in when you are ready. 

 Importing Audio CDs (ripping) – This method you will most probably 
use the most for songs and other commercial audio. Basically, this 
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involves digitally transferring the audio from a CD directly onto the 
Audio Wall via the PCs CD ROM (or DVD ROM) drive.

This broadly outlines the options available however both Importing and 
Manually Recording can be achieved in several different ways. These are 
described below:

Manual Recording Methods

Manual recording can be used to record audio from any source but it is 
primarily used when Importing CD (ripping) or Importing Files is not possible 
because of the format of the original material.

In simple terms, the Record Cart Player is used to Manually Record into
Myriad and it does this by recording the audio input from a specific sound 
card. This would typically be connected to the output of your mixing desk or 
preferably, the record / AUX bus on your mixing desk for greater flexibility. In 
this scenario, you can record audio into Myriad from any source connected to 
your mixing desk (including the mic for voice tracking). You can however
connect any audio source directly to the selected soundcard input if it suits 
your needs better.

Once connected, you can record at any time in Myriad, even when you are in 
the middle of a ‘live’ show. This can be done in a number of different ways 
(outlined below). The primary advantage of all of the Manual Record methods 
is that you can continue to use Myriad normally while you are recording which 
makes them ideal for use in a ‘live’ show environment.

Quick Record – Recording into an Automatically Assigned Cart

This is the simplest and fastest of all the ways of manually recording audio 
into Myriad but it is also the least flexible as the Cart that the audio is 
recorded into is automatically assigned from a specified range which is set on 
a per User basis.

The idea behind Quick Record is to give a fast way of recording audio without 
having to set up the recording in advance. This is ideal for recording 
telephone conversations or interviews as it can be accessed via a single click 
on screen.

To initiate a Quick Record, click on the Record button on the Record Cart 
Player (or press <Ctrl> + <Shift> + <Insert> - this may be represented by a 
Quick Record button on your Myriad keyboard).
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Depending on how you have set up Myriad, you may then be asked whether 
you wish to use trigger level recording.

If you say Yes then the Record Card Player automatically assigns the first
empty Cart in your Personal Cart Range (defined on a per User basis) and 
prepares to start recording, but does not actually start recording until the 
incoming audio level rises above the configured trigger level (set to 25% in the 
example above).

As soon as the incoming audio level rises above the trigger level, the Record 
Cart Player starts recording.

If you select No then the Record Cart Player automatically assigns the next 
empty Cart in your Personal Cart Range and starts recording immediately.

Selecting Cancel will abandon the recording session.
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As you can see from the diagram above, the Record Cart Player has 
automatically assigned the Cart to record into, it shows how long has been 
recorded and how much more record time is available. The button at the 
bottom of the Record Cart Player flashes red to indicate that recording is 
taking place. This button also acts as the Stop button when you want to stop 
recording. Finally, the VU bars at the right of the Record Cart Player show an 
approximation the incoming audio level to the Record Cart Player.

When you are ready to stop recording, click on the Record Indicator / Stop 
Recording button. You will then be asked if you want to save the Cart. 
Clicking Yes will save the Cart whilst clicking No will abandon the recording 
and you will loose all of the audio that has been recorded.

If you select Yes then you will then be asked whether you wish to jump to that 
Cart to allow you to begin working with it.
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Again, clicking Yes will take you to the Cart, clicking No will leave you in the 
current position on the Audio Wall but the recorded Cart will remain where it 
is.

TIP: To get to your Personal Cart Area quickly at any time, click on the Home 
button on the Audio Wall Main Tab Strip.

As mentioned previously, the keyboard short cut Quick Record is <Ctrl> + 
<Shift> + <Insert> and whilst this is a bit of handful on a normal keyboard, you 
could configure a programmable Myriad keyboard to provide a short cut to this 
feature.

You can also use the following keyboard shortcuts to control the Record Cart 
Player.

 Ctrl + Shift + Insert – Starts recording in the next free Cart in your User 
Edit Range.

 Ctrl + Insert – Starts recording into the currently highlighted Cart on the 
Audio Wall.

 Shift + F12 – Stops recording and asks the User whether they wish to 
save the recording.

 Ctrl + Shift + F12 – Stops and automatically saves current recording.

Manual Recording – into a Specific Cart

Manual Record is very similar to Quick Record in that it is fast and easily 
accessible, uses the Record Cart Player and allows you to continue to use 
Myriad normally whilst recording. The main difference is that in a Manual 
Record, you specify which Cart the audio is recorded into.
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Myriad employs a comprehensive User management system (see The 
Directory) which includes the ability to restrict Users to only be able to record 
and edit (or play) Carts in certain ranges. This means that the Manual Record 
feature may not be available to all Users in all areas of the Audio Wall. For 
this example, it is assumed that the User has full record / edit rights for the 
chosen Cart Range.

There are actually two methods for Manually Recording into a specific Cart. 
They are both outlined below.

Using the Right Click Menu (Or Keyboard Shortcut)

This method is the faster of the two and allows you to continue to use Myriad 
normally whist you are recording but it does not allow you to add additional 
information whilst the Cart is being recorded.

To perform a Manual Record using the right click menu, Right click on the 
Cart you want to record into and select Record into this Cart.
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N.B. If you select a Cart that already has information stored in it, you will be 
asked to confirm that you wish to overwrite it. If you say Yes then the original 
information will be deleted prior to beginning recording. You cannot recover 
this information even if you abandon the recording later on so take care with 
this option!

Just as with Quick Record, you will then be asked whether you wish to use 
the trigger level to start recording.

Selecting Yes will make the Record Cart Player wait until the audio input level 
rises above the specified trigger level before it starts recording. Once this 
level is reached, it starts recording normally.

If you select No then the Record Cart Player starts recording immediately.

To stop recording, click on the Recording Indicator / Stop Recording button 
(see diagram). You will then be asked whether you wish to save the Cart. 
Click Yes if you do and No if you want to abandon the recording and discard 
the recorded audio.
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Finally, you will be asked whether you wish to jump to that Cart to begin 
working on it. Again, click on Yes if you do and No if you don’t. 

You can also Manually Record a Cart using the keyboard by highlighting the 
Cart that you want to record into and then  pressing the <Ctrl> + <Insert> keys 
on the keyboard. This will then go through the same procedure as outlined 
above. The standard Myriad keyboard has a Manual Record button on it to 
allow you to start a Manual Record from the keyboard. 

You can also use the following keyboard shortcuts to record into a specific 
Cart.

 Ctrl + Shift + Insert – Starts recording in the next free Cart in your User 
Edit Range.

 Ctrl + Insert – Starts recording into the currently highlighted Cart on the 
Audio Wall.

 Shift + F12 – Stops recording and asks the User whether they wish to 
save the recording.

 Ctrl + Shift + F12 – Stops and automatically saves current recording.

Using the Audio Edit Area on the SmoothEdit Screen

The alternative method for Manually Recording audio into Carts is to use the 
record facility built into the Audio Edit Area which is the audio editing tool 
located on the SmoothEdit window.

To record into a Cart using this method, first click on the Cart that you want to 
record into, then click on the Edit button on the Audio Wall Main Tab Strip.
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Alternatively, you can right click on the Cart you want to record into and then
select Edit Cart Using SmoothEdit from the menu.
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Whichever method you choose, the SmoothEdit screen will automatically 
open and the SmoothEdit tab will be added to the Main Tab Strip.

If the Cart you are editing is an empty Cart then the SmoothEdit screen (and 
audio editor) will also be blank. If you selected a Cart that does contain audio 
or data then this will be displayed on the SmoothEdit screen. You can still 
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record new audio in or even add additional audio to the existing recording. 
Once SmoothEdit has loaded, you can click on the Record button in the Audio 
Edit Area to start recording. Click on it again to stop recording and view the 
resulting wave file.

The best way to explain this process is by example. We have already 
mentioned that you can use this method to record into empty Carts or to 
replace (or add to) the audio in existing Carts. Let’s deal with each of these 
scenarios in turn.

In this first example we will see how to Manually Record using SmoothEdit
when the Cart is empty.

First we use either of the methods outlined above to open an empty Cart in 
the SmoothEdit window.
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As you can see from the screen shot above, the SmoothEdit window is broken 
into two areas, the top half is used to add in text, timing and additional data for 
the Cart whilst the bottom half is used to view and edit the audio for the Cart. 
(The SmoothEdit screen is covered in greater detail in the SmoothEdit section 
of the documentation so for now we will just concentrate on how to manually 
record some audio into the Cart).

To start recording, click on the Record button which is located with the other 
SmoothEdit Audio Controls.

As soon as you click on the Record button, SmoothEdit will start recording the 
incoming audio to the sound card. The incoming audio wave form is displayed 
on the screen (although its refresh speed will depend on the speed of your 
PC) but the VU bars offer a good indication as to whether the audio level is 
about right.
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When you are ready to stop recording, click on either the Stop button or the 
Record button (again) to end the recording. 

Once you have finished, the audio wave form for the recording will appear in 
the Audio Edit Area to allow you to edit the audio if necessary. For more 
details on Editing Audio, please refer to the Audio Edit Area section of
SmoothEdit.

This method is particularly good if you have a lot of additional text and timing 
information to add to the Cart as you can add it all while the Cart is being 
recorded using the information fields at the top of the SmoothEdit screen. For 
more details please refer to the SmoothEdit section of the documentation.

Once you are happy with the Cart, click on the Save button (located on the 
Edit Cart Tool Bar at the top of the screen – see below). 
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Alternatively you can close the window (by clicking on the cross in the top 
right hand corner of the SmoothEdit window) and if you have not saved the 
audio or data, you will be prompted to save.

Clicking Yes will save the Cart details, clicking No will discard the Cart details 
and close SmoothEdit, clicking Cancel will not save the Cart details but will 
allow you to continue working on the Cart in SmoothEdit.

This next example deals with a situation where the Cart already has 
information stored on it.

You can see that we have clicked on the Edit button with an occupied Cart 
highlighted. As you can see the SmoothEdit window includes the audio for the 
Cart as well as the text, timing, copyright and picture information for the Cart.

From here we can do one of two things.

 We can add additional audio to the Cart by moving the cursor in the 
Audio Edit Area to the point in the existing audio where we want to start 
recording from. If we do this and then click on the Record button (as 
above) then the audio is recorded in the normal way but when you 
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have finished recording, the audio is inserted into the original at the 
point you selected. It does not overwrite any of the original audio but 
rather just extends the length of the Cart accordingly. This is ideal for 
building an interview or feature from several different sources.

 Alternatively, if you select all of the wave form in the Audio Edit Area 
(by using the left mouse button to highlight it or double clicking in the 
centre of the wave form) and then press the <Delete> key or click on 

the Delete Highlighted Section  button then the current audio for the 
Cart will be deleted leaving the way free for you to record new audio in 
the normal fashion (see the first example above).

This is really useful because whilst the audio is completely new, all of 
the additional Cart information (Title, Artists, and Copyright Details etc) 
is retained (except timing as this is no longer relevant). This can be 
very useful if you are recording, for example, a new news bulletin into 
the same Cart each hour, as it saves you from having to retype all the 
text information each time.

Once you are happy with the recording, all you need to do is click on the Save 
button on the Edit Cart menu (see diagram in the previous example) or close 
the SmoothEdit window and save when prompted.

The SmoothEdit screen contains a great deal of information and powerful 
tools. These are covered in more detail in the SmoothEdit Chapter later in this 
documentation.

Importing Audio Files into the Audio Wall
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This method of adding Carts to the Audio Wall is becoming more and more 
important as legitimate digital sources for music and audio distribution are 
becoming common place, and online music stores such as iTunes and MSN 
Music can provide plentiful and inexpensive ways to build your music 
database.

One important thing to bear in mind is that Myriad’s native audio format is 
uncompressed WAV files which offer the best audio quality and fidelity but do 
take up a lot of hard disk space (typically about 40MB per song). Most web 
based delivery methods rely on using audio compression techniques such as 
MP3 or Windows Media to reduce the size of audio files. This does have an 
impact on the audio quality, but when balanced against the decrease in time 
taken to transport them and the reduced bandwidth costs, the drop in quality 
is acceptable to many people. If you are using Myriad v3.0 then you will have 
to convert any file that is not in a WAV format in order for Myriad to be able to 
play it (we will cover how to do this). If you are using Myriad v3.1 or higher 
then Myriad can play a greater number of compressed formats (MP3, WMA, 
MP2 & Ogg Vobis) so the likelihood of having to convert your digitally sourced 
files is somewhat reduced.

There are three main methods used for Importing Audio into Carts on the 
Audio Wall:

 Import Audio using the Import Audio Wizard.
 Import Audio using the Audio Edit Area on the SmoothEdit screen.
 Drag & drop audio files from Windows Explorer™ directly onto the 

Audio Wall.

Importing Audio Using the Import Audio Wizard

This is probably the primary method most people will use for importing audio 
into Carts on the Audio Wall. The Import Audio Wizard is a multi-function 
wizard that is used for both importing existing audio files and ripping audio 
files directly from a CD. In this instance we will concentrate on the Import 
Audio Files section as the CD ripping facilities are covered elsewhere.

The Import Audio Files option is accessed via the right click menu so to begin 
with, right click on an empty Cart and scroll down the menu to the Import 
Audio option.
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Here you will see that the expanded menu gives you three options:

1. Import Wizard – This opens the Import Wizard at the first page which 
allows you to choose whether you want to import files or import audio 
from an audio CD. As well as allowing you to rip multiple CD tracks, the 
wizard also allows you to import multiple audio files at one time.
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2. Rip One Or More CD Tracks – This option basically skips the first 
page of the Wizard and goes straight to the CD ripping option. This 
allows you to select multiple tracks from an audio CD to be ripped into 
Myriad starting at the highlighted Cart and working up from there.

3. Import From A Single WAV Or Transport File – This option skips 
most of the steps in the wizard and allows you to immediately select a 
single WAV or Transport (zip) file to be imported into the highlighted 
Cart.

In most cases you would go straight for option 3 as it skips most of the 
settings and allows you to get on with importing a single file, but for the sake 
of this example, we will assume that we selected Option 1, Import Wizard.

The Information Page
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The first page that you will see just explains what the wizard is for. If you tick 
the ‘Skip this screen in future’ option then you will not see this screen each 
time you run the wizard. Click on the Next button to proceed to the next page.

Selecting Import Type Page
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Here we get to choose whether to import audio files or rip tracks from a CD (in 
this case we are looking at importing audio files). Tick the ‘Import Audio files’ 
option and click on Next.

Select Audio Files Page
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This page of the wizard allows you to select the file or files that you want to 
import. There are a number of options on this screen so we will go through 
them in turn.

The Select Single File button allows you to browse your computer and 
network to select a single file to be added to the list of files to be imported. 
When you click on the Select Single File button, the standard windows file 
selection window appears.

You can use this window to select a single WAV or Transport (zip) file to be 
imported or (as in the example above) you can select multiple files by holding 
down the <Ctrl> key and clicking on the ones you want (other standard 
windows selection tricks also work). Click on the Open button and the files are 
added to the Files to Import list.
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You can click on the Import Single File button multiple times to select files 
from different folders or locations to build up a list of files that you want to 
import.
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Note the tick by each file. Only the ticked files will be imported, so even if you 
add a file to the list by mistake, you can still exclude it from the import process
by clicking to un-tick it.

Below the Select Single File button is the Select Folder button which offers a 
simple way of adding all of the suitable audio files within a folder, to the list of 
files to be imported. Clicking on this button allows you to select the folder
whose content you want to import.
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The tick boxes to the left of the files in the Files To Import list is even more 
useful when you are adding a folder’s worth at a time because you can add 
the entire folder and then go through and exclude any you don’t want to 
import.

You may want to exclude, for example, any files which could already exist on 
your Audio Wall, to avoid making duplicates.  The Check for Similar button 
allows you to search the Audio Wall and look for any Carts that match the 
Title or Artist information for the files that you are planning to import. 
Obviously, this option will only be useful if the Title and Artist information is 
present, meaning that it needs to either be embedded into the filename (e.g. 
Overprotected – Britney Spears) or hidden inside the file itself (e.g. it is 
CartChunk compliant which all Carts exported from Myriad are). If you click on 
the Check for Similar button, the results are displayed in a separate panel 
underneath the Files to Import list.
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As you can see from the screen shot above, several of the Songs we are 
trying to import already exist on our Audio Wall, so we may wish to exclude 
them from the import process by un-ticking the conflicting songs.

The File Name Processing options allow you to alter the way in which Myriad 
interprets the file name when it is using it to title the files it is importing. 
Consider the following.

Overprotected – Britney Spears
Britney Spears – Overprotected
Overprotected / Britney Spears

To a human, it is clear that they are all the same track (i.e. Overprotected by 
Britney Spears) but because software is not as intelligent as your average 
person, it can get confused by this type of situation. Myriad will always 
attempt to interpret the file name as best it can, but the File Name Processing 
options allow you to give it a hand by telling it the order it should be using for
Title and Artists and also the character that is being used to separate them.
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Use the drop down lists to select the options that best suit the files that you 
are trying to import. If you have several different filename formats within the 
list of files to import, it may be impossible to resolve the situation, in which 
case it is advisable to import them in small batches of similarly formatted files.

The final option on this page is the Delete the File after Importing option which 
does exactly what it says.  After the file has been imported to the Cart the 
original source file will be deleted.  

CAUTION – If you tick this option and then run the import process, there will 
be no way to recover the audio files that Myriad deletes.

Finally, when you are happy with all of the options on Select Audio Files page, 
click on the Next button to proceed.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio file in the list to be imported to and 
also how to deal with the subsequent files in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally) or to attempt to interpret the 
destination Cart Number from the file name (e.g. MYR05467.wav would be 
imported in to Cart number 5467).

The second option allows you to select whether to overwrite Carts that 
already exist in that range. Let’s say we were importing 10 files starting at 
Cart number 2941 (as above) then they would each be imported in sequence 
between Carts 2941 and 2951 on the Audio Wall. Now let’s say we already 
had a Cart at 2950, if this option were ticked then the Cart at 2650 would be 
overwritten with the new imported Cart. If you leave this option un-ticked then 
the Cart at 2950 would remain and the position of the imported files after that 
would be shuffled up by one so the imported Carts would actually end at 
2952. Basically, if you leave this option un-ticked then the import process will 
stop the overwriting of any existing Carts on your Audio Wall which is 
probably the way you will usually want it.

When you are happy with the destination Cart selection, click on the Next 
button.

Import Audio Format
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The next stage in the Import Wizard allows you to control the format of the 
audio files that you are importing and also the audio level of the audio within 
the files.

From this screen you can opt to convert all the imported files to a pre-set 
format and compression scheme, leave the files in their current format 
(regardless of whether it is compatible with Myriad) or to convert them to a 
User specified format. You can also set whether to ‘normalise’ the audio and if 
so what level to normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted into the same format and quality as the other audio on the Audio 
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in a quality or format that Myriad cannot convert, you will be 
notified as it attempts the conversion.

The Import Audio in its Current Format option does exactly as the name 
suggests. Audio is imported into the destination Cart but is left in the original 
format and quality. This option is not advisable as it could lead to Carts
existing on the Audio Wall that Myriad cannot play.

The Convert Audio to a Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.
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This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.

 Audio Format – This allows you to select the basic audio format to 
convert the audio to. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) and ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. NB: This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This option is only applicable to MP2, MP3, Ogg and WMA 
formats. The higher the bit rate, the higher the quality, but the larger 
the file size. It is generally accepted that 256Kbit MP3 or WMA give a
comparable audio quality to CDs but you must set the bit rate that best 
suits the balance between audio quality and file size that your station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in Autumn 
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to do normalising of the audio as it is imported. But what de we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs and like any graph, there is always a point in the wave form that is the 
loudest single point. When you perform a normalisation, Myriad scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level.

If you tick the Normalise the Audio after It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to be the same as the Percentage to Normalise To. Once it has this 
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value, it will then apply the same amplification / reduction to the rest of the file 
and hence the file will be normalised. The important thing is if all the audio 
files imported or ripped onto the Audio Wall are normalised to the same value 
then the loudest point in each file will be exactly the same.

You can alter the Percentage to Normalise to value as part of the normalise
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% representing silence. The default of 63% has been calculated 
to provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Settings>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

This next page in the wizard provides an overall summary of the audio files 
that you want to import, along with destination Carts, Title & Artists 
information and length of audio.
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If you are not happy with the displayed summary, click on the Back button 
until the relevant page is displayed and make whatever alterations are 
needed. If you are happy, click on the Next button to proceed.

You will then be asked to confirm that you want to proceed.

Importing Audio

Once you have confirmed that you want to proceed, Myriad starts the import 
process. The Importing Audio screen shows you a summary of the progress 
made along with a log of the actions it has performed.
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You can stop the import process at any time by clicking on the Stop Importing 
Audio button. If you do this then any audio files that have been successfully 
imported will remain on the Audio Wall but the current audio file and any 
remaining in the list to import will be discarded.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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This page concludes the wizard. Remember that if the imported files did not 
include embedded timing information, you will need to use SmoothEdit to set 
the Intro and Extro for the Carts in order for them to sound good in an 
automated segue. If you have imported Songs or Links, you will also have to 
add them to your scheduling system as even when you are using AutoTrack 
or AutoTrack Pro, they will not automatically be added to the scheduling 
system.
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(Resulting audio imported onto the Audio Wall using the Import Audio Wizard)

Importing Audio Directly onto the Audio Wall (Using Right Click 
Option)

In the previous section, we looked at how to import audio files using the 
Import Audio Wizard which is available via the right click menu. This method 
is great if you want to import multiple files or if you want to control the way in 
which Myriad imports them. If, however, you only wish to import a single audio 
file using the Myriad default qualities and formats then there is a quicker 
method using the Import Single WAV or Transport File option on the right click 
menu.

To do this, right click on the Cart you want to import into and select the Import 
Single WAV or Transport File on the Import Audio menu.
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When you click on this option, you will then be asked to locate the audio file 
that you want to import.
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NB: You can only select files in the supported formats and you can only select 
one file at a time.

When you have located the audio file that you want to import, make sure it is 
highlighted and then click on the Open button.

You will be asked whether you want to delete the original file before the import 
starts. Use the Yes / No buttons to answer accordingly. Click on Cancel if you 
wish to abandon the import.

Clicking Yes will complete the Import process.
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Importing Audio Using SmoothEdit (including MP3, WMA etc)

The final method for importing an audio file onto the Audio Wall involves 
importing the audio directly into the destination Cart via the SmoothEdit 
screen which is accessible via the Edit button on the Main Tab or the Edit Cart 
Using SmoothEdit option on the right click menu. This method only allows you 
to import one file at a time but does allow you to import audio files of multiple 
formats (e.g. MP2, MP3, WMA & Ogg), plus it allows you to edit the audio, 
data and timing information directly after the audio has been imported.

To use this method, find the Cart that you want to import into and either click 
on the Edit button on the Main Tab Strip or right click and select Edit Cart 
Using SmoothEdit option.
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This will then load the SmoothEdit screen.

If you click on a populated Cart and then open the SmoothEdit window then 
the Cart’s current details and audio wave form will be displayed. This does not 
stop you from importing a new audio file using this method. If you place the 
playback cursor (see Audio Edit Area) at a single point in the wave form then 
the imported audio will be added to the existing audio at that point. If however, 
you double click in the middle of the wave form (to select it all) and then 
‘Insert Another File’ then the imported audio will replace the existing audio.
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Click on the down arrow  to open the extended Paste menu.

Select the Insert Another File option and you will then be asked to select the 
file that you want to import.



199

Note that the key difference here is that as well as WAV files, audio files of 
other formats are also listed. In this example we will select the ‘Get The Party
Started – Pink.mp3’ file to demonstrate importing an MP3 file.

Here we can see that the MP3 file has been converted into a suitable format 
and imported into the selected Cart. All that remains to be done is to add the 
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Title & Artists information and ideally add the Intro and Extro timing 
information.

Here we can see the finished Cart complete with Title, Artists and timing 
information (see SmoothEdit documentation for how to do this). All that 
remains to be done is to click on the Save Cart button on the Edit Cart Tool 
Bar (see arrow on diagram) and then close the SmoothEdit window. If you 
attempt to close the window before saving, you will be prompted to save 
before the Cart is closed.

Importing Audio CDs (Ripping)

In this section we will look at how to import audio directly from a standard 
audio CD. This procedure is commonly referred to as ‘ripping’ and it involves 
the rapid transfer of audio from a CD to the PC as raw data. This means that 
a file can be transferred into the system in a fraction of the time of manually 
recording it in. The other advantage is that the vast majority of commercial 
CDs have unique numbers that can be used to find the Title and Artist 
information from specialised websites on the Internet. This means that in 
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some cases, Myriad can automatically gather this information as part of the 
CD ripping process.

The only problem with this method is that some commercial CDs now include 
protection to prevent this type of digital transfer as an anti-piracy measure. 
Unfortunately, it would be unlawful for Myriad to work around such measures, 
so CDs that include copy protection cannot be ripped into Myriad using the 
built in Import Audio CD function.

CD Tracks are imported into Myriad using the Import Audio Wizard but you 
can actually initiate this process in two different ways.

Importing CD Tracks Using the Import Audio Wizard

This method uses the Import Wizard which is available from the right click 
menu on the Audio Wall.

This will then open the Import Audio Wizard.
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The Information Page

The initial page on the Import Audio Wizard offers some general information 
on what the Import Audio Wizard does.

You can opt to skip this page in future by ticking the Skip This Screen In 
Future option. 

Selecting Import Type Page

The next page in the Wizard allows you to select whether you wish to import 
audio from existing audio files or whether you wish to import CD tracks from 
an audio CD. In this case we obviously need to select the Rip Audio Tracks 
From CD option.
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Once it is selected, click on the Next button to continue.

Rip Audio from CD Tracks Page

The next page is the main page for setting which tracks you want to rip into 
Myriad and also how to interpret and process the audio tracks imported. This 
page of the Wizard contains a number of settings and options. The diagram 
below shows a general overview of the layout of the page and the individual 
options are examined in more detail below.
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The most obvious section of the page is the Track Listing section. When you 
first move onto this page, Myriad will automatically scan the CD that is in the 
CD ROM drive with the lowest drive number. It will read how many tracks are 
available on the CD and put an entry for each in the Track Listing area.

Beside each track is the Individual Track Selector which is a tick box option 
that allows you to indicate whether the track should be imported as part of the 
CD ripping process.
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In the above example, tracks 1, 2, 4 & 5 will be imported and all other tracks 
will be ignored. This option is very useful when you are working with albums 
that only have a few tracks that you want to install.

Related to this feature are the Select All and De-select All buttons. As you 
would expect, these buttons allow you to select (‘tick’) all of the tracks on the 
CD to be imported or to de-select any that have already been selected.

The Get Titles button is only enabled if your Myriad system has been 
configured to use a web connection to ‘look up’ Title and Artist information for 
CDs using one of the CD databases available on the web (FreeDB or CDDB 
are the most common).

Once enabled, this option will make Myriad submit the unique ID number for 
the CD to the online database and will then display any Title and Artist 
information listed in the database for the CD.

Please note that the information stored on the online databases are 
maintained by the general public and as such the information may not be 
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available or accurate. It is always worth checking that the information is both 
relevant and accurate. 

Once the information has been gathered, Myriad will do it’s best to sort the 
information into the correct fields in the Track Listing area. The problem is that 
there is no standard for entering the data onto the online databases so 
sometimes the Artist and Title appear in the wrong order. To make matters 
worse, the character used to separate the Artists and Title is not always the 
same so you could end up seeing something like the screen shot below.

In this case the Track Details Import Options can be useful to allow you to 
work around information that has been listed incorrectly or in the wrong 
format.

We can see from this example that the ‘/’ character is used to separate the 
Artist and Title but we are using the ‘-‘ or ‘_’ characters to separate them so 
Myriad is not able to separate the information correctly. This is simple to fix 
however, using the Separators drop down lists to select the correct character.
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By selecting the ‘/’ character as one of the separators, the problem is 
alleviated.
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The Item Title Order drop down list is used if the Title & Artist information 
appears the wrong way round in the Track Listing area.
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In this situation, you can use the Item Title Order to switch the Title and Artist 
to be displayed correctly.

The Force Title / Artist options allow you to overrule the information supplied 
by the online database with your own information.
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Once you have Title and Artist information that you are happy with, you can 
get Myriad to check the Audio Wall for existing Carts with similar Artist or Title 
information to avoid duplication, using the Scan Audio Wall For Similar button.
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This will scan the Audio Wall and display all Carts with similar information to 
the selected tracks in the Track Listing Area.
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As you can see from the example above, similar Carts were found for both 
Christina Milian and Anastacia but not with the same track Titles so importing 
the Christina Milian and Anastacia tracks from this CD should be OK.

The final option on this page is the Automatically Trim The Silence From The 
Start Of The Audio (‘Top’) option which, as the name suggests, automatically 
removes any silence from the beginning of the audio track as it is imported. 
This option is highly recommended because without it you would have to 
manually trim the silence from the beginning of tracks using SmoothEdit. 
Otherwise Myriad would play the silence each time the Cart was played in a 
Cart Player.

When you are happy with your selection of tracks, and that the additional 
information will be imported as correctly as possible, click on the Next button 
to continue.

Select Destination Carts Page

The next page on the Import Audio File Wizard allows you to select the Cart 
Slot Number that you want the first audio track in the list to be ripped into and 
also how to deal with the subsequent tracks in the list.
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The top section allows you to choose between automatically assigning a Cart 
Slot Number on the Audio Wall starting from the selected point (which by 
default is the Cart you right clicked on originally).

The second option allows you to select whether to overwrite Carts that 
already exist in that range. Let’s say we were importing 10 tracks starting at 
Cart number 3092 (as above) then they would each be imported in sequence 
between Carts 3092 and 3102 on the Audio Wall. Now let’s say we already 
had a Cart at 3100 then if this option were ticked the Cart at 3100 would be 
overwritten with the new imported Cart. If you leave this option un-ticked then 
the Cart at 3100 would remain and the position of the imported files after that 
would be shuffled up by one so the imported Carts would actually end at 
3103. Basically, if you leave this option un-ticked then the import process will 
stop the overwriting of any existing Carts on your Audio Wall which is 
probably the way you will usually want it.

Import Audio Format

The next stage in the Import Wizard allows you to control the format of the 
audio tracks that you are importing and also the audio level of the audio within 
the tracks.

From this screen you can opt to convert all the imported tracks to a pre-set 
format and compression scheme or to convert them to a User specified 
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format. You can also set whether to ‘normalise’ the audio and if so the level to 
normalise it to.

If you select the Convert The Audio To Match The Audio Wall Format option 
then (if possible) Myriad will convert the audio to the audio quality (e.g. 
44,100Khz stereo) and format (e.g. WAV, ADPCM etc) that has been set as 
the default for the Audio Wall - see Settings>Audio Settings menu and the 
Record / Edit tab – as seen below.
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This is the most commonly used setting as it ensures that the audio is 
converted into the same format and quality as the other audio on the Audio 
Wall. It should be noted that Myriad cannot convert all file types and formats. 
If you import a file in a quality or format that Myriad cannot convert, you will be 
notified as it attempts the conversion.

The Convert Audio to a Specified Format option allows you to set the audio 
format and quality for the import batch you are working on. To use this option, 
select it and then click on the Select button to choose the format you want to 
use.

This will open the Choose Audio Format window which allows you to select 
from the available audio formats and quality options. The available options do 
differ from format to format but in general, the options are listed below.
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 Audio Format – This allows you to select the basic audio format to 
convert the audio into. In Myriad v3, this is restricted to just Windows 
Wav files but in Myriad v3.1 this option is expanded to allow you to 
select from MP2, MP3, WMA (windows media format), Ogg (ogg 
vorbis) and WAV files in Myriad v3.1.

 Format (WAV only) – This option allows you to select between PCM 
(uncompressed WAV files) or ADPCM (4:1 compressed WAV files).

 Sample Rate – This allows you to select the sample rate on which the 
audio is based. NB: This is not a configurable option on some formats.

 Bit Rate – This option allows you to set the bit rate at which to encode 
the audio. This option is only applicable to MP2, MP3, Ogg and WMA 
formats. The higher the bit rate, the higher the quality, but the larger 
the file size. It is usually accepted that the 256Kbit MP3 or WMA give a
comparable audio quality to CDs but you must set the bit rate that best 
suits the balance between audio quality and file size that your station 
needs.

 Stereo / Mono – This option allows you to select whether the audio 
should be imported as a stereo or mono audio file. This option may not 
be available on all formats.

Many of the above options are only available in Myriad v3.1 so if you do not 
have all the options, please check that you are on the latest version of Myriad 
before contacting P Squared. Myriad v3.1 is scheduled for release in autumn
2005 so it is possible that not all the features will be available before this date.

The final option on the Import Audio Format page of the Import Audio Wizard 
is to normalise the audio as it is imported. But what do we mean by 
normalising?

The basic idea is simple. An audio file or wave form is a graph of peaks and 
troughs, and like any graph, there is always a point in the wave form that is 
the loudest single point. When you perform a normalisation, Myriad scans 
through the wave form to find this point. It then works out how much it would 
need to amplify this point by in order to reach the percentage level that you 
have specified when setting up the Normalisation. It then applies the same 
level of amplification to the entire wave form. This is important because as the 
loudest point is used to calculate the amplification level and this level is 
applied to the rest of the wave form, you avoid distortion by over amplification. 
It is also important because if multiple audio files are normalised to the same 
level, they should be pretty even in terms of volume as the loudest point in 
each file will always be at the same level.

If you tick the Normalise the Audio after It’s Imported option then Myriad will 
scan through the audio after it has imported it, find the loudest point, and then 
work out how much it will need to amplify or reduce the volume by in order for 
this point to be the same as the Percentage To Normalise To. Once it has this 
value, it will then apply the same amplification / reduction to the rest of the file 
and hence the file will be normalised. The important thing is if all the audio 
files imported or ripped into the Audio Wall are normalised to the same value 
then the loudest point in each file will be exactly the same.
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You can alter the Percentage To Normalise To value as part of the normalise 
procedure. The value represents the entire range of volume of the sampled 
audio with 100% representing full volume (e.g. wave form reaches top of 
scale) and 0% representing silence. The default of 63% has been calculated 
to provide audio normalised to -14Db which is the technically correct level for 
digital audio. It is worth experimenting to get the right level for your station. 
The Audio Wall Default button resets this value to the pre-set default 
normalise level which can be altered using the Settings>Audio Wall File 
Settings menu and selecting the Importing Audio tab.

When you are happy with the Import Audio Format setting, click on the Next 
button to advance to the next page of the wizard.

Import Audio Summary

The Import Audio Summary page displays an overview of the CD tracks that 
are going to be imported and the destination Carts they will be imported into.
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Click on the Next button to start the CD ripping process, you will then be 
asked to confirm that you want to proceed.

Click Yes to start the process.
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The import process is displayed both as a progress bar and as a text log of 
the tracks imported.

You can stop the import process at any time by clicking on the Stop Importing 
Audio button. If you do this then any audio files that have been successfully 
imported will remain on the Audio Wall but the current audio file and any 
remaining in the list to import will be discarded.

Once the import process has been completed, the final page of the wizard will 
be displayed.
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Click on the Close button to close the Import Wizard and return to the Audio 
Wall.

The Clock

The Clock in Myriad performs three important functions which are listed 
below:

 Clock – This is the simple one. It displays the PCs system time and if 
the PC has been configured to use either an atomic clock (such as the 
Rugby radio controlled clock in the UK) or an Internet based time 
server then the time displayed by the Clock should be absolutely 
accurate. 

 Countdown – When in countdown mode, rather than the PCs system 
time, the Clock displays a count down to the start of the next hour to 
help with back timing live shows.

 AutoPlay – The AutoPlay feature is designed to help you back time 
manual or live shows to the top of the hour by automatically fading out 
any playing Carts at the appropriate time, and playing the pre-defined 
Cart instead. The classic use for this would be if you had a ‘news in’ 
jingle that was five seconds long and you wanted to play it ahead of 
taking a network news bulletin at the top of the hour (such as IRN in 
the UK). In this scenario, if you loaded the ‘news in’ Cart into the Clock 
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in AutoPlay mode, five seconds from the end of the hour, all other 
playing Carts would be faded out and the ‘news in’ Cart would be 
played automatically.

Switching Between Clock & Countdown Modes

The Clock displays the PCs system time by default; however, you can switch 
to a Countdown mode at any time. When in this mode, the Clock will display a 
countdown of the minutes and seconds left before the very end of the current 
hour.

To switch between Clock and Countdown modes, click on the Clock (using 
either the left or right mouse button) and select the option you want from the 
menu that appears.

As you can see, switching from Clock to Countdown mode alters the Clock to 
show you how much time is remaining in the hour.

Using the AutoPlay Feature

As outlined above, the AutoPlay feature is mainly used when you are 
presenting a fully manual ‘live’ show using the Audio Wall but you still need to 
backtime the show so that it finishes at the very end of the hour in order to 
allow you to switch to a news source (either local or remote).

The AutoPlay feature allows you to place a Cart into the AutoPlay Clock to be 
played in such a way that the Cart will end exactly at the XX:59.99 (i.e. the top 
of the hour). As well as starting the selected Cart at the appropriate time so 



222

that it will end at exactly the end of the hour, AutoPlay will also fade out any 
other Carts playing at the time.

Let’s look at an example. If we had a ‘news in’ jingle that was exactly 5 
seconds long then the following sequence would need to happen:

1. At 59 minutes and 45 seconds, fade out any Carts that are already 
playing in Cart Players.

2. Load the ‘news in’ Cart into the first free Cart Player.
3. Start playback of ‘news in’ Cart.
4. ‘News in’ Cart finishes (or reaches Extro more accurately) at exactly

the end of the hour.

When you are using AutoPlay, all this happens automatically so all you have 
to do is drop the Cart you want to play into the AutoPlay Clock and let Myriad 
do the rest.

Adding a Cart to the AutoPlay Clock

In order to add a Cart to the AutoPlay Clock, all you have to do is drag the 
Cart that you want to be AutoPlayed onto the Clock on the Audio Wall (top 
right hand corner) until you see the mouse icon change to a copy symbol.
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Then release the left mouse button to ‘drop’ the Cart into the AutoPlay Clock. 
The display will change to show a countdown to the point at which the Cart 
will be played as well as the title of the Cart itself.

NB: The AP initials indicate that the Cart is scheduled to be AutoPlayed.

Removing Carts from the AutoPlay Clock

Once a Cart has been added to the AutoPlay Clock, it can be removed using 
the Remove The AutoPlay Item option on the Clock menu which can be 
accessed at any time by clicking on the clock with either the left or right 
mouse buttons.

When you select to Remove Item, the Cart is removed from the AutoPlay 
Clock and the Clock returns to its ordinary status.

Switch Clock Views Whilst In AutoPlay Mode

You can also use the Clock menu (accessed via the left or right mouse 
buttons) to switch between Clock and Countdown mode even when you are 
using the AutoPlay feature. Just click on the Clock and select either the 
Display Clock or Display Countdown mode.

In Countdown mode, the display changes to show the time remaining in the 
current hour.

This may be different to the countdown displayed in AutoPlay mode as the 
countdown in AutoPlay mode counts down to the point where the AutoPlay 
Cart starts playing where as Countdown mode always displays the time until 
the end of the hour (regardless of AutoPlay Cart length).
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If you switch to Clock mode, the standard PC system time is displayed.

You will note that in either mode, the AutoPlay indicator remains visible to let 
you know that a Cart has been added to the AutoPlay Clock.

You can of course switch the view back to AutoPlay using the Clock Menu.

Jump Buttons

As covered in the Carts section of this Chapter, the Audio Wall is really just a 
large list of Carts, each of which contains a single audio file along with 
complimentary text, timing information and other data. All of the individual 
parts of the Myriad Suite revolve around this single Audio Wall which can 
consist of anything from 10,000 to 100,000 Carts. 

It is advisable to separate the Audio Wall into different areas to allow you to 
group similar Carts together to make navigating through the Audio Wall easier 
for the end users. The Audio Wall includes several tools to help you navigate 
around the Audio Wall quickly and efficiently to allow you to find the Carts you 
want. The Audio Wall navigation tools can be broken down into three key 
areas.

1. Jump Buttons – Customisable short cut buttons that jump to specific 
places on the Audio Wall.

2. Jump To Cart – This allows you to jump to a specific Cart Slot Number 
on the Audio Wall.

3. Find – Allows you to add search criteria and then search the Audio 
Wall for Carts that match.

All of these methods have their own advantages and uses but in this section 
we will focus on the Jump buttons, how they are used and how they can be 
configured.

Local, Personal & Shared Jumps – Explained

There are actually three different types of Jump buttons in Myriad designed to 
allow you to customise the system to your individual needs. The Jump button 
types are:

 Local – These are specific to each Myriad workstation and are 
displayed on the main Audio Wall at all times. Local Jumps are limited 
to a maximum of 10 at any one time.

 Personal – These Jump Buttons are specific to each Myriad User 
Account and effectively follow users around as they log in and out of 
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different Myriad workstations. Users can set an unlimited number of 
Personal Jump Buttons.

 Shared – These Jump Buttons are non specific are available to all 
Users using any Myriad workstation. You can set an unlimited number 
of Shared Jump Buttons.

Although all Users can use Local, Personal or Shared Jump Buttons; adding, 
configuring and removing them is restricted to Users with appropriate User 
Access Rights.

Each of the Jump Button types is explored in more detail below.

Local Jumps

Local Jump Buttons are specific to each individual Myriad workstation and are 
visible on the Audio Wall at all times running along the top of the Audio Wall 
screen.

In the example above, only three local Jump Buttons have been configured 
and they have been labelled ‘jingles’, ‘adverts’ and ‘music’.  As we will see in 
the next section, each Local Jump Button is given a title and a destination 
Cart Slot Number which is the Cart that the Audio Wall will jump to when the 
button is clicked. The number of Local Jump Buttons visible on screen varies 
between zero and ten depending on how many you have configured. You 
cannot have more then ten Local Jump Buttons configured per workstation.

In general, Local Jump Buttons are configured to go to broad areas of your 
Audio Wall. They are specific to each workstation so you may configure a 
studio workstation to have very different Local Jump Buttons to a newsroom 
workstation.

To the right of the Local Jump Buttons is the More button which allows you to 
configure the Local Jumps as well as view and configure Personal and 
Shared Jumps.

Adding Local Jumps

Local Jumps are configured on a per workstation basis which means that they 
may be different in different studios or locations within your station. To 
configure Local Jumps, you need to be logged in as a User with sufficient 
User Access Rights.

Adding Local Jumps is a very simple process. All you need to know is what 
you want the caption on the Local Jump Button to say and what Cart Slot 
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Number you want to jump to when the button is pressed. To add a new Local 
Jump Button, use the following method:

1. Ensure you are logged in as a User with sufficient rights to add / edit 
Local User Jumps.

2. Click on the More button located to the right of the Local User Jumps to 
access the More Jumps screen.

3. Next you will see the More Jumps screen which allows you to maintain 
your Local Jumps as well as access and maintain the Personal and 
Shared Jumps.

4. The top part of the More Jumps screen is used to display and configure 
Local Jumps so that is what we are interested in at this stage. To add a 
new Local Jump, click on the Add (+) button on the Local Jumps 
section.
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5. This will open the Jump Properties window which allows you to 
configure the Jump Button we are working on. 

6. First type in the title for the Jump Button in the Caption section. 
Remember that this is what will be displayed on the main Audio Wall 
view so keep it short and sweet.

7. Next, select an icon for the Jump Button using the Icon drop down list. 
NB: The icon will not be visible when in the main Audio Wall but will be 
visible when using the More Jumps screen to click on the Jump.

8. Finally, set the target Cart Number that you want to jump to using the 
Jump To option.

9. The click on the OK button.

As you can see, the new Local Jump Button has been added to the More 
Jumps window. Close the More Jumps window by clicking on the (X) in the 
top right of the window and you will see that the new Local Jump Button has 
also been added to the Audio Wall.



228

Remember, you can only add up to ten Local Jumps per workstation and the 
Local Jumps need to be configured on each Myriad workstation individually.

Editing Existing Local Jump Buttons

You might need to alter the caption or destination of Local Jump Buttons from 
time to time. To alter the Local Jump Button properties, follow these steps:

1. Make sure you are logged in as a User with sufficient User Rights to 
alter the Local Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Properties button for the Local Jump Button that you wish 

to edit.

4. Use the Jump Button Properties window to make the alterations that 
you need to.
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5. Click on the OK button to save the changes to the Jump Button
properties.

6. Close the More Jump Buttons window by clicking on the (X) in the top 
right of the window.

Removing Existing Local Jump Buttons

You may also wish to remove Local Jump Buttons from time to time. The 
procedure is very similar to editing them and is outlined below.

1. Make sure you are logged in as a User with sufficient User Rights alter 
the Local Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Delete Jump Button icon for the Local Jump Button that 

you wish to delete.
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4. You will then be asked to confirm that you wish to delete the Local 
Jump Button. Click on Yes if you do and No if you don’t.

5. The Local Jump Button is then removed from the Local Jumps section. 
Click on the (X) to close the More Jumps window and return back to 
the Audio Wall.

CAUTION: As with most areas in Myriad, once a Local Jump Button has been 
deleted, it cannot be recovered so please use this facility with caution.

Personal Jumps

In the last section, we looked at how to use, add and edit Local Jump Buttons. 
Now we will move on to Personal Jump Buttons which are very similar but 
rather than being specific to a particular Myriad workstation, the Personal 
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Jump Buttons are specific to the User logged into Myriad and effectively follow
you to whichever workstation you are using (well within a single station at 
least!). The other principle difference is that unlike the Local Jump Buttons, 
the Personal Jump Buttons are only accessible via the More Jump Buttons 
window.

The procedure for adding, editing and removing Personal Jump Buttons is 
basically the same as for Local buttons so if you have already read that 
section then you can probably skip on ahead. If not then the procedures are 
outlined below.

Adding Personal Jump Buttons

If you have sufficient User Access Rights, you can add additional Personal 
Jump Buttons to provide you with short cuts to specific Cart Numbers on the 
Audio Wall. The procedure is outlined below:

1. Ensure you are logged in as a User with sufficient User Access Rights 
to add Personal Jump Buttons.

2. Click on the More button located to the right of the Local Jump Buttons.

3. This will open the More Jumps Window which is used to access and 
configure Local, Personal and Shared Jump Buttons. In this case we 
are adding a new Personal Jump Button so we are concerned with the 
middle section.

4. Click on the Add (+) button in the Personal Jumps section.
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5. This will open the Jump Button Properties window which allows us to 
set the caption, icon and destination Cart Number for the Jump Button 
we are adding.

6. First type in the title for the Jump Button in the Caption section. 
7. Next, select an icon for the Jump Button using the Icon drop down list. 
8. Finally, set the target Cart Number that you want to jump to using the 

Jump To option.
9. Then click on the OK button.
10.The new Personal Jump Button will then be added to the More Jumps 

window.

11.Finally, click on the (X) icon at the top of the More Jumps window to 
close it and return to the main Audio Wall.
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Editing an Existing Personal Jump Button

As with adding a Personal Jump Button, the procedure is the same as editing 
a Local Jump Button. The process is outlined below:

1. Make sure you are logged in as a User with sufficient User Rights to 
alter the Personal Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Properties button for the Local Jump Button that you wish 

to edit.

4. Use the Jump Button Properties windows to make the alterations that 
you need to.

5. Click on the OK button to save the changes to the Jump Buttons 
properties.

6. Close the More Jump Buttons window by clicking on the (X) in the top 
right of the window.
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Removing an Existing Personal Jump Button

Once again, the procedure here is the same as for Local Jump Buttons and is 
outlined below:

1. Make sure you are logged in as a User with sufficient User Rights to 
alter the Personal Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Delete Jump Button icon for the Local Jump Button that 

you wish to delete.

4. You will then be asked to confirm that you wish to delete the Personal
Jump Button. Click on Yes if you do and No if you don’t.
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5. The Personal Jump Button is then removed from the Personal Jumps 
section. Click on the (X) to close the More Jumps window and return 
back to the Audio Wall.

CAUTION: As with most areas in Myriad, once a Personal Jump Button has 
been deleted, it cannot be recovered so please use this facility with caution.

Shared Jumps

As with Personal Jumps, Shared Jumps share many common procedures 
with Local Jumps. The principle difference is that whereas Local Jumps are 
for each individual workstation and Personal Jumps are for a specific User, 
Shared Jumps are available to all Users on all workstations across your 
Myriad system.

Adding Shared Jump Buttons

If you have sufficient User Access Rights, you can add additional Shared 
Jump Buttons to provide you with shortcuts to specific Cart Numbers on the 
Audio Wall. The procedure is outlined below:

1. Ensure you are logged in as a User with sufficient User Access Rights 
to add Shared Jump Buttons.

2. Click on the More button located to the right of the Local Jump Buttons.
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3. This will open the More Jumps Window which is used to access and 
configure Local, Personal and Shared Jump Buttons. In this case we 
are adding a new Shared Jump Button so we are concerned with the 
bottom section.

4. Click on the Add (+) button in the Shared Jumps section.

5. This will open the Jump Button Properties window which allows us to 
set the caption, icon and destination Cart Number for the Jump Button 
we are adding.
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6. First type in the title for the Jump Button in the Caption section. 
7. Next, select an icon for the Jump Button using the Icon drop down list. 
8. Finally, set the target Cart Number that you want to jump to using the 

Jump To option.
9. Then click on the OK button.
10.The new Shared Jump Button will then be added to the More Jumps 

window.

11.Finally, click on the (X) icon at the top of the More Jumps window to 
close it and return to the main Audio Wall.

Editing an Existing Shared Jump Button

As with adding a Shared Jump Button, the procedure is the same as editing a 
Local Jump Button. The process is outlined below:

1. Make sure you are logged in as a User with sufficient User Rights to 
alter the Shared Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Properties button for the Local Jump Button that you wish 

to edit.
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4. Use the Jump Button Properties windows to make the alterations that 
you need to.

5. Click on the OK button to save the changes to the Jump Buttons 
properties.

6. Close the More Jump Buttons window by clicking on the (X) in the top 
right of the window.

Removing an Existing Personal Jump Button

Once again, the procedure here is the same as for Local Jump Buttons and is 
outlined below:
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1. Make sure you are logged in as a User with sufficient User Rights to 
alter the Shared Jump Buttons.

2. Click on the More button (to the right of the Local Jump Buttons).
3. Click on the Delete Jump Button icon for the Local Jump Button that 

you wish to delete.

4. You will then be asked to confirm that you wish to delete the Shared
Jump Button. Click on Yes if you do and No if you don’t.

5. The Shared Jump Button is then removed from the Shared Jumps 
section. Click on the (X) to close the More Jumps window and return 
back to the Audio Wall.

CAUTION: As with most areas in Myriad, once a Shared Jump Button has 
been deleted, it cannot be recovered so please use this facility with caution.
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The Record Cart Player

The Record Cart Player is a special Cart Player that is used to record ‘real 
time’ audio into Carts on the Audio Wall. Unlike previous versions, Myriad v3 
displays the Record Cart Player at all times (under most circumstances) to 
offer a fast and simple way of recording audio into the system via the selected 
soundcard audio input channel.

The exception to this is when you are logged in as a User that does not have 
the necessary access rights to record or edit Carts on the Audio Wall in which 
case the Record Cart Player is not displayed.

The great thing about the Record Cart Player is that you can continue to use 
Myriad normally while it is recording so you can set it to record a segment of 
your show and then get straight on with presenting without having to worry. 
When you have finished, stop recording and the audio will be instantly 
available across the entire Myriad system.

The Record Cart Player is used whenever audio is recorded in ‘real time’ to 
the Audio Wall unless the audio is recorded directly in to the Audio Edit Area 
of SmoothEdit.

The Record Cart Player General Layout

The diagram below shows the Record Cart Player’s general layout. In this 
example the Record Cart Player is in record mode. The other states are also 
covered below.

Record Cart Player in Recording State

Record Cart Player in Ready State
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Record Cart Player in Waiting for Trigger Level State

Time Recorded

This indicates the total time recorded into the target Cart so far.

Available Time Remaining

This shows an estimate of the total recording time available for the selected 
Cart. Myriad has a maximum recording time per Cart of around 3 hours and 
22 minutes (about 2GB linear audio) which is imposed by Windows™, so 
when you start recording, the Available Time Remaining counts down from 
this time to zero. If you actually have less than 3 hours 22 minutes (or 2GB) of
space left on the folder that the selected section of the Audio Wall resides in,
then this starting time will be reduced accordingly.

VU Bars

The VU Bars show a general indication of the incoming audio level to the 
soundcard channel that the Cart Player is configured to use for recording. The 
lower the VU bars, the lower the level. As the incoming audio level gets 
louder, the VU bars move towards the red zone which possibly indicates that 
the volume is too loud.

The VU Bars are not calibrated and should be used as an indicator only.

Cart Being Recorded Into
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This indicates the Cart Slot Number that is currently being recorded into. If 
you used Quick Record (clicked Start Recording button on Record Cart 
Player) to initiate the recording then this Cart Number will automatically be 
assigned from your personal Edit Range. If you used the right click menu to 
select a Cart specifically to record into then it is this Cart Number that is 
displayed here.

Start / Stop Record Button

The Start / Stop button actually has three distinct states and clicking on the 
button in each of these states has a different effect.

Not Recording

 (not flashing)

Clicking on the button in this state will initiate a Quick Record which will 
automatically assign the next free Cart in the currently logged in User’s 
personal edit range. Whether recording starts straight away or only after the 
incoming audio level reaches a pre-defined volume will depend on the setting 
on the Audio tab of Customise Myriad (see Tools menu).

You can also use the following keyboard shortcuts to start recording.
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 Ctrl + Shift + Insert – Starts recording in the next free Cart in your User 
Edit Range.

 Ctrl + Insert – Starts recording in to the Cart currently highlighted on 
the Audio Wall.

Tip: One of these is usually set up on the customised Myriad keyboard.

Waiting for Trigger Level

(animated button)

If you have customised Myriad to either ‘always use trigger level’ or ‘ask user 
for trigger level’ ( and the User has selected to use trigger level) then the 
Record Cart Player goes into Waiting For Trigger Level mode and the Start / 
Stop button changes to display an animated horizontal VU style bar. In this 
state, as soon as the incoming audio level rises to the pre-configured trigger 
level, the Record Cart Player will automatically start recording and the Record 
Cart Player will switch to recording mode (see below).

If you click on the button when it is in this state, the Record Cart Player will 
start recording immediately and switch to record mode (regardless of trigger 
level).

Recording

 (flashing red light in middle of button)

When the Record Cart Player is recording audio, the Start / Stop Recording 
Button indicates this by flashing the LED icon in the middle of the button.

If you click on the Start / Stop Record button in this state, the Record Cart 
Player stops the current recording and allows you to select whether to keep 
(Yes) or discard (No) the recording.

You can also stop recording by using the following keyboard shortcuts:



244

 Shift + F12 – Stops recording and asks User whether they wish to save 
the recording.

 Ctrl + Shift + F12 – Stops and automatically saves current recording.

If you opt to save the Cart you have been recording, you will then be asked 
whether you wish to jump (Yes) to that Cart or remain where you are (No) on 
the Audio Wall.

Using the Record Cart Player to Quick Record (Into User Edit 
Range)

The Quick Record feature in Myriad is accessed using the Record Start / Stop 
button on the Record Cart Player and will automatically assign the next free 
Cart Slot Number to record into from the Edit Range for the User logged into 
the system.

This is ideal if you just want to quickly record something but don’t have time to 
find an empty Cart to record into.

To Quick Record, follow these steps:

1. Click on the Start Record button on the Record Cart Player

2. The next free Cart in your User Edit Range will be assigned 
automatically and if your system has been customised to start 
recording automatically then the Record Cart Player will start recording.

3. If you have customised Myriad to use trigger level recording then the 
Record Cart Player will move straight into Waiting for Trigger Level 
status.



245

4. If you have customised Myriad to ask about using trigger level each 
time then you will be asked whether you wish to use trigger level or not.

If you click on Yes then the Record Cart Player will go into Waiting for 
Trigger Level state (see step 3), if you click on No then it will go straight 
into Record mode (see step 2). If you click on Cancel then the 
recording will be abandoned and you will return to the Audio Wall.

5. Once you are recording, you can click on the Start / Stop Recording 
button at any time to stop recording.

Once you have clicked on the Start / Stop Recording button, you will be 
asked whether you wish to save the recording (Yes) or discard it (No).

6. If you opt to save the Cart you have been recording, you will then be 
asked whether you wish to jump (Yes) to that Cart or remain where you 
are (No) on the Audio Wall.
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NB: You can also use the following keyboard shortcuts:

 Ctrl + Shift + Insert – Starts recording in the next free Cart in your User 
Edit Range.

 Shift + F12 – Stops recording and asks User whether they wish to save 
the recording.

 Ctrl + Shift + F12 – Stops and automatically saves current recording.

Recording Into a Specific Cart Slot Number Using the Record Cart 
Player

In the last section we looked at how to use the Record Cart Player to Quick 
Record into your User Edit Range. Now we will look at how to record into a 
specific Cart Number.

If you have already been through the Manual Recording Methods section then 
you should be familiar with this process. Basically, there are two ways to 
make Myriad record into a specific Cart Slot Number using the Record Cart 
Player, they are both outlined below:

1. Ensure you are logged on as a User with sufficient rights to record into 
the Cart you want to use.

2. Right click on the Cart you want to record into and select ‘Record Into 
This Cart’.
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3. If you have customised Myriad not to use a trigger level then the 
Record Cart Player will go straight into record mode.

4. If you have customised Myriad to use trigger level recording then the 
Record Cart Player will move straight into Waiting For Trigger Level 
status.
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5. If you have customised Myriad to ask about using trigger level each 
time then you will be asked whether you wish to use trigger level or not.

If you click on Yes then the Record Cart Player will go in to Waiting For 
Trigger Level state (see step 4), if you click on No then it will go straight 
into Record mode (see step 3). If you click on Cancel then the 
recording will be abandoned and you will return to the Audio Wall.

6. Once you are recording, you can click on the Start / Stop Recording 
button at any time to stop recording.

Once you have clicked on the Start / Stop Recording button, you will be 
asked whether you wish to save the recording (Yes) or discard it (No).

7. If you opt to save the Cart you have been recording, you will then be 
asked whether you wish to jump (Yes) to that Cart or remain where you 
are (No) on the Audio Wall.
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NB: As ever, the Record Cart Player keyboard shortcuts are available 
throughout this process:

 Ctrl + Shift + Insert – Starts recording in the next free Cart in your User 
Edit Range.

 Ctrl + Insert – Starts recording into the currently highlighted Cart on the 
Audio Wall.

 Shift + F12 – Stops recording and asks User whether they wish to save 
the recording.

 Ctrl + Shift + F12 – Stops and automatically saves current recording.

Remember, you can also use the Audio Edit Area on the SmoothEdit screen 
to record into a specific Cart. For more details on this procedure, please 
check the ‘Manual Record – Using the Audio Edit Area on the SmoothEdit 
Screen’ section in this Chapter and the SmoothEdit Chapter later in the 
manual.

The Cart Players

The Cart Players are used throughout the Myriad product suite whenever 
audio needs to be played by the system. The Cart Players are almost 
certainly the part of Myriad that you will use the most but they are also the 
part of Myriad that you will think about the least. 

The Cart Players have been designed to be fast and simple to use, offering a 
range of features but only displaying the information that is most useful to the 
presenter using them.

The Cart Players used by Myriad and Myriad Manager are different to the Cart 
Players used by AutoTrack and AutoTrack Pro (and Scoop) as the role of Cart 
Players in each application is different. In this section, we will focus on the 
Cart Players that are used in Myriad and Myriad Manager but we will also 
touch on the Cart Players in other products just to give you a little background 
on how they differ.

The Cart Players General Layout

The Cart Players are generally located along the bottom or top of the main 
Myriad screen(s). The screen shots below show the Cart Players location 
when Myriad is configured in a variety of different modes.
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This first screen shot shows Myriad in its most typical configuration which is a 
single screen system running in ‘classic’ Myriad mode. In this configuration, 
the Cart Players are spread across the bottom of the screen (alongside the 
Record Cart Player). The Cart Players remain visible regardless of which 
screen is on display (i.e. which tab on the Main Tab Strip is selected).

This shot shows the same configuration but running on a ‘dual screen’ 
platform. In this case, the Audio Wall, Instant Carts & Database (and 
SmoothEdit but not visible in this example) screens are selectable via the 
Main Tab Strip on the left hand screen. The Log screen is visible on the right 
hand screen and the Cart Players are spread across both screens at the 
bottom.

Tip: In this example, Myriad has been configured to have four Cart Players. 
You can also configure Myriad to have between 1 and 6 Cart Players 
depending on how many soundcard output channels you have available. 
Myriad will automatically configure itself to a suitable number of Cart Players 
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based on how many sound cards it detects when setting up. You can alter this 
using the Settings>Audio Settings menu option.

You can configure Myriad to have multiple Cart Players even if you only have 
a single sound card (as above) but you should keep in mind that in Myriad 
v3.0.x, Myriad will not have the ability to alter the volume for the Cart Players 
independently so ‘Auto Fade’ playout mode and Voice / Segue Links may not 
function correctly. This restriction is removed in Myriad 3.1.x.

In the example below, Myriad has been configured to run in ‘dual screen’ 
mode, but on a PC that only has a single monitor setup. In this configuration, 
the two main screens are displayed side by side on the single monitor and the 
Cart Players are spread across the bottom of the screen.
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Tip: To switch to this mode, use the Settings>Myriad Setting menu 
option, switch to the General Options tab and then tick the ’Display In 
Dual Screen Mode Even When Only On A Single Screen’ option. 
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You will note that whilst Myriad itself can be configured to run in several 
different modes, the Cart Players appear common throughout. This is to 
ensure that presenters can always see the Cart Players and can use them 
regardless of how Myriad is configured. 

So let us now look at the actual layout of the Cart Players themselves.

There are also two additional special states that the Cart Players use to 
display the Intro time at the beginning of a Cart and the Extro at the end of the 
Cart.

When a Cart Player finishes playing a Cart, it always ejects the Cart and 
returns back to the Empty state ready for the next Cart to be played.

Most of these elements will be self explanatory and you may well find that 
most Users will be able to understand and use the Cart Players almost 
instinctively but there are a few less obvious elements so we will go through 
them all in turn.
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Title & Artist 

The Title & Artist sections on the Cart Players display the Title and Artist (or 
description lines 1 & 2 for Carts that are not songs) for the Cart that is playing.

The size of the Artist & Title text and the amount of text displayed is 
automatically set by Myriad to be as large as possible given the amount of 
Cart Players that you have requested and the resolution that your video 
output is set to. 

End Type

The End Type indicator shows the currently set End Type for the Cart being 
played. This End Type is set using the SmoothEdit screen and can be set to 
one of the following options:

 Ends (E) – The Cart comes to an abrupt end.
 Fades (F) – The Cart fades out at the end.
 Sustain (S) – The Cart’s ending is sustained for a period at the end.
 Slow Fade (SF) – The Cart fades out over a longer period at the end.
 Not Specific (blank) – The ending has not been specified.

The End Type is used to let the presenter know how a Cart is going to end but 
it also used by Myriad to determine which Songs in an Auto Fade hour can be 
faded early in order to hit time critical markers (Absolute Times). This will be 
covered in greater detail in the Log Screen Chapter but the following basic 
rules apply.

Ends – Cannot be faded early.
Fades – Can be faded early.
Sustain – Cannot be faded early.
Slow Fade – Can be faded early.
Not Specific – Cannot be faded early.

Count Up

As you would expect, the Count Up displays a count of the time played of the 
Cart so far, counting up towards the end of the Cart.

Count Down
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This provides a countdown of the time remaining to the end of the Cart that is 
playing. More accurately it actually counts down to the Extro point if one has 
been set and the end of the audio file if one has not been set.

Intro Count Down

This special case counter is only visible at the beginning of Carts that have an 
Intro period set. When you cue a Cart that has an Intro, this box appears 
instead of the standard Count Up / Count Down timers. When you click on 
Play to start playback, the Intro Count Down counts down the seconds to the 
end of the Intro period.

One easy way of telling the difference between the Intro Count Down and the
Extro Count Down (see below) is that the Intro Count Down is in a square box 
and the Extro Count Down is displayed in a circle.

Extro Count Down

Like the Intro Count Down, the Extro Count Down replaces the standard 
Count Up / Count Down timers but unlike the Intro Count Down, the Extro 
Count Down is displayed when playing the last ten seconds of all Carts 
played. Under normal conditions, the Extro Count Down will display the last 
ten seconds before the Extro but if no Extro has been set then the Extro 
Count Down will count down the final ten seconds of the audio file.

The Extro Count Down always appears in a circular graphic.

VU Bars

The VU bars provide a simple visual representation of the audio output of the 
Cart Player. The VU Bars are not calibrated and simply display a value 
between 1 – 100% of the overall scale output of the sound card.

Overall Progress Bar

In normal operation, the Overall Progress Bar offers a visual representation of 
where the current playback position is in relation to the overall length of the 
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Cart (to the Extro point). The bar slowly fills as the Cart plays, when it is full, 
that is the Extro (or end) of the Cart.

Carts that have an Intro period set will behave slightly differently. When a Cart 
that has an Intro set is played, the Overall Progress Bar is green to begin with 
and fills rapidly during the Intro such that the bar is full at the Intro end point. It 
then drops back to display the overall position of the Cart, and continues to fill 
at a normal pace towards the end of the Cart. Ten seconds from the Extro 
point, the Overall Progress Bar turns yellow to indicate the Extro is 
approaching. Five seconds from the Extro, the Overall Progress Bar turns red 
to warn you that there are only a few seconds left on the Cart. The screen 
shots below show the Overall Progress Bar in all its states.

Intro Progress Bar

Overall Progress Bar

10 Seconds from Extro the Overall Progress bar Turns Yellow

5 Seconds from Extro the Overall Progress bar Turns Red
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Using the Main Progress Bar to ‘Skip’ Through a Cart

You can use the Main Progress Bar to skip ahead or backwards through the 
Cart by right clicking on the Main Progress Bar and ‘dragging’ the playback 
point left or right.

NB: This feature has been included for Myriad v2 users but the need for it has 
been largely replaced by the Jog Bar (see below).

The Jog Bar

The Jog Bar is used to skip forward or backwards around the Cart that is 
playing. To use this feature, use the left mouse button to click and drag the 
Jog button left or right. As you drag the Jog Button left and right, the audio will 
jump forwards or backwards accordingly.

Play

The Play button is used to start playback. The Play button is only available 
when a Cart is cued or paused.

Pause

The pause button stops playback from the Cart Player but leaves the play 
position in the same place. The Pause button is only enabled when a Cart 
Player is actually playing audio.

Recue

The Recue button is used to pause playback and rewind to the very start of 
the Cart i.e. to recue it ready to play from the beginning again. The Recue 
button is only enabled when the Cart Player is playing.
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Eject 

The Eject button is used to stop playback and remove the Cart from the Cart 
Player. The Eject button can be customised in two different ways. You can 
either have the Eject button both stop playback and eject immediately (hard 
eject) or you can customise the Eject button to fade out the audio over a 
second or so and then eject the Cart (soft eject).

In addition, you can customise the system to work differently depending on 
whether the User used the keyboard or the mouse to trigger the eject. This 
means that you could customise the keyboard to do a hard eject and the 
mouse to do a soft eject, giving the presenter both options.

To alter these customise options, use the Customise Myriad option on the 
Tools menu, switch to the Audio (vertical) tab and the Playback / Recording 
(horizontal) tab.

In this screen, you can also customise whether you want Myriad to be able to 
Eject Carts while they are playing or whether you wish the User to have to 
Pause or Recue the Cart first (like some CD players).

As both of these options are Customise options, they are personal to the User
logged in, so different presenters can set them in different ways to suit their 
preferences.
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Display Info

The Display Info icon is only displayed when the Cart Player is playing a Cart 
that has some additional text notes available (see The SmoothEdit Screen for 
more details).

To view the text notes, click on the Display Info icon to open the Cart 
Information window which displays a summary of the Cart information 
including the Title & Artists, the timing information and the additional 
information for the Cart provided by your scheduling system (see The
Database Screen). In addition, the Cart Information displays any text Notes 
that have been added to the Cart.
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There are three different types of Notes in Myriad:

 Show Notes – designed for use by the presenter.
 DAB Notes – designed to be passed on to a DAB (digital radio) 

transmitter.
 Web Notes – designed to be passed on to OCP (Online Content 

Processor) to be displayed on your web site.

The Cart Information window allows you to switch between these notes by 
clicking on the appropriate Notes button (as seen in the picture above).

Please note that Notes buttons are only displayed when Notes of that specific 
type have been added to the Cart. If no Notes buttons are displayed then 
there are no Notes associated with that Cart.

Cart Number

This displays the Cart Slot Number of the Cart that is currently loaded or 
playing in the Cart Player.

Super Sweep 

The Super Sweep button is used to manually set up Myriad to automatically 
‘sweep’ one Cart in to the beginning of another. Before we look at how this
works, it would be a good idea to clarify what we mean by ‘sweeping’:

What Is A Sweeper And How Are They Handled By Myriad?

When we talk about ‘sweeping’ a Cart what we actually mean is to play it over 
the Intro of another Cart such that it can be heard over the top.

You can probably think of many times when you have heard a radio DJ talk 
over the beginning section of a song and sometimes they will time their voice 
link so that it ends just as the lyrics kick in for the song. When we talk about 
sweeping in Myriad we are talking about basically the same process but 
instead of a presenter talking live, Myriad plays one Cart over the beginning 
(Intro) of another Cart following the rules you have used for sweepers when 
configuring Myriad. There are basically three different ways of sweeping one 
Cart into another.



261

In this mode, Myriad will start the main Cart (usually the Song) and then start 
the sweeper cart (usually a dry voice link or dry jingle – i.e. no music) such 
that the end of the sweeper cart will coincide exactly with the end of the Intro 
on the main Cart.

NB: In this mode, if the sweeper Cart is longer than the length of the Intro on 
the main Cart then the sweeper Cart is played first and the main Cart is 
automatically started at the appropriate time in order for the end of the 
sweeper Cart and the Intro on the main Cart to coincide.

In this mode, Myriad will start both the sweeper Cart and the main Cart at 
exactly the same time such that the sweeper Cart plays along with the start of 
the main Cart but the end of the sweeper Cart may be before the end of the 
Intro on the main Cart. 

NB: In this mode, the end of the sweeper Cart will not occur after the end of 
the Intro of the main Cart. If the length of the sweeper Cart is greater then the 
length of the Intro on the main Cart then the sweeper will be played using the 
‘dry’ method outlined below.

In this final method, Myriad makes no attempt to play the sweeper Cart over 
the top of the Intro of the main Cart but rather plays the sweeper and then 
automatically goes on to the beginning of the main Cart.

In all of these modes, Myriad will automatically ‘duck’ the playback volume of 
the main Cart while the sweeper Cart is playing so that the sweeper Cart can 
be heard over the Intro of the main Cart. The level that the main Cart is 
ducked to is configurable using the Playback Setting tab on the 
Settings>Audio Setting menu option.
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You can also configure Myriad to not ‘duck’ the audio of the main Cart when 
playing a sweeper but rather to play back all audio at one volume (usually you 
would set this to a lower level such as 80%), but play sweepers and voice link 
at a higher level (usually 100%) and let the station processing handle the rest. 
Use the configuration screen above to select the method and settings that you 
feel will work best for you.

The default for Myriad is for it to try and Sweep To Intro End at all times but it 
will select an alternate method if the timing of the sweeper Cart is not 
compatible with the Intro length. In this situation, Super Sweep has the ability 
to play the sweeper ‘dry’. You can however, change the default sweeper 
method Myriad uses by using the Settings>Database Setting menu option and 
selecting the General tab. You can then use the Sweeper Style drop down list
to select the sweeper style that you wish to use.
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Using Super Sweep

Using Super Sweep manually is a very simple process. Use the guide below 
to set up your first manual Super Sweep.

1. First, cue up the Song that you want to use (It is not important how long 
the Intro is on the Song, Myriad will automatically select the sweeper 
method best suited to the song / sweeper Cart combination). 

2. Cue the sweeper Cart in an alternate Cart Player so that you have both 
elements of the sweep cued and ready to go (see screen shot).
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3. IMPORTANT – This is the most important stage. Click on the Super 
Sweep button on the Cart Player that the sweeper Cart is in, not the 
Cart Player that the main Cart is in.

4. Myriad will then automatically link the two Cart Players. This is 
indicated by the SS buttons being displayed in red.
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5. If more than one or two Cart Players have Carts cued in them then you 
will be given the option to chose which main Cart you want the 
sweeper Cart swept in to.

6. Once linked, simply press play on either Cart Player and Myriad will 
automatically start the correct Cart Player to play the sweeper using 
the most appropriate sweeper mode.

7. If you need to cancel a Super Sweep, click on the SS button on either 
of the linked Cart Players and the Super Sweep is cancelled.

When you are running on Live Assist, Auto or AutoFade Playout Mode using 
the Log Screen, items in the Log can be set to automatically sweep into the 
next item. These can be manually added by Users or scheduled using the 
music scheduling system (like AutoTrack Pro). Items that will be swept into 
the next item have a yellow Segue Type indicator. 

For more details, check out Segue Type in Chapter 1 or the Log Screen 
Chapter.

Cart Player Number

The Cart Player Number displays the number of the Cart Player that you are 
using. These will normally correspond to specific channels on your studio 
mixing desk.

Cart Player Right Click Menu

You can also right click on a Cart Player to get a range of options.
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The options are:

 Add The Cart To The Pad – Adds the Cart in the Cart Player to the 
Pad (see The Pad).

 Jump To This Cart On The Audio Wall – Will jump to the Cart on the 
Audio Wall.

 Display This Carts Information – Will display the Cart details window 
which provides a summary of all the information available about the 
Cart.

 Send This Carts Information To OCP – This option will only be 
available when Myriad is configured to work with OCP. Selecting this 
option will send the Carts details to OCP as the currently playing item. 
OCP can then use this information to update a range of digital 
platforms including web sites and DAB radios.

Cart Number

The Cart Number display on the Audio Wall screen shows the Cart Slot 
Number for the Cart currently highlighted (the Cart with the red box around it 
on the Audio Wall).
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If you click on the Cart Number box, the Jump To Cart window appears which 
allows you to type in a specific Cart Slot Number to jump to.

To use this window, type in the Cart Slot Number that you want to jump to and 
then click OK.

You can also find the next empty Cart Slot by clicking on the Next Empty Cart 
button.
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For more details, see the Jump To Cart section in this Chapter.

Page Up / Down

The Page Up / Page Down buttons on the Audio Wall scroll forwards or 
backwards through the Audio Wall a page at a time. The amount of Carts on a 
single page is determined by the size you have set the Carts to and the
resolution you have set your PC to run at.

You can also use the Page Up / Down on the Audio Wall by pressing the 
Page Up / Down keys on the keyboard or you may have dedicated Audio Wall 
Page Up / Down keys on your custom Myriad Keyboard.

Edit Cart – See SmoothEdit Screen for Details

The Edit Cart button on the Main Tab Strip is used to open the currently 
highlighted Cart on the Audio Wall using the SmoothEdit screen. This allows 
you to add and edit the Cart details such as Title, Artist and Timing 
information as well as additional information such as Copyright details, Notes 
and accompanying pictures.

You can also use the SmoothEdit screen to alter and edit the audio for a Cart 
as well as record new audio.
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The SmoothEdit Screen is covered in brief in Chapter 1 (see SmoothEdit 
Screen) and in more detail in the SmoothEdit Screen Chapter later on. For 
details on how to use the SmoothEdit screen to alter and edit Carts, please 
refer to the SmoothEdit Screen Chapter.

Myriad can also be customised to not automatically load the audio wave form 
when you click on the Edit Cart button. This is done by clicking on the 
Tools>Customise Myriad menu option, then the Audio vertical tab and finally 
the Playback/Recording horizontal tab. Then toggle the Open The Audio File 
For Editing Immediately option on and off depending on whether you want 
Myriad to automatically open the audio wave form when you click on the Edit 
Cart button.
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If this option is turned off then the SmoothEdit screen will load all the general 
Cart information such as Title, Artist, Notes etc but will not automatically load 
the audio wave form. This may be useful as loading the audio wave form can 
take several seconds for larger files.

When SmoothEdit is in this mode, you can load the audio wave form at any 
time by clicking on the wave form icon in the Audio Wave Form Edit Area.

You can also access the SmoothEdit screen by right clicking on a Cart on the 
Audio Wall and then selecting one of the Edit Cart options from the right click 
menu.
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If you select Edit Cart Audio & Details Using SmoothEdit then the Cart details 
and audio are loaded into the SmoothEdit screen. 
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If you select the Edit Carts Details Using SmoothEdit option then the Cart 
details are loaded into the SmoothEdit screen but the audio wave form is not 
automatically loaded which can save time if you do not actually need to view 
or edit the audio wave form.

You can also open the SmoothEdit screen by pressing the <Insert> button on 
the keyboard or you may have a specific Edit Cart button on your custom 
Myriad keyboard.

Move Cart

The Move button on the Main Tab on the Audio Wall screen opens the Move / 
Copy Cart window which is used to move or copy a single Cart to another 
Cart Slot on the Audio Wall.

The Move / Copy Cart window is very simple to use. Highlight the Cart on the 
Audio Wall that you want to move or copy to another Cart Slot and then click 
on the Move Cart button on the Main Tab Strip. This will open the Move / 
Copy window.

The Move Copy Window General Layout
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Original Cart Preview

The Original Cart Preview section shows a visual representation of the Cart 
that you are intending to move or copy. This allows you to check to make sure 
it is the right Cart.

Cart to Be Moved / Copied

This shows the Cart Slot Number for the Cart that will moved or copied. When 
you highlight a Cart and then click on the Move  button on the Main Tab Strip, 
this field is automatically populated with the Cart Slot Number that was 
highlighted (or the Cart you right clicked on if you have accessed the Move / 
Copy option via the right click menu).

You can manually type in an alternate Cart Slot Number if you wish to move 
or copy a different Cart.

Select Move / Copy

This option is key as it allows you to select whether to move the selected Cart 
(i.e. move the original to a new destination leaving the original Cart Slot 
empty) or to make a copy of the selected Cart leaving the original in place.
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To use this option, simply click to toggle between the two settings. You can 
also use <Alt> + <M> to select Move and <Alt> + <C> to select Copy.

NB: Be careful when you move Carts on the Audio Wall. You should keep in 
mind that moving a Cart on the Audio Wall may affect your advert or music 
scheduling system. Let’s say you have a Fat Boy Slim track at Cart Slot 5000 
but you decide to move it to Cart Slot 6000. Unless you tell your scheduling 
system that you have moved the Cart, it will still schedule Cart 5000 to be 
played, expecting Fat Boy Slim to still be there. This may result in Carts being 
scheduled to play that do in fact not have any audio or a totally different Song 
recorded into that Cart.

If you are using AutoTrack or AutoTrack Pro then Myriad will check on the 
Database Screen to see if the Cart you are moving is listed as either a Song 
or a Link and if it finds the Cart listed, it will prompt you before it actually 
moves the Cart.

If you click on Yes then the Cart will be moved regardless. If you click on No 
then the Move will be abandoned. If you are using AutoTrack or AutoTrack 
Pro then the Move / Copy Carts facilities within either product will allow you to 
move Carts around on the Audio Wall whilst maintaining the link to the Carts 
in the music and link databases.

Destination Cart Preview

The Destination Cart Preview shows a visual representation of the destination 
Cart Slot that the original Cart will be moved or copied to. If the destination 
Cart is empty then no Cart will be displayed in the Destination Cart Preview.
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If however, the Cart is occupied then the Cart details are displayed.

In this situation, if you click on the OK button, you are presented with a range 
of options as to how to deal with the conflict.

 Yes – If you click on Yes then the Cart in the Destination slot will be 
overwritten by the Cart you are moving. The audio and data currently in 
the destination Cart will be discarded and you will not be able to 
recover them.

 No – If you select No then the two Carts will swap positions so the Cart 
currently in the Destination Cart Slot will be moved to the Original Cart 
Slot and vice versa.
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 Cancel – Clicking on the Cancel option will abandon the Move / Copy 
and return you to the Audio Wall.

Destination Cart Slot Number

The Destination Cart Slot number allows you to type in the Cart Slot Number 
that you want the original Cart copied or moved to. By default, this will be 
empty when the Move / Copy window first opens.

As you type in the Destination Cart Slot Number, the Destination Cart Preview 
will automatically update to show you the Cart (if any) that is already in the 
Destination Cart Slot.

Scan for Next Empty Cart 

The Scan for Next Empty Cart button is used to automatically find the next 
empty (or free) Cart Slot on from the Cart Slot Number currently typed into the 
Destination Cart Slot Number. It is probably easier to explain this by example:

In the above example, the Destination Cart is set to 3007 but we can see from 
the Destination Cart Preview that Cart Slot 3007 is occupied (by Shakira). If 
we clicked on the Scan for Next Empty Cart button, Myriad would scan 
forward from Cart Slot 3007 on the Audio Wall looking for the next Cart Slot 
that is empty.
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In this particular case, the next free Cart Slot was at Cart 3099. The 
Destination Cart Slot Number is automatically updated with this Cart Number. 
We can now click on OK to proceed with our Move / Copy.

In this example, the Destination Cart Slot Number field is empty so if we 
clicked on the Scan for Next Empty Cart button, Myriad would start at Cart 1 
(the beginning of the Audio Wall) and find the first empty Cart it came across.
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OK / Cancel

Once you have set up the Move / Copy window to do what you want, click on 
the OK button to start the Move / Copy.

If you click on the Cancel button then the Move / Copy window will close and 
you will be returned back to the Audio Wall.

Mass Moving & Copying

The Move / Copy window in Myriad can only be used to Move or Copy a 
single Cart from one Cart Slot to another. This is ideal for occasional use in 
the studio but if you want to move or copy several Carts then you would be 
better off using the Mass Move / Copy facilities found in Myriad Manager or 
AutoTrack / AutoTrack Pro. 

Myriad Manager provides a range of administrative tools and reports to help 
you manage and get the most from your Myriad system. If you are using 
either AutoTrack or AutoTrack Pro for scheduling music and links then many 
of the administrative features found in Myriad Manager are also carried over 
into AutoTrack and AutoTrack Pro. The key difference is that if you used 
Myriad Manager to mass move a number of Carts, you would still have to go 
into the corresponding Songs / Links in AutoTrack or AutoTrack Pro and 
update them with the new Cart locations. If you used AutoTrack or AutoTrack 
Pro to mass move those same Carts then it would not only move them in 
Myriad but also update the Song / Link databases at the same time, saving 
you loads of extra work. If you are using a 3rd party scheduling system (such 
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as Selector™) then you will have no choice but to use the Mass Move 
features in Myriad Manager and then manually update the corresponding 
Songs / Links in your music database.

In this next section, we will briefly look at how to mass Move / Copy Carts in 
Myriad Manager and AutoTrack / AutoTrack Pro but as both of these 
procedures are covered in more detail in the corresponding product 
documentation, we will only look at the overall processes.

Mass Move / Copy Carts Using Myriad Manager

In this section, we will briefly look at the procedure for Mass Moving / Copying 
Carts using the Myriad Manager. Please note that this is covered in more 
detail in the Myriad Manager documentation.

1. Start Myriad Manager and log in with a user name and password with 
an appropriate level of security.

2. Expand the Cart Reports section if it is not already expanded.
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3. Highlight the Run Custom Cart Report option and then click on the 
Open button. You can also double click on the Run Custom Cart 
Report option if you prefer.

4. The Cart Report Options window will open (this can take a second to 
pop up). This allows you to set a whole range of different criteria to 
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allow you to restrict the Carts displayed in the Cart Report Results 
window.

If you wish to add any of these criteria, feel free. If not, click on the OK 
button to get a full list of all of the Carts on your Audio Wall. (Please 
note that these options are covered in more detail in the Myriad 
Manager Manual).

5. The Cart Report Results window shows a list of Carts on your Audio 
Wall that match the set criteria. If you just clicked OK on the previous 
screen this will be a full list of all of the Carts on your Audio Wall.
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This is the standard Cart Report Result window which is used in many 
different places within the Myriad suite of products as well as 
AutoTrack Pro and Scoop. You can use this window to restrict the 
Carts displayed by Range, Title / Artist and a whole range of other 
criteria but for this example, we will assume that we are interested in 
Move / Copying the first five Carts on the Audio Wall.

6. Hold down the <Ctrl> key on the keyboard and then click on the Carts 
that you want to Move or Copy (you could also use the mouse to select 
them or the <Shift> key – standard Windows techniques).

7. Next use the Edit  button drop down menu to select either Move 
The Selected Carts or Copy The Selected Carts.

In this example, we will assume we want to Copy the Carts but moving 
works in virtually the same way.
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NB: You will see that you have a range of other options on this menu. 
We will not go through them here but this is a very useful tool to know 
about.

8. Next you will be asked to type in the Cart Slot Number that you want 
the first Cart to be Moved / Copied to. In this example, let’s say that we 
want to copy the selected Carts to Cart Slot 100 onwards.

9. Next you will be asked to confirm your action.

10.You will then be asked to handle any Carts Slots that already contain 
Carts. Your options are outlined below.

o Yes – If you click on Yes then the Cart in the Destination slot will 
be overwritten by the Cart you are moving. The audio and data 
currently in the destination Cart will be discarded and you will 
not be able to recover them.

o No – If you select No then the two Carts will swap positions so 
the Cart currently in the Destination Cart Slot will be moved to 
the Original Cart Slot and vice versa.

o Cancel – Clicking on the Cancel option will abandon the Move / 
Copy and return you back to the Audio Wall.
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11.Decide on what option is best and click as appropriate. You will then 
see a progress bar displayed along the bottom of the Cart report 
Results window which shows the progress of the move / copy process.

Once the process has finished, a summary will be displayed to show 
how many Carts were moved or copied.

Keep in mind that if you move Carts that are referenced in external programs 
such as your music or advert scheduling systems, if you move Carts in Myriad 
you will need to update these records accordingly. If you are using AutoTrack 
or AutoTrack Pro then you can mass move / copy Carts from within the 
scheduler which will prevent this problem from happening.

Mass Move / Copy Using AutoTrack Or AutoTrack Pro 

Now we will look at how to Mass Move / Copy Carts using AutoTrack or 
AutoTrack Pro. In this example we are using AutoTrack Pro but the procedure 
is the same in both (although more options are available to AutoTrack Pro 
users).
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1. Start AutoTrack Pro in the normal way and login with a suitable 
username and password if needed.

2. Click on the Carts>Audio Browser menu option to open the Audio 
Browser (the Audio Wall in Myriad terminology).

3. Ensure the Audio Browser is in list mode by clicking the List Mode 
button (circled section below), then click on the Search button (see the 
arrow below) to list all the Carts on the Audio Wall. 

NB: You can also restrict the Carts displayed by range, title and a whole 
host of other criteria should you wish.
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4. This will then display the Carts on the Audio Wall in a list format.
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5. Just as before, hold down the <Alt> key and then click on the Carts that 
you want to mass move or copy. You can also use the <Shift> + cursor 
keys or left mouse button to select multiple Carts (using standard 
Windows methods).

6. Once you have selected the Carts you want to mass move / copy, click 
on the Edit drop down menu and select either Mass Move Selected 
Carts or Mass Copy Selected Carts.

In this example, we have selected some different Carts (10 – 14) and 
we will Mass Move them to another place on the Audio Wall.

7. Next we need to type in the destination Cart Slot Number for the first 
Cart to be moved. We will use Cart Slot 150 in this example.



288

8. You will then be asked to confirm the action. As we are doing this in 
AutoTrack or AutoTrack Pro, it also confirms that the Song or Link 
Record Cards will also be automatically updated as part of the move 
process.

Click on Yes to proceed.

9. You will then be asked to handle any Cart Slots that already contain 
Carts. Your options are outlined below.

o Yes – If you click on Yes then the Cart in the Destination will be 
overwritten by the Cart you are moving. The audio and data 
currently in the destination Cart will be discarded and you will 
not be able to recover them.

o No – If you select No then the two Carts will swap positions so 
the Cart currently in the Destination Cart Slot will be moved to 
the Original Cart Slot and vice versa.

o Cancel – Clicking on the Cancel option will abandon the Move / 
Copy and return you back to the Audio Wall.
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10.Decide on the option best for you and click as appropriate. You will 
then see a progress bar displayed along the bottom of the Cart report 
Results window which shows the progress of the move / copy process.

11.Once the process has finished, a summary will be displayed to show 
how many Carts were moved or copied.

Moving Carts Using Drag And Drop

You can customise Myriad to allow users to move Carts around on the Audio 
Wall using standard windows drag and drop. To turn on this option, go to the 
Tools>Customise Myriad menu option and select Audio from the vertical tab 
and Navigation on the horizontal tab. You can then toggle the Allow Carts To 
Be Moved By Drag And Drop option on and off as appropriate.

As with all Customise options, this is set on a per user basis and is linked the 
person logged into Myriad at the time the setting is altered.

Once enabled, you can move a Cart very simply by click and holding the left 
button on your mouse, dragging the cursor to the Cart Slot you want to move 
the Cart to and then releasing the left mouse button.

This option is not normally recommended for use in ‘live studio’ situations but 
as it is a customise option; users can set it to their personal preference.
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Jump to Cart

The Jump to Cart button on the Main Tab Strip on the Audio Wall is used to 
access the Jump to Cart window which in turn is used to jump to a highlighted 
Cart on the Audio Wall to a specific Cart Slot Number. 

You can actually access the Jump to Cart window from two places on the 
Audio Wall. You can either click on the Jump to Cart button or you can click 
on the Cart Number section on the Main Tab Strip.

Either way, the Jump to Cart window appears to allow you to enter the Cart 
Slot Number you want to ‘jump’ to.

You can also access the Jump to Cart window by pressing the <Ctrl> + <J> 
keys on the keyboard and some custom Myriad Keyboards may also have a 
dedicated Jump to Cart button.

The Jump to Cart Window General Layout

The Jump to Cart window works a bit like a number pad on a telephone or a 
computer keyboard. You type in the Cart Slot Number that you want to jump 
to by either clicking on the on screen number pad with the left mouse button, 
or by typing the number in directly using the number keys on your keyboard.
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Jump to Cart Slot Number

This section displays the Cart Slot Number that you would jump to if you 
clicked on OK. As you type in the Cart Slot Number (using the keyboard or on 
screen keypad) this section updates accordingly.

Cart Slot Preview

This section displays a visual representation of the Cart that occupies the Cart 
Slot Number that you are going to jump to. This allows you to see whether it is 
the right Cart prior jumping to it.

TIP: You can actually use the left mouse button to drag a Cart from the Cart 
Slot Preview directly into a Cart Player or the Log Screen.

Delete

The Delete button on the Jump to Cart window performs the same function as 
the <BACKSPACE> key on the keyboard and allows you to delete numbers 
when you are using the on screen key pad to type in the Cart Slot Number 
that you want to jump to.

Number Pad

The Number Pad is used to type in the Cart Slot Number that you want to 
Jump to without having to use a keyboard. You can use the left mouse button 
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click on the number buttons to ‘dial’ in the Cart Slot Number you wish to jump 
to.

OK Button

Once you have typed in the Cart Slot Number that you want to jump to, click 
on the OK button to actually move the highlight to the selected Cart on the 
Audio Wall and to close the Jump to Cart window.

Find Next Empty Cart

The Find Next Empty Cart button will scan the Audio Wall starting from the 
Cart Slot Number currently displayed in the Jump to Cart Slot Number section 
and locating the next empty Cart on the Audio Wall.

If there is no Cart Slot Number typed in then it will locate the first empty Cart 
Slot on the Audio Wall.

Cancel

Clicking on the Cancel button will close the Jump to Cart window and return 
you back to the Audio Wall with the last Cart you were working with still 
highlighted.
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The Home Button

The Home button is used as a shortcut to the personal Home area for the 
User logged into Myriad at the time.

Each Myriad User can be given their own Username and Password and they 
can use this to customise Myriad (to a certain extent) to their personal tastes. 
Part of this is assigning a ‘personal edit’ area on the Audio Wall that is used 
whenever they perform a Quick Record (see Record Cart Player). 

The Home button provides a constant, fast route back to this area whenever 
the Audio Wall is on display. Clicking on the Home button will move the Audio 
Wall highlighted Cart to the first Cart in the logged in Users personal edit area.

Find Cart

The Find Cart button on the Main Tab Strip offers access to the extensive 
Find Cart facilities on the Audio Wall. These allow you to search part or all of 
the Audio Wall for Carts that contain certain key words or phrases in the Title, 
Artist or Description fields or in the additional Notes. You can also search for 
Carts of a specific length (give or take a few seconds), or that end in a specific 
way.

The Find Cart window can be toggled on and off using the Find Cart button on 
the Main Tab Strip or using the <Ctrl> + <F> keys on your keyboard. Some 
systems may also have a dedicated Find button on the optional Myriad 
keyboard.
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Once you have added the criteria you want to use to search for a Cart, the 
results are  displayed in the Find Cart Result Window from here you can ‘drag’ 
Carts directly into the Cart Players, Instant Carts, Cart Pad or Log Screen. 
You can also double click on Carts in this list to close the Find Cart window 
and jump to the selected Cart on the Audio Wall.

The Find Cart Screen General Layout

The diagram below shows the Find Cart Screen general layout.

The individual sections of the Find Cart screen are detailed below.

Find Cart Button

The Find Cart button on the Main Tab Strip allows you to toggle the Find Cart 
window on and off. 
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While the Find Cart Window is visible, the Find Cart button remains red to 
indicate that the Find Cart Window is open.

Text to Search For

The Text to Search For box allows you to type in the word or phrase that you 
wish to search the Audio Wall for. You can type in whole or partial words to 
this box but the more specific the text, the more accurate the results will be.

If, for example, you were looking for a song by Madonna, typing Madonna into 
the Search For box and then clicking on the Find button will provide 
reasonably specific results.

If, however, you try searching for ‘Mad’ instead, you would get more varied 
results:
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As you can see, as well as the Madonna tracks, ‘Baggy Trousers’ by Madness 
was also included in the Find Cart Results window.

This facility means that you can search for Carts even if you are unsure of the 
exact spelling or format of the details you are looking for.

You can also use the drop down list on the Search For box to look through the 
recent words or phrases used as search criteria and select one of them to re-
use by either clicking on it or highlighting it with the keyboard and then
pressing <enter>.

You can also select <All Audio> from this list which shows a list of all the 
Carts on your Audio Wall in the Find Cart Results Window. Simply select <All 
Audio> from the drop down list and then click on the Find button to list all the 
Carts.

TIP: You can reorganise the Carts listed in the Find Carts Search Results 
Window by any of the criteria listed in the column headers (along the top of 
the Search Results). This is really useful because you can see a list of all the 
Carts on your Audio Wall sorted alphabetically by Artist, Title or any of the 
other column header criteria. If for example, you wanted to view the Carts 
sorted alphabetically by Artist, select <All Audio> from the drop down list and 
then click on the Find button. Once the results are listed, click on the Artist 
column header to reorganise them alphabetically.
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In all cases, Find Cart will only search for the word or phrase you have 
specified within the Cart fields that you have selected in the Options section. 

General Options

The General Options section allows you set Find Cart to search for your 
specified word or phrase within the additional Notes or Copyright fields on the 
Carts.

If you tick the Search Notes option then as well as searching the standard 
Cart details (i.e. Title, Artist, Description etc – see Text Options), Find Cart will 
also search all of the Cart Notes for each Cart on the Audio Wall looking for 
your specified word or phrase. This has a number of significant advantages, in 
that it widens the criteria you can search with, but may also increase the time 
taken to perform the search.

Text Options

This option allows you to alter the search criteria further by selecting which of 
the main Cart details are included when searching for a specific word or 
phrase. 
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 Search Title – This option allows you to toggle on and off, whether to 
include Carts whose Title matches the word or phrase you are 
searching for.

 Search Artist – This option allows you to toggle on and off, whether to 
include Carts whose Artist matches the word or phrase you are 
searching for.

 Search Description – This option allows you to toggle on and off, 
whether to include Carts whose Description matches the word or 
phrase you are searching for.

 Search For Similar Items – This option toggles Soundex processing 
on and off. See below for more detail on Soundex processing.

By default, all of these options are switched on, as searching all of these fields
at once is extremely fast but you can turn off any options that are not relevant 
to the search you are performing to make the search faster or more specific.

Search for Similar Items – Soundex Processing

The Find Similar Carts option allows you to toggle Soundex processing on 
and off when using the Find Cart facility. Soundex is a mathematical process 
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designed to match similarly spelt words without the need for exact matches to 
the search criteria.  This means that if you miss-spell the word you are 
searching for, you may still find the Cart you want.

In this example, instead of searching for Kylie Minogue we have typed Kylee 
Minogue but because the Find Similar option is ticked, the Find Cart Search 
Results also includes close matches to the spelling and (in this case) the 
Carts we are looking for.

As with all things like this, Soundex is not perfect and can yield surprising 
results sometimes, but it can also be a very useful tool if you are not 
completely sure how to spell the Artist or Title you are looking for.

Exclude Items

The Exclude Items section allows you to add in some additional criteria to 
further reduce the amount of Carts listed in the Find Cart Search Results.
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If you tick any of the options in this section then Carts that meet the selected 
criteria will be excluded from the final results.

 Played Recently – Ticking this option will exclude any Carts from the 
Find Cart Results that have been played ‘recently’. Here ‘recently’ 
refers to the time period you have set as the Recent Play warning 
period for the Audio Wall in general. To view this setting, go to the 
Setting>Myriad Setting menu option and then click on the Audio Wall 
tab. In here you can specify that Carts played within XXhXXmXXs will 
be marked on the Audio Wall as being played recently. Carts that have 
been played within this period will have an explanation icon next to the 
Title & Artist on the Audio Wall to indicate they have been played 
‘recently’. 

The same Carts will be excluded from Find Cart Results if this option is 
ticked in the Find Cart window.

NB: This option will only be visible on the Find Cart window if you have 
configured Myriad to display Carts played recently on the Audio Wall as a 
whole (see Settings>Myriad settings menu and the Audio Wall tab for more 
details).

Time Options

The Time Options section of the Find Cart window allows you to refine your
search criteria using time related factors.

Time Rules

The first option under Time Options is the Time Rules search which allows 
you restrict the Find Cart Results to Carts that fall within a specific duration.
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To use this option, first tick the Time Rules option and then use the Cart 
Length Must Be box to type in the length of the Carts that you are interested 
in. Finally, use the drop down box to select the Plus/Minus to set the accuracy 
that you want to use with the search. Click on the Find button to begin the 
search and list the results.

As with all of these options, you can combine the Time Rules with other 
search criteria for more specific search results.

Ending Rules

The End Rules option in the Time Option section allows you to restrict the 
Find Cart Results to only include Carts that are set as having the specified 
Cart Ending Type.
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To use this option, tick the Ending Rules option and then use the drop down 
list to select the Ending Type that you want to use for this search.

You can use this option in combination with other search criteria for more 
specific Find Cart Results.

Find Button (Start Search)

The Find button is used to begin searching the Audio Wall for the word, 
phrase and criteria as specified in the Find Cart window.  Once you have 
selected the criteria you wish to use, click on the Find button to begin the 
search.
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While Myriad is searching the Audio Wall, the search criteria panel is disabled 
with the exception of the Stop button which replaces the Find button. Clicking 
on this stops the current search.

You will also notice that the progress of the search is displayed along the 
bottom of the Find Cart window.

Find Cart Results Window

Once the search is complete, the results are listed in the Find Cart Results 
Window.
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The Find Cart Results Window is divided into a series of rows and columns 
and each row represents a Cart on the Audio Wall that matches the search 
criteria. The columns are there to display pertinent information about the Carts 
listed. The list below explains what each column is used to display.

 Cart – The Cart column shows the Cart Slot Number for each Cart 
listed in the Find Cart Results window. By default, the results are listed 
in ascending order by Cart Slot Number.

 Title – This column displays the Title information (description line 1) for 
each Cart. If you click on the Title column header, the results will be 
sorted alphabetically (or reverse alphabetically if you click again) by 
Title.

 Artist – This column displays the Artist information (description line 2) 
for each Cart. If you click on the Artist column header, the results will 
be sorted alphabetically (or reverse alphabetically if you click again) by 
Artist.

 Description – This column displays the Description information 
(description line 3) for each Cart. If you click on the Description column 
header, the results will be sorted alphabetically (or reverse 
alphabetically if you click again) by Description.

 Intro – The Intro column shows the Intro length for each Cart listed in 
the results. If no Intro has been set on a Cart then this column is left 
blank. You can sort the results in ascending or descending order by 
Intro length by clicking on the Intro column header.

 Length – The Length column shows the Length (to the Extro if one is 
set, otherwise to the end of the file) for each Cart listed in the results. 
You can sort the results in ascending or descending order by Length by 
clicking on the Length column header.

 H (Hook) – The H column on the Find Cart results Window indicates 
the Carts listed that have a Hook set on the Cart (see SmoothEdit 
Screen). If an ‘H’ appears next to a Cart then it has a Hook set, if this 
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column is blank then no Hook has been set for the Cart. As with the 
other columns, if you click on the H column header, the results will be 
sorted into those that have a Hook set and those that do not.

 L (Loop) – The L column on the Find Cart results Window indicates the 
Carts listed that have a Loop set on the Cart (see SmoothEdit Screen). 
If an ‘L’ appears next to a Cart then it has a Loop set, if this column is 
blank then no Loop has been set for the Cart. As with the other 
columns, if you click on the L column header, the results will be sorted 
into those that have a Loop set and those that do not.

 Ending – The final column lists the type of ending that has been set for 
each Cart. The possible options are listed below:

o Ends – The Cart comes to an abrupt end.
o Fades – The Cart fades out at the end.
o Sustain – The Cart’s ending is sustained for a period at the end.
o Slow Fade – The Cart fades out over a longer period at the end.
o Blank - The ending has not been specified.

As with all the other columns on the Find Cart Results Window, clicking 
on the End column header will sort the listed results by Ending type.

Once you have found the cart you were looking for in the Find Cart Results 
Window, you can then use it in one of two ways:

 Drag the Cart you want to use into one of the Cart Players, the Log 
Screen, the Pad, Instant Carts or any other area in Myriad where a 
Cart can be dropped.

 Double click on the Cart in the list. This will close the Find Cart Results 
Window and ‘jump’ you to that specific Cart on the Audio Wall.

Working With Find Cart Results – Dragging Carts into the Cart 
Player or Log

As outlined in the screenshots below, you can ‘drag’ Carts directly from the
Find Cart Results Window into a number of areas in Myriad but most notably, 
directly into the Log Screen or one of the Cart Players located along the 
bottom of the screen.

To do this, simply click and hold the left mouse button on the Cart you want to 
work with and then drag it into either the Cart Player you want to use or the 
position in the Log Screen that you want to insert it into (great for dual screen 
systems or single screen systems running in dual screen mode – see Settings 
Menu> Myriad Settings> General Options).
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Single Screen drag into Cart Player
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Dual Screen drag into Log Screen

You can also drag from the Find Cart Results Window directly into the Instant 
Carts and the Pad, plus just about anywhere else in Myriad where you can
drop Carts.

Working With Find Cart Results – Double Clicking On Carts

As well as dragging Carts from the Find Cart Results Window, you can also 
double click on them which will close the Find Cart window and return you to 
the Audio Wall with the Cart you double clicked on highlighted.
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If you click on the Find button on the Main Tab Strip, the Find Cart window will 
re-open with the last Find Cart results already listed.

For a description of what each column in the Find Cart Results Window 
displays see the Find Cart Results Window section above.

The Tab Strip

The Tab Strip is used to switch between the major screens in Myriad and is 
displayed at all times, regardless of which screen you are currently working 
on. 

The Tab Strip usually has five major options:

1. Audio Wall – Offers access to the Myriad Audio Wall which is the core 
list of Carts available on the system. The Audio Wall is central to all 
Myriad operations. An assortment of options and tools are available 
using the buttons on the Audio Wall tab.

2. Instant Carts – Switches to the full Instant Carts screen which allows 
you to set up Instant Cart ‘hot keys’ to your favourite Carts on the 
Audio Wall in banks of 20. 
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NB: Myriad can be configured so that the Instant Carts are also on 
screen on the main Audio Wall but even in this mode, the Instant Carts 
tab is still available. An assortment of options and tools are available 
using the buttons on the Instant Carts tab.

3. Database – Switching to this tab will switch to a spread-sheet style 
listing of all the Songs and Links in your AutoTrack or AutoTrack Pro 
database or if you are using a third party music scheduling system, the 
imported Song / Link list. The Database can provide more detailed 
information as well as the ability to browse your Carts by Category etc.
An assortment of options and tools are available using the buttons on 
the Database tab.

4. The Log Screen – The Log Screen is used to display the schedule Log 
which is a pre-generated list of Carts and events that can be played in 
Live Assisted or Automated playout modes. The Log Screen is most 
commonly used in stations that also use a program scheduling system 
such as AutoTrack or AutoTrack Pro.

NB: Dual Screen – If you have configured your system to have two 
monitors, or you have configured Myriad to run in ‘dual screen’ mode 
even though you only have one monitor, then the Log Screen is 
displayed on it’s own tab and is removed from the Main Tab Strip.

An assortment of options and tools are available using the buttons on 
the Log Screen tab.

5. The SmoothEdit Screen – The SmoothEdit tab is only visible when 
you are editing a Cart using the SmoothEdit window. While you are 
editing a Cart, the SmoothEdit tab appears and the Cart you are 
working one appears as a button on the SmoothEdit tab. When you are 
working on more that one Cart, each is listed in this way and you can 
switch between them by clicking on the buttons on the Main Tab Strip
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In addition to using the mouse to switch between tabs, you can also use the 
following shortcut keys on the keyboard:

 <Ctrl> + 1  Switch to the Audio Wall tab
 <Ctrl> + 2  Switch to the Instant Carts tab
 <Ctrl> + 3  Switch to the Database tab
 <Ctrl> + 4  Switch to the Log Screen tab
 <Ctrl> + 5  Switch to the SmoothEdit tab

Viewing & Using Instant Carts from the Audio Wall

In previous versions of Myriad, the Instant Carts were traditionally available 
‘on screen’ on the main Audio Wall so that you could see and use them 
alongside the standard Audio Wall operations. In Myriad v3 and higher
versions, Instant Carts have their own screen, but you can still configure 
Myriad to have the Instant Carts visible on the main Audio Wall screen. 

In this section, we will see how to set Myriad up with this option and also how 
to use the Instant Carts when running in this mode.
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What Are Instant Carts?

Instant Carts are effectively just shortcuts to specific Carts on your Audio 
Wall. Instant Carts are linked to the number keys on your keyboard which 
means that Instant Carts offer fast and simple access to key Carts on your 
Audio Wall.

Myriad allows you to configure Instant Carts in banks of twenty with the first 
ten being triggered by keys <1> to <0> and the second ten being accessed by 
keys <Shift> + <1> to <0>. If you have attached a Cart to Instant Cart one and 
you then press the number <1> key on your keyboard then the Cart attached 
to Instant Cart one will immediately load into a free Cart Player and begin 
playback.

This makes Instant Carts ideal for playing commonly used jingles or liners as 
well as competition stabs, sound effects and pretty much anything else you 
will use on a regular basis.

NB: Instant Carts will trigger regardless of which screen is visible in Myriad 
(with the exception of the Find Cart window, the Database window, the Jump 
window and the Goto window on the Log Screen) so you do not have to be 
able to see the Instant Carts to be able to use them!

Instant Carts are covered in more detail in Chapter 3 of this documentation.

Making Instant Carts Visible On the Audio Wall Screen

To turn on the Instant Carts section of the Audio Wall, click on the View 
Menu> Display Instant Carts menu option.
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The Instant Carts will then be displayed (in a cut down mode) to the right of 
the main Audio Wall screen.

This setting is stored as part of the Customise Myriad data that is set on a per 
User basis so if you make the Instant Carts visible and then log out of Myriad, 
the next time you log in, the Instant Carts will be visible on the Audio Wall 
straight away.

Once enabled, the Instant Carts will be visible on the Audio Wall, Database, 
SmoothEdit and Log Screens, i.e. they will be visible everywhere except in the 
Instant Carts tab (where they are already displayed on screen!).

Mini Mode (Audio Wall) Instant Carts General Layout
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The Mini Mode Instant Carts are a cut down version of the main Instant Carts 
available from the Main Tab Strip. The general layout below shows the key 
components:

Select Instant Carts Set

The Select Instant Carts Set button has a dual role. When in normal 
operation, it displays the name of the Instant Cart Set (bank of 20 Instant 
Carts) currently being used. Clicking on the button will also allow you to select 
the Instant Cart Set that you want to be displayed so that you can change the 
Instant Cart set directly from the Audio Wall.
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The Instant Carts are divided into two different types of Sets, Personal (per 
User) and Shared (available on all workstations to all Users). The number of 
Personal and Shared Instant Cart Sets that you can have is virtually unlimited.

To select a new Instant Cart Set from the list, just click on it and the Instant 
Carts Set List will close and the new Instant Cart Set will be displayed.

You cannot add, rename or remove Instant Cart Sets from this window, this 
must be done on the main Instant Cart Screen (accessed via the Main Tab 
Strip).

Cart Description

This section displays as much of the Cart Description (e.g. Title, Artist & 
Description) as the Audio Wall customise settings for font size allows.

Intro Length

This shows the duration of the Intro period of the Cart that is attached to the 
Instant Cart. If no Intro has been set then this will be displayed as zero.

Cart Slot Number

This displays the Cart Slot Number for the Cart currently attached to the 
Instant Cart.

Overall Length

This displays the overall length of the Cart attached to the Instant Cart. If the 
Cart has an Extro set then this length will be reflective of the duration from the 
start of the audio file to the Extro point. If no Extro point has been set then this 
length will be the total length of the audio file.

Instant Carts 1 to 10

When in Mini Mode, the Instant Carts are arranged into sets of twenty but only 
ten are on screen at any one time. Each instant Cart is linked to a number on
the keyboard <1 to 0> and when that number key is pressed, the Cart 
attached to the corresponding Instant Cart instantly starts playback.

If you switch to the 11-20 view (see Switch +/- 10) then the Instant Carts are 
numbered 11 – 20. 
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Instant Cart Number / Clear Instant Cart

The Instant Cart Number on the top right hand corner of each Instant Cart 
indicates the Instant Cart Number and therefore the key on the keyboard that 
needs to be pressed to trigger the Instant Cart.

The Instant Cart Number also performs a secondary function in that clicking 
on this area of the Instant Cart (as opposed to the main Instant Cart) will give 
you the option to clear the Cart from the Instant Carts leaving it blank to be 
filled with another Cart.

When you click on the Instant Cart Number to clear the Instant Cart, you will 
be asked to confirm before the Instant Cart is cleared.

Switch +/- 10

These two buttons allow you to switch the Instant Cart view to view Instant 
Carts 1-10 or Instant Carts 11-20

As you can see from the screen shots below, switching between the two 
views offers access to all of the Instant Carts within the Instant Cart Set.
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It is worth noting that all Instant Carts can be triggered by their keyboard short 
cut regardless of whether they are visible on screen. This means that even if 
you are looking at Instant Carts 1-10, you can still trigger Instant 18 by 
pressing the Instant Cart 18 key on your Myriad keyboard or the <Shift> + <8> 
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key on a standard keyboard. A full listing of Instant Cart trigger keys is listed 
below.

 Number Keys 0-9  Instant Carts 1 – 10
 <Shift> + Number Keys 

0-9
 Instant Carts 11 – 20

Working With Instant Carts – Adding / Changing Instant Carts

Instant Carts can be added or altered at any time directly from the Audio Wall 
when Instant Carts are set to run in Mini Mode.

To add a Cart to a blank Instant Cart, simply drag the Cart from the Audio 
Wall onto the Instant Cart that you wish to use.



319

In the above example, the left mouse button is used to drag the Cart from the 
Audio Wall onto Instant Cart 8 on the Mini Mode Instant Cart section. The Cart 
will now be triggered whenever the <8> key on the keyboard is pressed or 
Instant Cart 8 is clicked on screen.

You can also drag a Cart onto an Instant Cart that is already occupied. If you 
do this (and have the access rights to do so) then the new Cart replaces the 
existing Cart in the Instant Cart slot and will be played whenever the Instant 
Cart is triggered from that point onwards.

Working With Instant Carts – Removing Carts from Instant Carts

To remove a Cart from an Instant Cart, simply click on the Instant Cart 
Number indicator located in the top right corner of each Instant Cart.

This will first ask you to confirm that you want to remove the Instant Cart.
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If you click on Yes then the Instant Cart is cleared.

Working With Instant Carts – Playing Instant Carts

You can play an Instant Cart using one of the following methods:

 Keyboard Number Keys – Use the keyboard number keys <1 to 0> to 
play Instant Carts 1 to 10 and <Shift> + <1 to 0> to play Instant Carts 
11 to 20.

 Click On The On Screen Instant Carts – You can also use the left 
mouse button to trigger Instant Carts to play instantly.

Working With Instant Carts – Adding, Renaming & Deleting Instant
Cart Sets

You cannot add, rename or remove Instant Cart Sets from the Mini Mode 
Instant Carts available on the main Audio Wall screen. In order to add a new 
set, rename an existing set or remove an existing set, switch to the Instant 
Carts tab on the Main Tab Strip and use either the buttons on the Main Tab 
Strip or the options on the right click menu for the Instant Cart Set tree view 
section.
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These procedures are covered in more detail in Chapter 3 of this 
documentation, however, below is a brief description.

Adding a New Set

1. Click on the Instant Carts tab to switch to the Instant Carts screen.
2. Click on either Personal or Shared in the Instant Carts Set tree view 

section to select whether you wish to add a Personal or Shared Instant 
Cart Set.

3. Click on the New button on the Main Tab Strip, or if you prefer, right 
click on the Instant Carts Set tree view window and select Add Set from 
the right click menu.

4. Type in the name for the new Instant Cart Set.
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5. Press the <Enter> key on the keyboard once you have finished typing. 
6. You have just created a new empty Instant Carts Set.

Renaming an Existing Instant Carts Set

1. Click on the Instant Carts tab on the Main Tab Strip to ensure the 
Instant Carts screen is visible.

2. Click on the Instant Carts Set that you want to rename in the tree view 
section to make sure it is highlighted (shown in blue with white text).

3. Either click on the Rename button on the Main Tab Strip or right click 
on the Instant Carts Set and then select Rename Set from the right 
click menu.

4. Type in the new name for your Instant Carts Set and then press 
<Enter> when you have finished.

5. You have just renamed an existing Instant Carts Set.
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Deleting an Existing Instant Carts Set

CAUTION! You will need to be logged on as a User with enough access 
rights to perform this operation. Once you have deleted an Instant Carts Set 
you cannot recover it.

Deleting Instant Carts Sets does not affect the Carts that the Instant Carts 
within the Instant Cart Set link to so you will not loose any Carts or audio from 
the audio wall.

1. Click on the Instant Carts tab on the Main Tab Strip to ensure the 
Instant Carts screen is visible.

2. Click on the Instant Carts Set that you want to delete in the tree view 
section to make sure it is highlighted (shown in blue with white text).

3. Either click on the Delete button on the Main Tab Strip or right click on 
the Instant Carts Set and then select Delete Set from the right click 
menu.

4. You will then be asked to confirm that you wish to delete the selected 
Instant Carts Set. Click on Yes if you wish to proceed.

5. You have just deleted an existing Instant Carts Set.

Viewing and Using the Pad

The Pad is a special tool built into Myriad and designed to be a simple, fast 
and effective automation tool for situations when automated playout is needed 
but no scheduled Log is available or appropriate.

What Is The Pad?

The Pad is basically a list of Carts that will be played in order. You can build 
up the list of Carts to be played by dragging them into the Pad from the Audio 
Wall. Once the Pad is started, each Cart in the list is cued up in turn into the 
Cart Players and the next Cart is automatically started as the previous one 
finishes.
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You can add additional Carts, or change the order of Carts in the Pad even 
once it has started running and because you can save and load Pad runs and 
make them loop to run indefinitely, it is also a great emergency backup tool.

In addition to these core features, the Pad introduces a number of extra 
facilities such as the ability to just play the Hooks from the selected Carts, to 
insert Pauses into the automated playback and even ‘render’ the contents of 
the Pad to a single Cart on the Audio Wall.

In this section, we will look at the tools and facilities that the Pad offers.

Making the Pad Visible On the Audio Wall

By default, the Pad is not visible when Myriad first starts up but you can make 
it visible by clicking on the View Menu> Display Pad option.
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This will enable the Pad on the left hand screen of the Audio Wall.
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Although the Pad is not initially visible the first time you run Myriad, its visibility 
status is actually stored as part of the User Customise profile so if you enable 
the pad and have it visible when you log out of the system, it will be visible the 
next time you log in again.

Please note that once enabled, the Pad will be visible on the Audio Wall, 
Database, SmoothEdit, Instant Carts and Log Screens, i.e. it will be visible 
everywhere in Myriad.

The Pad General Layout

The diagram below shows the general layout of the Pad in Myriad:

These elements are explained in greater detail below.

The Pad Tool Bar

The Pad Tool Bar is the key to using the Pad as it offers a number of different 
tools and facilities to help you to get the most from the Pad.
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Each of these functions are explained below:

Clear Pad

This option is used to clear the Pad of any Carts currently listed in it leaving a 
completely blank Pad for you to start dropping Carts back into.

The Clear Pad option is only enabled when you have one or more Carts listed 
in the Pad and the Pad is not active. As soon as the Pad has started (is 
active) then this option becomes disabled once again.

If you click on the Clear Pad button on the tool bar (when it is available) then 
you will be asked to confirm before the information on the Pad is discarded.

CAUTION – As with other areas in Myriad, if you click on Yes at this stage 
then the list of Carts on the Pad will be discarded and there will be no way to 
recover the list unless you have already saved it, in which case you could 
simply reload it.

Clearing the Pad will not have any adverse on the Carts listed within the Pad, 
they remain totally unaffected by the clearing process.

Save Pad 
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The Save Pad option allows you to save the list of Carts currently displayed
on the Pad for loading back into the Pad at a later date.

To use this feature, click on the Save Pad button and then select the location 
and file name that you want to use to save the Pad listing.

You can save Pad listings anywhere on your local PC or network but it is a 
good idea to save them in a location that is easy to remember and if you want 
to be able to access them from other Myriad workstation, store them in a 
location that has shared access.

Load Pad 

The Load Pad option allows you to browse the local computer or network and 
select a previously saved Pad list to be loaded into the Pad. To use this 
option, click on the Load Pad button and then use the standard Windows
Explorer window to locate the Pad List you want to load.
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What makes this option really useful is that you can actually load more than 
one saved Pad List into the Pad. Each Pad List you load will be appended on 
to the bottom of the existing list so that you can load several previously saved 
Pad Lists to create a single list of a greater duration.

The Load / Save capabilities of the Pad make it ideal for simple show 
preparation (where no scheduled show is used) as well as for emergency 
broadcasts or test transmissions.

Add Pause 

The Add Pause button on the Pad Tool Bar adds a special Pause item to the 
Pad list which causes the Pad to temporarily stop playback between Carts 
when it is actively running.



330

In the example above, when the Pad is started the first Cart (Evergreen) 
would be played as normal, and around 15 seconds from the end, the next 
Cart (Am to PM) would be cued ready to start playing at the end of Evergreen. 
Under normal circumstances, when the Extro point on Evergreen is reached, 
AM to PM would automatically start but because there is a pause between the 
two Carts, the Pad would actually stop between the two Carts and it would be 
up to the presenter to manually start AM to PM by clicking the Play button on 
the Cart Player it is cued up in (or pressing Play on the keyboard etc).

A Pause can be inserted into the Pad at any time (even while it is active) by 
clicking on the Pause button. The pause is always initially added to the Pad 
List below the last Cart but you can use the left mouse button to drag the 
Pause back up the list to the position you want it to actually be in.

Pauses can be used to create a pseudo-live assist mode when using the Pad 
instead of the Log screen for automated playout.

Loop Pad 

As the name suggests, this option will determine whether or not the Pad just 
stops when it has finished playing the last Cart in the list or whether it loops 
back to the beginning and starts playing the whole list again.

When this option is selected, the Loop Cart button appears ‘indented’ on the 
Pad Tool Bar.

With this option turned on, you could leave the Pad running a list of Carts 
indefinitely.

Play Hooks 
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The Play Hooks option on the Pad Tool Bar changes the way in which the 
Pad plays the listed Carts. Ordinarily, the Pad will just start at the beginning of 
each Cart in the list and play through to the Extro point, at which point it will 
automatically start the next Cart in the list (assuming there are no Pauses –
see above). 

With the Hook option selected (see screen shot above), for any Carts listed on 
the Pad that have Hooks defined the Pad will only play the Hook from each 
Cart listed. Any Carts that do not have a Hook defined will be played in their 
entirety.

You can toggle this option on and off even while the Pad is active (running). 
When Carts are loaded into Cart Players in Hook mode, the word ‘Hook’ is 
displayed across the Cart Player and a large count down is displayed to show 
when the Hook will end.

Start  / Stop  Pad

The Start / Stop button on the Pad Tool Bar allows you to toggle the Pad 
between Active mode and Standby mode or to put it another way, allows you 
to start and stop the Pad from running its list of Carts. When the Pad is in 
Standby mode, it will not be playing any Carts and will not be active in any 
way. You can still add Carts and change the other options on the Pad Tool 

Bar. In this mode, the Start / Stop button is in Start  mode and clicking on it 
will activate the Pad. The screen shot below shows the Pad in Standby mode:
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If you click on the Start button then the Pad moves into Active mode.
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You will notice that the Start / Stop button toggles to Stop  mode to allow 
you to switch the Pad from Active mode back to Standby mode when you 
want to.

You will also see that the first Cart in the Pad list has been loaded into one of 
the Cart players although it has not actually started playback yet. Clicking on 
the Play button on the Cart Player that the first Cart in the Pad list is loaded 
into will start the Pad run actually playing. The currently cued / playing Cart in 
the Pad list is also highlighted by a green box while the Pad is Active.
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In the screen shot above, you can see that the Pad is Active and that the first 
Cart in the Pad list is coming to an end. The Pad automatically loads the next 
Cart in the list into a free Cart Player and will automatically start the next Cart 
when the current one finishes (reaches its Extro point). The Pad will continue 
to automatically load and play all of the Carts in the list until the end of the list 
is reached or a Pause is encountered. You can manually stop the Pad run by 
clicking on the Stop button. This will put the Pad into Standby mode but the 
Cart that is currently playing will continue playing to the end as normal.

NB: When the Pad is running, if you eject a Cart that is being played as part of 
the Pad run, then the Pad will automatically load and start the next Cart in the 
list. If you want to end the Pad run, click on the Stop   button to put the Pad 
in to Standby mode before ejecting the Cart from the Cart Player.

Export Pad to Cart

The Export Pad to Cart option on the Pad Tool Bar allows you to create a 
single Cart on the Audio Wall that contains all of the Carts listed on the Pad.

When Myriad plays the Carts listed in the Pad in sequence, it uses two or 
more Cart Players to overlay the end of one Cart with the beginning of the 
next depending on whether there is an Extro set on the Cart that is finishing.

This allows playback to sound smooth as Myriad effectively ‘cross fades’ 
between the two Carts. This is the same method used by the Log Screen in 
any of the Active Playout Modes. 

When you use the Export Pad to Cart facility, Myriad does the same thing but 
instead of doing it in ‘real time’ it exports all of the Carts in the Pad to a single 
audio file, overlaying the Intros and Extros as if they were playing out live. 
This audio file is then added to the Audio Wall as a Cart.  So when it is played 
out it uses only one Cart player.
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This feature becomes very useful when you combine it with Hook mode 
playout. When the Pad is playing a list of Carts on Hook mode, it only plays 
the Hook from each Cart and then moves on to the next. When you export to 
a Cart while in Hook mode, the Hooks from the listed Carts are combined into 
one single piece of audio and then added to the Audio Wall. If you then put a 
jingle at the beginning and end of the Pad list (with no Hook defined on either 
jingle) then you end up with a Cart that contains a starting jingle, then the 
Hooks from a number of songs followed by an ending jingle…instant promo!!

This feature also has a number of good applications for combining sections of 
an interview or separate news stories into a single Cart.

Currently Playing Item

When the Pad is Active (i.e. playing), the Cart that is currently being played is 
highlighted in the Pad list by a green box.

As the Pad works its way down the listed Carts, the green highlight box also 
moves down the list showing where in the current list you are up to.

NB: You can drag and drop Carts into the Pad below the currently playing 
Cart directly from the Audio Wall (or Find Cart screen) and you can also use 
drag and drop to move Carts around within the Pad list provided you remain 
below the currently playing Cart. You cannot drag Carts into the Pad list 
above the currently playing item.

Pad Cart List
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This is where the Carts that form the Pad list are listed. The Pad runs simply 
from top to bottom with the Pad playing each of the listed Carts in turn.

You can add Carts to the Pad Cart List by dragging them directly from the 
Audio Wall screen, Database screen or Find Carts window. You can also drag 
items from the Log screen into the Pad Cart List if you wish. You can alter the 
order of Carts listed on the Pad by dragging items around within the list but 
only below the currently playing Cart (shown with a green box around it) when 
the Pad is in Active mode.

You can remove Carts from the Pad Cart List by double clicking on them.

Time Remaining

The Time Remaining counter shows the total duration of all of the Carts listed 
in the Pad when in Standby mode and a count down of the total run time 
remaining of the Carts left still to play in the Pad list when in Active mode. In 
this mode, as the Carts in the list are played, the Time Remaining counts 
down towards zero (or the end of the Pad run).

Items Remaining

The Items Remaining indicator provides a total of the number of Carts waiting 
to be played in the Pad Cart List. When in Standby mode, this provides the 
total number of Carts currently listed in the Pad Cart List. When the Pad is 
switched to Active mode, as each Cart in the list is played, the Items 
Remaining counter will drop by one. If you add additional Carts to the Pad list 
then this number will also rise accordingly.

Cart Description

The Cart Description is used to display the Cart Description details such as 
Title, Artist etc. The amount of information available on the Cart Description is 
dependent on the font size used on the Audio Wall and the resolution that you 
have configured the PCs monitor to display at.

Cart Number

This shows the unique Cart Slot Number for the Cart listed in the Pad List.
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Cart Length

The Cart Length shows the length of the Cart listed in the Pad Cart List. This 
length would normally be the duration from the start of the audio file to the 
Extro point on the Cart but if no Extro point has been set then this will be to 
the very end of the audio file.

Working with the Pad – Building & Editing Pad Runs

To build Pad runs, drag Carts from the Audio Wall onto the Pad. Follow these 
steps:

1. Ensure that the Pad is visible. If it is not then click on the View menu 
and select the Display Pad option.

2. Drag Carts from the Audio Wall, Database, Log or Find Cart screens 
directly onto the Pad Cart List area on the Pad.

3. You can move the Carts on the Pad around by dragging them up or 
down with the left mouse button.

NB: If the Pad is active, you can only move Carts around below the 
currently playing Cart.

4. If you need to delete a Cart from the Pad list, double click on it and it 
will be removed from the Pad.

The simplest way to think of the Pad is as a list of Carts that you want to be 
played when the Pad is activated.

Working with the Pad – Starting & Stopping Pad Runs

Once you have loaded some Carts onto the Pad, and you are ready to
activate the Pad to make it play the Carts listed, follow these steps to start the 
Pad run:

1. Ensure that the Pad is visible. If it is not then click on the View menu 
and select the Display Pad option.

2. Make sure that you have one or more Carts listed in the Pad Cart List 
area. You can drag additional Carts into the Pad from the Audio Wall, 
the Database screen, the Log screen or the Find Cart window. You can 
add Carts to the list even when the Pad is in Active mode and you can 
move Carts around within the Pad Cart List by dragging them using the 
left mouse button.

3. Click on the Start  button to put the Pad into Active mode. The first 
Cart listed in the Pad Cart List will be loaded into the first free Cart 
Player and will be cued ready to be played.

4. Click on the Play button on the Cart Player in question, this will start 
the Pad running and it will continue to play all the Carts listed until the 
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final Cart finishes, or a Pause is encountered, or you manually stop the 
Pad.

5. If you click on the Start  button when a Cart is already playing in any 
Cart Player, a menu option pops out from the Start button that allows 
you to decide how to deal with the situation.

If you select the Start After option then the Cart that is currently playing 
will automatically be added to the top of the Pad Cart List and when it 
finishes playing, the next Cart listed will start playing automatically, as 
normal. If you select the Ignore Item In Players option then the first 
Cart in the Pad will be immediately loaded into a free Cart Player to 
await manual triggering by the presenter (see step 4). If you click 
anywhere else on the Audio Wall (other than the menu) then the Start 
operation is cancelled and you return to the Audio Wall.

If you click on the Start button when more than one Cart is playing, you 
will be asked to select the Cart that you want to use to act as the 
trigger for the Pad run, using the menu that pops out from the Start 
button.



340

You can also select the Ignore Items in Players option to manually load 
the first Cart on the Pad into one of the free Cart Players.

Once the Pad is in Active mode, each Cart in the list will be automatically 
played unless a Pause is encountered in the list or you manually stop the Pad 
run. 
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One thing that should be kept in mind is that once the Pad is running, clicking 
on the Eject button on a Cart Player that is playing a Cart from the Pad will 
eject the Cart but the Pad will automatically load and start the next Cart in the 
list. If you wish to stop the Pad run, you will need to follow these steps:

1. Click on the Stop  button.
2. Any cued Carts will automatically be ejected from the Cart Players but 

any Carts that are playing will be allowed to continue to play through to 
their natural end (or Extro).

3. If you wish to end the currently playing Cart early, click on the Eject 
button on the appropriate Cart Player.

Working with the Pad – Saving & Loading Pad Lists

You can save and load lists of Carts for use within the Pad. This is really 
useful for creating sequences of Carts that you may wish to reuse in the future 
(like emergency programs etc). You can load multiple lists into the Pad to 
allow you to combine two or more previously saved lists into a single Pad run. 
To load and save Pad lists, follow these steps:

1. Build the Pad list that you want to save.
2. Click on the Save button.
3. Use the Navigator window to select the file name and location you wish 

to save the Pad list in.
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Then click on the Save button to save your Pad list.

4. To load a previously saved Pad list, click on the Load  button.
5. Use the Navigator window to select the Pad list file that you wish to 

load in to the Pad.

Then click on the Open button to add the saved Cart list to the bottom 
of the Pad.

If you already had Carts in the Pad then the new Cart list that you have 
just loaded will be appended to the Pad below the exiting Carts. 

Chapter 2 Summary

Chapter 2 has covered the Audio Wall and shown how it is central to all 
Myriad operations and that it is essentially a ‘shelf’ full of audio Carts that can 
be manually or automatically played using the Cart Players.

We have also looked at the various tools and facilities the Audio Wall offers 
and how these can be used to use and maintain your Myriad system. 

In the next few Chapters we will look at some of the other areas in Myriad but 
all of them will be based on a good working knowledge of what the Audio Wall 
is and what role it plays in the system as a whole.
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Chapter 3 – The Instant Carts Screen

In this Chapter we will look at the Instant Carts screen in detail and examine 
how Instant Carts are used in everyday broadcasting. We will also look at how 
Instant Carts are maintained and how they integrate with other sections of 
Myriad.

What Are Instant Carts?

Instant Carts are effectively just shortcuts to specific Carts on your Audio 
Wall. Instant Carts are linked to the number keys on your keyboard which 
means that they can offer fast and simple access to important Carts without 
having to search for them.

Myriad allows you to configure Instant Carts in banks of twenty with the first 
ten being triggered by keys <1> to <0> and the second ten being accessed by 
keys <Shift> + <1> to <0>. If you have attached a Cart to Instant Cart one and 
then you press the number <1> key on your keyboard, the Cart attached 
would immediately load into a free Cart Player and begin playback.

This makes Instant Carts ideal for playing commonly used jingles or liners as 
well as competition stabs, sound effects and pretty much anything else you 
want to use on a regular basis.

NB: Instant Carts will trigger regardless of which screen is visible in Myriad 
(with the exception of the Find Cart window, the Database window, the Jump 
window and the Goto window on the Log Screen) so you do not have to be 
able to see the Instant Carts on screen to take advantage of them!

If you have read through Chapter 2 of this manual, then you should already be 
familiar with Instant Carts and their role which was covered in brief as part of 
the Audio Wall section. This is because Myriad v3 allows you to customise the 
system to display Instant Carts in two different ways; the dedicated Instant 
Carts screen (covered here), and as a cut down view available on most other 
screens in Myriad. 

The Instant Carts screen provides a dedicated display for Instant Carts along 
with all the tools you need to manage the Instant Cart Sets (blocks of 20 
Instant Carts). The optimum configuration for using Instant Carts in this way is 
a dual screen system with most of the station content coming from the pre-
scheduled Log screen. In this type of set up, when in Live Assist mode, the 
presenter will be able to use the Log screen for most things but also have the 
Instant Carts available on the other screen for playing promos, competition 
FX’s and other additional audio content. They will also be able to switch to the 
Audio Wall at any time.
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Additionally, you can customise Myriad to display a cut down view of the 
Instant Carts on most other major screens in Myriad, so that your Instant 
Carts are visible when you are looking at the Audio Wall, the Database 
screen, the SmoothEdit screen and the Log screen. This can be very useful if 
you use Instant Carts but also regularly need to use other screens in Myriad 
such as the Audio Wall. The screen shots below show Myriad in a number of 
different configurations:

Standard Instant Carts Screen
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The Audio Wall customised to have Instant Carts Displayed
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The Log Screen with Instant Carts Enabled

What Are Instant Cart Sets?

Instant Carts are arranged into blocks of twenty Carts, each of these blocks is
called an Instant Cart Set. The reason they are arranged in this way is that 
each of the twenty Instant Carts that make up an Instant Cart Set is assigned 
a specific key on the keyboard (1-20) and whenever this key is pressed (or 
the Instant Cart is clicked on screen) the Cart attached to the Instant Cart 
starts playing immediately in the first free Cart Player. The keys used to 
trigger Instant Carts are listed below.

 Number Keys 0-9  Instant Carts 1 – 10
 <Shift> + Number Keys 

0-9
 Instant Carts 11 – 20

Myriad allows you to set up an unlimited number of Instant Cart Sets and you 
can switch between them at any time. 

You can add Instant Cart Sets as either Personal (just for the person logged 
into Myriad) or Shared (available across all workstations to all users) and the 
Instant Cart Set Tree View makes managing and maintaining the Instant Cart 
Sets fast and simple.
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The Instant Carts Screen Layout at a Glance

The Instant Cart screen is split into two main areas. The main part of the 
screen displays the twenty Instant Carts that make up an Instant Cart Set. 
Some or all of these may be populated with Carts and clicking on them or 
pressing the corresponding key on the keyboard will instantly play the Cart in 
question. 

The second part of the Instant Cart screen is the Instant Cart Set Tree View
which provides a very simple way of navigating around and managing your 
Instant Cart Sets. 

Finally, the Main Tab Strip provides access to a number of tools that help you 
maintain and get the most from your Instant Carts.

The diagram below shows the general layout of the Instant Cart screen.

 Available Button Sets – Toggles the Instant Cart Set Tree View panel 
between visible and hidden.

 Pin Instant Cart Tree View - The pin button toggles between having 
the Cart Set Tree View panel between being visible all the time and 
auto hiding when not in use.

 Current Instant Cart Set Name – Displays the name of the Instant 
Cart Set currently in use.

 Cart Description – Shows the Cart Description lines of the Cart 
associated with the Instant Cart.

 Intro Time – Shows the duration of the Intro on the Cart associated 
with the Instant Cart.

 Overall Length – Shows the overall duration (to Extro) of the Cart 
associated with the Instant Cart.
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 Cart Number – Shows the Cart Slot Number for the Cart associated 
with the Instant Cart.

 Instant Cart Number / Remove Cart From Instant Cart – Shows the 
Instant Cart number, this is the number of the keyboard that will trigger 
the Instant Cart. If you click on this number, the Cart associated with 
the Instant Cart will be removed from the Instant Cart (but remains on 
the Audio Wall).

 Instant Carts 1 – 20 – Displays the twenty Instant Carts that make up 
the Instant Cart Set.

 Tab Strip – Used to switch between the major screens in Myriad. Also 
has context sensitive tool buttons.

 Carts – Opens a floating Audio Browser window (see Chapter 7) which 
is a mini version of the Audio Wall screen. You can drag Carts from the 
Audio Browser onto the Instant Carts to associate Carts with Instant 
Carts.

 Delete Set – Deletes the Instant Cart Set that is highlighted in the 
Instant Cart Set Tree View panel.

 Rename Set - Renames the Instant Cart Set that is highlighted in the 
Instant Cart Set Tree View panel. 

 New Set – Creates a new Personal or Shared Instant Cart Set.
 Refresh – Reloads the Instant Carts and Instant Cart Set Tree View 

panel taking in to account changes made on other Myriad workstations 
within your station.

Instant Cart Set Tree View

The Instant Cart Set Tree View panel provides a simple way of navigating and 
managing your Instant Cart Sets based on a Windows Explorer method. The 
Instant Cart Set tree View is divided into Personal and Shared sections to 
allow you to work with your own personal Instant Carts as well as Instant Cart 
Sets shared with all other workstations and users.

To switch to an Instant Cart Set, simply click on it in the Instant Cart Set Tree 
View and the main Instant Carts will update accordingly.
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You can also right click on the Instant Cart Set Tree View to access the right 
click menu which allows you to add new Instant Cart Sets, rename existing 
ones or delete Instant Cart Sets.

Instant Cart Set Tree View – Right Click Menu Options

If you right click on an Instant Cart Set in the Tree View section, the right click 
menu becomes available.

Adding Instant Cart Sets Using the Right Click Menu

To add an Instant Cart Set using the right click menu, follow these steps:

1. Ensure that the Instant Cart Set Tree View is visible. If it is not visible 
then click on the Available Sets button to open the Tree View panel.

2. Decide whether you wish to add a Personal Instant Cart Set (only 
available when you are logged into Myriad) or a Shared Instant Cart 



350

Set (available to everyone). Once you have decided, right click on 
either the Personal or Shared folder as appropriate. In this example we 
will add a Personal Instant Cart Set

3. Select the Add Set menu option to add the new Instant Cart Set.
4. A new Instant Cart Set will be created with the title ‘Untitled Set’.

5. Type in a new title for the set in the box provided.
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When you are happy with your new title, hit the <Enter> key on the 
keyboard to save your Instant Cart Set’s title.

6. You have now added a new Instant Cart Set.

You can also add a new Instant Cart Set by clicking the New button on the 
Main Tab Strip.

NB: If you want to add Shared Instant Cart Sets then you will need to be 
logged in as a User with sufficient permissions to do so (see the User / 
Contacts section in Myriad Manager for more details).

Renaming Instant Cart Sets Using the Right Click Menu

You can also rename any existing Instant Cart Sets using the right click menu 
by following these steps.

1. Ensure that the Instant Cart Set Tree View is visible. If it is not visible 
then click on the Available Sets button to open the Tree View panel.

2. Locate the Instant Cart Set that you wish to rename and then right click 
on it.

3. Select Rename Set from the right click menu.
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4. Type the new Instant Cart Set name into the box provided.

5. When you have finished, press the <ENTER> key on the keyboard or 
click elsewhere on the Instant Carts screen.
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6. You have now renamed the Instant Cart Set.

NB: You can also double click on the Instant Cart Set in the Tree View panel 
to rename the Instant Cart Set, or click on the Rename button on the Main 
Tab Strip.

Deleting Instant Cart Sets Using the Right Click Menu

You can delete an existing Instant Cart Set using the right click menu on the 
Tree View by following these steps:

1. Ensure that the Instant Cart Set Tree View is visible. If it is not visible 
then click on the Available Sets button to open the Tree View panel.

2. Locate the Instant Cart Set that you wish to delete and then right click 
on it.

3. Select Delete Set from the right click menu.

4. You will then be asked to confirm the deletion of the Instant Cart Set. 
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Click on Yes if you wish to continue with the deletion and No if you do 
not want to continue.

5. If you click on Yes, the Instant Cart Set is deleted and the next Instant 
Cart Set in the list is displayed.

You can also delete an Instant Cart Set by highlighting it in the Tree View 
panel and then clicking on the Delete button on the Main Tab Strip.

Instant Carts 1 – 20

The main section of the Instant Carts Screen shows the twenty Instant Carts 
that form the Instant Carts Set currently in use. 

When you create a new Instant Cart Set, all twenty Instant Carts are initially 
blank but you can add Carts (from the Audio Wall) to the Instant Carts Set by 
clicking on the Carts button on the Main Tab Strip.
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Each Instant Cart displays the Cart Description, Intro length, Cart Slot Number 
and Overall length of the Cart attached to it, as well as the Instant Cart 
Number (i.e. the number on the keyboard that you must press to trigger the 
Instant Cart).

Any Instant Carts that appear blank have not had a Cart attached to them.

You can trigger Instant Carts by using one of the following methods:

 Press the corresponding key on the keyboard.

 Number Keys 0-9  Instant Carts 1 – 10
 <Shift> + Number Keys 

0-9
 Instant Carts 11 – 20

NB: If you have a customised Myriad keyboard then you may have all 
twenty Instant Carts available as buttons on the keyboard.

 Click on the Instant Carts using the left mouse button.

If you need to remove a Cart from an Instant Cart, click on the Instant Cart 
Number in the top right hand corner.
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This will clear the Instant Cart leaving it blank.

You can also drag new Carts into Instant Carts that are already occupied; the 
Instant Carts will be updated immediately to display the new Cart details.

The Main Tab Strip

The Main Tab Strip is used to switch between the main screens in Myriad. It is 
also used to display a range of context sensitive tools and buttons that update 
depending on which screen you are working with.

In the case of the Instant Carts Screen, the Main Tab Strip includes a number 
of buttons to allow you to use and maintain the Instant Carts and Instant Cart 
Sets. The main functions of these buttons are outlined in brief below:

 Refresh – Reloads the current Instant Carts and the Instant Cart Set 
Tree View list to reflect any changes made by other Myriad 
workstations on the network.

 New – Adds a new blank Instant Cart Set to either the Personal or 
Shared area of the Tree View panel (depending on which is currently 
highlighted).

 Rename Set – Allows you to rename the currently highlighted Instant 
Cart Set.

 Delete Set – Allows you to delete the currently highlighted Instant Cart 
Set.

 Carts – Opens the Cart Browser window which is a floating window 
that offers access to the Myriad Audio Wall. In this context, the Cart 
Browser is primarily used to drag Carts from the Audio Wall into Instant 
Carts to assign the Cart that will be played when the Instant Cart is 
triggered.

The Main Tab Strip remains on screen at all times regardless of which screen 
in Myriad you are working on.

The Carts Button
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The Carts button on the Main Tab Strip of the Instant Carts screen is used to 
open the Audio Browser which is a slightly cut down version of the main 
Myriad Audio Wall screen that appears in a floating window.

The Audio Browser is used throughout Myriad wherever access to the Audio 
Wall is needed to view or select Carts. It basically allows you to browse the 
Audio Wall when you are in other areas of Myriad. You can drag Carts from 
the Audio Browser into other areas of Myriad (such as Instant Carts), in some 
circumstances, you can also double click on Carts to select them (like the 
Insert Cart function on the Log Screen). The Audio Browser also goes beyond 
the standard Audio Wall in some respects as you can limit the Carts displayed 
by a range of criteria. All of this is covered in greater detail in Chapter 7 - The 
Audio Browser section of the documentation.

The Audio Browser can be used in three different view modes which can be 
seen below:

Standard Mode
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Slim Cart Mode

List Mode

You can switch between these three modes by clicking on the Audio Browser
Mode Select buttons on the Cart Browser Tool Bar.
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Although the Audio Browser is a powerful and versatile tool, in this section we 
will only look at how it can be used to attach Carts to Instant Carts.

We will assume that the Audio Browser is in Standard Mode for this example 
but the same methods apply whichever mode the Audio Browser is viewed in.

Assigning Carts to Instant Carts

To assign a Cart from the Audio Browser to an Instant Cart, simply drag the 
Cart from the Audio Browser onto the Instant Cart.

Find the Cart that you want to use for your Instant Cart, using the Audio 
Browser (see below). Use the left mouse button to drag the Cart from the 
Audio Browser onto the Instant Cart that you want to use.
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Release the left mouse button to drop the Cart onto the Instant Cart. The 
Audio Browser will remain open to allow you to add Carts to other free Instant 
Carts.

If you drag a Cart onto an Instant Cart that already has a Cart assigned, the 
assigned Cart will be replaced with the new Cart – you will not be asked to 
confirm the action!
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Once you are happy with the Carts you have assigned, click on the X in the 
top right hand corner of the Audio Browser to close it.

You can also assign Carts to Instant Carts using the main Audio Wall screen 
when the Instant Carts are configured to be displayed in ‘mini mode’ (see Mini 
Mode Instant Carts in Chapter 2).

The Delete Set Button

The Delete Set button is used to delete the selected Instant Cart Set from the 
Tree View.



363

To use this feature, make sure the Instant Cart Set that you want to delete is 
highlighted in the Set Tree View panel and then click on the Delete Set button.

You will then be asked to confirm the action. If you click on Yes then the 
Instant Cart Set will be deleted from the system but the Carts that were 
attached to Instant Carts in the Set will not be deleted, they will remain on the 
Audio Wall.

You can also delete Instant Cart Sets using the right click menu on the Instant 
Cart Set Tree View panel.

The Rename Set Button

The Rename Set button is used to rename an Instant Cart Set listed in the 
Instant Cart Set Tree View panel.

To use this feature, highlight the Instant Cart Set you wish to rename in the 
Tree View panel and then click on the Rename Set button.

You can then type in a new name for the Instant Cart Set. Once you have 
finished, press the <Enter> key on your keyboard or click on another area on 
the Instant Carts screen.
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You can also rename an Instant Cart Set by using the right click menu in the 
Tree View panel.

The New Set Button

The New Set button is used to add a new Instant Cart Set to the system. To 
use this feature, follow these steps:

1. Ensure that you are looking at the Instant Cart screen and that you are 
logged in with sufficient User Access Rights to add a new Instant Cart 
Set to the system.

2. Decide whether you wish to add a Personal or Shared Instant Cart Set 
and then click on either Personal or Shared on Tree View panel as 
appropriate.

3. Click on the New Set button. A new Set will be created in the Tree 
View panel.
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4. Type in a name for the new Instant Cart Set that you have just added 
and then press the <Enter> key.

5. You can now use the Audio Browser to start to add Carts to your new 
Instant Cart Set (see Adding Carts to Instant Carts).

You can also use the right click menu on the Tree View panel to add in new 
Instant Cart Sets (see Adding Instant Cart Sets Using the Right Click Menu).

The Refresh Button
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The Refresh button checks the network system for updated Instant Cart Sets 
and updates the display on the Instant Carts screen accordingly. 

The main use for this button is that if another person is adding Shared Instant 
Cart Sets in another studio (or another Myriad workstation), you can use this 
option to force Myriad to check for updates and display the latest Instant Cart 
Set information.

Myriad automatically updates the Instant Carts displayed within a set 
periodically so if two people are looking at the same Instant Cart Set then 
changes made on one would automatically be reflected in the other. Myriad 
does not however, automatically refresh the overall Instant Cart Set list in the 
Tree View Panel so you would have to use the Refresh button in order to 
update this list if it is added to at another workstation.

Pin Instant Cart Set Tree View Panel

As we have already seen, the Instant Cart Set Tree View panel is used to 
display, manage and browse the Personal and Shared Instant Cart Sets
available on the system. You can configure the Instant Carts screen to either 
display the Tree View panel all the times or to hide it most of the time such 
that you can access it when you want to, and forget about it the rest of the 
time.

This is done using the Pin Instant Cart Set Tree View button. The two possible 
states are shown in the screen shots below.
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Instant Cart Set Tree View Unpinned
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Instant Cart Tree View Pinned

Note the two different states of the icon on the Pin button.

 Unpinned

 Pinned

As you will see, when the Tree View panel is unpinned, it basically disappears 
and the Instant Carts take up the majority of the Instant Carts screen. In this 
configuration, you use the Available Sets button to ‘drop down’ the Tree View 
panel.

The Tree View panel drops down over the top of the left hand row of Instant 
Carts. You can select the Instant Cart Set you want to switch to by clicking on 
it in the Tree View. When you do this the Instant Carts screen will switch to 
show the new Instant Cart Set and the Tree View Panel will disappear again 
revealing all of the Instant Carts. You can also close the Tree View Panel by 
clicking elsewhere in the Instant Carts screen.
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The Available Sets Button

The Available Sets button is used to access the Tree View panel when it is in 
unpinned mode. In this mode, the Tree View is hidden most of the time and is 
only accessed by the user when they want to use it (see above). This is done 
via the Available Sets button. 

Click on the Available Sets button to ‘drop down’ the Tree View panel. Select 
the Instant Cart Set that you want to view by clicking on it and the Instant Cart 
Set will be displayed and the Tree View panel will disappear again.

Current Instant Cart Set Name

This panel displays the name of the Instant Carts Set that is currently active 
on the Instant Carts screen.

Cart Description

Once an Instant Cart has a Cart attached to it, the details of the Cart are 
displayed on the Instant Cart in question. The Description segment of the 
Instant Cart shows the three primary description fields for the Carts. These 
are:

 Title – The Cart’s title.
 Artist – The Cart’s artist(s).
 Description – Miscellaneous information.

The background colour and text information is also adopted by the Instant 
Cart from the linked Cart.

Intro Time

This displays the Intro time (if one is set) for the Cart that is attached to the 
Instant Carts. For more details on Intro Times see Chapter 2 – Intro Time.

Overall Length

This displays the overall length of the Cart that is attached to the Instant Cart. 
If the Cart has an Extro set then the Overall Length will be defined as the time 
from the beginning of the audio file to the Extro point. If no Extro is available 
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then the Overall Length is defined as from the beginning of the audio file to
the end of the audio file.

Cart Number

This displays the Cart Slot Number for the Cart that is attached to the Instant 
Cart.

Instant Cart Number / Remove Cart from Instant Cart

This is a dual purpose element. Firstly, it is used to show the number of the 
Instant Cart. This is the number on the keyboard that you need to press to 
trigger the Instant Cart, so for example, in the screen shot below, is Instant 
Cart 14 and pressing the 14 key on a Myriad keyboard or the <Shift> + <4> 
keys on a normal keyboard will trigger the Instant Cart.

The other role for this element is as a mechanism used to remove the Cart 
from the Instant Cart.

If you click on Instant Cart Number then the Cart that is attached will be 
removed from the Instant Cart leaving it blank.
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Firstly you will be asked to confirm that you want to remove the Cart from the 
Instant Cart.

If you click on Yes then the Cart will be removed from the Instant Cart leaving 
it blank.

NB: Please note that this will not remove the Cart from the Audio Wall.

Working with Instant Carts

In the previous section we looked at the basic Instant Carts screen layout and 
the facilities it offers. In this section we will concentrate on how to use Instant 
Carts and how to configure them for your needs.

Assigning Carts to Personal or Shared Instant Carts

Once a Cart is assigned to an Instant Cart, that Cart is played automatically 
whenever the Instant Cart is triggered by either a mouse click or keyboard 
press (see Triggering Instant Carts).
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Assigning Carts to Instant Carts is actually a very simple process. You can 
drag Carts from the Audio Wall, the Audio Browser, the Database screen or 
the Log screen directly onto Instant Carts. Basically, you can drag Carts from 
almost any source but by far the most common method is to use the Audio 
Browser which can be accessed via the Carts button on the Instant Carts 
screen.

To assign a Cart to an Instant Cart using the Audio Browser, follow these 
steps:

1. Make sure that you are logged into Myriad with a Username that has 
sufficient rights to modify Shared Instant Carts (if it is Shared Instant 
Carts that you wish to modify). 
NB: Users always have rights to modify Personal Instant Cart Sets.

2. Switch to the Instant Carts screen using the Main Tab Strip.
3. Use the Instant Cart Set Tree View panel to select the Personal or 

Shared Instant Cart Set that you wish to work with.

In this example we will assume that we wish to assign a Cart to an 
Instant Cart in the ‘Liam’s Set’ Instant Cart Set which is located under 
the Personal section of the Tree View panel. 

When you click on the Instant Cart Set that you wish to work with, the 
Instant Carts for that Set are displayed in the main section of the 
screen.

NB: If the Tree View panel is ‘unpinned’ then it may not be visible at 
this stage. If the Tree View panel is not visible, click on the Available 
Sets button to ‘drop’ it down.
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Once you are happy that you have selected the Instant Carts Set that 
you wish to work with, you are ready to move on to the next step.

4. Next, click on the Carts button to access the Audio Browser. The Audio 
Browser should be considered as a ‘cut down’ version of the Audio 
Wall screen and it is used throughout Myriad whenever access to Carts 
is needed. In this case we will be using the Audio Browser to view the
Carts on the Audio Wall and to ‘drag’ a Cart onto the target Instant 
Carts.
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TIP: As you can see from the screen shot above, the Audio Browser 
has opened in Standard mode but in this case we need to drag Carts 
from the Audio Browser onto the Instant Carts screen, therefore we 
need more screen space, so we will switch to Slim Cart mode to make 
more space. This is not an essential step as you can drag Carts onto 
Instant Carts from any of the three Audio Browser view modes; this will 
just make the job of explaining it easier.

So now the screen looks more like this.
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We can move the Audio Browser around on screen to give us access 
to the Instant Carts screen behind and if you are working on a dual 
screen system, you can always move the Audio Wall on to the other 
screen.

NB: Myriad remembers the mode last used for the Audio Browser on a 
per User basis so if you switch to this mode, it should remain like that 
next time you use the Audio Browser.

5. Use the Audio Browser to find the Cart that you want to assign to the 
Instant Cart. You have several options to help you do this. These 
include:

 Scroll around the Audio Wall using the <Page Up> / <Page 
Down> keys or onscreen buttons.

 Jump to a specific Cart by typing in the Cart Slot Number in to 

the Jump To field and then clicking on the Jump To button .
 Use the Find field to type in a name or phrase to search for and 

then click on the Start Search button .

The Audio Browser offers a great many different options for navigating 
and searching the Audio Wall. For more details on the Audio Browser 
and how to use it, please refer to Chapter 7 – The Audio Browser.
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In this case we will assume that the Cart that we want to assign to the 
Instant Cart is already visible on the Audio Browser.

6. Next decide which Instant Cart you want to assign the Cart to. In this 
example we will assume that we wish to assign Cart 3 to Instant Cart 
10. To do this, simply drag the desired Cart onto the target Instant Cart. 

When you drop the Cart on to the target Instant Cart, the Cart is 
assigned to the Instant Cart and the Cart details are displayed. The 
Audio Browser remains open.
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7. You have now assigned your first Cart to an Instant Cart. The Audio 
Browser remains open to allow you to assign additional Carts to Instant 
Carts or you can click on the ‘X’ in the top right hand corner of the 
Audio Browser to close the Audio Browser window.

Playing Instant Carts

You can play an Instant Carts using one of the following methods:

 Keyboard Number Keys – Use the keyboard number keys <1 to 0> to 
play Instant Carts 1 to 10 and <Shift> + <1 to 0> to play Instant Carts 
11 to 20.

 Click On The On Screen Instant Carts – You can also use the left 
mouse button to trigger Instant Carts to play instantly.

Removing Carts from Instant Carts 

Assuming that you have the access rights to do so, you can remove Carts 
assigned to Instant Carts leaving the Instant Carts blank. This is done by 
clicking on the Instant Cart Number / Remove Cart from Instant Carts 
indicator which is located in the top right hand corner of the Instant Cart.
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If you click on this indicator, you will be asked to confirm that you wish to 
remove the Cart assigned to the Instant Carts.

If you click on Yes then the Cart will be removed from the Instant Cart leaving 
it blank.

NB: Please note that this will not remove the Cart from the Audio Wall, only 
from the assignment to the Instant Cart.
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If you try to play an empty Instant Cart by either pressing the keyboard 
shortcut or clicking on it, Myriad will ignore the request as there is no Cart to 
play for that Instant Cart.

Adding a New Instant Cart Set

Instant Cart Sets are groups of 20 Instant Carts that can be either Personal 
(just available when you are logged in) or Shared (available to all Users on all 
Myriad workstations). 

To add a new Instant Cart Set, follow these simple steps:

1. Click on the Instant Carts tab to switch to the Instant Carts screen.
2. Click on either Personal or Shared in the Instant Carts Set Tree View 

section to select whether you wish to add a Personal or Shared Instant 
Cart Set. In this example, we will add a new Instant Cart Set to the 
Shared section.

3. Click on the New button on the Main Tab Strip or if you prefer, right 
click on the Instant Carts Set Tree View panel and select Add Set from 
the right click menu.
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4. Type in the name for the new Instant Cart Set.

5. Press the <Enter> key on the keyboard once you have finished typing. 
6. You have just created a new empty Instant Carts Set.

Renaming an Existing Instant Carts Set

You can also rename an existing Instant Cart Set using the following the steps 
below.
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NB: You can always rename Personal Instant Cart Sets but you will need to 
be logged in with a Username that has sufficient access rights to rename a 
Shared Instant Cart Set.

1. Click on the Instant Carts Set that you want to rename in the tree view 
section to make sure it is highlighted (shown in blue with white text).

2. Either, click on the Rename button on the Main Tab Strip or right click 
on the Instant Carts Set and then select Rename Set from the right 
click menu.
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3. Type in the new name for your Instant Carts Set and then press 
<Enter> when you have finished.

4. You have just renamed an existing Instant Carts Set.
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Deleting an Existing Instant Carts Set

CAUTION! You will need to be logged on as a User with enough access 
rights to perform this operation. Once you have deleted an Instant Carts Set 
you cannot recover it. However, deleting Instant Cart Sets does not affect the 
Carts that the Instant Carts within the Set point to so you will not lose any 
Carts or audio from the Audio Wall.

To delete an Instant Cart Set follow these steps:

1. Click on the Instant Carts Set that you want to delete in the tree view 
section to make sure it is highlighted (shown in blue with white text).

2. Either, click on the Delete button on the Main Tab Strip or right click on 
the Instant Carts Set and then select Delete Set from the right click 
menu.
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3. You will then be asked to confirm that you wish to delete the selected 
Instant Carts Set. Click on Yes if you wish to proceed.

4. You have just deleted an existing Instant Carts Set.

Mini Mode Instant Carts

In Chapter 2 we looked at the Mini Mode Instant Carts configuration, which is 
where the Instant Carts are displayed (in a cut down form) on the main Audio 
Wall screen.

Although this configuration was covered in some detail in Chapter 2, it is 
worth mentioning here that if you turn on the Mini Mode Instant Carts (View 
Menu > Display Instant Carts) then the Mini Mode Instant Carts are also 
displayed on the Instant Carts screen.
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This has no real bearing on the operation of the Instant Cart screen and is 
only mentioned to avoid confusion.
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Chapter 3 Summary

In this Chapter we have looked at the concept of Instant Carts and how they 
are represented by the Instant Carts Screen in Myriad. We have seen how to 
use and interact with the Instant Carts and how we can use and manage the 
Instant Carts themselves. 

The key things to take from this Chapter are:

 Instant Carts are shortcuts to specific Carts on the Audio Wall.
 Instant Carts can be played at any time by pressing the corresponding 

number keys on a standard or customised Myriad keyboard.
 Instant Carts are arranged into groups of twenty which are known as 

Instant Cart Sets.
 Instant Cart Sets can be either Personal (to the User logged in) or 

Shared (for all Users on all workstations).
 You can assign Carts to Instant Carts using the Audio Browser or any 

of the other main screens in Myriad where Carts can be dragged from 
into the target Instant Cart.

 You can manage your Instant Cart Sets using the Main Tab strip 
buttons or the right click menu on the Tree View panel.

 The selected Instant Cart Set determines which Carts get played when 
an Instant Cart is triggered, even when Instant Carts are not visible on 
screen.
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Chapter 4 – The Database Screen

In this Chapter we will concentrate on the Database screen and look at how it 
offers a powerful alternative to the Audio Wall when looking for and working 
with Carts.

By the end of this Chapter you should be familiar with the following topics:

 What the Database screen is and what it can be used for.
 The general layout of the screen and the function of the key 

components.
 How to use the Database screen to browse and search for Songs and 

Links on your system.

What Is The Database Screen?

The Database screen is usually only used in Myriad systems that also use 
AutoTrack or AutoTrack Pro for scheduling Songs, Links and station output. 
Essentially the Database screen offers access to the AutoTrack and 
AutoTrack Pro Song and Link databases which in turn allow Users to search 
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and browse the Songs and Links on the system using the categorisation 
structures that the station employs.

In everyday terms that means that if you are looking for a Song to play and 
you want it to be from the station’s ‘A List’ then you can use the Database 
screen to browse all the Songs in the ‘A List’ category and select the one you 
want to use.

The Database screen is not limited to just AutoTrack and AutoTrack Pro 
users. Stations that use other 3rd party scheduling systems can still employ 
the Database Screen in one of three different ways (depending on the options 
you have selected for your Myriad system).

 Disable – If you cannot, or do not want to, use the Database screen
you can disable it. Once disabled, switching to the Database Screen 
will present the User with a panel telling them that the Database is 
currently not enabled.

 Using Cart Ranges – This allows you to define special ranges of Cart 
Slot Numbers for Songs and Links. The Database will then list the 
Carts in these ranges as either Songs or Links as appropriate.

 Import the 3rd Party Music Database (Advanced Tool Pack Only) –
This option is only open to Myriad systems that have the optional 
Advanced Tools Pack. One of the tools in the Advanced Tools Pack 
allows you to manually import your Songs database from 3rd party 
scheduling systems such as RCS Selector™. In order to do this, you 
need to run a specific report in Selector and save the results to a text 
file. The Import tool in the Advanced Tool Pack can then import this 
text file and update the Database screen accordingly. Unlike when 
using AutoTrack or AutoTrack Pro, you have to manually update the 
Database periodically in order to keep it current but it does provide a 
useful way of accessing the advantages of the Database screen even 
when you are using a 3rd party scheduling system.

The Advanced Tools Pack offers a range of powerful and useful tools 
designed to allow you to expand your Myriad system’s functionality and 
flexibility. For more details on the Advanced Tool Pack and how to add 
it to your system, please contact sales@psquared.net or check out the 
P Squared web site (www.psquared.net).

The Database Screen General Layout

The Database general screen is split into two areas. The left panel shows a 
‘Tree View’ of the Song and Link Categories and can be used to navigate to a 
specific Category to view the Songs or Links in that Category.

Above that are the Search Criteria and Search Options which are used to 
search for an entry in the Database that matches the search criteria and 
selected options.
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 Search Criteria – Type in the word or phrase that you wish to search 
for.

 Find – Click on the Find button to begin the search of the Database.
 Search Options – Offers a range of options for narrowing the search 

results.
 Category Tree View Navigation – Select the Songs / Links listed by 

Song / Link Category by using the tree view.
 Song / Link List – Shows the results of the Search Criteria or the 

Song / Links in a selected Category.
 Cart Slot Number – The Cart Slot Number associated with entries in 

the Database.
 Length – The overall duration of the Cart associated with a Database 

entry.
 Category – The Category that a Database entry resides in.
 Artists – Shows the Artist name (if applicable).
 Item Title – Shows the Database entry Title information.
 Play Song / Link Icon – Clicking on this icon will play the Song or Link 

in a free Cart Player.
 Main Tab Strip – Used to switch between the major screens in Myriad. 

Also used to access context sensitive tools on each major screen.
 Legacy Button (not on by default) – Imports Database info from 

older AutoTrack v2.6.x scheduling system (only needed if using 
AutoTrack v2.6.x).

 Edit Button – Opens the Cart associated with the highlighted 
Database entry for editing using the SmoothEdit window.

 Cue Button – Loads the Cart associated with the highlighted Database 
entry in to a free Cart Player ready to be played. NB: You can also drag 
Database entries into the Cart Players using the left mouse button.
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 Details Button – Displays the Item Details window which is a summary 
of all the Cart, Database and Notes information for a Cart or Database 
entry.

The main section of the Database screen shows a list of all the entries in the 
Database that match the search criteria or are in the selected Category. This 
list is organised into columns and can be sorted by any of the categories by 
clicking on the column headers. As with all the main screens in Myriad, the 
Main Tab strip completes the screen layout and offers access to a number of 
tools and options via the buttons. The elements that make up the Database 
Screen are discussed in more detail below:

Search Criteria

The Search Criteria field is used to type in a word or phase to search the 
Database for; when you perform a search of the Database, Myriad looks at a 
range of information for entries that match your Search Criteria. These 
include:

 Title
 Artist
 Year
 Notes
 Copyright Details

To set the Search Criteria, type a word or phrase that you wish to search for 
into the ‘Search For’ box.
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You can also use the drop down list to view and select words that you have 
searched for recently. Once you are happy with the word or phrase that you 
want to search for, click on the Find button or press the <Enter> key on the 
keyboard.

To return to a list of all the Songs or Links in the Database, or a selected 
Category, select <All Items> from the drop down list or ensure that the Search 
For box is empty when you click on the Find button.

The Find Button

The Find button is used to start searching through the Database for the word 
or phrase entered into the Search For box.

When you click on the Find button, Myriad performs a fast search of the 
Database and displays the results almost instantly in the Song / Link List area. 
Because of the speed with which the Database is searched, there is no need 
for a progress bar or cancel button.

You can also trigger a search by pressing the <Enter> key on the keyboard 
while the Search For field has focus (i.e. directly after typing in your search 
criteria). You can also use the <Alt> + <F> keys to do the same thing.

Search Options

The Search Options panel allows you to specify how Myriad should search 
the Database when using your Search Criteria. 
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Your search can be refined using the following options and you can toggle the 
various options on and off by clicking on them to tick the relevant boxes.

General Options – Search Notes

The Search Notes option allows you to toggle whether or not Myriad will 
search additional Notes for key words or phrases when doing a search. These 
are the Notes that have been imported from your AutoTrack or AutoTrack Pro 
Database so they may be different to the Notes that are attached to Carts on 
the Audio Wall.

General Options – Search Copyright

The Search Copyright option allows you toggle whether or not Myriad will 
search additional Copyright for key words or phrases when doing a search. 
These are the Copyright details that have been imported from your AutoTrack 
or AutoTrack Pro Database so they may be different to the Copyright details
that are attached to Carts on the Audio Wall.

Text Options – Search Title

The Search Title option allows you to toggle whether Scoop will include the 
item Title field when searching the Database for a Song or Link that matches 
the Search Criteria.

Text Options – Search Artist

The Search Artist option allows you to toggle whether Scoop will include the 
item Artist field when searching the Database for a Song or Link that matches 
the Search Criteria.

Text Options – Search Year

The Search Year option allows you to toggle whether Scoop will include the 
item Year field when searching the Database for a Song or Link that matches 
the Search Criteria.

Exclude Items – Played Recently

As we have already seen in Chapter 2, Myriad can be configured to mark 
Carts on the Audio Wall that have been played within a specific time period. 
Once a time period has been set within which you wish to warn Users that the 
Cart has been played, any Carts on the Audio Wall that have been played
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within that period will display the Recently Played icon. Hovering over this 
icon will show you when the Cart was played.  This prevents the User from 
repeatedly playing a Cart within a given period.

If you tick the Exclude Items Played Recently option in your search, Myriad 
will cross reference the Songs and Links displayed in the Song / Link List, with 
the corresponding Cart Numbers and exclude any Songs or Links that refer to 
Carts that are currently marked as having been played recently.

This means that you can look for a Song or Link from a specific Category 
using the Database whilst filtering out items that are linked to Carts that have 
been played recently.

NB: This only applies to Carts played on this workstation so it will not filter 
Carts played in another studio.

Category Tree View Navigator

The Category Tree View Navigator (or the Tree View as we will refer to it from 
now on) is used to provide a fast and simple way of navigating the Database 
and restricting lists of Items listed in the Song / Link List area.
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The Tree View panel works in a similar way to Windows Explorer in that Song
and Link Categories are represented by folders which can be expanded by 
clicking on them.

All Songs

The All Songs section of the Tree View panel is used to browse and navigate 
through all the Songs that are stored in the Database.

When dealing with Songs, you can choose the following folders to expand.

 All Categories – When this folder is selected, all Songs will be listed in 
the Songs / Links List area, regardless of Category. Clicking on this 
option also expands the Tree View to show the individual Category 
folders.

 Category Folders- You will also have a folder for each Category that 
you have defined in AutoTrack, AutoTrack Pro or Selector™ (if you are 
using the Advanced Tools Pack to import a Selector database). You 
can click on one of these Categories and the Song / Link List area will 
update to only display the Songs that reside within that Category.
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You can view the details for a Song by double clicking on it in the Song 
/ Link List area. You can also play the Songs using the Cart Players by 

clicking on Play icon. 
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When you expand a Category folder the Songs in the Category are 
displayed in the main Songs / Link List area but a list of Artists within 
that Category are also listed in the Tree View panel. To view the 
Song(s) for an Artist in the expanded Category, click on the Artist in the 
Tree View.
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 All Artists – The final option in the Songs section of the Tree View is 
the All Artists option which expands to show a full list of all the Artists in 
the Database (regardless of Category). You can use this to browse 
through the Artists that you have listed in the Database and by clicking 
on an Artist, you can see the Song or Songs that you have in the 
system for that Artist.

In the above example, the All Artists section is expanded and Britney 
Spears is highlighted. We can see from the Songs / Links List area that 
Britney has two Songs in the Database.

All Links

Moving on to the All Links section of the Tree View, this section is used to 
browse and navigate through the Links section of the Database.
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Under the All Links section you have the following options:

 All Categories – As with the All Songs section, the All Categories 
folder is used to view all of the Links in the Database regardless of 
what Category they are in. Clicking on this option also expands the 
Tree View to show the individual Category folders.

 Category Folders - Underneath the All Categories folder there is a 
folder for each Link Category stored in your Database. If you click on 
the specific Link Category folder, the Links that are specified in 
AutoTrack or AutoTrack Pro as being in that Link Category are 
displayed in the Song / Link List area.

To view the details of a Link, simply double click on it in the Song / Link 
List area.
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You can also play the Links using the Cart Players by clicking on the

Play icon  in the Song / Links List area.

Search Results

The final option on the Tree View panel is the Search Results folder which is 
used to view the results from the most recently performed search of the 
Database. In the example below, we have done a search of the database 
using the Search Criteria ‘minogue’ and as you can see; several songs by 
both Kylie and Dannii Minogue have been listed.
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Now if we were to click on one of the Song or Link Category folders or All 
Songs / Links then the Song / Link List area would update to display the 
information accordingly but we could switch back to viewing the ‘minogue’ 
results by clicking on the Search Results folder.

NB: The Search Results section is cleared if Myriad is restarted or you log off
the system.

You can combine any of the Tree View Navigator options with any of the 
Search Options to create more powerful and specific Search Results.

Song / Link List Area

The Song / Link List Area dominates the centre of the Database screen and is 
used to display a list of Songs / Links that match the Search Criteria or are
contained in the selected folder in the Tree View panel (or both).

The list of Songs or Links displayed in the Song / Link List area is updated in 
real time as you select new folders using the Tree View panel or use the 
Search facilities.
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The Songs / Links displayed are organised into columns:

 Play Item - The Play column is used to display the Play icon beside 
each item listed. If you click on the Play icon for an item, the Cart that 
the Song or Link refers to will be automatically loaded and started in a 
free Cart Player.

 Item Title – The Item Title column displays the Item Title for the Songs 
and Links in your Database. Please note that the Item Title in the 
Database may differ from the Title field on the Audio Wall Cart. That is 
because the Item Title displayed is taken from your AutoTrack or 
AutoTrack Pro database (or Selector™ if you are using the Advanced 
Tools Pack to import the 3rd party database), so if you have updated 
the information in your scheduling system, it is this altered information 
that is displayed.

 Artist / Info – This column displays the primary Artist for Songs or the 
Information field for Links. Both of these fields are originated from 
AutoTrack or AutoTrack Pro and as such might be different to the Artist 
field on the Audio Wall Cart that the Song / Link refers to.

 Category – This column shows the Song or Link Category that the 
Song or Link reside in within your Database. This information is 
automatically imported from AutoTrack or AutoTrack Pro (or Selector™ 
if you are using the Advanced Tools Pack to import the 3rd party 
database).

 Length – This column shows the length of the Cart that the Song or 
Link refers to. This information is read from the Audio Wall in real time 
so will reflect any changes made to the Cart even after it has been 
added to your music scheduling system.

 Cart Number – This column shows the Cart Slot Number on the Audio 
Wall that the Song or Link refers to.

By default, the Song / Link List area is sorted alphabetically by Item Title but 
you can alter the way it is sorted by clicking on the column header for the 
criteria that you wish to sort the listed items by.



402

Taking the example below, as you can see, we are currently looking at the 
Songs listed in the ‘Chart’ Category in the Database and by default, they are 
sorted alphabetically by Item Title.

Now let’s assume that it would be far more useful if we could view the Songs 
in the same Category but sorted alphabetically by Artist / Info. Click on the 
Artist / Info column header to alter the way the Songs are displayed.

As you can see, the Song / Link List area updates automatically to sort the 
displayed Songs by the selected column header (in this case Artist).

You can drag Songs or Links directly from the Song / Links List area into the 
Cart Players at the bottom of the screen. 
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You can also drag Songs / Links from the List area into the Log Screen on a 
dual screen system.

Song / Link Details
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Finally, you can also use the Song / Link List area to view the details for a 
Song or a Link. To do this, double click on the Song or Link that you wish to 
view the details for.

When you double click on a Song or Link in the Song / Link List area, the Item 
Details window opens which shows a combination of Audio Wall and 
Database related information. 

The top section (Cart Information) shows information about the Cart that the 
selected Song or Link refers to. This information is lifted directly from the 
Audio Wall so will always be up to date. The middle section (Database 
Information) contains information held within the Database and includes 
information such as the Category that the Item is in and the Year that it was 
released. Then bottom section shows any Notes that are associated with the 
Item.



405

Cart Slot Number

The Cart Slot Number column is used to display the Cart Number of Carts 
associated with Songs and Links in your Database.

You can resort the Items listed in the Song / Link List by Cart Number by 
clicking on the Cart No. column header as indicated in the image above.

Length

The Length column in the Song / Link List Area shows the length of the Carts 
associated with the items in the Database. As with the other columns in the 
Song / Link List Area, you can click on the Length column header to sort the 
Songs / Links listed by the length of the associated Carts.
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Category

The Category column in the Song / Link List Area displays the Song or Link 
Category that the Songs or Links reside in within the Database.

If you use the Category Tree View Navigator to select a specific Category to 
be displayed then all of the Songs or Links displayed will be in the same 
Category.
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As with all the other columns in the Song / Link List Area, you can sort the 
Songs or Links listed by the Category they are in by clicking on the Category 
column header.

Artist / Info

The Artists column displays the primary Artist for Songs and the Info field for 
Links.

As with all of the other columns we have looked at, you can sort the Songs or 
Links displayed in the Song / Link List Area by either Artist or Info (depending 
on whether it is Songs or Links) by clicking on the Artist / Info column header.
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This is particularly useful for Songs as you can list the Songs in the Database, 
a specific Category or that match your Search Criteria, alphabetically by Artist. 
If you click on the Artist / Info column header again, the Songs / Links will be 
sorted in reverse alphabetical order by Artist or Info.

The reason that this column has a dual role is that the Database is effectively 
a copy of your AutoTrack or AutoTrack Pro database (or possibly your 
Selector™ database if you are using the Advanced Tools Pack to import your 
database) and the Links in AutoTrack and AutoTrack Pro do not have an 
Artist field. When dealing with Links, the Artist field is replaced by an 
additional Information (Info) field.

Item Title

As you may expect, the Item Title column is used to display the Title of the 
Song or Links displayed in the Song / Link List Area.

As we have already seen with the other columns, you can sort the Songs / 
Links listed by clicking on the Item Title column header.
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The Item Title field is common for both Songs and Links in AutoTrack and 
AutoTrack Pro so the Item Title column is used for both Songs and Links.

Play Song / Link

The final column is the Play Song / Link column which is basically used to 
allow you to review a listed Song or Link using the Myriad Cart Players.

To review a Song or Link using the Cart Players, click on the speaker icon in 
the Play Song / Link column for the Song or Link that you want to review. The 
Cart associated to that Song or Link will then be automatically loaded into a 
free Cart Player, ready to be played. 
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Simply click on the Play button on the Cart Player to begin playback.

Unlike all of the other columns, clicking on the Play / Song / Link column 
header will have no effect on the sort order of the Songs / Links listed.

NB: You can also click on the Cue button on the Main Tab Strip to achieve the 
same thing.
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Main Tab Strip

The Main Tab Strip is used to switch between the major screens in Myriad 
which are:

 Audio Wall
 Instant Carts
 Database
 The Log Screen
 SmoothEdit

The Main Tab Strip also offers access to a range of Database related tools 
and options in the form of the buttons that reside on the Main Tab Strip when 
the Database tab is selected.

The Legacy Button

The Legacy Button is used to import Database information from legacy 
systems such as AutoTrack v2.6. This button is only visible if it is enabled in 
the Station Database Settings window. To enable this option, click on the 
Settings>Station Database Settings menu option and then make sure the 
General tab is visible on the Station Database Settings window.
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In the Options section (top right of window), tick the Import Legacy Songs and 
Links options to enable the Legacy button on the Database screen.

When you click on Legacy button, you will be asked to confirm that you wish 
to import the AutoTrack v2.6 (or Myriad v2) database. Importing this legacy 
database will overwrite the current information in the Myriad v3 Database.

If you click on the Yes button, the old Myriad / AutoTrack v2 Song and Link 
information will be imported. Once Myriad has finished importing the 
information, a message appears to confirm.
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Using Myriad v3 With AutoTrack v2.6

You should use this option if you are using Myriad v3 with AutoTrack v2.6 as 
only AutoTrack v3 or AutoTrack Pro v3 will update the information in the 
Database screen automatically as part of the schedule / push process.

If you are using AutoTrack v2.6 then changes you make to the Songs and 
Links in your AutoTrack database will not be passed on to Myriad 
automatically so you will have to manually import the legacy information using 
the Legacy button in order for any changes you make (in AutoTrack) to 
appear in Myriad.

If you are using AutoTrack Pro v3 then you will not have to worry about this as 
AutoTrack Pro can be set up to have Myriad v3 as a primary Playout System 
and this will automatically update the Songs / Link information listed in the 
Database screen as part of the schedule / push process.

The Edit Button

The Edit button is used to open the Cart associated with the highlighted Song 
or Link (in the Song / Link List Area) using the SmoothEdit screen. This allows 
you to view and edit the Cart details and the actual audio for the Cart 
associated with the Song or Link.

In this example, you will see that a Song by Holly Valance is highlighted in the 
Song / Link List Area.
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Clicking on the Edit button will cause Myriad to switch to the SmoothEdit 
screen and the Cart associated with the Holly Valance Song will be loaded 
ready for editing.

For details on using the SmoothEdit screen, please refer to Chapter 6 of this 
documentation.

The Cue Button

The Cue button on the Main Tab Strip is used to cue the selected Song or 
Link (in the Song / Link List Area) into a free Cart Player.

Once again, Holly Valance is highlighted in the example below. In this case, if 
we click on the Cue button, the Cart associated with the highlighted Song is 
loaded into one of the Cart Players at the bottom of the screen.
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Once the Cart associated with the Song / Link has been cued, you can click 
on the Play button on the Cart Player to begin playback.
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NB: Clicking on the speaker icon to the left of each Song / Link in the Song / 
Link List Area (Play Song / Link column) will also do the same thing.

The Details Button

The Details button on the Main Tab Strip is used to view the Item Details 
window for the highlighted Song or Link in the Song / Link List Area.

Highlight the Song in the Song / Link List Area and then click on the Details 
button.

This will open the Item Details window for the selected Song (or Link) which is 
an information summary window that combines information about the 
associated Cart as well as pictures, Notes and Database information.
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The top section (Cart Information) shows information about the Cart that the 
selected Song or Link refers to. This information is lifted directly from the 
Audio Wall so will always be up to date. The middle section (Database 
Information) contains information held within the Database and includes 
information such as the Category that the Item is in and the Year that it was 
released. Then bottom section shows any Notes that are associated with the 
Item.

As we saw in Chapter 2, Carts can have several different types of Notes 
attached to them and if you view the Item Details for a Song or Link that is 
associated with such a Cart, the different types of Notes are represented by 
icons along to top of the Notes section.
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In such a case, you can click on the different Notes icons to read each of the 
attached Notes.

NB: You can also view the Item Details for a Song or Link by double clicking 
on it in the Song / Link List Area.

Working with the Database 

In the last section we covered the general layout of the Database screen and 
saw the function of each of the elements that make up the screen. In this 
section we will concentrate more on how to use the Database to get the 
results you want.

Searching For a Song or Link

You can use the Database screen to search for a Song or Link that matches 
your Search Criteria.

This process is very similar to the Find process on the Audio Wall but the 
important distinction here is that we are not searching the Audio Wall, but the 
Database, which should be an up to date copy of your music / link library from 
your music / link scheduling system.

If you are using AutoTrack or AutoTrack Pro, you are searching a copy of the 
AutoTrack database, not the Audio Wall. This means that the Database could 
contain Song or Links that do not exist on the Audio Wall or only include the 
Songs / Links that you use when scheduling. The Options section can be
used to further ‘fine tune’ the results when searching for a Song or Link.

To search for a Song or Link, follow these steps:

1. Click on the Database tab on the Main Tab Strip to ensure you are 
viewing the Database screen.
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2. Click in the Search For box and type in the word or phrase that you 
wish to search the Database for.

NB: You can use the drop down list on this box to view and select 
words or phrases that have been used as Search Criteria recently.

3. Next check out the options section to make sure that the search 
options that you wish to use are selected.

These options are covered in more detail in the Search Options section 
earlier in this Chapter but in brief:

 Search Notes – Include the Cart Notes when searching.
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 Search Copyright – Include the Cart Copyright details when 
searching.

 Search Title – Include the Song / Link Title when searching.
 Search Artist – Include the Song / Link Artist / Info when 

searching.
 Search Year – Include the Song / Link Year when searching.
 Exclude Recently Played Items – Filters out Songs / Links that 

are attached the Carts that are classed as having been played 
recently (a configurable setting – see Chapter 2 – Recently 
Played Cart Icon).

4. Once you are happy with the Search Criteria and Options, click on the 
Find button. Myriad will search the Database for your selected Search 
Criteria and Options and display all the Songs / Links that meet the 
criteria in the Song / Link List Area.

The most recent Search results are retained by Myriad and can be 
viewed at any time by clicking on the Search Results folder on the 
Category Tree View Navigator.

NB: These will be lost if you restart Myriad or when you log out from 
Myriad and another User logs in.
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5. Searching the Database is virtually instant so your search results will 
be displayed immediately.

Sorting Songs / Links in the List Area

Whether you are viewing Songs / Links by Category or you are looking at 
search results, the Song / Links displayed in the List Area can be easily sorted 
in ascending or descending order by any of the main columns by clicking on 
the appropriate column header.

The columns are:

 Item Title – The Song / Link Title.
 Artist / Info - The Song’s primary Artist or the Link’s Info field.
 Category – The Song or Link Category that the item is in.
 Length – The length of the Cart associated with the Song or Link.
 Cart No – The Cart Number associated with the Song or Link.

Clicking on one of these column headers will sort the Songs / Links in 
ascending alphabetical or numerical order (depending on whether is a text or 
numeric field). Clicking on the column header again will re-sort in descending 
order.

Using the Tree View Navigator to View Song / Link Categories

You can use the Database screen to view only Song and Links within a 
certain Song or Link Category.
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Follow these steps:

1. Make sure that the Database screen is selected by clicking on the 
Database tab on the Main Tab Strip.

2. Select the Song or Link Category that you wish to browse using the 
Category Tree View Navigator.

As you click on a Song or Link category, the Song / Link List Area is 
updated in ‘real time’ to display the Songs or Links within the selected 
Category.

3. You can also use the All Artists option to view all the Artists listed in the 
Database.



423

If you click on All Artists then all the Songs in Database are listed by 
Artist. You can also expand the All Artists tree to see a list of the 
Artists. Clicking on an Artist will display all the Songs by that Artist in 
the Database.

4. You can also use the Search Results folder to view the results for the 
most recently performed Database search.

Playing Songs & Links and Dragging Them into the Log Screen

Once you have browsed to or found the Song or Link that you want to use, 
you can do one of the following.

 Play Using A Cart Player – You can play a Song or link any of the 
methods below.

o Highlight the Song or Link and then click on the Cue button on 
the Main Tab Strip. The Cart associated with the Song / Link will 
be cued into a free Cart Player ready to be played.

o Click on the Play Song Link Icon  to the left of the Song or 
Link in the Song Link List Area. This will have the same effect as 
clicking the Cue button.

o Drag the Song / Link directly into a Cart Player.
 Drag Song / Link into Log Screen (dual screen) – If you are running

a dual screen system or you have Myriad configured to operate in dual 
screen mode on a single screen then you can drag a Song or Link 
directly from the Database screen into the Log screen area.

In this example, Myriad is configured to display in dual screen mode on 
a single monitor. We will drag the Britney Spears Song from the 
Database screen directly into the schedule log on the Log Screen.
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The ‘bar’ on the Log Screen shows where the Song will be dropped in 
to the schedule log. Release the mouse button and the Song is added 
to the schedule log.

You can also drag a Song directly into a free Cart Player if you wish to 
play the Song manually.



425

Chapter 4 Summary

In this Chapter we have examined what the Database Screen is, the 
information it provides and the tools it offers. We have seen how the 
Database is effectively a copy of your Song / Link scheduling system 
database and that certain systems (like AutoTrack and AutoTrack Pro) will 
automatically update the Myriad Database as part of the music scheduling 
process.

We have seen how to search the Database using a number of different 
methods and finally how we can use the Database screen to play Carts or to 
add Songs and Links to the schedule Log. 

The key Database features are:

 The Database is a copy of your music and link scheduling database.
 It allows you to search the Songs and Links available to you using 

Song / Link Categories and a number of additional criteria not available 
when using the Find Cart facilities on the Audio wall.

 You can search the Database for a word or phrase.
 You can browse the Songs and Links by Category or Artist using the 

Category Tree View Navigator.
 You can view a summary of the Song or Link by double clicking on it or 

highlighting it and pressing the Details button.
 You can play Carts associated to Songs or Links by highlighting it and 

clicking the Cue button or clicking on the Play icon to the left of the 
Song or Link.

 You can drag a Song or Link directly into a Cart Player or into the Log 
Screen (on dual screen configured systems).

In the next Chapter we will move on to look at the Log Screen in detail. The 
Log Screen is key to Myriad as it is the principle method of providing both Live 
Assisted and fully Automated output from Myriad.
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Chapter 5 – The Log Screen

In this Chapter we will examine the Log screen and its role within Myriad. We 
will look at the general layout of the Log screen and the functions of its 
constituent elements. We will then concentrate on how to use the Log screen 
in both Live Assist and Automated situations.

If you are using Myriad for Automation or Live Assist program delivery then 
this will probably be the most important Chapter to read and understand as 
the Schedule Log is crucial to working with Myriad.

What Is The Log Screen?

The best way to think of the Log screen is as a playlist or running order that is 
used to deliver Live Assisted or Automated playout. Basically, the Schedule 
Log (as we will refer to it) is a list of Carts and events that make up your 
station output. Myriad then follows this list of Carts and events and either 
helps you to present them live (Live Assist) or plays them all automatically 
(Automation). 

In simple terms, imagine you had never done a radio show before and 
somebody asked you to prepare a show ready to be presented ‘live’ on air. 
You may well start with a piece of paper and a pen and sketch out an outline 
for your first show. It might look a little like this:

My New Show
3 minutes of news
Introduce myself
Play record
Play record
Play jingle
Play Advert
Live link
Play Record
Read traffic and weather
Play jingle
Play record
Etc…….

This would be a great start but you might want to ‘flesh out’ your plan so that 
you know exactly what you are going to play and you can get all the CDs and 
jingles together before your first show. You might end up with something like:
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My New Show
3 minutes of news – News bed – Mini disc 3 track2
Introduce myself – My name is Liam and welcome to Hot FM Drive
Play record – Pussycat Dolls – Don’t cha
Play record – Kelly Clarkson – Since You’ve Been Gone
Play jingle – Hot FM Sweeper – Mini Disc 1 track 1
Play Advert – Mini disc 4 – Tracks 1 to 3
Live link – Entertainment news – Holly Valance will be visiting our 
area next week for a concert at the Arena – tickets available from 
01233 556627
Play Record – Oasis – Wonder Wall
Read traffic and weather – Get from local paper and traffic link.
Play jingle – Hot FM Great Music Mix – Mini disc 1 track 5
Play record – Green Day – September Comes
Etc…….

This is a Schedule Log. If you were to prepare your show in this much detail, 
you could get together all the music and jingles you needed in advance, 
practice your links and print out all the details. With this much preparation, 
your show is bound to go well. 

It is to provide this level of preparation week in and week out that systems like 
Myriad were invented, and the Log screen is the part of Myriad that allows you 
to do this.

But before we give Myriad all the credit, it is important to remember that music 
and link scheduling systems such as AutoTrack and AutoTrack Pro are the 
systems that actually generate the Schedule Log based on the frameworks 
that you provide. In effect, you give AutoTrack the basic outline for the show 
(your first draft) along with some rules about how you want your station to 
sound and it produces the ‘fleshed out’ version (the final draft above) which is 
what it then passes on to Myriad.

Myriad then allows you to add to and edit the Schedule Log, changing things 
where you see fit, and customising it to your needs. It is common (but not 
essential in Live Assist shows) that all of the music and jingles that will be 
used in your show will be Carts on the Audio Wall, which means that you will 
not have to prepare the CDs and mini discs as in our example.

So what we end up with is a Schedule Log that is (usually) generated by a 
music scheduling system such as AutoTrack Pro. This is then fed into Myriad 
so that you can see all of the Jingles, Songs, Adverts and events that make 
up your show, on the Log Screen. Much of the content will also be on Myriad 
so typically all you will have to do is concentrate on your links and the external 
elements such as travel and weather. You can also view and edit the 
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Schedule Log both before your show and while you are on air. You can even 
record voice links into the Schedule Log so you can nip out for a pizza!

This all sounds very complicated but is very simple in practice. The Log 
screen contains the Schedule Log which is a list of Carts and events that are 
played in order. Each show in the Schedule Log is an hour long and the 
Schedule Log is a continuous list that goes as far ahead as your scheduling 
system has scheduled.

NB: You can also manually build a Schedule Log by dragging Carts in from 
the Audio Wall, though this is a time consuming job.

The Log Screen Layout at a Glance

As we touched on in the last section, the Log screen is used to display and 
work with the Schedule Log which is effectively a list of Carts to play and 
events to happen in a given show. This Schedule Log (or Log as we will refer 
to it) can be used in one of two ways:

 Live Assist – This mode is used when you are doing ‘live’ shows with 
a presenter. In Live Assist mode, the Carts that appear in the Log are 
cued by Myriad to make life easy for the presenter but the presenter 
retains control over when each item in the Log is started. They do have 
the option to hand over control to Myriad at any time.

 Automated – This mode is used for automated playout when no 
presenter is present. Once again, the Log contains a list of all the Carts 
that need to be played but Myriad will automatically cue and play the 
Carts in the order that they appear in the Log. In this mode, a presenter 
can still move the order of the Log and add and remove Items from the 
Log but they cannot instruct Myriad to ‘stop’ at the end of an Item 
before starting the next.

There are additional variations on these two fundamental modes but these will 
be covered in more detail later.

The Log screen is dominated by the Log itself which takes up the majority of 
the centre of the screen. In addition, the Main Tab Strip offers a range of tools 
and facilities, the Mini Segue Editor allows you to review and adjust 
automated segues (or mixes), the Notes area displays Cart Notes or Link 
Scripts and the navigation tools to the right of the Log allow you to scroll up 
and down the Schedule Log area.

The general Log Screen layout is shown below. The Log screen includes a lot 
of information so in order to make the diagrams below as clear as possible, 
the general layout has been broken into three separate diagrams.
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The General Screen Layout

 The Power Button – This is used to toggle between the default Active 
Playout Mode for the currently selected section of the Schedule Log 
and Standby mode.

 Log Date / Time – Shows the date and time of the section of the 
Schedule Log that is currently being viewed on the Log Screen.

 Playout Mode – These buttons allow you to switch between Myriad’s 
five Active Playout Modes which are Live, Auto, AutoFade, Preview 
Live and Preview Auto.

 On-Air / Off Air Control – Allows you to take On Air Control or release 
On Air Control.

 The Schedule Log – Displays the Schedule Log which is a list of 
Carts, Links and events that are scheduled to be played.

 Current Time – Shows the current PC system time (and date 
optionally).

 Jump To Start – Moves the highlight cursor on the Schedule Log 
window to the start of the currently selected hour. Also doubles as 
‘Prev’ button which jumps to the start of the previous hour in the 
Schedule Log but only when you are on an Hour Start Log Item.

 Page Up – Scrolls up the Schedule Log a page at a time.
 Home – Returns the highlight cursor to the Log Item that is currently 

playing or the Log Item that would be playing if the workstation were in 
an Active Playout mode.

 Page Down - Scrolls down the Schedule Log a page at a time.
 Jump To Next – Jumps the highlight cursor to the Hour Start Marker 

for the following hour in the Log.
 Trash Can / Undo – You can drag Log Items directly from the Log into 

the Trash Can to delete them from the Log (but not from the Audio 
Wall). The Undo button returns the last Log Item deleted, back to the 
Schedule Log.
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 Mini Segue Editor – Used to review and alter the segue between Log 
Items.

 Over / Underrun – Shows whether the remaining Log Items will
overrun or underrun with respect to the next Absolute Time Event in 
the Log (or the end of the hour, whichever is first).

 Time Remaining – Shows a total of all of the audio Log Items left in 
the current hour.

 Next Segue – Shows the time remaining until the next segue is due.
 Notes – Display Cart or Log Event Notes. You can click on the ‘i’ icon 

to open the Notes in a floating window.
 Main Tab Strip – Allows you to switch between the major screens in 

Myriad and also has context sensitive buttons depending on the screen 
you are viewing.

 Go – Moves on to the next Log Item in the Schedule Log, optionally 
fading out the currently playing Log Item.

 Preview – Loads an independent version of the highlighted Log Item 
into the preview Cart Player for reviewing.

 Pre-Cue – Loads the next Log Item in the Schedule Log, into a free 
Cart Player (this happens automatically before the Log Item is actually 
needed anyway).

 Suggest – Offers a list of Songs or Links in the same Song / Link 
Category as the highlighted Log Item (Autotrack or AutoTrack Pro 
only).

 Carts – Opens the Cart Browser, a mini version of the Audio Wall used 
to drag Carts from the Audio Wall into the Schedule Log when working 
with a single screen configuration.

 Seg / Edit – Toggles into full Segue Editor Mode which is used for 
Voice Tracking and adjusting the fade points on segues.

 Goto – Allows you to select a time and date to jump to in the Schedule 
Log.

Please note that the above layout refers to the Log Screen running on a single 
screen Myriad system but if you have a dual screen system then the Log 
Screen will be displayed on the right hand side at all times. The only other 
difference is that the Log Screen Main Tab Strip moves to the right hand side 
of the right hand screen.
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Log Item General Layout

 Hook Icon – Indicates whether the Log Item has a Hook set on the 
Cart it refers to.

 Info Icon – Indicates whether the Log Item has additional text 
information attached.

 Currently Highlighted Log Icon – The double height (blue by default) 
bar indicates the Log Item that is currently highlighted in the Schedule 
Log. You can move this up and down by using the mouse wheel or 
cursor keys.

 Ending Type – Shows the Ending Type that has been specified for the 
Log Item (see Chapter 2 – Carts – Cart Layout – End Type).

 Segue Type – Indicates what will happen at the end of the Log Item.
o Green – Automatically segue on to the next Log Item.
o Yellow – Sweep the Log Item into the Intro of the next Log Item.
o Red -  Stop at the end of the Log Item and wait for the presenter 

to press the Go button (Live & Preview Live playout modes 
only).

 Item Length – Displays the length of the Log Item (to Extro point).
 Fixed Log Item – If the Item Length appears in red text then it is fixed 

and cannot be dropped or faded early by Myriad.
 Intro Time – Shows the duration of the Intro for the Cart associated 

with the Log Item.
 Description – Shows the Artist and Title for Songs and general 

description for all other Log Items.
 Estimated Play Time – Shows the time that the Log Item is scheduled

to start playing based on current information.
 Locked Item – Around three seconds before Myriad plays a Log Item, 

it locks it. Once locked, the item cannot be moved or deleted.
 Log Item Type Icon – Shows the type of Log Item for each entry.

Mini Segue Editor General Layout
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 Previous Log Item – Shows the last viewed seconds of the previous 
Log Item. The top of the slope indicates the Extro point and the end of 
the slope indicates the end of the audio file. 

 Segue Point – Shows the point at which the segue will occur.
 Extro Point (start of slope) – Shows the Extro point on the previous 

Log Item.
 Review Segue / Stop Segue – Click to start playback of the segue. If 

in an Active Playout Mode you will be prompted to close the faders on 
the segue review Cart Players before playback begins.

 Save Segue – You can use your left mouse button to drag the segue 
point to the left or right. When you are happy, click on the Save button 
to save the new segue.

 Currently Highlighted Log Item – The Log Item that is currently
highlighted.

 Intro End (top of slope) – Shows the Intro End point in the currently 
highlighted Log Item.

 Intro Start (bottom of slope) – Shows the start of the currently 
highlighted Log Item.

Full Segue Edit Mode / Voice Tracking Mode

You can toggle into full Segue Edit mode by clicking on the Seg Edit button on 
the Main Tab Strip.
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When this button is pressed, the Segue Editor area on the Log Screen 
expands to allow you to work with the Segue Editor more efficiently and also 
to record and edit voice links in to the Schedule Log.

The Full Segue Editor shares many features with the Mini Segue Editor (see 
above) but also adds a number of new features and facilities.
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 Previous Song – Shows the Song or Log Item prior to the highlighted 
item in the Schedule Log.

 Fade Envelope – Allows you to set the way Myriad will fade out the 
previous Log Item or the Voice Track.

 Review Segue – Allows you to review the segue in the reserved 
Myriad Cart Players.

 Record Voice Link – Starts recording when you are adding Voice 
Tracks to the system.

 Abandon – Abandons the segue edit or Voice Track and returns the 
segue to its original state.

 Save Segue – Saves changes made to the timing and fade of the 
segue and commits Voice Tracks to the Schedule Log.

 Next Track – Shows the next Log Item when Voice Tracking or the 
highlighted Log Item when editing a normal segue.

 Voice Link – Shows the Voice Track when you are working with a 
segue that includes a Voice Tracked link.

We will now look at each of these functions in turn in more detail:

The Power Button

The Power button is used to toggle Myriad between one of the Active Playout 
modes and Standby mode. The best way of thinking of the Power button is 
that it works in the same way as the Power button on your TV. Clicking on the 
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Power button (on the Log screen) will perform the following sequence of 
events:

1. Optionally – Take On Air Control. 
(NB: This will only happen if Myriad has been configured to 
automatically take On Air Control as it enters an Active Playout mode.)

2. Switch to the default Active Playout Mode for the hour that is currently 
visible in the main Log area.

3. Cue the highlighted Log Item (if appropriate) and display the ‘Waiting 
For Go’ message in the Notes area. When you press the Go button (on 
screen or on your Myriad keyboard), the cued Log Item will start and 
you will be in an Active Playout mode.

Once you are in an Active Playout mode, clicking on the Power button will 
have an alternate effect.

1. Switches back to Standby mode, i.e. no Active Playout Mode is 
selected.

2. Removes any cued Log Items from the Cart Players but leaves the 
currently playing Log Item to finish.

We will cover the Active Playout Modes in more detail later, however as a 
brief summary:

 Standby Mode – When in Standby Mode, Myriad will not automatically 
cue or play any Items from the Schedule Log. You can still view, edit 
and add to the Schedule Log but the only way to cue and play Items is 
to manually load them into the Cart Players (by dragging them in) and 
clicking on the Play button for the Cart Player. 
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 Active Playout Mode – When in one of the Active Playout Modes, 
Myriad will treat the Log as being ‘live’ and will work through the Items 
in the Log playing Carts and carrying out instructions in the order they 
appear in the Log. Exactly how it does this is determined by which of 
the Active Playout Modes is selected. The Active Playout Modes are 
outlined below.

Preview Live (off air only)

This mode is only available when the workstation is not On Air and allows you 
to preview the log as if it were in ‘live assist’ mode without making any 
permanent changes to the timing information log. This allows you to practice a 
‘live assisted’ show without affecting the on air log. In Live mode, the user 
controls whether items are automatically or manually segued (mixed) by using 
the Segue Type indicator (green – auto, red – stop).

Preview Auto (off air only)

This mode is only available when the workstation is not On Air and allows you 
to preview a show in automation mode without permanently changing the 
timing information on the log. In Automation mode, all items in the log will 
automatically be segued (mixed) into the next.

Live (on air only) 

The Live mode is only available if the workstation you are working on is 
currently On Air. In Live mode, the presenter controls when Myriad 
automatically segues onto the next Item and when it stops and waits to be told 
to continue. This is controlled by the Segue Type control on each item (red –
stop, green – go) and can be toggled by clicking on the Segue Type icon.

Live mode is the most commonly used mode for presenting live shows as 
Myriad will load each item as you need it but you control how the action flows.

Auto (on air only)

In Auto mode, Myriad will turn all of the Segue Types green (automatically 
segue from one to next) within a given hour and then play through all the 
items in the Log for that hour in an automated fashion.

Auto Fade (on air only)

Auto Fade mode is similar to Auto mode in that it is used to switch all of the 
Segue Types green to play through the hour in automation but the difference 
is that whilst Auto will just play all the items in the Log for the hour, Auto Fade 
will automatically back time the hour so that it ends at the correct time (i.e. the 
end of the hour). It will also work around time critical events (called Absolute 
Time Markers) which allow you to have automated output that can interact 
with time critical events such as external news etc.
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Please note that you can manually switch between Active Playout modes and
Standby Mode by clicking on the Active Playout Mode buttons which run 
along to the top of the Log Screen.

Let’s say you wanted to manually switch to Live mode. Make sure that the 
Myriad Workstation you are working on has On Air Control (as Live is only 
available in this mode) and then click on the Live button. The button will be 
depressed and the Currently Highlight Log Item will be cued ready to be 
played.

To switch back to Standby mode, click on the Live button again and it will ‘pop 
out’. Any cued Carts will be ejected but any Carts that are still playing will be 
left to continue playing to the end or until you manually Eject them.

Log Date / Time

The Log Date / Time indicator displays the date and hour of the section of the 
Log that is currently visible in the main Log area. This means that if you were 
to use the Goto button to jump to tomorrow’s show to review or edit it, 
tomorrow’s time and date would be displayed in this area.

Playout Mode Buttons

We touched on Playout Modes in the Power Button section (see above) but 
we will now look at the role of the Playout Mode buttons in more detail.

Essentially, the Playout Mode buttons are there to perform two functions. 
Firstly, the Playout Mode buttons provide you with a visual indication of the 
Playout Mode that Myriad is currently operating in. This is indicated by the 
currently selected Playout Mode button appearing depressed on screen (see 
below).

The second function of the Playout Mode buttons is to allow you to switch 
between the available Active Playout Modes with a single click.

In the example above, the Live Active Playout Mode is selected which means 
that Myriad is working in Live Assist mode and there is a presenter ‘driving’ 
the show. Now, if the fire alarm went off and the presenter needed to leave 
the studio, a single click on the AutoFade Playout Mode button would switch 
Myriad from Live Assist mode to full Automation mode (AutoFade mode).
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In this mode, Myriad would play all of the remaining Log Items in the hour, 
automatically segueing between them. It would also back time the Log Items 
in the hour, making adjustments to ensure the final Item in the hour finished 
exactly at the ‘top’ of the next hour (as this is a feature of AutoFade mode).

When he returned, the presenter could switch back to Live mode by clicking 
on the Live Playout Mode button.

There are actually five Active Playout modes in Myriad as well as Standby 
mode. Each Active Playout Mode has different attributes and some of them 
are only available when a Myriad workstation has ‘On Air’ control. The Active 
Playout Modes are examined in detail below.

On Air Control Overview

Myriad v3 employs three different types of On Air Control system depending 
on how complicated your broadcast system is and whether you need to 
control external systems such as Myriad STS or OCP. The three possible On 
Air Control scenarios are outlined below.

 Simple On Air Control – This is the simplest On Air Control solution 
and is the default setting for Myriad. In this mode, only one Myriad 
workstation can have On Air Control (i.e. be ‘On Air’) and the On Air 
status is passed from workstation to workstation like a token. So if you 
have two studios and studio 1 is On Air then studio 2 would be Off Air. 
If you wanted studio 2 to be On Air then it could take the On Air Control
token taking studio 1 Off Air. The procedure for taking On Air control 
can be configured such that control must be released before it can be 
reassigned, this removes the possibility of accidentally taking studio 1 
Off Air. In practice, the On Air status is used to determine which Active 
Playout Modes are available and is also used by Myriad when 
compiling ‘play log’ reports and copyright report returns. There is no 
direct communication between the Myriad workstations in Simple On 
Air Control mode.

 Advanced On Air Control – This mode offers a more advanced On 
Air Control configuration and is principally used in stations that need 
Myriad to interact with external systems such as Myriad STS and OCP. 
The reason for this is that Advanced On Air Control includes two way 
communications between the Myriad workstations (and external 
elements such as OCP and STS) but the negative aspect is that it
requires more setting up. Once it is correctly configured, it works in 
exactly the same way as Basic On Air Control from a Users point of 
view.

 No On Air Control – The final option is to use no On Air Control
system which effectively means that Myriad will not track which 
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workstation is On Air and so will not be able to adjust the available 
Playout modes accordingly. This method is not recommended as it 
removes certain safe guards that have been put in place to protect the 
‘live’ content from being compromised by other Myriad workstations. 
For example, when using either of the above On Air Control systems, 
Myriad can be configured so that only the On Air workstation is able to 
edit the Log for the hour that is currently being broadcast (although you 
can override this on a per User basis to still provide the functionality to 
key personnel). If No On Air Control is used then this safety feature is 
also disabled.

There is also a fourth option which is to assume that the Myriad workstation 
always has control. This option should be used for ‘playout’ workstations or 
where you only have a single broadcast studio that is always ‘on air’.

For more information on On Air Control and how to configure it, please refer to 
Chapter 8 – Settings Menu>Myriad Settings> On Air Control tab.

Standby Mode

This is applied when Myiad is awaiting the start of an Active Playout mode. 
Myriad workstations can only be in one of two states, either Standby mode or 
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Active Playout mode. When in Standby mode, Myriad does not actively use 
the Log. It will not cue or play any items in the Log and the only way to play 
Items from the Log is to manually drag them into Cart Players and play them 
yourself. 

In the majority of cases, Myriad workstations that are not in the primary 
broadcast studio (or are playout machines) will spend the majority of their time 
in Standby mode as the Active Playout modes are generally needed for studio 
workstations or PCs that are used for live broadcasts.

Preview Live Mode (Off Air Mode Only)

The first Active Playout mode we will look at is the Live Preview mode. The 
first thing to note is that Preview Live mode is only available on Myriad 
workstations that are set to Off Air, i.e. they do not have On Air Control. 

As you can see in the example above, this Myriad workstation is Off Air (does 
not have On Air Control) so the Playout Mode button options are Preview Live 
and Preview Auto (but not Preview AutoFade).

If you click on the Preview Live button it will switch Myriad into Preview Live 
mode which allows you to listen and review the Log as if it were played out in 
full Live Assist mode but there a couple of key differences. 

When you are reviewing the Log in Preview Live mode:

 Estimated Play Time Does Not Update – When you work with the 
Log in full Live mode, the estimated play times are updated in real time, 
as each segue occurs. This means that if you were to look at 
tomorrows Log and put it into Live mode, the Estimated Play Time for 
each Item in the Log would be replaced with the current time which 
would look very confusing. It would not really matter tomorrow when it 
was played out because Myriad would correct it again at the start of the 
show but it could be very confusing to anyone looking through the Log. 
Preview Live avoids this problem by not updating the Estimated Play 
Time as you preview the Log.

 Log Items Not Marked As Played – When you watch Myriad work 
through the Log in any of the three ‘On Air’ Active Playout modes (Live, 
Auto or AutoFade), you see that as each item in the Log is played, the 
Segue Type marker is superimposed with a tick icon to indicate that the 
Item has been played.
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When you review the Log using Preview Live mode, the Log Items that 
are played are not marked as being played. Again, this means that you 
can preview a show in Preview Live mode without having any adverse 
effect on the Log as a whole.

Preview Live mode does allow you to edit, add and remove Items from the 
Log so it is the ideal mode to use when working with the Log in a non 
broadcast situation.

Preview Auto Mode (Off Air Mode Only)

Just like the Preview Live mode, the Preview Auto mode is only available 
when you are working on a Myriad workstation that does not have On Air 
Control (is Off Air). The Preview Auto mode provides a way of previewing how 
automated shows will sound without adversely affecting the Schedule Log.

Basically, when in Preview Auto mode, Myriad will work its way through all the 
Log Items in the Schedule Log, automatically segueing between each item. 
You can still edit, add and remove Items from the Log but you cannot change 

the Segue Type to be anything other than Automated Segue (  green 
speaker icon) mode.  This is essentially the same as the Auto mode that is 
available on ‘On Air’ machines but just as with Preview Live, Myriad will not 
update Estimated Play Times or mark Log Items as having been played (see 
Preview Live Mode) so that previewing the Log in this way will not adversely 
affect the Schedule Log.

Live Mode (On Air Mode Only)

This will probably be the mode that you become most familiar with if you use 
the Log screen to deliver Live Assisted programming. The Live Playout mode 
button is only available when the Myriad workstation you are working on has 
On Air Control (is On Air), or if you have On Air Control disabled entirely.
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In the above example, the workstation has On Air Control (is On Air) but 
currently, no Active Playout Mode is selected (it is in Standby mode). You 
may notice that the Live Playout Mode button text is in yellow. This indicates 
that the hour that is currently visible in the main Log area is scheduled to be a 
Live Playout mode hour.

If we click on the Live button, Myriad will enter Live Playout mode.

Myriad will automatically load the highlighted Log Item into the first free Cart 
Player and will display the ‘Waiting For Go’ message in the Notes area. Click 
on the Go button to start the playback of the cued Log Item and to start Live 
mode playout.

In Live mode, Myriad will automatically work its way through the Items listed in 
the Schedule Log, loading Carts into the Cart Players and performing other 
scheduled events such as Link Scripts, Hardware Events and AutoHooks. The 
key thing about Live mode is that whilst Myriad will always load the next Item 
that is needed, ultimately the presenter controls the flow of the playback.

In Live mode, the Segue Type determines what Myriad does as each Log 
Item comes to an end. The options are:

Icon Segue Type Description
Stop At the end of a Log Item with this Segue Type, 

Myriad will cue the next Item in the Log but will not 
play it. The User must manually start playback by 
pressing GO or clicking Play on the Cart Player the 
Item is loaded into.

Auto Segue At the end of a Log Item with this Segue Type, 
Myriad will automatically Segue into the next Item in 
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the Log using the Extro point on the currently playing 
Item to trigger the next (unless the Segue has been 
edited using the Segue Editor). 

Sweeper This is a special case that you will only see on Log 
Items that have been set (either manually or by the 
scheduling system) to ‘sweep’ into the Intro of the 
next Log Item. When Myriad encounters an Item that 
has this Segue Type, it looks at the following Item 
and determines how best to ‘sweep’ the Item into the 
Intro period of the next item.

For more detail on what Sweepers are and how they 
work in Myriad, please refer to Chapter 2 – What Is A 
Sweeper And How Are They Handled By Myriad.

Played Item This is not technically a Segue Type but it is an 
indication that a Log Item has been successfully 
played.

Not Played
Item

This is not technically a Segue Type but it is an 
indication that a Log Item has not been successfully 
played.

So basically, when in Live mode, Myriad will automatically segue into the next 
Item if the currently playing Log Item has an Auto Segue (Green) Type. If the 
Segue Type is a Stop (red) then it will cue the next Log Item ready to be 
played but will not actually start playback. This will be done by the presenter 
by either pressing the Go button or the Play button on the Cart Player that the 
next Item is loaded into.

In Live Playout Mode, Myriad will not attempt any type of back timing or 
dynamic adjustment, this will be left to the presenter although it will still 
calculate how much over or under the current hour is (see Over / Under Run).

Auto Mode (On Air Mode Only)
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Auto Playout mode is only available on Myriad workstations that have On Air 
Control (is On Air) or on Myriad workstations that have been configured to 
always have On Air Control or if On Air Control is disabled completely.

Auto Playout mode is actually a mode that does not get used very often as it 
bridges the gap between Live and AutoFade mode by offering automated 
output without the ability to automatically adjust the Log to ensure it is back 
timed to time critical events (such as the news).

When you click on the Auto button, Myriad will automatically load the 
highlighted Log Item into a free Cart Player and display the ‘Waiting For Go’ 
message in the Notes area. It also automatically converts all of the Segue 
Types within the current hour to Auto Segue (Green). 

This means that when in Auto Playout mode, it will automatically play all of the 
Log items in the hour, automatically segueing between. What it does not do is 
perform any type of ‘running to time’, so it will not dynamically adjust the 
Schedule Log to ensure that Absolute Time Markers (or Time Critical Events) 
are reached at the correct time.

In effect, this means that in Auto Mode, if there is one hour and three minutes 
worth of content in the Log, it will take one hour and three minutes to play it!

If you switch back from Auto mode to Live mode, the Segue Types are 
returned to their previous state.

AutoFade Mode (On Air Mode Only)
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AutoFade Playout mode is only available on Myriad workstations that have On 
Air Control (is On Air), on Myriad workstations that have been configured to 
always have On Air Control, or if On Air Control is disabled completely.

AutoFade Playout mode is the playout mode that you will probably use most 
often for any automated playout that you wish Myriad to do. Just like in Auto 
mode above, AutoFade mode is used to play all of the items within the Log 
with each segue handled automatically by Myriad. This means that when in 
AutoFade mode, Myriad will play all of the Items in the log using the Extro 
points on each Item to segue into the next.

The principal difference between this and standard Auto Mode, is that when 
running in AutoFade mode, Myriad will automatically make adjustments to the 
Log to ensure that time critical events (called Absolute Time Markers) such as 
the news at the top of the hour, happen at the right time. 

For example, if we wanted Myriad to automatically take a network news feed 
at the start of each hour, Myriad needs to ensure that when it is running an 
automated show, the final Item in the Log finishes in time for the start of the 
externally fed news bulletin. In Live mode, it would be the responsibility of the 
presenter to ‘back time’ the output so that they can bring in the news on time. 
They would do this by calculating how much time is left in the Log and then 
deciding whether they need to fade a Song or two out early or maybe even 
drop a Song or two altogether. When in AutoFade mode, Myriad does the 
same thing. 

In order to ensure that time critical events happen when they are supposed to, 
Myriad needs to constantly monitor the amount of total time left in the hour 
and if there are too many items in the Log then it will remove Songs if 
necessary and fade others early according to needs. The exact method that 
Myriad uses to do this will depend of the way that you have configured the 
QAE settings in the Station Database settings (see Settings Menu) but by 
default, Myriad will first look through the Log for the hour it is working on and 
identify all the Songs in the hour that have been set as droppable (this is 
usually set in the scheduling systems Clock but can be manually changed 
using the right click menu on the Log Screen). Once it has identified the 
Songs that could be dropped, it then looks at the best place to drop one or 
more Songs. It will not drop Songs that have voice links going into or out of 
them and it will also not drop Songs that have been included in any 
AutoHooks that are scheduled for the hour. It will also try to avoid Songs that 
are nested between Links or other non-Song Log Items (such as Hardware 
Events or Adverts etc). So basically it will look for a nice run of two or more 
Songs that can be dropped and then drop as many Songs from this area as it 
can to get as close to running to time as possible.

Once it has dropped as many Songs as it can, Myriad will then complete the 
back timing process by spreading the remaining overrun over multiple fadable 
Songs (Songs that have the End Type set to Fades or Slow Fades). This is 
designed to minimise the impact on the listener whilst still allowing Myriad to 
run to time.
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The easiest way to explain this process is by way of an example. Look at the 
screen shots below. In the first shot, Myriad is in Live Playout mode and 
Myriad is currently playing a Song by Darren Hayes. You will see that the 
Overrun indicator is showing that if all of the Log Items remaining in the hour 
were played in full, the total show would overrun by 7min 34 seconds.

Now let’s take a look at what happens when we switch to AutoFade Playout 
mode by clicking on the AutoFade button at the top of the Log Screen.
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As you can see, Myriad manipulates the Station Log so that the Overrun is 
removed from the show. Any Red (Stop) Segue Types will also be set to
Green (Go) as part of this process.

The graphic below shows an extract from the Station Log which includes the 
remaining Log Items within the Hour.
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Myriad has dealt with the Overrun by dropping three Songs from the Log and 
fading time off of a number of other Songs in the hour that have the End Type 
set to either Fades or Slow Fades as it considers Songs with these End Types 
to be fadable. This means that the Log will run to time and the impact on the 
listener has hopefully been minimised.

The logic that Myriad uses when dealing with Overruns can be customised to 
suit your station’s sound and further control over how Myriad can manipulate 
the Log can be exacted by setting Songs as droppable and fadable in when 
you are creating the Clocks in your scheduling system.

The screen shot below shows the Q-AE settings (Settings Menu > Station 
Database Settings) that were used in this example. The key things to look at 
are the Fading Rules section which allows you to set which Log Items can be 
faded early (just Songs in this case). This section also allows us to tell Myriad 
what to do if no Fadable Items are available and in this case we have ticked 
the option to allow Myriad to fade from the last Song in the hour regardless of 
Fadable status if no other options are available.
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The other important section is outlined below.

These two options allow you to set parameters as to how Myriad will fade Log 
Items to hit Absolute Time Events. The first option (the one we are using in 
this example) allows you to set an upper amount to fade off of the last Song in 
the hour and once this amount has been exceeded, to spread the fade over 
all the Fadable Items within the hour.

The Second option basically does the opposite. It allows you to set the 
maximum that can be faded from general (fadable) Items in the hour. Once 
this limit has been reached, any remaining overrun will be faded off the last 
fadable Log Item in the hour.

 Always Fade XX Option – Myriad will always try to fade time off of the 
last fadable Log Item in the hour. It will not spread the fading over 
several Songs in the hour unless the time needed to be faded exceeds 
the XX setting.

 Fade At Most XX Option – Myriad will first try to spread the time it 
needs to fade over all of the fadable Log Items in the hour, but, if doing 
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so will mean that it will have to fade more than XX from each item, then 
it will fade XX off of each item and then fade the remainder from the 
final fadable Log Item in the hour.

On-Air / Off-Air Control Button

The On-Air / Off-Air buttons are only visible if you are using either Simple or 
Advanced Station Control (see On Air Control Overview) and have your 
system configured to allow workstations to manually take or release On-Air 
(Station) Control.

The On-Air button indicates that the workstation you are working on is 
currently ‘On Air’ and has On Air Control. You can release On Air Control by 
clicking on the On Air button.

The Off-Air button indicates that the workstation does not currently have On 
Air Control and so is classed as Off-Air. You can take On Air Control by 
clicking on the Off-Air button.

Myriad can be configured so that the On-Air workstation must release control 
before another workstation can take On Air Control. If this option is configured 
then if you click on the Off-Air button while another workstation has On Air 
Control, you will receive a message letting you know which workstation has 
On-Air control and that you will need to release control on that workstation 
first.

The Schedule Log

The Schedule Log section dominates the centre of the Log screen and is 
essentially used to display and manipulate the Station Log in either Stand By 
mode or any of the active Playout Modes.
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The Station Log is a list of Songs, Links, Carts and other events that make up 
your station output. When in Standby mode, you can scroll through and 
manipulate the Station Log, adding, moving and deleting Log Items as you 
see fit. In one of the Active Playout modes, Myriad works its way through the 
Station Log (from top to bottom), cueing audio Log Items and executing other 
Log Items as it encounters them. How it handles the segue between each Log 
Item is determined by the Segue Type and the Active Playout Mode selected 
(see Playout Mode Buttons).

In this section we will concentrate on the Schedule Log layout and how to 
work with the Songs, Links and other Log Item types.

Log Items General Layout

In this section we will look at the general layout of the Log Items that make up 
the Schedule Log.  Whilst there are a number of different Log Items that can 
appear in the Schedule Log, the majority of them are very similar in look and 
layout. Different Log Item types can be colour coded and this can be 
customised using the Log Entries tab on Database Settings (see Settings 
Menu>Database settings).

We will look at the special Log Entry types in a few minutes but first let us 
concentrate on the standard Log entry layout.

Hook Icon 

The Hook Icon indicates that the Cart that the Log Item refers to has a Hook 
set. The Hook is generally used to indicate the most popular or recognisable 
section of a song but can be used for marking any section of any Cart. 

Knowing whether a Log Item has a Hook is useful as you can then use that to 
manually play hooks or prepare AutoHook runs.
Log Items that refer to Carts that do not have Hooks will not display the Hook 
Icon.
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Info Icon

The Info Icon appears on all Log Items that have text or scripts attached 
directly. It will also appear on audio based Log Items that are associated with 
Carts that have text Notes or Scripts. When a Log Item is highlighted that 
includes the Info Icon, the text Info is displayed in the Notes area.

Currently Highlighted Item

When you are working with the Schedule Log, you can move up and down the 
Log Items using the cursor keys, clicking on Log Items or using the wheel on 
your mouse (if you have one). As you move up and down the Log, the 
currently highlighted Log Item is indicated by the background colour changing 
(to blue by default) and the size of the Log Item doubling in height. This 
makes it easy to see which Log Item is currently highlighted.
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In the example above, the Log Item that is currently playing is ‘Don’t Give Up’ 
but the currently highlighted Log Item is ‘Shoulda Woulda Coulda’ as indicated 
by the double height Log Item with dark blue background.

Many of the tools available on the Main Tab Strip or the right click menu affect 
the Currently Highlighted Log Item, not the currently playing Log Item.

Ending Type

The End Type indicator shows the End Type that has been assigned to the 
Cart that the Log Item refers to. The End Type is used to indicate to the 
presenter how the Log Item is likely to end. 
The possible End Types are:

 Ends (E) – The Cart comes to an abrupt end.
 Fades (F) – The Cart fades out at the end.
 Sustain (S) – The Cart’s ending is sustained for a period at the end.
 Slow Fade (SF) – The Cart fades out over a longer period at the end.
 Not Specific (blank) – The ending has not been specified.

It is also used by Myriad in AutoFade Playout Mode to determine which Log 
Items can be faded early in order to reach time critical events such as top of 
the hour news. The logic that Myriad uses is outlined below.

Ends – Cannot be faded early.
Fades – Can be faded early.
Sustain – Cannot be faded early.
Slow Fade – Can be faded early.
Not Specific – Cannot be faded early.

Segue Type

The Segue Type indicator on each Log Item determines what Myriad will do at 
the end of the Log Item when it is in an Active Playout Mode. The possible 
options are outlined below.

 Red (Stop) Segue Type - The Red (Stop) Segue Type is used to 
indicate that at the end of the Log Item, Myriad will cue the next Log 
Item in the Schedule Log but will not actually start playing it. It will be 
up to the presenter to manually start the next Log Item by either 
pressing (or clicking) the Go button or manually triggering the play
button on the Cart Player the Log Item is loaded into. This option is 
only available when in Live or Preview Live Active Playout Modes or in 
Standby mode. You can toggle between Red (Stop) and Green (Go) 
Segue Types by clicking on the Segue Type icon with the left mouse 
button.
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 Green (Go) Segue Type - The Green (Go) Segue Type is used to 
indicate that at the end of the Log Item, Myriad will automatically segue 
on to the next Log Item in the Schedule Log using either the Extro point 
or the edited segue (depending on whether you have set an edited 
segue point using the Segue Editor). When in Auto, AutoFade or 
Preview Auto Playout Modes, all Segue Types will be set to Green 
(Go) or Yellow (Sweep) – see below. In Live or Preview Live mode, you 
can toggle between Red (Stop) and Green (Go) Segue Types by 
clicking on the Segue Type icon.

 Yellow (Sweep) Segue Type - The Yellow (Sweep) Segue Type 
is a special case that indicates that Myriad will ‘sweep’ the Log Item 
into the Intro of the next item. 

In Myriad, when we refer to sweeping, we actually mean overlaying 
one Cart over the Intro of another Cart. This is most commonly used to 
play a ‘dry voice’ style link over the top of the beginning of a Song and 
is often set up in such a way that the end of the ‘dry voice link’ 
coincides with the end of the Intro period on the following Song. This 
mimics the way some presenters will continue to speak over the 
beginning of a song and stop at exactly the right point to allow the 
listeners to hear the vocals on the song. 

When a Log Item has the Yellow (Sweep) Segue Type, Myriad will 
automatically treat it as a sweeper and sweep it into the Intro of the 
next Log Item using the default sweeper style you have configured. 
Your options are:

 Timed To Intro End – The sweeper is backtimed so that the end 
of the sweeper coincides with the end of the Intro period on the 
next Log Item.

 Start At Intro Start – The Sweeper and the next Log Item will 
start simultaneously providing that doing so will not cause the 
sweeper to overrun the Intro end on the next Log Item.

 Dry – The sweeper will be played on its own just like any other 
Log Item.

You can select the sweeper method that you wish to use for your 
station using the Database Settings window which is accessible via the 
Settings Menu. Use the drop down Sweeper Style option to select the 
Sweeper Style that you wish to use.
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You can toggle back from Yellow (Sweep) Segue Type to Red or 
Green by clicking on the Segue Type icon. To set a Log Item as having 
a Yellow (Sweep) Segue Type manually, right click on the Log Item 
and select the Change Ending>Sweep Into The Intro option.

The three Segue Types above are used for Log Items that have not 
been played yet. There are a further two Segue Item types that you will 
see on Log Items that have been played or have been soft deleted:
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 Played Segue Type - Once a Log Item has been played (or 
executed) in an Active Playout Mode, the Segue Type icon changes to 
include a tick. 

 Soft Deleted Segue Type - If a Log Item is soft deleted (by 
clicking on the Log Item Type Icon or using the right click option) then 
the Log Entry appears ‘greyed out’ and the Segue Type Icon has a red 
cross on it.

It is important to remember that whilst you can freely switch Segue Types on 
Log Items when in Standby, Preview Live or Live mode, you cannot add Red 
(Stop) Segue Types when in Auto, Preview Auto or Autofade Playout Modes.

The default Segue Type for each Log Item would normally be determined by 
the Clock in your scheduling system. If you use AutoTrack Pro for example, 
each Clock Item can be set to have a Red, Yellow or Green Segue Type. This 
information is then passed on to Myriad as part of the scheduling and 
Schedule Log import process.

Item Length / Fixed Log Item (Red Time Text)

The Item Length field on the Log Item shows the overall duration of the Log 
Item or the Cart associated with the Log Item. The Item Length would 
normally be determined as the duration from the start of the audio file 
attached to the Cart to the Extro point or if no Extro has been set, the end of 
the audio file.

If however, you edit the segue using the Segue Editor, or if Myriad needs to 
fade out the Log Item early in order to hit a time critical event (in AutoFade 
mode) then the original Item Length is ‘crossed out’ and the new length takes 
it’s place. This will be the length of the Cart / Log Item that will be played up to 
the segue.

In the above example, the Segue Editor has been used to adjust the segue 
such that the Log Item will be segued into the next approximately 9 seconds 
earlier than originally planned. The original Item Length appears with a strike 
through it and the new length is added. You will also note that the colour of 
the Item Length has been changed from black (by default) to red to indicate 
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that the segue has been edited. Myriad cannot drop or alter the fading on any 
Log Items that have the Item Lengths in red text.

Intro Time

The Intro Time displays the duration of the Intro time in seconds, for the Cart 
that is associated with audio based Log Items.

Not all Carts have Intros and not all Log Items are based on Carts so this field 
will only be visible on Log Items when it is appropriate.

Description

The Description area displays a brief two line description of the Log Item in 
question. For audio based Log Items, it would normally be the Description 
lines from the Carts that the Log Item is associated with but you can configure 
Myriad to display the information from the Schedule system, not the Audio 
Wall if you prefer. 

Cart Number

The Cart Number section shows the Cart Slot Number of Carts associated 
with audio based Log entries. For Log Items that are not based on Carts or 
have not been associated with a specific Cart, this field will remain blank.

Currently Playing Item

The Currently Playing Item icon is only visible when you are in one of the five 
Active Playout Modes and is used to indicate the Log Item that is currently 
playing on ‘on air’.

If you are in Live or Preview Live mode and the Currently Playing Item is set 
to have a Red (Stop) Segue Type then the Currently Playing Item icon will not 
move on to the next Log Item in the Schedule Log until you manually start the 
next Item with the ‘Go’ button.

Estimated Play Time

The Estimated Play Time is used to indicate the estimated time that each Log 
Item within a given hour is likely to be played. When you are in an Active 
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Playout Mode, this Estimated Play Time is recalculated for the entire hour at 
each segue so if you are in Live Playout Mode and you stop to speak for 20 
seconds, when you start the next Log Item, the Estimated Play Time for each 
subsequent Log Item in the hour will have moved by 20 seconds accordingly.

Locked Items

Myriad uses a locking system to lock the Log Items that it is playing to prevent 
them from being moved, altered or deleted whilst they are playing. As you will 
see while you are using Myriad, the Currently Playing Item in the Schedule 
Log is always locked which means that it cannot be moved or deleted until it 
has finished playing or until you have moved on to the next Log Item. When 
you are in Preview Auto, Auto, AutoFade or Live mode but with the Segue 
Type set to Green (Go), three seconds before it is scheduled to start the next 
Log Item in the Log, Myriad will also place the locked icon on the next Log 
Item. At this point, Myriad is committed to playing the Log Item and it cannot 
be deleted from the Schedule Log.

If you are in Live or Preview Live Playout Mode and the Segue Type is set to 
Red (Stop) then Myriad will not lock the next Log Item to allow you to decide 
to move, replace or delete the next Log Item even in the middle of a vocal link 
or split advert break.

Log Item Type Icon

The Log Item Type icon indicates the type entry each item in the Schedule 
Log is. The different Log Item types can also be colour coded (using Settings 
Menu>Station Database – Log Entries tab) to further aid identification. 

The different Log Item Type logos are shown below.

 Song

 Link (or Jingle)

 Split Cart Group

 Voice Tracked Link

 Advert Break
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 Split Advert Break

 Cart – Specific Cart from the Audio Wall

 AutoHook – N.B. You can double click on AutoHook 
Log Items to alter the AutoHook properties

 Command

 Hardware Event

 Time Critical Event

Depending on your system setup and the Clock you are using in your 
scheduling system, you may not see all of these different Log Item Types in 
your Schedule Log.

You can also right click on the Log Item Type Icon to change a Log Item from 
one type to another.

The tick indicates the Log Item’s current type and you can click on an 
alternative option to change the highlighted Log Item to another Log Item 
Type.

The Log Item Right Click Menu

By right clicking on general Log Items, you can access the right click menu 
which offers a range of tools and options.
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NB: The right click menu is context sensitive so not all options will be 
available when right clicking on all Log Item Types.

Change Log Item’s ending

The Change Ending option allows you to alter the Segue Type for the Log 
Item that you right clicked on. When you select the Change Ending option, the 
menu expands to allow you to select the Segue Type that you want to change 
the Log Item to use. The options are:

 Stop At The End And Wait – This will change the Segue Type to be a 
Red (Stop) Segue Type which means that at the end of the Log Item, 
Myriad will not start the next Log Item until the presenter manually 
triggers it. This is only applicable when in Live or Preview Live Playout 
Modes.

 Segue To The Next Item – This will change the Segue Type to be a 
Green (Go) Segue Type which means that at the end of the Log Item, 
Myriad will automatically segue into the next Log Item. This is valid for 
all Active Playout Modes.

 Sweep Into Intro – This will change the Segue Type to be a Yellow 
(Sweep) Segue Type which means that Myriad will use the default 
sweeper style to embed the Log Item into the Intro of the next Log 
Item. This is valid in all Active Playout Modes.

For more detail on the Segue Types, please refer to Segue Type section 
earlier in this Chapter.

Special Case – Convert Log Item to Voice Link

The Convert to Link option is only available on the right click menu when you 
have right clicked on a Log Item that is a Link.



461

If you select the Convert To Voice Link option, the Link in question is 
converted to be a Voice Link Log Item and will be treated just like any other 
Voice Link which includes Myriad ‘ducking’ the audio playback volume of 
other Carts when the Voice Link is playing. You can also edit the new Voice 
Link item using the Segue Editor (in either mini or full mode) to get the perfect 
mix.

Special Case – Convert Log Item to Cart

The Convert to Cart right click option only appears when you right click on a 
Voice Link Log Item in the Schedule Log.
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Selecting this option will convert to the selected Voice Link to be a standard 
Cart Log Item which means it will be played back without being embedded 
into the Intro of the next Log Item (unless you manually alter it to have a 
Yellow (Sweep) Segue Type) and Myriad will not ‘duck’ the audio volume on 
any other Carts while it is playing (again unless you manually set it to be a 
Yellow (Sweep) Segue Type.

Change Log Item’s Type

The Change Type option allows you to change the Log Item Type for the Log 
Item you right clicked on. Again, selecting this option will cause an expanded 
menu to pop out.
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The options are:

 Cart – Changes the selected Log Item to be a Cart.
 Link – Changes the selected Log Item to be a Link.
 Song - Changes the selected Log Item to be a Song
 Advert - Changes the selected Log Item to be an Advert.

For more detail on the Link Types, please refer to the Link Type Icons section 
of this Chapter.

Insert Log Item

The Insert menu is used to insert a particular Log Item above the Log Item 
that you right clicked on. Click on the Insert option to expand the Insert menu 
options.

Each of these options is used to insert a different Log Item type and each 
results in a different procedure in order to insert the desired Log Item. These 
are explained below.

 Cart – The Cart option allows you to insert a Cart Log Item Type into 
the Log. When you select Cart, the Audio Browser appears to allow 
you to select the Cart that you want to insert into the Schedule Log
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To select a Cart either double click on it or highlight it and then click on 
the tick button in the top left of the Audio Browser. The selected Cart 
will then be inserted into the Log above the item you originally right 
clicked on. For more details on the Audio Browser, see Chapter 7.

 Link – The Link option allows you to use a special floating window 
version of the Database screen (see Chapter 4) to select a Link to be 
inserted into the Schedule Log.



465

To select a Link to be inserted, simply double click on it in the main 
central list area.

 Sweeper – The Sweeper option works in the same way as the Link 
option but the resulting Link that is inserted in to the Log will also be set 
to have a Yellow (Sweep) Segue Type – i.e. it will be a sweeper!

 Song – The Song option allows you to select a Song to be inserted in 
to the Schedule Log using a special floating window version of the 
Database screen (see Chapter 4).
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To select a Song to insert, just double click on it in the main Song / Link 
list area of window.

NB: If you are not using AutoTrack, AutoTrack Pro or another 
compatible scheduling system that allows you to import your Song / 
Link databases into Myriad then this option will not be of use.

 AutoHook – The AutoHook option will insert a AutoHook Item into the 
Log above the Log Item you right clicked on. Once you have selected 
this item, the AutoHook properties window opens to allow you to set 
the AutoHook properties.
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These properties are –
 Max Number Items – The maximum number of Songs in the 

hour to include Hooks from. If there are less Songs that have 
Hooks left in the hour than this number then the AutoHook 
player will reduce this number accordingly.

 Item Selection – Allows you to choose between the AutoHook 
playing the next X Songs in the hour with Hooks or X random 
Songs from the hour with Hooks.

 Start Cart – Allows you to specify a Cart to play directly before 
the first Hook in the AutoHook run. You can use the Browse 
button to open the Audio Browser to aid with your selection.

 Separator Cart Number – Allows you to specify a Cart to be 
played between each Hook. If you leave this blank then the 
Hooks will be played ‘back to back’. Again, you can use the 
Browse button to access the Audio Browser.

 End Cart – Allows you to specify a Cart to be played after the 
end of the final Hook.

Once you are happy with these properties, click on the OK button to 
insert the AutoHook item into the Log.

When the AutoHook Log Item is reached in the Schedule Log, 
Myriad will automatically select Log Items that have Hooks defined 
(as per the AutoHook properties you have set) and then load them 
into a Cart Player.

NB: You can access and alter these AutoHook properties by double 
clicking on the AutoHook Log Item in the Schedule Log.

 Command – The Command option is used to insert a Command Log 
Item into the Log.  Commands can be set up to do a number of things 
such as carry out a simple sequence of events within Myriad, to run an 
external program, to send an TCP/IP command or to send a serial 
RS232 command via the serial port. Commands need to be set up in 
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Myriad prior to inserting them in the Log (using the Settings Menu > 
Myriad Settings > Other Settings tab). Once you have selected this 
option, you will be asked to confirm which pre-defined command you 
wish to insert into the Log using the drop down list.

Once you have made your selection, click on OK to insert the 
Command above the Log Item that you right clicked on.

 Hardware – The Hardware option on the Insert right click menu is used 
to manually insert a Hardware Event into the Schedule Log. The 
Hardware Events are used to control external equipment by means of 
switching a hardware I/O logic line on a special card (called an 
Advantech PCI1750) fitted to your PC. The most common application 
for this type of event is to switch control logic that in turn controls an 
external audio router to allow Myriad to switch audio sources (such as 
external news) on and off.

When you select this option, you will then be asked to set which 
hardware line you wish to work with and also what action you wish to 
take.

o Activate – This will turn the selected hardware line on.
o De-Activate – This will turn the selected hardware line off.
o Flash – This will continuously toggle the selected hardware line 

between on and off until a De-activate event is used.
o Pulse – This will switch the selected hardware line on for a short 

period (1 second) before automatically deactivating.

You can also set the hardware line number using the drop down list. 
Each hardware line can be assigned a description using the Hardware 
Card Settings option on the Setting window. 
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 Wait For Time (Absolute Time Event) - This option allows you to 
manually insert an Absolute Time Event (also known as Time Critical 
Event) into the Schedule Log. These are used in AutoFade playout 
mode to determine what time Myriad will back time the content in the 
Schedule Log to. 

They can be used in two different ways, firstly, if the total audio running 
time of the Log Items before an Absolute Time Event, exceeds the time 
stated in the event then Myriad will alter the log to ensure that the last 
Log Item before the Absolute Time Event  finishes at the specified time 
(see AutoFade Playout Mode).

You can also use Absolute Time Events to instruct myriad to wait for a 
specific time. If the total audio duration of the Log Items prior to the 
Absolute Time Event is less than the specified time then Myriad will 
wait for the Absolute Time Event time to occur before it will move onto 
the next Log Item in the Log. A good example of this in practice is the 
sequence of events needed to back time to the top of the hour, then 
switch on the news, wait for 3 minutes and then continue with the 
Schedule Log.

The typical sequence is:

o Final song in previous hour.
o News in jingle
o Hardware Event – Turn news on
o Absolute Time Marker – 59:59.99
o Hour Start Marker – Next Hour
o Absolute Time Marker – 03:00.00
o Hardware Event – Turn off news
o First song or jingle in hour

There are other ways in which this sequence can be done but this does 
illustrate one way in which Absolute Time Markers can be used to 
perform two different roles.

When you manually insert an Absolute Time Marker using the right 
click menu option, you will then be asked to type in the time that you 
wish to use. This will default to the estimated play time for the point in 
the Log you are inserting the item.
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Format: HH:Min:Sec.Hundreth of second

Once you are happy, click on the OK button to insert the Absolute Time 
Event.

 Cart Group – The Cart Group option will only be enabled when you 
have configured Myriad to work with Myriad STS in a split transmission 
environment. Cart Groups act a lot like Instant Carts in that each Cart 
Group is assigned a number and when the Cart Group is triggered, 
Myriad instructs all of the Myriad STS workstations to play the Cart 
assigned to the Cart Group. The difference of course is that the Split 
Cart Groups only apply to Myriad STS workstations.

You can insert a Cart Group using the Cart Group option on the right 
click menu. Select the option and then select the Cart Group that you 
wish to insert using the drop down list of available groups (these are 
read from the STS Master workstation).

Once you are happy with your selection, click on the OK button and the 
Cart Group Log Item will be inserted into the Schedule Log. Once 
inserted, a Cart Group Log Item behaves and can be manipulated just 
like any other Log Item.

Replace Log Item

The Replace menu options work in exactly the same way as the Insert menu 
options with the exception that when you right click on a Log Item and select 
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Replace, the Log Item that you originally right clicked on is replaced with the 
new Log Item that you have selected.

As with the Insert menu, clicking on the Replace Log Item option will expand 
the Replace menu.

The options on this menu are exactly the same as the first four options on the 
Insert menu so we will not cover them in detail again.

 Cart – This option replaces the current Log Item with a new Cart Log 
Item. Selecting this option will open the Audio Browser to allow you to 
select the Cart you want to replace the current item with.

 Link – The Link option allows you to replace the current Log Item with 
a Link Log Item. Selecting this option will open a special floating 
window version of the Database screen to allow you to select a Link by 
double clicking.

 Sweeper – This does exactly the same thing as the Replace > Cart 
option (see above) but the resulting replacement Cart is also set to 
have a Yellow (Sweep) Segue Type.

 Song – The Song option allows you to replace the current Log Item 
with a Song Log Item. Selecting this option opens a floating Database 
window to allow you to select the Song you wish to use by double 
clicking on it.

Delete Log Item

The Delete menu option is used to delete the Log Item that you have right 
clicked on. Expanding the Delete menu shows the available options.
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There is an important distinction between Soft Deleting a Log Item and 
Permanently Deleting a Log Item. When you Soft Delete a Log Item, the Log 
Item appears ‘greyed out’ in the Schedule Log and Myriad will act as if it is not 
there but the Log Item remains visible in the Log and can be restored if need 
be.

If a Log Item is Permanently Deleted then it is removed from the Schedule 
Log altogether and the only way of putting it back into the Log is to manually 
insert it again.

The right click Delete menu option allows you to Soft and Permanently delete 
Log Items depending on which one suits your needs best.

 Soft Delete – Selecting this option will soft delete the Log Item that you 
right clicked on.

 Restore – This option is only available when you right click on a Log 
Item that has been Soft Deleted and selecting it will restore it back to 
the Schedule Log.

 Delete Permanently – The Delete Permanently option removes the 
selected Log Item from the Schedule Log. 
NB: If a Log Item is Permanently Deleted then you can restore it by 
clicking on the Undo button located below the Trash Can in the right 
hand corner of the screen. 
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Myriad will only store the last Permanently Deleted Log Item so if you 
delete another Log Item then you will not be able to restore the first. 
The only option will be to manually insert the Log Item back into the 
Schedule Log. Permanently Deleting Log Items will not delete any 
associated Carts from the Audio Wall.

You can also Soft Delete Log Items by clicking on the Log Item Type icon to 
the left of the Log Item.

You can then Restore a Soft Deleted Log Item by clicking on the Log Item 
Type icon.

You can Permanently Delete a Log Item by dragging it from the Schedule Log 
area down into the Trash Can in the bottom right hand of the Log Screen.
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This will enable the Undo button below the Trash Can.

Clicking on this will restore the last Log Item that was Permanently Deleted.

Advanced Log Item Options

The Advanced right click menu option is only available on certain Log Items 
depending on how you have configured Myriad. It is used to view and edit 
whether a particular Log Item can be dropped automatically, or faded out 
early, when Myriad is running in AutoFade Playout Mode. For this reason, the 
Advanced option is only available on Log Item Types that are allowed to be 
dropped or faded in AutoFade mode so, for example, it would normally be 
available when right clicking on Songs but not when you right click on an 
Advert.
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You can however configure Myriad to fade Log Items other than Songs early 
using the Settings Menu > Database Settings and Q-AE tab.

You can toggle the ‘This Item Can Be Dropped’ and ‘This Item Can Be Faded’ 
options on and off by clicking on them. This will add or remove a tick from the 
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menu option to indicate the status of the Log Item you originally right clicked 
on. In the example below, the Log Item can be faded early in AutoFade mode 
but cannot be dropped.

NB: If an item cannot be dropped by Myriad in AutoFade Playout Mode, the 
timing information to the right of the Log Item is displayed in red text.

Locked

The Locked option on the right click menu is used to indicate whether a Log 
Item is Locked and also to manually toggle a Log Item status between Locked 
and normal status.
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If the Locked menu option has a tick by it, then the Log Item that you right 
clicked on is Locked. This will also be indicated by a padlock icon on the Log 
Item Type indicator.

The reason for the Locked status is explained in more detail in the Locked 
Items section of this Chapter but in brief, if an item is Locked then it cannot be 
moved within, or deleted from, the Schedule Log. Myriad normally locks Log 
Items a few seconds before it plays them but you can manually lock a Log 
Item by clicking on the Locked right click menu option.

NB: You cannot change the Locked status of the Log Item that is currently 
playing.

Send This Item’s Information to OCP (only available when using OCP)

This option will only be available when Myriad is configured to work with OCP. 
Selecting this option will send the Log Items details to OCP as the currently 
playing item. OCP can then use this information to update a range of digital 
platforms including web sites and DAB radios.

Display Item Information

The Item Information option on the right click menu allows you to view the 
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Item Details window which displays a summary of the selected Log Item 
including pictures, notes, Cart information and schedule system information 
(usually only available when using AutoTrack or AutoTrack Pro).

Please note that when a Cart has more than one type of text Notes attached 
to it, the Text Note Type buttons allow you to switch between the available 
notes.
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Cue No More Than X ‘Hooked’ Items in a Hook Player

Earlier in this Chapter we looked at how the AutoHook option could be used to 
place AutoHook Log Items into the Schedule Log. These AutoHook Items act 
like any other item in the Log but when Myriad encounters them, it looks 
forward in the Schedule Log within the current hour and selects X songs that 
have Hooks set (depending on the AutoHook options). It then cues them in a 
Hook Cart Player and plays just the Hook from each song creating a dynamic 
‘promo’ for what it is going to play in the near future.

The ‘Cue No More Than X ‘Hooked’ Items in a Hook Player’ option allows you 
to manually cue a run of Hooks in a Cart Player. When you select this option, 
Myriad will scan the current hour and look for the next X Log Items that have 
Hooks defined. It will then cue them into a single Cart Player to be played out 
as a hook run.

The difference between using this method and inserting an AutoHook is that 
the AutoHook becomes a part of the Schedule Log and can be moved around 
and played just like any other Log Item. When you use this method however, 
no Log Item is created, the Hooked Carts are just loaded into a Cart Player to 
be manually triggered at your leisure. If you do not ensure that the currently 
playing Log Item has a Red (End) Segue Type then Myriad will automatically 
start the next item in the Schedule Log, ignoring the Hook run you have just 
set up. Only use this option if you want to manually cue a Hook run without 
adding it to the Schedule Log.

The number of Hooked Items added to the Hook run is determined by a 
setting on the Settings Menu > Station Database Settings and Hooks tab.



480

Preview Log Item’s Hook

The Preview Hook option on the right click menu allows you to cue just the 
Hook from the Log Item you right clicked on with the Cart Player in Preview 
mode.

When a Cart Player is in Preview Mode, clicking on the transport controls for 
that Cart Player (or using the keyboard) will not affect playback of the 
Schedule Log so you can use a Cart Player in preview mode to review a Cart 
(or in this case a Hook) without it inadvertently triggering a Go event which 
causes Myriad to fade out the current Log Item and move on to the next. The 
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reason this is important is that under normal operation, if Song A is playing 
and the system cues Song B (or you do it manually) and you then click on the 
Play button on the Cart Player Song B is cued in, Myriad will treat this in the 
same way as if you have pressed the Go button and will either fade out the 
current Log Item and start the next or just start the next and leave the current 
Log Item playing (depending on how you have it configured – see Settings 
Menu > Station Database Settings > Q-AE tab and the ‘Fade the current item 
after the Go is pressed’ option).

Obviously, this is great if you want it to do this but if you wanted to review a 
Log Item without it triggering a Go event then you would have to load the item 
into a Cart Player in Preview mode.

In this case, the Cart Player will not only be in Preview mode but it will also 
only play the Hook from the selected Log Item. If no Hook is defined, the
Preview Hook option will not be available.

Preview Log Item

The Preview option on the right click menu will cue the selected Log Item into 
a Cart Player in Preview mode.

In this mode, you can review the Log Item without it triggering a Go event as it 
would in normal operation (see Preview Hook for a more detailed 
explanation).

NB: Selecting this option is the same as clicking on the Preview button on the 
Main Tab Strip.
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Special Case: Hour Start Marker

The Hour Marker is a special Log Item that is placed at the start of each hour 
in the Schedule Log. Myriad deals with the Schedule Log in chunks of an hour 
at a time, we sometimes refer to these as shows. 

The Hour Start Marker provides a range of useful information:
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Hour Marker

This indicates the hour of the day that the Hour Start Marker is for.

Show Date & Title

The Show Date & Title displays the date that the hour in question is 
scheduled to be played out and also the Show Title according to the 
scheduling system that generated it.

Playout Mode

The Playout Mode shows the Active Playout Mode that Myriad will use to play 
the selected hour. If you change the Active Playout mode by either using the 
right click menu on the Hour Start Marker or by simply clicking to another 
Playout Mode while the hour is being played, this will update accordingly.

Total Length of Show

This tells you the total current duration of all the audio Log Items scheduled 
for the hour. This is really useful if you are voice tracking a show as it gives 
you an indication of how much time you have to fill or whether you need to 
remove some content in order to make it all fit.

The Hour Start Marker Right Click Menu

The Hour Start Marker has its own right click menu with different options to 
the standard right click menu for Log Items.
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Change Hour Mode

You can use the Change Hour Mode right click option to change the 
scheduled Active Playout Mode for an hour in the Schedule Log. 

Use the right click menu to select the mode that you wish to change to, the 
currently selected mode is indicated with a tick, click on another mode to 
change it.

The options are:

 Live – Presenter controls the segues.
 Auto – Myriad automatically segues each item.
 AutoFade – Myriad automatically segues each item and back-times to 

Time Critical Events (Absolute Time Markers).

Once you have changed the Active Playout Mode, Myriad will automatically 
switch to that mode when the Hour Start Marker is reached.

CAUTION – Remember that Myriad deals with the Schedule Log an hour at a 
time so if you have three hours that were originally scheduled as Live Playout 
Mode and you want to switch them to play in AutoFade mode, you will need to 



485

right click each of the three Hour Start Markers and make the change, 
otherwise, the first hour will be ok but at the start of the second hour, Myriad 
would switch back to the original Live playout mode which could be a disaster 
if it was at 3am on New Years day!

Soft Delete All the Items in This Hour

If you select this option then Myriad will soft delete all the items in the hour 
you are working with leaving it effectively empty. 

This option can be very useful if you have a breaking story or event that 
means that you need to ditch the originally scheduled programming and use 
some alternative programming. 

Restore All Items in This Hour

The Restore All Items option does the opposite to the delete all items in that it 
goes through the current hour and restores any Log Items that have been soft 
deleted. 

Obviously this is useful for reversing the Soft Delete All option but it can also 
be useful if you have soft deleted a number of Log Items in the hour but you 
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want to restore them all and start again. Instead of having to go through the 
hour manually restoring them, you can do them all in one go with this option.

Permanently Delete the Entire Hour

As the name suggests, this option can be used to permanently remove an 
entire hour from the Schedule Log. When you permanently remove an hour 
from the Log, all of the Log Entries in the hour will be removed including the 
Hour Start Marker. This will not, however, harm any Cart on the Audio Wall.

Once Log Items have been permanently removed, there is no way to recover 
them other than manually dragging them back in from the Audio Wall. You 
can use the Audio Wall and the right click menu to add most Log Item Types 
back in to the Log but the only way to add a Hour Start Marker is using the 
Add Hour option on the Log menu.

You will then be asked which hour you wish to add and also whether you wish 
to add some Carts at the same time, more detail on this situation will follow in 
later sections.

Permanently Deleting the Entire Hour is obviously a powerful and potentially 
dangerous feature so it is protected by three warning messages prior to the 
actual deletion. Once you select the option, you get the first warning message 
asking you to confirm that you wish to proceed.
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If you click on Yes you will then be presented with another chance to abandon 
the procedure.

If you still choose Yes then you will be greeted with the final warning 
message.

If you answer Yes to this final warning then the contents of the hour you are 
working on will be permanently deleted from the Schedule Log (but not from 
the Audio Wall).

CAUTION! – Using this feature will permanently remove the hour from 
the Schedule Log and the only way to recover the original schedule will 
be to manually rebuild it or re-send it from your scheduling system – It 
will not delete any audio from the Audio Wall or remove other common 
Log Items as Commands from the overall Myriad system.

Update Timing Information for This Hour

Update Timing Information for This Hour is used to force Myriad to recalculate 
the Estimated Play Times for each Log Item in the hour. The Estimated Play 
Times are calculated when the schedule is first imported into Myriad but then 
they are not checked again until the hour is played in one of the Active 
Playout modes. 

Earlier in this Chapter we looked at the Active Playout Modes and why the 
Preview Live and Preview Auto modes were necessary to prevent previewing 
a future part of the Log from screwing up all the Estimated Play times. What 
basically happens is that if you go into Live, Auto or AutoFade Playout modes 
in an hour in the Schedule Log other than the current hour, the Estimated Play 
Times for the hour are automatically updated to reflect that you are playing 
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the hour out now! The Preview Live and Preview Auto modes avoid this by 
letting you preview the Log without adjusting Estimated Play times. 

If however, you do get it wrong and end up with an hour that has all the 
Estimated Play Times screwed up then the ‘Update Timing Information for
This Hour’ option will fix the problem.

It can also be useful if you heavily edit the audio for Carts on the Audio Wall 
as this can have an effect on the timing in the Schedule Log.

Print Hour

The Print Hour option will send a text version of the hour of the Schedule Log 
you are working on to your default printer. Once the print is complete, you will 
get a conformation message.

You can also access this feature from the Log menu.

Current Time

The Current Time indicator shows the current PC system time. If you have 
configured your PC to set it’s time from a local or web based time server, or 
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you have a radio (atomic) clock attached, then this time will be exactly 
accurate. You can also customise Myriad to display the current date at the 
same time.

As this is a customised option, this is set on a per User basis and is 
configured using the Tools Menu>Customise Myriad option and selecting the 
General and Myriad tabs.

The Start and Prev(ious) Buttons

The Start and Prev(ious) buttons share the same space on screen, but the 
Prev(ious) button is only visible when then currently highlighted Log Item is a
Hour Start Marker.
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Start

The Start button is visible when anything but an Hour Start Marker is 
highlighted in the Schedule Log and clicking on the Start button will jump the 
highlight cursor to the Hour Start Marker for the hour you are working on.

Prev

The Prev(ious) button is only visible when the currently highlighted Log Item is 
an Hour Start Marker.

Clicking on the Prev button will jump the highlight cursor to the Hour Start 
Marker for the hour previous to the one you are currently working on.

Page Up

The Page Up button (the up arrow) will scroll up the Schedule Log (backwards 
in time) a page at a time. The size of a page is determined by the resolution 
you are configured to run in and the size of the Log Items text.

You can also use the <Ctrl> + <Page Up> keys on your keyboard to scroll up 
the Schedule Log a page at a time.  You may have a dedicated key on your 
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Myriad keyboard to perform this task depending on your keyboard model and 
layout.

NB: when running a dual screen configuration, <Ctrl>+<Page Up> scrolls the 
Log, and <Page Up> scrolls the Audio Wall back a page at a time. If you are 
configured to run on a single screen then the <Page Up> key will also allow 
you to scroll up the Log page at a time when the Log Screen is active (as the 
Audio Wall is not visible).

Although you can use the keyboard, the easiest way of moving up and down 
the Schedule Log is to use the central wheel on your mouse (if you have one).

Home

The Home button on the Log screen performs two different tasks depending
on whether you are in an Active Playout Mode or in Standby mode. If you are 
in any of the Active Playout Modes then clicking on the Home button will jump 
the highlight cursor back to the Log Item that is currently being played or 
executed. If you are in Standby Mode then the Home button will jump the 
highlight cursor to the Log Item that would be playing now if you were in one 
of the Active Playout modes.

You can also use the <Home> key on your keyboard, and some Myriad 
keyboards will have a dedicated Home button.

As Myriad performs each segue, it automatically moves the highlight cursor 
onto the currently playing Log Item so the highlight cursor will not be left 
behind as Myriad plays it’s way through the Schedule Log. If you scroll further 
down (or up) the log and start working with the Log (adding, editing or moving 
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Log Items) then Myriad will not jump back to the currently playing Log Item 
even if a segue occurs. Once you have finished playing with the Log or if you 
have not made a change or moved for X many settings, Myriad will 
automatically jump the highlight cursor back to the currently playing Log Item. 
The duration of inactivity before Myriad jumps back is a customised option 
which means it can be set on a per User basis. To set this option, click on the 
Tools Menu>Customise Myriad and select the Log Display and Myriad tabs.

Page Down 

The Page Down button (the down arrow) will scroll down the Schedule Log 
(forwards in time) a page at a time. The size of a page is determined by the 
resolution you are configured to run in and the size of the Log Items text.

You can also use the <Ctrl> + <Page Down> keys on your keyboard to scroll 
down the Schedule Log a page at a time.  You may have a dedicated key on 
your Myriad keyboard to perform this task depending on your keyboard model 
and layout.

NB: When running a dual screen configuration, <Ctrl>+<Page Down> scrolls 
the Log down and <Page Down> scrolls the Audio Wall forwards a page at a 
time. If you are configured to run on a single screen then the <Page Down> 
key will also allow you to scroll down the Log page at a time when the Log 
Screen is active (as the Audio Wall is not visible).
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As before, the mouse wheel provides a useful alternative way of scrolling up 
and down the Schedule Log.

The Next Button

The Next button is visible at all times in the Log screen and is used to jump 
the highlight cursor to the Hour Start marker for the next hour in the Schedule 
Log.

The Trash Can / Undo

The Trash Can provides a graphical area that you can drag Log Items to in 
order to permanently delete them from the Schedule Log. In the example 
below, the selected (Gareth Gates) song is permanently deleted by click-and-
dragging it to the Trash Can. 
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As your mouse cursor passes over the icon, you will see the Trash Can icon 
changes from empty to full. Release the mouse button and the Gareth Gates 
song is deleted from the Log.

Although the Song has been removed from the Schedule Log, the Cart 
remains on the Audio Wall and in your music scheduling database.

You will notice from the graphic that once you have deleted a Log Item, the 
Trash Can Icon appears full and the Undo button becomes enabled.

The Undo button is used to restore the last Permanently Deleted Log Item 
back in to the Schedule Log. If we click on it in this example, then the Gareth 
Gates song would be restored to the Log.
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This feature will work regardless of whether you use the Trash Can or the 
right click menu to Permanently Delete an item from the Log but it will only 
restore the last deleted Log Item and it will place it back in the Log in the 
position it was last in, so if you deleted an item three hours ago and then you 
click on the Undo button, the Log Entry will be put back in the Schedule Log 
three hours ago (at the position it was in when you deleted it).

The Mini Segue Editor

The Mini Segue editor appears on the Log Screen at all times and shows a 
graphical representation of the segue between the currently highlighted Log 
Item and the pervious Log Item.

In the example above, ‘The look Of Love’ is highlighted so the Mini Segue 
Editor shows a graphical representation of the segue that it will perform (or did 
perform) between ‘The Look Of Love’ and ‘Like To Get To Know You Well’
which is the previous item in the Log. 

The Mini Segue Editor shows the amount of overlap between the Extro point 
of the previous track and the Intro of the currently highlighted track. It also 
allows you to manually move these points to experiment with alternative 
segues and ultimately, to save a new segue that Myriad will use when the 
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time comes to play out these two items. In more detail, the Mini Segue Editor 
looks like this:

The diagram above shows the segue as Myriad will perform it, before we have 
edited it in any way. You will see that the previous item (in yellow) appears as 
a block with a sloped ending. The top of the slope represents the Extro point 
in the Log Item and the bottom of the slope represents the very end of the 
audio file. The slope therefore shows the duration from the Extro point to the 
end of the audio file.

The next Log Item (in green) is represented in a similar way but in this case, 
the bottom of the slope represents the Intro Start of the audio file and the top 
represents the Intro End point so the slope shows the duration of the Intro on 
the Log Item.

Without editing, Myriad will perform the segue at the Extro Point as can be 
seen in the diagram. Using the left mouse button, we can drag either song to 
the left or right to alter the way Myriad performs the segue.

Here we can see that ‘The Look Of Love’ has been dragged to the left which 
moves the Segue Point to the left as well. This means that in this example, 
‘The look Of Love’ would start playing into ‘Like To Get To Know You Well’
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earlier, several seconds before the Extro point on the Song. We can now 
review the edited segue by clicking on the Play segue button.

If you are working on a Myriad workstation that does not have On Air Control
(is Off Air) then the segue start to play immediately in two free Cart Players. If 
however, you are working on a workstation that does have On Air Control
then Myriad will reserve a couple of Cart Players for playing the segue back 
but will then throw up a message box warning you that it is about to start 
playback on the reserved Cart Players. This will allow you to pull down the 
faders on your mixing desk to ensure that the segue you are reviewing does 
not go out ‘on air’.

You can see in the screen shot above that the Cart Players Myriad will use to 
review the segue have a little Segue Editor panel appear at the top and a 
warning box appears to warn you to get ready. Pull down the faders on your 
mixing desk and when you are ready, click on the OK button to begin 
playback.
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While the segue is playing, you can drag the Log Items within the Mini Segue 
Editor until you get the segue exactly the way you want it. Once you are 
happy, click on the Save Segue button to commit your new segue timing 
details to the Schedule Log.

Below are a couple of other examples of the Mini Segue Editor in action under 
different circumstances.

In this situation, we are using the Mini Segue Editor to review a Voice Track 
between two Log Items. It works in exactly the same way, there are just three 
Log Items in view at once to allow for the unique characteristics of Voice 
Tracked segues.

In this case, we are looking at a segue between two Log Items that have no 
Extro or Intro’s set. These are both jingles, so it does not matter too much
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how this is done, but if these were songs then they would require some 
attention.

If at any point, you want to get a bit more control of the Segue Editing or if you 
want to record a Voice Track into the segue (and assuming you have the 
Voice Tracking module), then you can always click on the SegEdit button to 
switch into full Segue Editor mode, there are more details on this in the Segue 
Editor section of the manual.

Over / Under Run 

The Over / Under Run indicator is only visible when you are running in Live, 
Auto or AutoFade (or the Preview Live and Preview Auto) playout modes, and 
is used to show whether the remaining Log Items in the hour would lead to a 
excess or deficit assuming they are all played ‘back to back’ with no pauses 
between items. This means that you can easily see whether your live or 
automated show is going to end at the ‘top of the hour’ or whether it is going 
to overshoot or finish early.

The Over / Under Run is calculated in real time so if you are in Live playout 
mode and it is indicating that you will under run by 20 seconds (indicated by a 
minus sign and the font turning red) then it means that if all the Log Items left 
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in the hour are played out automatically then the last item in the Schedule Log 
will finish exactly 20 seconds from the end of the current hour.

As we are in live mode in the above example, if we were to change the Segue 
Type on the current Log Item to a Red (stop) Segue Type then at the end of 
the current Log Item, Myriad would stop and wait for you to manually restart 
playback by pressing the Go button or the Play button on the Cart Player that 
the Log Item is cued into. At this point, the Under Run indicator would start to 
count down to zero as every second that Myriad is not playing is adding a 
second onto the overall length of the Log Items in the Schedule Log. So this 
means that if we were to talk for exactly 20 seconds and then press the Go 
button then the Over / Under Run would be corrected.

It works the same way if you have too much in your hour. The Over Run 
would be indicated as a positive number.

This indicates that currently, if all the Log Items in left in the current hour are 
allowed to play in their entirety with no pauses in between then the last Log 
Item in the hour will finish 1 minute and 47 seconds into the next hour. That 
means that if you are working towards taking a news bulletin at the end of the 
hour, you will need to either drop something from the Schedule Log or fade 
out a couple of items early in order to reach the ‘top of the hour’ correctly.

In practice, you can use the Over / Under Run indicator to help you present 
Live Assist shows and shows presented when Myriad is in Auto Playout 
Mode. If you switch to AutoFade mode, the Over / Under Run indicator should 
always read 00:00.00 as Myriad will be automatically managing the fading of 
items in order to have an Overrun of zero. 
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The exception to this is if there is actually an Under run in which case you will 
need to add one or more Log Items to the Schedule Log so that there is more 
in the hour than Myriad needs, Myriad will then trim the hour accordingly. This 
situation should not normally happen as each hour is checked for under runs 
as they are scheduled or imported into Myriad (depending on whether you are 
using AutoTrack Pro or a 3rd party scheduling system).

Please note that in all cases, Myriad takes into account Extro’s, edited segues 
and special cases such as Voice Tracks, AutoHooks and sweepers when 
calculating the Over / Under Run so it is always accurate.

Time Remaining

Located next to the Over / Under Run indicator, the Time Remaining indicator 
shows the total duration of all of the Log Items left within the current hour 
regardless of whether the hour will over or under run. This is great for 
checking that you have enough Log Items at the start of each hour.
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As Myriad plays Log Items, the Time Remaining counter will continuously 
drop but if you stop playback (to speak etc) then the Time Remaining counter 
will pause.

The Time Remaining counter is only visible when you are in one of the Active 
Playout modes (Preview Live, Live, Preview Auto, Auto or AutoFade – not 
standby).

Please note that in all cases, Myriad takes into account Extro’s, edited segues 
and special cases such as Voice Tracks, AutoHooks and sweepers when 
calculating the Time Remaining so it is always accurate.

Next Segue

The Next Segue indicator is only visible when Myriad is in one of the Active 
Playout modes (Preview Live, Live, Preview Auto, Auto or AutoFade – not 
standby) and provides a countdown to the Extro point or end of the currently 
playing Log Item. If you are running in Auto or AutoFade Playout modes or 
you are in Live or Preview Live mode but the Segue Type is set to Green (Go) 
then this will be the point at which Myriad performs the next segue. If you are 
in Live or Preview Live mode and the Segue Type is set to Red (Stop) then 
this will be the countdown to the end of the current Log Item only as it is up to 
you to manually start the next Item using the Go or Cart Player Play buttons.

NB: The Next Segue indicator is located on the right hand side of the screen 
on later versions of Myriad.

Notes

The Notes panel displays any text notes associated with a Log Item.

Myriad allows you to enter a variety of different Notes to Carts, and your 
music scheduling system may also allow you to attach text to entries in the 
music database (AutoTrack and AutoTrack Pro does).

The primary use for this panel is to provide some script information for 
presenters. In cases where a Log Item may have more than one different type 
of Notes, Myriad will display the text in the Notes field in an order of priority 
outlined below:
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 Notes on the Log Schedule (provided by the scheduling system)
 Cart Studio Notes 
 Cart Web Notes
 Cart DAB Notes
 No info available

This means that when you move the highlight cursor onto a Log Item in the 
Schedule Log, Myriad will first check to see if the Schedule Log itself contains 
any Notes for the item. If Notes are found, they are displayed but if no Notes 
are found in the Schedule Log, Myriad checks the Cart itself (assuming it is a 
Cart based Log Item). It will first check to see if there are any Studio Notes. If 
none are available then it will look for Web Notes and the DAB notes. If it 
cannot find any Notes at all then it displays ‘No additional information 
available’ in the Notes panel.

If the text displayed in the Notes Panel is several lines long then a scroll bar 
will appear and, after a pause of a second or so, the text will automatically 
start to scroll.

You can also click on the ‘i’ icon to open a floating window with the text 
displayed in it.
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Once you have opened a floating script window, it will remain open until you 
close it again (by clicking on the cross in the top right hand corner); even if 
you scroll away from the Log Item it refers to. This is ideal for getting the 
Notes from a Log Item that is going to be played soon.

The Main Tab Strip

The Main Tab Strip allows you to switch between the major screens in Myriad 
and also contains a range of context sensitive tool buttons for each of the 
major screens.

Most of the screen shots in this section have been taken with Myriad running 
in single screen mode, in which case the Log Screen appears as a tab on the 
Main Tab Strip and you can switch between the Log Screen and all of the 
other major screens in Myriad.

If you are running a dual screen configuration then the layout is slightly 
different. When in dual screen mode, Myriad always displays the Log Screen 
on the right hand screen and allows you to switch between the other major 
screens using the Main Tab Strip on the left hand screen.
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In this configuration, the Log Screen Tool Buttons are located on the right 
hand side of the right hand screen and not on the Main Tab Strip.

Go
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In many ways the Go button is the most important button on the Log screen. 
When you are in any of the Active Playout modes (any mode other than 
Standby), pressing the Go button starts the next Log Item in the Schedule 
Log.

This means that whether a Log Item is still playing or whether you are in Live 
(or Preview Live) mode and you are currently between Log Items, pressing 
the Go button will start the next Log Item playing and, depending on how 
Myriad is set up, fade out the previous Log Item (if it is still playing).

The Go Event

The process above is known as the Go Event and there are a couple of ways 
the Go Event can be triggered in Myriad. Obviously, pressing the Go button 
on screen will always cause a Go Event to be triggered, but you may also 
have a Go button on your Myriad keyboard, there are also a couple of 
different keyboard shortcuts that will work, and you can also click on the Play 
button on the Cart Player that the next Log Item is cued up in. The list below 
outlines the ways of triggering a Go Event.

 Click on the Go button on screen.
 Press the Go button on your Myriad keyboard.
 Press the <Ctrl>+<Q> keys on your keyboards (works in all 

configurations and all screens in Myriad).
 Press the <Space Bar> (only works in single screen mode when the 

Log Screen is visible and has focus. This method should be avoided).
 Press the Play button on the Cart Player that the next Log Item is cued 

in (either using the on-screen play button or a keyboard shortcut / 
Myriad keyboard Cart Control).

 Select the Log Menu > Go option.

Whilst there are several ways in which a Go Event can be triggered, you will 
probably find that you only use one or two methods regularly. Either way, the 
result is always the same.

What happens when a Go Event is triggered can be configured using the 
Settings Menu > Station Database Settings > Q-AE tab. The two settings that 
determine whether the previous Log Item is faded out, and the duration of the 
fade if used, are highlighted in the screen shot below.
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PreCue

The PreCue button is only available when you are in Active Playout mode and 
it is used to manually force Myriad to cue the next Log Item into a Cart Player 
ready to be played.

Normally, Myriad only cues the next Log Item into a Cart Player a few 
seconds before it needs to play it, but there may be occasions where you 
would prefer to have the next Log Item cued long before Myriad would 
normally do the job. In these situations, clicking on the PreCue button or 
pressing the Ctrl+Shift+Q keys will force Myriad to cue the next item for you.

Some Myriad keyboards will also have a PreCue key on them which works in 
exactly the same way. You can also manually drag a Log Item into a free Cart 
Player and Myriad will use the cued item when it needs to play it rather than 
load cue a second version of the same Log Item.

Please note that whether the next Log Item is cued or not, if Myriad receives a 
Go command from with the on screen button or the keyboard, it will 
automatically cue and play the next Log Item. Similarly, if it gets to a segue 
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point and the next Log Item is not cued, it will cue and play it anyway so you 
really don’t have to worry!

Preview

The Preview button on the Main Tab Strip is used to load a copy of the 
currently highlighted Log Item into a Cart Player in Preview Mode.

When a Cart Player is working in Preview mode, you can listen to the Cart 
and use the Cart Player as normal but Myriad will ignore the fact that you are 
using the Cart Player when it comes to playing Log Items from the Schedule 
Log.

The reason Myriad does this, is that in normal operation, when Myriad is in 
one of the Active Playout Modes, if the next Log Item to play is loaded into a 
Cart Player and then the Play button is pressed, Myriad will treat this as a ‘Go’ 
event and will move the Currently Playing Item indicator on to that item. 
Depending on how Myriad is set up, it may also fade out the previous Log 
Item at the same time. The reason for this is that it allows you to use the Play 
buttons on each Cart Player to control the flow of the program when 
presenting a Live Assisted or Automated radio program. The problem comes 
when you want to preview a Log Item to see what it sounds like but you do not 
want Myriad to move on to that Log Item just yet. Under these circumstances, 
clicking on the Preview button will load the Log Item into a Cart Player in 
Preview mode which allows you to play and review the Log Item without 
affecting the main playout of Myriad. Indeed, if you still have a Log Item in 
Preview mode when it is time for Myriad to play the Log Item, Myriad will load 
the item again on another Cart Player (but not in Preview mode).

You can also use the Preview option on the right click menu to do the same 
thing, and many Myriad keyboards also have a Preview Log button on them 
as well. The keyboard shortcut for this option is <Shift>+<Ctrl>+<Alt>+<Q>.
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Suggest

The Suggest button is only available when you highlight a Song or Link Log 
Item and it is used to help you replace the currently highlighted Log Item with 
an alternative Log Item from the same Song or Link Category in your 
scheduling system.

If you highlight a Song or Link Log Item and then click on the Suggest button 
then a ‘floating’ Database Screen (see Chapter 4) window appears to allow 
you to browse the Database and select a suitable Song and Link by double 
clicking on it.

In the example above, ‘Praise You’ is the currently highlighted Log Item and 
clicking on the Suggest button opens a ‘floating’ Database screen which 
initially shows the other Songs in the same Category as ‘Praise You’. Whilst 
the default is to display Songs from the same Category, you can use Song / 
Link Category Navigation tree to the left of the screen to browse Songs and 
Link Database by Category. You can also perform a Search of the Database 
using the Search For box and some of the Search Options such as excluding 
Songs / Links Played Recently may prove very useful.

To Select a Song or Link to replace the highlighted Log Item, double click on 
the Song or Link entry on the Database screen.

Please note that just as with the Database screen as a whole, this option will 
only be useful if you are using AutoTrack or AutoTrack Pro or if you are using 
a third party scheduling system (like RCS Selector™) and have imported the 
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music database into Myriad using the Log Importer tool (which is part of the 
Myriad Tools Pack).

You can also access this facility using the Replace > Song option on the right 
click menu.

Carts

The Carts button on the Main Tab Strip is used to open a ‘floating’ Audio 
Browser window to allow you to browse the Audio Wall, search for Carts and 
‘drag’ Carts from the Audio Browser directly into the Schedule Log.
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The Audio Browser is an extremely powerful and flexible tool and is covered 
in detail in Chapter 7. For more details on the Audio Browser and how to use 
it to navigate around and search the Audio Wall, please refer to the Audio 
Browser documentation.

The Carts button is very useful if you are using Myriad in single screen mode 
as it is the simplest method for adding Carts from the Audio Wall to the 
Schedule Log. If you are running in dual screen mode then there is far less 
need for the Carts button as the Audio Wall will be available on the first 
screen via the Main Tab Strip. The Carts button will still be available in this 
mode should you wish to access it.

SegEdit

The SegEdit button on the Main Tab Strip is used to toggle the Mini Segue 
Editor between mini and full Segue Editor modes. Clicking on the Seg Edit 
button will have the effect of enlarging the Mini Segue Editor into full Segue 
Editor mode which allows you to adjust the fade points and positioning of the 
segue between two Log Items as well as allowing you to record a Voice Track 
in between two Log Items (assuming you have the Voice Tracking module 
installed).
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The Large green arrow on the Schedule Log shows the two (or sometimes 
three) Log Items that are currently displayed in the Segue Editor.

You will notice that when you go into full Segue Editor mode, two or more Cart 
Players will be reserved for use by the Segue Editor.

The Segue Editor in full mode will assume that it can use these Cart Players 
whenever it needs to, so it is important that if you are working on a Myriad 
Workstation that is ‘live to air’ then make sure you close the faders for the 
corresponding channels on your desk (and prefade / cue them if needed) at 
this stage.

In Mini Segue Editor mode, the Segue Editor will warn you prior to using Cart 
Players for reviewing purposes, but in Full Segue Editor mode, it assumes
that you have decided to use the Segue Editor (by clicking the button) and 
that you have taken the necessary steps to ensure that the audio will play 
safely. You have been warned!

To review a segue, click on the Play button on the Segue Editor and playback 
will begin using the reserved Cart Players.
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You can stop playback at any time by clicking on the Stop button (which 
replaces the Play button while it is playing).

Adjusting Positioning and Fading in SegEdit Mode

Once you are in full SegEdit mode, the Segue Editor works in exactly the 
same way as the Mini Segue Editor (see Mini Segue Editor). The currently 
highlighted Log Item is shown in the lower section of the Segue Editor (in 
green) and the previous Log Item is shown in the top section in yellow. As 
before, the downward slope on the top Log Item indicates the duration 
between the Extro point on the item and the very end of the audio file. The 
upward slope on the lower item represents the duration between the start of 
the Log Item and the Intro End point. The vertical line represents the segue 
point between the two Log Items and as we have not edited the segue yet, it 
will be at the previous Log Item’s Extro point.

To edit the Segue point between the two items, use the left mouse button to 
drag the lower Log Item to the left or right.
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Note how the Segue Point moves with the start of the Lower Log Item. 

CAUTION: when you release the Log Item, the Segue Editor will automatically 
begin playback of your newly edited segue in the Segue Editor reserved Cart 
Players.

When you edit a segue using the Mini Segue Editor, you have to click on the 
Play button on the Segue Editor in order to review the segue but when you 
are in Full Segue Edit mode, Myriad assumes that you have taken steps to 
ensure that the reserved Cart Players are safe to use (i.e. you have pulled 
down the corresponding faders on your mixing desk). 



516

Once playback has started you can continue to edit the segue in the same 
way if needed. To stop playback, click on the Stop button.

If you wish to abandon your segue edit and return the segue to its original 
position, click on the abandon button.

When you are happy, click on the Save button to save the new segue 
information to the Schedule Log.
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You can also use this mode to edit the way in which the previous Log Item is 
faded out to allow for greater control of the segue. This is done by adjusting 
the fade ‘envelope’ (the blue line) on the upper section of the Segue Editor.

The fade ‘envelope’ consists of two editable points, one for the start of the 
fade and the other for the end. In the example above, the fade start and end 
are directly above each other and at the end of the audio file so effectively, 
Myriad will not fade the item at all. In the example below, the fade ‘envelope’ 
has been adjusted to start fading the item out earlier.

Note how the fade ‘envelope’ has been edited to start fading before the song 
reaches its Extro point and will be faded out completely before the end of the 
audio file is reached.

To edit the fade ‘envelope’ use the left mouse button to drag the fade start 
and end points to the left or right.

Again, you can use the Save button to save your edited fade ‘envelope’ and 
the Abandon button to discard your fade ‘envelope’ changes and return to the 
original state.
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Recording A Voice Track (Link) Using the Segue Editor

The other primary use for the Segue Editor in full mode is to allow you to 
record Voice Tracks between Log Items to be played back by Myriad in one of 
the Active Playout modes.

The general Voice Tracking (as it is known) is used to add ‘live’ sounding 
voice links to automated playout to make the listener think that a presenter is 
presenting the show when in fact Myriad is playing a mixture of Log Items and 
pre-recorded voice links. The key factor is that when Voice Tracking, each 
voice link is recorded as if it were being done ‘live’ and specifically for the Log 
Items that it is positioned between. Myriad then plays the Voice Tracks exactly 
as they were recorded meaning that they should be indistinguishable from the 
‘real thing’.

In practice, the Voice Tracking process is very simple to allow the presenter to 
concentrate on the content of their links and not the buttons they are pressing. 
In general, the entire process can be controlled by one button, and each stage 
happens automatically. The process is:

1. Click on the SegEdit button to open the Segue Editor in full mode.
2. Highlight the Log Item that you want to be playing at the end of your 

Voice Track. You can use the GoTo button on the Main Tab Strip to 
jump to a specific time and date in the Schedule Log if you need to.

3. Press one of the following to start the Voice Tracking process:

 Click on the Voice Tracking button on screen .
 Press the <Space Bar> (make sure that the Log Screen was the 

last screen you clicked on as you do not want to accidentally 
trigger an Audio Wall play).

 Press the <Ctrl>+<Space Bar> (this method works whichever 
screen you clicked on last).

 Press the Segue Step button on your Myriad keyboard.

4. Whichever method you chose, the result will be the same, the last few 
seconds of the previous Log Item will play using the first reserved Cart 
Player.

5. When you are ready to record your link, put the ‘mic’ fader up and start 
speaking. Myriad will automatically detect the incoming audio level and 
start recording into the next free Cart in the Voice Tracking Cart Range 
(see Settings Menu > Station Database Settings > General tab). If you 
have not configured Myriad to start from a ‘trigger’ audio level, or you 

wish to start recording manually, click on the Record button 
(which takes the place of the Voice Tracking button) or press either one 
of the <Space Bar> or <Ctrl>+<Space Bar> button options to manually 
start recording.
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6. When you are ready to start the next Log Item playing, click on the Play 

Next button  or press the <Space Bar> or <Ctrl>+<Space Bar> 
keyboard options (or the Segue Step button on your Myriad keyboard).

7. When you have finished your Voice Track, click on the Stop button 

 or press the <Space Bar> or <Ctrl>+<Space Bar> options (or the 
Step Segue button).

8. You will then be asked to confirm whether you wish to save the 
recorded audio (and the Voice Track information) or whether you wish 
to discard it. Click on Yes to keep the Voice Track or No to discard it.

9. Your finished Voice Link has been recorded to the Audio Wall and the 
relevant details have been added to the Schedule Log.
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Note how the large green arrow on the Schedule Log shows the Log 
Items that are displayed in the Segue Editor.

This may seem a little complicated in the above example but that is because 
there are a number of different methods that you can use to step through the 
Voice Tracking process. Let’s look at the process again but this time we will 
just assume that we are working with a single screen Myriad workstation and 
that the Log Screen is on display. In this instance, we can use the <Space 
Bar> to step through the entire process.

Firstly, click on the SegEdit button to open the Full Segue Editor.
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Ensure that the highlight is on the Log Item that you want to be playing when 
you finish your link.

Now press the <Space Bar>
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The end few seconds of ‘Run DMC’ starts playing in one of the reserved Cart 
Players. 

Let’s assume that we have configured Myriad to record from a ‘trigger’ audio 
level when working with the Segue Editor. In this configuration, Myriad will 
automatically assign the first free Cart in the defined Voice Segue Cart Range 
(all configured on the Settings Menu > Station Database Settings > General 
tab) and start recording as soon as the incoming audio level exceeds the 
defined ‘trigger’ level.

So to start recording our voice link, we put the ‘mic’ channel fader up (on our 
mixing desk) and start speaking.
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Next we want to start the next Log Item playing. Once again, hit the <Space 
Bar> to start playback.
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Currently, Myriad is still recording your voice and the next Log Item has been 
started. You can use the Cart Players to talk right up to the Intro End on the 
Song if you like but either way, as soon as you don’t want to speak any more, 
press the <Space Bar>, halt playback and decide whether you wish to keep or 
discard the Voice Track.
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You can click on the Yes button to keep the Voice Link or the No button to 
discard it, or, because the Yes button has focus, you can also press the 
<Space Bar> to keep the link.
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As you can see, the Voice Track has been added to the Schedule Log and the 
details are displayed in the Segue Editor. 

You can review the Voice Link by clicking on the Play button . The Link 
will be played in reserved Cart Players.
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NB: If Myriad is on an Active Playout Mode then it will always ensure that 
there are at least two Cart Players available for general playout, so if you only 
have four Cart Players (as above) and you review a Voice Track whist also in 
any Active Playout mode then Myriad will only reserve a maximum of two Cart 
Players for the Segue Editor. Myriad will still allow you to review segues under 
these circumstances but it will not be an accurate representation of how it will 
sound when it is eventually played out on air. If you are not in an Active 
Playout mode (as in the screen shot above) then Myriad can reserve three 
Cart Players and will provide an accurate recreation of the Voice Link.

If we leave this link as it is, Myriad will play it back exactly the way we 
recorded it in Active Playout mode so if we had been singing along to the 
vocals, that is what will go out ‘on air’. Myriad will even automatically ‘duck’ 
the volume of the two songs whilst the Voice Track is playing to allow the 
voice to ‘travel’ over the songs.

Alternatively, we can use the Segue Editing and fade ‘envelope’ editing 
techniques we discussed earlier to move any of the Log Items involved with 
our Voice Link around and change the fade points on the previous Log Item 
and Voice Link.
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Using these techniques, you can tidy up any gaps in your voice link, fade out 
the previous song early and generally make it as tight sounding as you like. 
When you have finished, click on the Save button to commit your changes to 
the Schedule Log.

GoTo

The Goto button allows you to select a time and date in the Schedule Log that 
you wish to view or work with.

To use this feature, click on the GoTo button and then select the date and 
time that you wish to GoTo using the popup window.

Once you have selected the time and date you wish to jump to, click on the 
Ok button. Myriad will then automatically jump to the Hour Start Marker for 
selected hour.
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Working with the Log Screen

In this section we will run though some of the more common tasks you will 
face when using the Log Screen. This section assumes that you are familiar 
with the screen layout and terminology used on the Log Screen and also you 
are familiar with the basic concept. If you are unsure, it may be worth 
reviewing the What Is the Log Screen and Log Screen General Screen Layout 
sections earlier in this Chapter.

Switching From Standby to an Active Playout Mode (and back 
again)

The first thing we will look at is how to switch between Standby mode and one 
of the five Active Playout modes (see Playout Mode Buttons for more details).

The screen shot below shows Myriad in a single screen configuration with the 
Log Screen selected.
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Note that the workstation currently has On Air Control (is On Air) and so the 
Live, Auto and AutoFade playout mode buttons are visible. If we did not have 
On Air Control then only Live Preview and Auto Preview buttons would be 
visible.

Note that the Live Playout Mode is in yellow text which indicates that it is the 
default Playout Mode for the currently selected hour in the Schedule Log.

To switch Myriad from Standby Mode to one of the available Active Playout 
Mode, use one of the following methods.

 The Power Button – If you click on the Power Button (top left), Myriad 
will automatically switch the default Playout mode for the hour (in this 
case Live mode), cue the currently highlighted Log Item in a Cart 
Player and display a ‘Waiting For Go’ message in the Notes panel. To 
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start Active Playout, press the Go button (or press play on the Cart 
Player the Log Item is loaded on to).

 Manually Select A Playout Mode – You can also manually select an 
Active Playout Mode by clicking on one of the three Active Playout 
Mode buttons (i.e. Live, Auto or AutoFade). When you click on one of 
these buttons, Myriad will switch to the selected Active Playout mode 
and cue the selected Log Item into a free Cart Player. You then press 
the Go button or press the Play button on the Cart Player being used to 
start Active Playout.

Please note that while you are in an Active Playout Mode, the corresponding 
Playout Mode button remains depressed to indicate which mode you are in.

If your workstation does not have On Air Control (is Off Air) then both of the 
methods above will still work but only Preview Live and Preview Auto Playout 
Modes will be available.

If you are in an Active Playout Mode and you want to drop back to Standby 
mode, you pretty much do the same thing but in reverse. The options are:

 The Power Button – Clicking on the Power button when in an Active 
Playout Mode will cause Myriad to drop back to Standby mode. The 
currently playing Log Item will continue playing but no further Log Items 
will be played while Myriad remains in Standby.

 Manually Deselect A Playout Mode – You can switch from an Active 
Playout Mode back to Standby by clicking on the depressed Playout 
Mode button. The currently playing Log Item will continue to play but no 
further Log Items will be played whilst Myriad remains in Standby 
mode.

Switching Between Active Playout Modes (on the fly)

Once you are in one of the five Active Playout Modes, you can switch to one 
of the other available modes at any time by simply clicking on the 
corresponding Active Playout Mode button.

In the example above, Myriad is in Live mode. To switch to AutoFade mode, 
simply click on the AutoFade button.
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To switch back to Live, just click on the Live button again!

Switching Station (On Air) Control 

As outlined in the On Air Control Overview section of this Chapter, Myriad can 
be configured to allow only one workstation to be classed as ‘on air’ at a time. 
This allows you to compile more accurate ‘as played’ logs for copyright report 
bodies or internal use. It also allows you to switch control of external software 
such as OCP and Myriad STS between Myriad workstations without changing 
any settings.

The default setting for Myriad is to use Simple On Air Control where only one 
Myriad workstation has On Air Control at any one time and On Air Control is 
passed from workstation to workstation using the On Air / Off Air button.

In the example above, the workstation currently does not have On Air Control
so the indicator shows ‘Off Air’ status.

To take On Air Control, simply click on the On Air / Off Air Control button.

To release On Air Control, click on the On Air / Off Control button again. 

Please note that Myriad can be configured so that the workstation that has On 
Air Control has to release it before another workstation can take control. If this 
is the case then you will see a message box that explains the situation when 
you attempt to take On Air Control. Myriad can also be configured so that a 
single workstation always has control or never has control in which case the 
On Air / Off Air button will not be visible at all.

Moving Log Items Around In the Log

To move Log Items around with the Schedule Log, simply use the left mouse 
button to drag them up or down the Log to the desired place.
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Once you have clicked on a Log Item and dragged it up or down the Log, a 
thick brown line indicates the position in the Schedule Log that the item will be 
dropped in when you release the left mouse button.

If you need to move a Log Item further up or down the Schedule Log than is 
currently visible then you can scroll up or down the log by dragging the Log 
Item in the area directly above or below the main Schedule Log Area.
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Deleting Log Item from the Schedule Log

There are a number of options open to you if you want to delete Log Items 
from the Schedule Log, but before we get to that we need to review the 
difference between a Soft Delete and a Permanent Delete. When you Soft 
Delete a Log Item, it remains in the Schedule Log but appears ‘greyed out’. In 
this state, Myriad will not play it and treat it as it is not in the Log at all but you 
can restore it to the log at any time (see below). When you Permanently 
Delete a Log Item it is removed from the Schedule Log altogether.

The options for deleting Log Items from the Schedule Log are outlined below:

 Soft Delete Using The Log Item Type Icon – You can Soft Delete a 
Log Item by clicking on the Log Item Type Icon. The Log Item will be 
Soft Deleted and the Type Icon will have a red cross through it.
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You can restore a Soft Deleted Log Item by clicking on the Log Item 
Type Icon again.

 Permanently Deleting Using The Trash Can – You can Permanently 
Delete a Log Item by using the left mouse to drag the Log Item to the 
Trash Can icon on the bottom right of the screen.

You can restore the last Permanently Deleted Log Item back to the 
Schedule Log by clicking on the Undo button located directly below the 
Trash Can.

 Using The Right Click Menu – You can use the Right Click menu to 
Soft or Permanently Delete a Log Item or to restore a previously Soft 
Deleted Log Item.

Adding a Voice Track to a Show

This is covered in detail in the SegEdit section of this Chapter but here is a 
brief recap. In this example, we will assume that Myriad is configured to use 
‘trigger’ audio level recording.
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1. Use the GoTo button on the Main Tab Strip to enter the time and date 
that you wish to work with in the Schedule Log.

2. Click on the SegEdit button to enter Full Segue Editor mode.
3. Highlight the Log Item that you want to be playing at the end of your 

Voice Track.
4. Ensure that the faders are down for the reserved Cart Player channels 

that the Segue Editor is going to use.
5. Press the <Space Bar>, Myriad will automatically start playback of the 

last few seconds of the previous Log Item.
6. When you are ready to start recording, put the ‘mic’ fader up and start 

speaking. Myriad will automatically start recording into a free Cart in 
the Voice Tracking Cart range.

7. Press the <Space Bar> again to start playback of the next Log Item.
8. When you have finished speaking, press the <Space Bar> to end 

recording and playback. You will now be asked to confirm the Voice 
Track.

9. Press the <Space Bar> one final time to save the Voice Track and add 
it to the Schedule Log.

You can review your Voice Track using the Play button on the Segue 
Editor, the link will be reviewed using the reserved Cart Players. You can 
change the segue points in the link by dragging the Voice Track and next 
Log Item to the left and right in the Segue Editor. You can also use the 
fade ‘envelope’ to change the way the fading will work. When you have 
finished editing your Voice Track, click on the Save button.

Adding / Replacing Items to the Schedule Log 

As well as moving Log Items around and deleting items, you can also add Log 
Items to the Schedule Log if you have enough access rights.

There are actually several methods that can be used for adding Log Items 
depending on your system set up and the type of Log Item that you want to 
use. Here are your options:

 Drag Carts From The Audio Wall – The first and simplest method is 
to drag Carts that you want to add to the Schedule Log directly from 
the Audio Wall. If you have a dual screen set up then you can drag 
directly from the Audio Wall on the left hand screen in to the Log 
Screen on the right.
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If you are working on a single screen system then you will have to use 
the Carts button on the Main Tab Strip to access the Audio Browser. 
Once the Audio Browser is open, you can drag Carts from the browser 
into the Schedule Log.

Whether you are using single or dual screen configurations, Carts 
added to the Schedule Log by dragging will automatically be checked 
against the Database (see Chapter 4 - The Database Screen) and if 
they are found listed as Songs or Links then they will be added to the 
Schedule Log as a Song or Link Log Item as appropriate. If you are 
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using a 3rd party music scheduling system and the Myriad Log Importer 
to import the Schedule Logs then you can set up Cart Ranges to tell 
Myriad where Carts of different types are stored on the Audio Wall. 
These will then be used to determine Log Item Types when dragging 
Cart from the Audio Wall. To set the Cart Ranges, run the Myriad Log 
Importer, click on the Settings > Log Import Settings menu option and 
select the Cart Ranges tab.

 Drag From Other Areas In Myriad – You can also drag in Log Items 
from several other areas in Myriad. These include:

o The Database Screen
o The Find Cart Window
o The Jump To Cart Preview
o The Pad List

Pretty much any areas in Myriad that contains Carts or a list of Carts 
will also allow you to drag them into the Schedule Log.

 Using The Right Click Menu – You have a range of options for 
Inserting Log Items using the right click menu on the Schedule Log.
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You can use the Insert menu option to insert a Log Item into the 
Schedule Log. You can use the extended menu options to select the 
type of Log Item that you want to insert. Each option allows you to 
either select a Cart from the Audio Browser or Database window or if 
the Log Item is not Cart based (e.g. Hardware, AutoHook etc) then you 
will be asked to provide the details for the Log Item you are inserting. 
For more details on the right click menu options, please refer to the 
Right Click Menu section of this Chapter.

You can also opt to use the Replace menu options to replace the 
highlighted Log Item with another Log Item. Again, use the extended 
menu to select the Log Item Type that you want to replace it with.

 The Suggest Button – You can use the Suggest button on the Main 
Tab Strip to replace the highlighted Log Item with another Song or Link 
from the Database window.
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When you click on the Suggest button, a special ‘floating’ Database 
window appears to allow you to browse the Songs and Links in your 
Database (See Chapter 4 for more details). By default, this window will 
list all of the Songs or Links in the same Category as the Log Item you 
clicked on but you can use the Song / Link Category Navigation Tree 
and Search For tools on the left of the window to browse and search 
the Database. To select a Song or Link to replace the highlighted Log 
Item, simply double click on it in the Database window.

Tips for Presenting a Show in Live Playout Mode

All of this has been covered in more detail earlier in the Chapter so here we 
will just recap over a few things that you should remember when presenting a 
live show using the Log Screen in Live Playout mode.

 If you are presenting a show using Myriad, make sure you are in Live 
mode as in Auto or AutoFade mode, Myriad will automatically perform 
all segues for you.

 Use the Segue Type to toggle between Red (Stop) and Green Go to 
decide when Myriad should pause at the end of a Log Item or 
automatically segue in to the next.
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 Remember that you can press the Go button at any time to move on to 
the next Log Item in the Schedule Log. Most commonly this is used to 
restart playback after a Red (Stop) Segue Type but you can click on 
Go at any time to start the next item. Myriad can be configured to 
automatically fade out the previous Log Item when you press Go and 
the next Log Item does not have to be cued for the Go button to work.

You can also trigger a ‘Go Event’ but pressing Play on the Cart Player 
in which the next Log Item is loaded. You can combine this with the 
Pre-Cue button to load the next Log Item before Myriad would normally 
do so.

 You can drag Carts in from the Audio Wall screen (in dual screen 
configurations) or from Audio Browser which can be accessed using 
the Carts button on the Main Tab Strip. You can also drag Songs and 
Links into the Log from the Database screen and replace Songs and 
Links using the Suggest button. Finally, the right click menu provides 
comprehensive options for adding, altering or removing Log Items from 
the Schedule Log.

 You can remove Log Items from the Schedule Log in two ways. When 
you Soft Delete a Log Item, it remains visible in the Log but appears 
‘greyed out’ and will not be played by Myriad. If you Permanently 
Delete a Log Item, it is removed from the Schedule Log altogether.

You can Soft Delete a Log Item by clicking on the Log Item Type Icon. 
You can restore a Soft Deleted Log Item by clicking on the Log Item 
Type Icon again.

To Permanently Delete a Log item, either use the Permanently Delete 
option on the right click menu or drag the Log Item in to the Trash Can 
icon (on the lower right hand side of the screen).
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You can restore the last Permanently Deleted Log Item back to it’s 
original position in the Schedule Log by clicking on the Undo button 
located below the Trash Can.

 Remember that Log Items that have a Yellow (Sweeper) Segue Type 
will be dealt with in a special way by Myriad. Depending on how Myriad 
is configured, the sweeper will either play with the beginning of the 
Song Intro, be back timed to the Intro End on the Song or be played 
dry. You can use the right click menu to change a standard Segue 
Type to a Yellow (Sweeper) Segue Type (See Change Log Items 
Ending Type).

 Use the Next Segue, Time Remaining and Overrun indicators to help 
you get the timing of your show just right.

 Use the Mini Segue Editor to review and adjust any automated segues 
to sound the way you want them to.

 If you need to open a ‘floating window’ with a Log Item’s Notes 
displayed, click on the large ‘i’ icon on the Notes panel.

 You can use the wheel on your mouse to scroll up and down the Log 
Screen quickly.

 If you need to step out of the studio, either ensure that the next few Log 
Items has Green (Go) Segue Types or better still, click on the Auto or 
AutoFade Playout Mode buttons to put Myriad in Auto or AutoFade 
mode. When you switch back to Live mode, all of your Segue Types 
will be restored back to their ‘live’ state.

Chapter 5 Summary

In this Chapter we spent a good deal of time looking at the Log Screen and 
the Schedule Log and how they can be used to deliver both ‘live’ and 
automated programming for your station. We examined the basic principles 
behind the Log Screen and how to actually use it in day to day operation. 
Finally we looked at how Voice Tracking could be used to enhance automated 
playout and how to add Voice Tracks to the Schedule Log. 

The key areas covered in this Chapter are:

 What the Schedule Log is and it’s role.
 The general layout of the Log Screen.
 What all the major elements of the Log Screen do.
 The different Active Playout Modes and how to use them.
 Working with the Schedule Log.
 Editing segues and recording Voice Tracks.
 Tips on how to get the most from the Log Screen.
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Chapter 6 – The SmoothEdit Screen (Edit Cart)

The SmoothEdit Screen is used to review and edit Cart Details in Myriad, this
means that everything from the Notes to the Timing information is set using 
various parts of the SmoothEdit screen.

In this Chapter we will familiarise ourselves with the SmoothEdit Screen 
layout and look at the elements included on screen. We will look at how to use
key Myriad functions such as titling Carts and adding timing information like
Intros, Extros and Hooks. We will then move on to basic audio editing and 
how to use the SmoothEdit audio editor. Key things we will cover include: 

 What is SmoothEdit and how does it fit into the Myriad suite of 
products.

 The general SmoothEdit Screen layout and the role of all the elements.
 Filling in basic Cart information such as Title and Artist.
 Adding the key timing events such as setting Intros, Extros and Hooks.
 The basic layout and tools available in the audio editor area.

What Is SmoothEdit?

SmoothEdit is a P Squared stand alone audio editing tool and it is designed to 
provide simple audio editing facilities for studios, news workstations and other 
low demand applications. Whilst SmoothEdit is a stand alone system (which 
can be purchased separately from P Squared), many P Squared products 
now incorporate a SmoothEdit module to allow the tools that SmoothEdit 
provides to be added to the overall product abilities.

The SmoothEdit module in Myriad has been expanded to include a whole 
range of additional information about Carts to provide a comprehensive 
screen for editing and working with the details for Carts on the Audio Wall.

In addition to the Cart information, you can also use the audio editing tools in 
SmoothEdit to edit the audio for a Cart, record new audio into a Cart and 
visually set the timing information for a Cart.
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You may notice that the SmoothEdit tab is not visible on the Main Tab Strip at 
all times, in fact it is only visible when one or more Carts are being edited, 
when the final Cart is closed, the SmoothEdit tab disappears from the tab strip 
altogether. You can open a Cart up for editing with SmoothEdit by either using 
the Audio Wall right click menu or by highlighting the Cart you want to Edit 
and then clicking on the Edit button on the Audio Wall Main Tab Strip.

The SmoothEdit Screen Layout at a Glance

In this section we will look at the General Layout for the SmoothEdit screen,
and the primary function of the elements on screen. The following section will 
then look at each element in a little more detail.

The General Tab at a Glance

The General tab is the default visible tab in SmoothEdit and covers all of the 
primary information you would normally set or review when working with 
Carts. There is also a Notes tab, a Copyright tab and an Other tab but we will 
deal with those in due course.
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 Edit Cart Tool Bar – This provides a range of tool options for working 
with the Cart as a whole. These tools include:

o Cart Number – The Cart Slot Number for the Cart you are 
working on.

o Launch External Audio Editor (if configured) – Launches 
another external audio editor (such as Adobe Audio Audition).

o Link Cart To Wav File – Link the Cart to an external audio file 
(but don’t copy the audio content to your Audio Wall folder.

o Export Cart – Export the Cart to an external file.
o Save Cart –Save any changes you have made.
o Delete Cart – Delete the Cart audio and details.
o Import Audio – Import an audio file as a Cart on the Audio Wall.
o Toggle Cart Descriptions – Toggles the Cart Descriptions 

panel on and off. 
 Notes Tab – Switch to the Notes tab to add text notes to the Cart.
 Copyright Tab – Switch to the Copyright panel for viewing and editing 

the Carts copyright details.
 Other Tab – Switch to the Other tab which allows you add pictures to 

the Cart and view recent play history.
 Time Info Panel – Allows you to view and set the Cart Timing 

information i.e. the Intro, Extro and Hook points.
 Audio Edit Tool Bar – Offers a range of tools that can be used to edit 

the audio. The options include:
o Undo - Undoes the last action in SmoothEdit.
o Redo – Redoes the last undone action.
o Cut – Cuts the highlighted section of audio from the overall file 

and copies it to the computers ‘clipboard’.
o Copy – Copies the selected section of audio to the computers 

‘clipboard’.
o Export Selection As Wave – Exports the selected section as a 

separate audio file.
o Paste – Pastes audio from the ‘clipboard’ into the selected 

position in the audio file. You can also use the drop down list to 
get a more comprehensive range of pasting options.
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o Delete Selection – Removes the selected section from the 
audio file.

o Replace With Silence – Replaces the selected section of the 
audio file with silence.

o Select Channels To Edit – Use the drop down list to select left, 
right or both channels to work with.

o Insert Silence – Inserts X many seconds of silence into file at 
the selected position.

o Delete Silence – Scans the audio file looking for silent periods 
and removes them.

o Reverse Selection – Reverses the selected section, so that it 
will be played backwards.

o Time Stretch – Allows you to stretch or shrink the selected 
section of audio to a specific length.

o Amplify Selection – Change the volume of the section of audio 
selected.

o Normalise – Performs a normalise function on the selected 
section of audio.

o Fade In Selection – Fades in volume from zero to full over the 
selected audio section.

o Fade Out selection – Fades out volume from full to zero over 
the selected audio section.

 VU Bars – Offers a visual representation of audio levels during 
playback.

 Time Info – Provides useful information about the length of recording 
space available and the length of the overall Cart you are working on.

 Extro Marker – Visually shows the position of the Extro point on the 
Cart.

 Playback Time – Displays the position of the audio edit cursor.
 Hook Markers – Visually shows the position of the Hook for the Cart.
 SmoothEdit Audio Controls – Provides a range of tools and options 

for controlling audio playback within SmoothEdit.
 Intro Markers – Shows where the Intro Start and Intro End markers 

are on the audio.
 Wave Form Edit Area – The Wave Form Edit Area displays a visually 

representation of the audio for the Cart in the form of a wave form. You 
can use this area view and edit the audio for the Cart.

 Cart Colours – You can set the colour for both the text and 
background for the Cart using these options.

 End Type – Allows you to specify the End Type that is most 
appropriate for the Cart you are working on.

 Description Lines – You can edit the Title, Artists and Description text 
using these fields.

 Open Carts – You can be working on more than one Cart at once in 
SmoothEdit. If you have multiple Carts open, the Cart buttons on the 
Main Tab Strip allow you to switch between the open Carts.

The Notes Tab at a Glance



547

The Notes Tab allows you to add a range of text notes to the Cart you are 
working on. Other than the areas highlighted below, the rest of the 
SmoothEdit screen remains the same.

 Studio Notes – The Studio Notes are used to add text information 
intended for use by the presenter when they are presenting a show. 
These Notes appear in the Notes panel on the Log Screen unless the 
Schedule Log contains notes itself.

 Web Notes – Web Notes allow you to set specific text notes that OCP 
can then use to update a web site in ‘real time’.

 Artist Website – Again, this can be used by OCP for updating your 
web site. The presenters may also find this useful.

 DAB Notes – The DAB Notes can be sent to DAB (Digital Radio) 
transmitters via OCP.

 Online Store Reference – Some online music stores require you to 
provide a unique song reference when setting up ‘click to buy’ 
reciprocal arrangements. Amazon however, does not need this as it 
uses the Artists and Title to formulate the search query.

The Copyright Tab at a Glance

The Copyright tab allows you to add a range of additional copyright 
information for the Cart you are working on. Other than the parts outlined 
below, the rest of the SmoothEdit screen remains the same.
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The Copyright info is used when generating copyright reports for copyright 
bodies, using Myriad Manager. The exact use for each field will differ 
depending on which country you are in and the organisation you are reporting 
to. The outline below is meant as a guide only.

 Product Title – The product title for the audio you are working with. 
This could be an album title for example.

 Music Title – The title of the music you are working with. Click on the 
Copy button to copy the Title from the General tab.

 Recording Number – This is normally the unique recording number 
found on the spine of the CD.

 Composer / Arranger – The name or names of the composer / 
arranger.

 Performer – The name of the artist who performed the song. This can 
be copied from the Artist field on the General tab using the Copy 
button.

 Publisher – The name of the company that published the recording.
 Record Label – The name of the record company that owns the 

recording.
 Rights Management Field – Special field used by some copyright 

agencies.
 Copyright Code – Allows you to assign a code to identify the use for 

the audio. The options are:
o Not Specified
o C – Commercial
o D – Disc
o L – Live / Local
o P – Promo
o S – Station Ident

 Total Duration – The total duration of the audio recording. You can 
click on the Copy button to copy the overall Cart Length from the 
General tab.

 Music Duration – This allows you to specify a separate music 
duration. This may be useful if you are working with a promo that is 30 
seconds long but only contains 10 seconds of music. You would set 
Total Duration to 30 seconds and Music Duration to 10 seconds. That 
way, if your music copyright body charges per second played, you will 
not have to pay for time you did not use.
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The Other Tab at a Glance

The Other tab provides access to recent play information for the Cart that you 
are working with. It also allows you to attach JPG pictures to the Cart which 
OCP can then in turn upload to your station website when the Cart is played. 

 Picture Carrousel – This allows you to add, view and remove JPG 
pictures to the Cart which can then be uploaded to your web site as the 
Cart is playing, by OCP.

 Recent Play History – This field shows information about the last five 
plays for the Cart you are working on.

 Erase Play History – This button will clear the Recent Play History 
window. Please note that this does NOT affect the overall play logs that 
Myriad maintains so clicking this box will not cause a problem for 
generating copyright reports etc. This will however, clear the recent 
play flag on the Cart which will also remove the Recently Played icon 
from the Cart on the Audio Wall.

We will now look at all these elements in greater detail.

The Edit Cart Tool Bar

Located at the top of the SmoothEdit Screen, the Edit Cart Tool Bar provides 
a range of tools to allow you to work with Carts as a whole. The diagram 
below shows the tools available on the tool bar.
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Cart Number

The Cart Number field on the Edit Cart Tool Bar displays the Cart Slot 
Number for the Cart that you are currently working on in the SmoothEdit 
Screen.

Save Cart

The Save Cart option only becomes available once you have made a change 
to a Cart’s details or the audio for the Cart. Once enabled, click on the Save 
button to commit the changes to the Audio Wall. Once you have saved the 
changes you have made to a Cart, you cannot recover the old information, so 
make sure you want to save the Cart before you click the button.

If you attempt to close the SmoothEdit Screen on a Cart that you have edited 
without saving first, Myriad will prompt you to save the Cart.

If you click on Yes then your changes will be saved and the SmoothEdit 
Screen will close. If you select No then the SmoothEdit Screen will close
without saving the Cart and any changes you have made will be discarded.
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If you click on the Cancel button, then you will be returned to the SmoothEdit 
Screen to allow you to continue to work on the Cart.

Audio Editor (optional)

The Audio Editor button is only visible if you have configured Myriad to use an 
additional external audio editor such as Adobe Audio Audition. 

If you have configured Myriad in this way then clicking on the Audio Editor will 
open your specified audio editor and replace a large panel of the SmoothEdit 
Screen you are working on. In the example below, the external audio editor 
window has been shrunk to allow you to see Myriad in the background.

If you are using the external audio editor to make changes to the audio, make 
your changes, and when you have finished, click on the close button on the 
audio editor (or click on the X in the top right hand corner of the audio editor 
window). You should then be asked whether you wish to save the changes.
Say ‘Yes’ and the audio editor should shut down and return you to Myriad. At 
this point, Myriad will re-scan the audio file and update the wave form display 
on the SmoothEdit Screen to reflect the changes you have made.
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Please remember that if you have trimmed the end of the Cart, you may have 
affected the Extro point so it is worth re-setting this if you need to.

You can configure Myriad to use an external audio editor using the Settings 
Menu > Audio Settings option and selecting the Rec/Edit Settings Tab.
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To enable the Edit Audio button, tick the ‘As well as SmoothEdit, also allow an 
External Audio Editor’ option and then type in (or browse using the Choose 
button) the path to the audio editor you want to use. In the example above, we 
have selected an installation of Cool edit 2000.

You can also change the priority in which windows runs Myriad or the audio 
editor using the slider below. It is recommended that you leave it at the default 
(all the way over towards the audio editor) unless you are finding the audio is 
‘skipping’ in Myriad while using an external audio editor.

Delete Cart

The Delete Cart button on the Edit Cart Tool Bar is used to delete a Cart from 
the Audio Wall from within the SmoothEdit Screen.

If you click on the Delete button, you will then be asked to confirm the action.
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If you click on Yes, then the Cart will be removed from the Audio Wall and the 
SmoothEdit Screen will shut down.

CAUTION – Once you have deleted a Cart, there is no way to recover it 
(unless you have an external backup), so exercise with caution!

Link to Wave File

The Link to Wave File option on the Edit Cart Tool bar allows you to link the 
Cart you are working on to an external audio file. The key difference between 
linking to a file and importing an audio file (see Import Audio File) is that when 
you import an audio file, the file is copied into the default Myriad Audio Wall 
folder location. When you link to a file, the original file stays where it is and no 
copy is made. When Myriad has to play or edit the linked Cart, it will read the 
audio file from the original ‘linked’ location.

The advantage of linking to files is that you do not duplicate audio, the down 
side is that you end up with a very dispersed file structure which is more 
difficult to maintain and backup, and may be slower as Myriad will need to 
work with multiple locations.

The Link to Wave File button has a drop down option list as shown below.

This allows you to either create a Link to an audio file, or if you are working on 
a Cart that is already linked to an audio file, to break the link to the file. If you 
click on the button, it will automatically select the most appropriate option.

When you click on the Link to Wave File option, if the Cart contained any data 
previously, you will be warned that continuing with the linking process will 
discard all previous data for the Cart.
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If you wish to continue, click on the Yes button.

You will then see a standard navigation window that allows you to browse the 
folders on your computer and available via your network. Use the browser to 
select the audio file that you wish to Link the Cart to, and then click on the 
Open button.

To stop linking the Cart to the audio file, use the drop down options on the 
Link to Wave File button and select the ‘Stop Linking to the Current File’ 
option.
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NB: It is recommended that Link to Cart option is not used for general 
operations as it does increase the workload on Myriad and can lead a system 
to be much harder to administer.

Import Audio File

The Import Audio File button is used to import an external audio file into the 
Cart you are working on. This differs from linking to the file in that when you 
import an audio file, a copy of the original audio file is made in the Myriad 
Audio Wall folder location.

This is the safest method as it means that all of the audio is in one place 
making it easier to secure and backup. It also means that Myriad only has to 
access one location to get to the audio. The down side is that is can lead to 
duplication.

When you click on the Import Audio File button, you will first receive a warning 
that importing will discard any previous information stored on the Cart.

You can then use the navigation window that opens to browse your local 
drives and network locations looking for the file that you want to import.
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In Myriad, there are two main types of audio file that can be imported. The first 
is a standard Windows™ WAV file, which can be either uncompressed (linear) 
or compressed (IMA ADPCM).

You can also import Myriad Transport Files which are special ZIP files created 
by Myriad or other compatible programs. These transport files contain all the 
additional information associated with a Myriad Cart including text, pictures 
and copyright information. For details on how to generate a transport file, 
please refer to Export Cart Information.

When you import a Transport file, all the additional supporting information 
such as Notes and Copyright details will be automatically imported into the 
Cart as well. If you are importing a WAV file that has been exported from 
Myriad previously (e.g. from another station) or was generated using a Cart 
Chunk compliant 3rd party application then key information such as the Title, 
Artist and Timing information will be automatically imported into the Cart from 
the WAV file header.

Export Cart Information

The Cart Information button allows you to export the Cart as an audio file to 
an external hard disk or location. It also gives you the option to export the 
information as a Transport file which is a special ZIP file that includes all of 
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the additional information that is associated with the Cart including pictures, 
copyright details etc.

Please note that as Myriad is a Cart Chunk complaint software product, it will 
automatically imbed certain key Cart information into the WAV file header. 
This information includes Title & Artist info as well as timing information such 
as Intro, Hooks and Extro. This means that if you export a Cart as a WAV file 
and then import it again later (or on a different Myriad system), most of the 
key information will be included along with the WAV file. The main things that 
are not included are the copyright details and associated picture file. You will 
need to use Transport files if you want to export this information as well.

To Export Cart Information, first use Export Cart button to access the drop 
down list (click on the little arrow to the right of the icon).

Select either ‘Export to a Transport File’ or ‘Export to an Audio File’ as 
appropriate.

Next you can use the navigator window to select the location that you wish to 
export to and the name of the audio file that you wish to generate. By default, 
the Artists and Title information are included in the audio file name.
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Finally, when you are ready, click on the Save button and the Cart will be 
exported as either a WAV file or a ZIP file depending on whether you are 
exporting as an audio file or a Transport file.

Toggle Cart Descriptions

The Toggle Cart Descriptions button is used to toggle between the Cart 
Descriptions panel being visible or hidden. The screen shots below show the 
two possible states:
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Cart Descriptions Visible
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Cart Descriptions Hidden

Note that when the Cart Description panel is hidden the General (and Other) 
Tabs are removed from the screen and the Audio Edit Area expands to take 
up the majority of the screen space. This mode is very useful when editing 
audio as it allows the wave form to be displayed more clearly.

The General Tab

The General tab contains all of the vital Cart Information that Myriad needs. 
This includes Title and Artist information as well as Timing information and 
cosmetic details such as the colour that the Cart will appear on the Audio 
Wall.
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Title

As you would expect, you use this field to add a suitable Title for the Cart. For 
songs it is simply the title of the song, for all other Carts it can be any 
descriptive title that you like.

Artist

Once again, you can type in the primary artist information into here and if 
there are any other artists, they can go in the Description field below. For 
Carts that are not songs, you can use this field for whatever you like.

Description

This third text field can be used for additional description. If you are using 
AutoTrack then when you import a Cart that is a Song, the Title and Artists 
fields in Myriad are imported into the Title and Primary Artist fields in 
AutoTrack but the Description field in Myriad is imported into the second Artist 
field in AutoTrack. AutoTrack Pro allows you to configure this import mapping 
so it is not a problem.

End Type

The End Type buttons are used to select one of the five available End Types 
for Carts. The End Types are used for two things; firstly they act as an 
indicator for presenters to tell them how a Cart ends without having to listen to 
it. If the Cart has a Fade Ending set then that would indicate to the presenter 
that the Cart will end ‘gently’ as opposed to an ‘Ends’ Ending which would 
indicate that it would come to an abrupt end. These settings are only intended 
as rough indicators and the exact definition will be personal to your station but 
in general, the available Ending Types are:

 Ends (E) – The Cart comes to an abrupt end.
 Fades (F) – The Cart fades out at the end.
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 Sustain (S) – The Cart’s ending is sustained for a period at the end.
 Slow Fade (SF) – The Cart fades out over a longer period at the end.
 Not Specific (blank) – The ending has not been specified.

The second and potentially more important use for End Types is that they are 
used by the Log Screen when it is running in AutoFade mode to determine 
which Carts it could potentially fade out early in order to help it ‘run to time’. 
Basically, the system will try to avoid fading Carts that have an ‘End’ or 
‘Sustain’ Ending Type and only fade Carts that have the ‘Fades’ or ‘Slow 
Fades’ Ending Types. There are situations when it will actually fade End Type 
Carts but that is explained in more detail in the Log Screen section.

To use the End Type indicators on the SmoothEdit Screen, just click on the 
button that you feel is most appropriate for the Cart you are working on.

Cart Colours

The Cart Colours section of the General Tab allows you to set the Audio Wall 
background and text colours for the Cart you are working on.  To enable this 
option, tick the Custom Colours option, this will enable the background and 
text Colour buttons.

Once enabled, click on the Background Colour button  to alter the 

background colour for the Cart or the Text Colour button  to alter the 
foreground text for the Cart. In both cases, you will then be asked to select the 
colour you wish to use by picking a colour from the floating colour palette 
window.
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This offers basic colour choices but if you want to get more creative, you can 
click on the Define Custom Colours button for a wider choice of colours.

When you are happy with the colour, click on OK. You can revert back to the 
default colours at any time by un-ticking the custom colours option.
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Mass Colour Changing (in Myriad Manager)

On a related note, you can change the colours of multiple Carts at once using 
the tools in Myriad Manager. This procedure is covered in detail in the Myriad 
Manager documentation but in brief you do the following:

1. Open Myriad Manager.
2. Double click on the Run Custom Cart Report option in the Cart Reports 

section.

3. When the Audio Browser Options window appears, make sure ‘Display 
All Carts’ is selected in the drop down list.
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The click on OK.

4. Select the Carts you want to change the colour on using the <Shift> or 
<Ctrl> keys and the left mouse button (standard windows style 
selection process).

5. Next, use the Edit Selection drop down menu (see picture) and select 
Change the Colours.
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6. Next you will be instructed to select the background colour that you 
want to change the Carts to have.

Click on OK and then select the colour you want to use from the Colour 
Palette window.
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Once you are happy, click on OK.

7. You will then be asked to set the text colour you wish to use.

Again, you will then be asked to select the text colour. Pick and colour 
and then hit OK.

8. Finally, you will be asked to confirm the action.

Click on Yes to change the colours.

9. Once the changes have been made, you will see a brief summary of 
the amount of Carts that were updated.

The Timing Panel 

The Timing Panel is a generic term for the section of the General tab to the 
right of the Description fields, and is used to review and set key timing 
information about the Cart you are working on. The Timing Panel itself is 
divided into three tabs which are:
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 Times – Allows you to set the key timing information for the Cart 
including Intros, Extros and Hooks.

 Looping – The Looping tab allows you to review and edit the looping 
information for a Cart. This allows you to specify a section of the Cart 
that Myriad will play repeatedly whenever the Cart is played.

 Hardware – The Hardware tab allows you to assign Hardware Events 
to the specific timing events set up on the Timings tab. A good example 
of this might be that you use the Hook markers on a news bed jingle to 
mark where the news actually is, then assign the news hardware 
control to turn on and off while the ‘Hook’ is happening.
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The Times Tab

The Times Tab allows you to set and review the Intro, Extro and Hook 
markers for the Cart you are working on.

Each marker has three sections as seen in the diagram below.

The left hand section shows the name of each time marker on the Timing 
panel. The middle section shows the Time in Cart that the marker is currently 
set to. The Set button can be used to update the marker to the current cursor 
position in the Audio Edit Area.

This all sounds complicated but in fact is really simple. It has been designed 
so that you can press play to listen to the Cart and just click Set at the 
appropriate time for each time marker. 

All should become clear when we look at the different methods for setting 
Intros, Extros and Hooks but first, let’s review exactly what we mean by each 
of these terms.

What Is An Intro?

Intros can be fairly subjective and certainly stations will have very different 
ideas about what Intros should be set to, but in general, an Intro can be 
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regarded as the section of a Song that the presenter could talk over should 
they wish to. In practice the Intro of a Song would run from the beginning of 
the Song to when the first vocals of the Song kick in. Some Songs have very 
long Intros (or are instrumentals) in which case you may prefer to set the Intro 
to end at a change in tempo of the Song or when the drum kicks in etc. The 
only real thing to avoid is having an Intro that goes over the top of vocals in 
the Song because if the presenter talks over this, or Myriad plays a sweeper 
over it, it will not sound good on air.

The diagram below shows the typical timing layout for a Song.

So why do we have an Intro Start and an Intro End?

The fact is for the vast majority of songs you will have on the Audio Wall, the 
Intro Start will be at the very beginning of the song and so can effectively be 
ignored when you are setting the timing marks. The exception is the rare song 
that starts with a bit of vocal and then goes into a classic ‘lull’ that can be used 
as an Intro section. In this case you could set the Intro Start to be at the end 
of the first section of vocals and the Intro End to be when the vocals kick in 
properly. The diagram below shows how that alters the typical song layout:
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A real world example of this might be ‘When the Going Gets Tough’ by Billy 
Ocean (and Boyzone later but we try not to talk about that!). That song starts 
with a couple of lines of singing, and then goes into an instrumental section 
for around 20 seconds before the singing starts again. So we would want to 
set the Intro Start at the end of the first section of singing and the Intro End at 
the beginning of the next section of singing.

The only real reason for going to all this effort is if you intend to use Myriad 
with sweepers and have the system automatically embed sweepers into the 
Intros of songs. Normally, when Myriad encounters a sweeper, it will do one of 
three different things depending on how you have set Myriad up and how the 
length of the sweeper compares with the length of intro in the Song.

Usually, it will play the sweeper so that it either starts at the same time as the 
song or so that the sweeper end coincides with the end of the Intro. In the 
case when an Intro Start is set, the situation is a little different:
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Normally, if the sweeper is longer than the Intro on the song, Myriad will just 
start the sweeper first and start the song ‘underneath’ the sweeper as 
appropriate.

But if there is an Intro Start then it cannot do this, because part of the sweeper 
would play over the vocals at the beginning of the song which would sound 
wrong, so in this situation, Myriad will play the sweeper ‘dry’.

This is a lot of explanation for a situation that really will not come up much at 
most stations but it is important to understand what the Intro Start is for and 
why it can be important to the sound of your station.

In general, you only need to set Intros in songs but you can set them on all 
Carts if you need them.
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What Is An Extro?

The best way to think of an Extro is the point at the end of a Song or Link 
when you would press play on the next item if you were DJ’ing manually. 
Technically, the Extro point is the point in a Cart when Myriad triggers 
playback of the next item whenever it is called upon to do an automated 
segue. The same mechanism is used whether the segue is being done as 
part of a ‘Pad’ run, or from the Log Screen in one of the active playout modes, 
when Myriad reaches the Extro on the current item, it starts the next.

The reason that Extros are so important is that without an Extro, Myriad has 
no choice but to play a Cart right to the end of the audio file before starting the 
next item. The diagram below shows what happens.

Whilst in practice, this will not stop Myriad from paying automated segues, 
they will not sound as natural, or ‘real’, and your automation will end up 
sounding more like a CD jukebox than sophisticated playout.

Extros are so important that Carts that do not have Extros set are marked on 
the Audio Wall by way of the Audio / Extro indicator.

- There is audio recorded into the Cart but the Extro has not been set.
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- There is audio recorded into the Cart and the Extro has been set.

It is a good idea to set Extros on all Carts even if they come to an abrupt end 
and they have been edited to cut any extraneous audio from the end of the 
file. Even a fraction of a second Extro can make all the difference in making 
your station sound as slick as possible.

What Is A Hook?

The final Timing Markers on the Times tab are the Hook Start and Hook End,
but what exactly do we mean by a Hook? 

Hook is a term used to describe the section of a Song that is most 
recognisable or most interesting and the term is derived from the idea of 
hooking your listeners in and reeling them in for more.

Hooks are most often the chorus of a song, or if there is a bit that everyone 
will recognise then that is the Hook. Hooks should be kept short and snappy 
as you only want to tease your listeners with what is coming up not play them 
a quarter of the song.

The reason for setting Hooks in Myriad is that it has the ability to just play 
Hooks from a selection of Carts, meaning that you can very easily ‘promo’ 
what you are going to play in the near future, playing just a snippet to whet 
your listeners appetite. 

You will have heard this effect at some time or another, where the station 
plays a jingle that says something along the lines of ‘Coming up in the next 30 
minutes’ followed by snippets of songs, often put together between sound 
effects or jingles. Traditionally, this type of thing (sometimes called a music 
positioner) is put together ‘by hand’ by the production team but with Myriad, it 
can be put together ‘on the fly’ with no effort or preparation.

Hooks can be played manually from the Audio Wall (using the right click > 
Play Hook or Cue Cart in Hook Player options) or automatically in the Log 
Screen using the AutoHook Log Item. Both of these methods are covered in 
the Audio Wall and Log Screen Chapters respectively.

Hooks are usually only used on song but can be put to lots of different uses 
with a little imagination. The diagram below shows how by combining Hooks 
with Hardware Events, you can create a ‘news switching’ Cart that when 
played will play the news intro, then trigger the hardware to switch to an
external news feed, play a bed underneath the news feed, and then use 
another hardware event to switch the news off again. This type of Cart could 
be used in both automated and live shows to make the news as easy as 
possible.
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For details on how to assign hardware events to the Hook markers (or Intro / 
Extro for that matter, please refer to the Hardware tab section of this Chapter).

Setting Intros, Extros and Hooks

There are three different ways in which Intros, Extros and Hooks can be set. 
No one method is better than another so you can choose the method that is 
better suited to your needs.

Whilst Intros, Extros and Hooks perform very different tasks, they are all set in 
exactly the same way, so we need only learn one method to be able to set all 
three.

Setting Intros, Extros and Hooks Audibly

The first method we will look at involves listening to the Cart you are setting 
the Timings on and setting the Intro, Extro or Hook points by clicking on the 
appropriate Set button at the correct time.

This method is good because you can set all three Timing types in a single 
pass and it tends to give a very ‘organic’ and natural sound to your 
automation, as the process is not really different to what you would do in a live 
show. The down side is that it can be fiddly, especially when you first start and 
if you are not quick with the mouse, you can spend a lot of time back-tracking.

The basic process for setting the Intro, Hooks and Extro for a song is as 
follows:

1. We will assume that for this song does not have any vocals at the 
beginning but goes into an instrumental section for around 10 seconds 
before the vocals kick in. As there are no vocals right at the beginning 
of the song we can ignore the Intro Start and leave it at 00:00:00.00 
and move straight on to the Intro End.

2. Click on the Set button on the Intro End section of the Times tab.
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Myriad will start playing the song and the Audio Cursor will start moving 
from left to right in the Audio Edit Area to show current progress 
through the audio file. The Set button will also change to say Mark 
rather than Set.

3. Get ready with your mouse cursor hovering over the Intro End Mark 
button and listen to the audio carefully. As soon as you hear the exact 
point you want to set the Intro End at, click on the Intro End Mark 
button.

If you miss it, don’t worry. Use the < and > keys (that’s the greater than 
and less than keys not the cursor keys) on your keyboard to shuttle 
playback backwards and forwards 2 seconds at a time, you can also 
hold down <Shift> and the < > keys to shuttle 5 seconds at a time.

Tip: Rest your left hand on the < and > keys to allow you to quickly 
shuttle back and forth and use your right hand to hover over the Mark 
buttons.

4. Now we have set the Intro End, it is time to move on to Hooks 
(assuming you want to, otherwise skip this stage). Use the > key or the 
<Shift> + > keys to shuttle forward to the chorus for the song (or 
wherever the Hook is most likely to be). Use the < and > keys to get to 
just before the Hook you want and then get ready on the Hook Start 
Mark button.
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As soon as you hear the exact bit where you want the Hook to start, 
click on the Hook Start Mark button. Once you get to the bit where you 
want the Hook to end, click on the Hook End Mark button.

5. Now all that is left to set is the Extro point. Hold down the > key to skip 
thought to towards the end of the song. You can use <Shift> + > to get 
there quicker, or if you prefer, you can click on the place you want to 
jump to in the Audio Edit Area. Once you get to the last bits of the 
song, get ready on the Extro Mark button.

When the point that you feel is most suitable is reached, click on the 
Mark button to set the Extro.

6. And that is it finished. All of the major Timing information done in a 
single sweep through the audio. With a little practice the process will 
become very natural and fast.
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The only additional tip that we can add is that this method is a fairly 
subjective process and you should not put too much thought into, go 
with your instincts, they are usually right.

You may also note that the Intro, Hook and Extro are also automatically 
displayed in the Audio Editing Area as visual markers. It is this that we 
will turn our attentions to next.

Setting Intros, Extros and Hooks Visually

In the last section we covered how to set Intros, Extros and Hooks audibly by 
listening to the audio and clicking on the button at the right time. In this 
section we will see how we can do a similar thing using a combination of 
listening to the audio and viewing the audio wave form in the Audio Edit Area. 
We will also see how this method can be used to ‘fine tune’ the Timing Info for 
very accurate results.

This method is particularly suited to setting Hooks where accuracy is essential 
for a clean Hook sound. It can be less productive for setting Intros and Extros 
as results are often a little too accurate and can lead to a fairly automated 
sounding output.

Before we get started on the actual procedure, it will be worth taking a few 
seconds to familiarise ourselves with the Audio Editing Area and the transport 
controls we use to move around inside it.
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The screen shot above shows a typical song in the Audio Edit Area. Notice 
how the wave form shows a graphical representation of the audio and the 
major Timing markers (Intro, Extro and Hooks) are overlaid over the top.

Directly below the Audio Edit Area are the Audio Controls and Zoom Controls. 
These are both covered in detail later but the available options are shown on 
the diagrams below.
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The only other thing we need to worry about at this stage is the Audio Cursor 
which is used to show the current point of playback when SmoothEdit is 
playing audio and the current selected position of the audio wave form when it 
is not playing. The Audio Cursor Position counter in the bottom centre of the 
window also shows this position.

The basic premise of setting Intros, Extros and Hooks visually is simple, 
position the Audio Cursor at the place where you want to place the marker 
and the click on the appropriate Mark button on the Times panel. In theory, 
because you can zoom in on the audio wave form, you can position the Audio 
Cursor with a great deal of precision. 

The general procedure is outlined below:
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1. Let’s assume we are working with a similar song to the previous 
example, and as such the Intro Start will remain at the start of the Song 
and we can move straight on to setting the Intro End.

2. In order to get a clear view of the beginning section of the audio wave 
form, highlight the beginning of the wave form by clicking the left button 
a couple of centimetres in and dragging back to the beginning of the 
wave form.

3. Next click on the Zoom To Selection button on the Zoom Controls.

This will zoom in the view so that just the selected area is visible in the 
Audio Edit Area. This will make it much easier to see the wave form.
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You can see clearly in the example above where the audio wave form 
starts to spike, this is where the drum beat kicks in on the song. Click 
on the Play button to listen to the selected area to double check.

4. Now we need to position the Audio Cursor where we want to place the 
Intro End. Use the left mouse button to click in the Audio Edit Area to 
position the Audio Cursor

5. If we are happy with the positioning, click on the Set button for Intro 
End.

Note how the Intro Start and End are both marked on the wave form in 
a blue colour. You can move the mouse cursor up to these colour-
coded markers for Intro, Extro and Hook and manually move them to 
the left or right by clicking when the mouse cursor turns to a hand icon.
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6. Ok, now we have done one, the rest are easy. Click on the Full View 

button  on the Zoom Controls and the use the same method to 
zoom in to the end of the audio wave form and set the Extro point.

7. We are going to do something a little different to set the Hook. Use the 
Zoom to Selection tool to zoom in on a section of the wave form that 
contains the part of the song that you want to ‘hook’. 

8. Next, use the left mouse button to highlight the exact section that you 
want to be marked as the Hook. Once you have made your initial 
selection, you can use the move the start or end of your selection to 
the left or right by moving up to the top of the wave form until the 
mouse cursor turn to a hand icon, you can now use the left mouse 
button to reposition the selected area boundaries.
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You can use the Play button on the Audio Controls to ensure you have 
the exact area that you want.

9. Once you are happy with the area you have marked, it is time to take a 
look at the Times tab.

Note how, when you have selected an area of the wave form in the 
Audio Edit Area, the Times tab alters to allow you to click Set the Hook 
Start and Hook Ends to be the start and end of the selected area. It 
does the same for Intro Start and End but Extro remains the same, as 
an Extro is only ever a single point, not a time between two points.

10.Click on the Set button next to Hook Start and End to set the Hook 
area to be the same as the selected area in the wave form. It is as 
simple as that.

You can also use the visual markers on the wave form to adjust the Intro, 
Extro and Hook points by moving the mouse cursor to the top of each mark 
until the mouse cursor changes to a hand icon, and then using the left mouse 
button to drag them left or right.
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The Timing Marks on the Audio Edit Area are colour coded to help you
identify them.

 Blue – Intro Start
 Green – Intro End
 Red – Extro

The Hook and Loops (see Looping Tab) also appear in light blue.

Your finished wave form will look something like this.

Setting Intros, Extros and Hooks Manually

The final option is to manually add the Intro, Extro and Hook markers by 
typing the times directly into each box.
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This method is rarely used as it involves a lot of work and offers no real 
benefits but there may be specific circumstances where it is useful like if you 
have already set an Intro and you just want to take half a second off of it but 
do not want to go through the whole process again. You can simply take half 
a second off the time by editing it directly in the timing box.

The Looping Tab

The Looping tab is used to set up a looping section on a Cart, this is a 
specially marked area of the Cart that Myriad will repeat whenever the Cart is 
played. When a Cart with a Loop section is played, Myriad will play the Cart 
normally until it reaches the end of the Loop section for the first time at which 
point it jumps back to the beginning of the Loop section and plays it again.

This continues until either the maximum number of Loops is reached (set on 
the Looping tab) or the presenter ends the Loop by clicking on the Play button 
on the Cart Player that is playing the Loop Cart. When this happens, Myriad 
will either jump directly to the end of the Loop section and then play the rest of 
the Cart normally or, continue to play from the point the presenter pressed the 
Play button but when it reaches the end of the Loop, it will continue to play the 
rest of the Cart normally. This is also set on the Looping tab on the 
SmoothEdit Screen.

You would normally use Looping Carts to create dynamic ‘music beds’ that 
can be played to accompany live vocal links. In this way you can make a Cart 
that starts with a jingle, then goes in to a few seconds of bed (low profile 
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music or sound you can talk over) before ending with an ‘out jingle’ section. 
By looping the bed section, you can take a relatively short Cart and use it for 
longer speech links, and it has the added bonus that as you control when the 
end part of the bed is played, it is always exactly the length that you need it to 
be.

Due to a technical constraint in Myriad, looping sections in Carts can only be 
positioned after the initial 4 seconds of the Cart. This is because Myriad 
internally buffers 4 seconds of audio for smooth playback (all part of 
SmoothStream™), this means that there are some restrictions on the lengths 
of Carts you can use and also on the position of the Loop. If you attempt to 
put a loop in a position Myriad cannot handle, it will let you know.

As well as using Loops on ‘jingles’ or ‘music beds’, you can also use them on 
the beginning of Songs to create a virtually infinite Intro to a song. You can 
combine this with the feature that means that when you press Play button, 
instead of jumping to the end of the looped section, it just continues and exits 
the loop when at the end of the next loop to create a seamless transition into 
the main part of the song.

CAUTION - Be careful when using Loops on Songs because you need to 
make sure that any Songs (or Jingles for that matter) that you add looping 
sections to will not end up in Automated output, as your listeners will get 
bored of hearing the same Intro looped all night. We would advise that all 
Carts with Loops do have a maximum number of loops set so that if they do 
find their way into automation, this will not be the result.

The Loop tab allows you to set the Looping Section on any Cart along with 
additional settings you wish to use.

To enable Looping on the Cart, tick the ‘Loop a Section of This Audio’ option 
to access settings.

Setting the Looped Section
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You can set the section of the audio that you want to loop using exactly the 
same methods that we used to set Intros, Extros and Hooks (see Setting 
Intros, Extros and Hooks).

Your options are:

 Set Audibly – Start playback and click on the Mark buttons for the 
Loop Start and Stop respectively. This method is ok but it can be 
difficult to getting the timing for the loop absolutely correct.

 Set Visually – Use the Audio Edit Area to view the audio wave form 
and position the Audio Cursor in the position that you wish the loop to 
start, then click on the Mark / Set button on the Loop Start button on 
the Looping tab. Move the Audio Cursor to section of the audio where 
you want the Loop to end and then click on the Loop End Set button.

 Set Manually – You can type in the start and end loop times manually 
using the time boxes.

Setting the Amount of Times the Loop Will Play

You can also set the maximum amount of times the Loop will play after which 
Myriad will automatically exit the loop and play the rest of the Cart as normal. 
To enable this, tick the ‘Play Loop X Times’ option and then type in the 
amount of times that you want the loop to play in the provided box.

In the example above, the looped section will be played a maximum of 10 
times before Myriad automatically exits the loop and plays the rest of the Cart.
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You can also review the looped section by clicking on the Play button on this 
section.

Setting Whether Myriad Will ‘Jump To End of Loop’ When You 
Press Play

As discussed earlier in this section, when Myriad is playing a looped section, 
you can click on the Play button on the Cart Player that is playing the looping 
Cart to manually exit the looped section. When you do this, one of two things 
will happen.

 Jump To End Of Loop – Myriad will automatically jump to the end of 
the looped section and play the rest of the Cart immediately.

 Continue From This Point In The Loop – Myriad will continue to play 
through the looped section from the current point (as normal) but when 
it reaches the end of the looped section, instead of going back to the 
beginning of the looped section, Myriad will instead carry on to the end 
of the Cart.

You can configure Myriad to use the ‘Jump to End of Loop’ method by ticking 
the ‘Jump to Loop End When User Terminates the loop early’ option on the 
Looping tab.
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If this option is not ticked them Myriad will use the ‘Continue from This Point in 
the Loop’ method when the User terminates the loop by clicking on the Play 
button on the Cart Player that the Cart is playing in.

Once you have configured a Loop Section and saved the Cart details, the 
Cart on the Audio Wall displays a Loop icon to indicate that the Cart has a 
Looped Section.

The Hardware Tab

The Hardware Tab is used to assign Hardware Events to the Intro, Extro and 
Hook marker times which in turn can be used for a variety of different 
applications.

In order to make use of these features, you will need to have a hardware I/O 
card (such as a PCI1750) fitted to your PC and configured for use within 
Myriad. Once configured, the hardware card provides Myriad with a method 
for interacting with the ‘outside world’ via switching logical outputs and reading 
logical inputs. The most common use for this type of technology is for 
switching external audio sources on and off and it is this mechanism that 
makes it possible for Myriad to automatically switch an external news feed on 
and off in automation (via an audio switcher).

Hardware cards can be configured and hardware lines assigned using the 
Settings Menu > Hardware Card Settings option which is covered in detail in 
the Menu System part of the documentation.
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For the purposes of setting up Hardware Events on the Intro, Extro and 
Hooks, we will assume that the hardware card is configured correctly and that 
you have already assigned some hardware outputs.

Setting Up Hardware Events to Happen On Intro, Extro or Hook 
Points

To demonstrate this feature, it is best to use an example. Let’s say that we 
want to turn Hardware Line 1 on while the Cart is in playing the Hooked 
section and turn it off again once the Hook has finished.

Now if Hardware Line 1 is configured to be the News Switch and the physical 
output of Hardware Line 1 is connected to a suitable audio switcher then we 
could use this Cart to switch the news on and off in live and automated output.
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If we assume that the Hook Start and End have already been set then all we 
have to do is go on to the Hardware tab and assign the appropriate hardware 
event to happen at the Hook Start and Hook End points.

Use the following procedure to set this event:

1. Make sure that you have set the Hook Start and Hook End on the 
Times tab and that they are in the correct place.

2. Now switch to the Hardware Tab. As we have not set any Hardware 
Events yet, it should all be blank.

3. In this example, we are going to set Hardware Line 1 to be switched by 
the Hook Start Marker but we could assign any Hardware Line to be 
affected by any of the available timing markers. First use the drop 
down list next to the Hook Start caption to select the Hardware Line we 
wish to work with.

In this case, we want to work with Hardware Line 1 so we select 1 from 
the drop down list. Then descriptions that you give to each Hardware 
Line in the Hardware Card Settings window are also included in the 
drop down list.
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4. Next we need to tell Myriad what action to take with the selected 
Hardware Line. The options are:

 Clear – Clears the hardware line (turns it off).
 Set – Sets the hardware line (turns it on).
 Flash – Continuously switches the hardware line between on 

and off (flashes it).
 Pulse – Sets the hardware line for 1 second, and then clears 

it (turns it on for 1 second only).

You can use the drop down list to the right of the Hardware Line to 
select the action we want to happen.

In this example, we want the Hardware Line turned on at the Hook 
Start point so we need to select Set.

Once we have done this we need to move on to the Hook End marker.

5. Now we have set Myriad to turn Hardware Line 1 on when the Hook 
Start point has been reached, we now have to set it to turn it off again 
once the Hook End is reached. To do this we repeat the steps for Hook 
End but set the action to Clear to turn off the Hardware Line. You 
should end up with something like this.

Obviously, you can set Hardware Events to happen on the Intro Start, Intro 
End and Extro Markers using the same method should you wish to.
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The Notes Tab

The Notes Tab provides fields to allow you to add text Notes to the Cart you 
are working on. There are a number of different Notes fields on the Notes tab 
to allow you to add different Notes for different potential outlets. The diagram 
below shows the layout of the Notes tab.

We will now look at these elements in more detail.

Studio Notes

The Studio Notes are the primary Cart notes in Myriad and are intended to be 
used by the presenter when presenting a live show. Notes typed into the 
Studio Notes field will be displayed on the Notes panel on the Log Screen 
whenever a Log Item that is linked to the Cart is highlighted.
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You can also access the Studio Notes on the Audio Wall via the Cart Details 
window which can be opened from the More Information option right click 
menu.

Or from the ‘i’ icon on the Cart Player when a Cart is playing.
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Web Notes

Web Notes are intended for text notes that you want to be posted to your 
station’s web site using OCP to upload them. Whereas the Studio Notes are 
intended for the presenter, in general, Web Notes are intended for your end 
listener so you may need to be a little more careful about what you write.

You can access Web Notes from the Audio Wall via the More Information 
option on the right click menu or the ‘i’ icon on the Cart Player (just like Studio 
Notes). Once the Cart Details window is open, click on the Web Notes icon to 
switch the view to Web Notes.
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Artist Web Site

This field is used to store the web site address for the Artist performing the 
Song on the Cart. The principle reason for this is to allow OCP to add a link to 
the Artist’s web site on your own site whilst the track is playing (if you want 
to). The presenter may also find this information useful, although it is only 
visible from the SmoothEdit Screen.

DAB Notes

The DAB Notes field allows you to add text specifically for display on Digital 
DAB Radios. OCP can take this information and send it directly to your DAB 
transmission provider. Once again, this may be public information field so be 
careful what you write.

Online Store Reference

This field allows you to add a unique reference for the Cart which may be 
useful if you are intending to add ‘click to buy’ style link on your web site.
The most commonly used online store is Amazon, who do not require you to 
put anything into this field. Amazon uses the Artist and Title fields along with 
your unique reseller reference to provide the ‘click to buy’ style service.

NB: Please note that most of these fields are for use with external applications 
for P Squared’s OCP (Online Content Processor). OCP is available as part of 
the standard Myriad package and its operation and configuration is covered in 
the separate OCP documentation.

The Copyright Tab

The Copyright tab is used to store additional copyright information for the Cart 
you are working on. This information can then be used by Myriad to generate 
an accurate copyright return report using the Myriad Manger application. 
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The Copyright tab is intended to work for a number of copyright organisations
and as such has been designed with fairly generic terms for the information 
fields.

The diagram below shows the fields available on the Copyright tab.

We will now briefly look at each of the available fields.

Product Title

The product title for the audio you are working with. This could be an album 
title for example.

Music Title 

The title of the music you are working with. Click on the Copy button to copy 
the Title from the General tab.

Recording Number

This is normally the unique recording number found on the spine of the CD.

Composer / Arranger

The name/names of the composer / arranger.

Performer

This is the name of the artist who performed the song. This can be copied 
from the Artist field on the General tab using the Copy button.
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Publisher

This is the name of the company that published the recording.

Record Label

This is for the name of the record company that owns the recording.

Rights Management Field

This is a special field used by some copyright agencies.

Copyright Code

This allows you to assign a code to identify the use for the audio. The options 
are:

 Not Specified
 C – Commercial
 D – Disc
 L – Live / Local
 P – Promo
 S – Station Ident

Total Duration

This is the total duration of the audio recording. You can click on the Copy 
button to copy the overall Cart Length from the General tab.

Music Duration

This allows you to specify a separate music duration. This may be useful if 
you are working with a promo that is 30 seconds long but only contains 10 
seconds of music. You would set Total Duration to 30 seconds and Music 
Duration to 10seconds. That way, if your music copyright body charges per 
second played, you will not have to pay for time you did not use.

NB: These definitions are intended as guides only, please consult with the 
appropriate copyright organisations that you report to for more details about 
the information you need to add to these fields.
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The Other Tab

The Other tab serves two general purposes. Firstly it allows you to view, add 
and edit the JPG pictures that are associated with a Cart. You can also use 
the Other tab to view and erase the recent play history for the Cart you are 
working on.

The Picture Carrousel

The Picture Carrousel is used to display, add and manage the JPG pictures 
that you have added to the Cart. The reason you may want to add pictures to 
a Cart is to allow OCP to upload one or more pictures to your web site when 
the Cart is being played.

The Picture Carrousel window displays the pictures currently attached to the 
Cart you are working on. If you have more than one picture attached to the 
Cart then the display will rotate through all the attached pictures, changing 
every few seconds.

The Picture Carrousel also includes the tools needed to add, edit and remove 
pictures from the Cart.
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Add Picture

The Add Picture button allows you to add another JPG picture to the Picture 
Carrousel. When you click on the Add Picture button, the Select Picture 
window opens which allows you to browse the local computer and connected 
network locations, looking for the picture you want to attach.
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Browse to the JPG image you want to add and then click on the Open button.
The image is then added to the end of the Picture Carrousel.

Delete Picture

The Delete Picture button is used to remove the currently visible picture from 
the Picture Carrousel.

Make sure the picture you want to delete is visible and then click on the 
Delete button. You will then be asked to confirm your action.

If you click on Yes then the picture will be removed. Please note that when 
you add a picture to Myriad, the picture is copied into the Audio Wall location 
leaving the original image where it is. When you delete the picture, it is 
deleted from the Audio Wall at the same time but the original file still remains 
where it is (unless you have deleted or moved it in the intervening time).

Move Picture Back / Forward

You can use the Move Picture Forward / Back buttons to move a picture 
either forward or backward one position in the Picture Carrousel. In the 
example below, the visible image is image 3 of 3.
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If you click on the Move Picture Back button once, the position of the picture 
will move to 2 of 3 (and the move forward button will be enabled).

Picture Number

The Picture Number shows the current position in the Picture Carrousel of the 
image that is currently visible. 

In the example above, the picture is the second of three pictures.

View Previous / Next

The View Previous / Next buttons are used to manually step through the 
pictures available on the Picture Carrousel.
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Recent Play History

The Recent Play History shows the last five times that the Cart you are 
working on was played along with additional information such as the date and 
time of play and the Myriad workstation that played it.

This information is also used by Myriad to determine which Carts need to 
have the Recent Play Icon on the Audio Wall.

Myriad stores the last five times that a Cart is played inside the Cart headers 
themselves which makes checking recent play history very fast but alongside 
this information, Myriad also maintains a full history of ‘play logs’ which are 
generated independently by the Cart Players and used to generate things like 
the Copyright Reports etc.

The Recent Play History can be deleted from the Cart using the Erase the
Last Play Information function.

Erase Recent Play History

As the name would suggest, the Erase the Last Play Information button clears 
the Recent Play History leaving a blank window.
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You may want to do this if you wish to clear the Recent Play Icon from a Cart 
on the Audio Wall. Doing this will not affect the overall play logs that Myriad 
maintains so it will not affect copyright reports etc.

The Audio Edit Area

The Audio Edit Area is a generic term that refers to the lower part of the 
SmoothEdit Screen which is dedicated to displaying the audio wave form for 
the Cart you are working on along with the tools and options for viewing and 
editing the audio. 

Conceptually, audio editors are very similar to word processors. The audio is 
represented visually on screen (in the form of a graph or ‘wave form’) and the 
editor is used to select areas to be moved, edited, replaced, formatted or 
deleted. The main difference between a word processor and an audio editor is 
that in an audio editor, you are not working with text and words but with 
digitally recorded audio (also known a sampled audio). In order to allow us to 
see and work with sound, the audio is represented as a graph or ‘wave form’ 
which plots the value of the audio every fraction of the second (known as a 
sample). In the case of audio editors, instead of making words bold, sections 
of the audio can be amplified, replaced, cut, pasted reversed, replaced with 
silence etc. Just like a word document, you can also select sections of an 
audio file and move them around within the file, copy and paste sections into 
the same file or into a new file or repeat a section as many times as you like.

There is a wealth of information on the subject available on the web but for 
the purposes of SmoothEdit™, all you really need to know is that you can 
open (or record) an audio file, edit it and save it back to the Audio Wall.

The diagram below shows the general layout of the Audio Edit Area:
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Audio Edit Tool Bar

The Audio Edit Tool Bar offers a range of tools and facilities that relate to 
working with and editing audio in the Wave Form Edit Area on the SmoothEdit 
Screen. The Audio Edit Tool Bar layout is outlined below.

In addition, the ‘Copy’, ‘Paste’ and ‘Select Channels to Edit’ options also offer 
drop down menus for expanded options.
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Please note that some of the screen shots used in the next section are taken 
directly from the SmoothEdit documentation so they may include a menu bar 
that is not necessary when using SmoothEdit in Myriad.

Undo 

This option only becomes available after you have started working with a Cart. 
Undo removes the last action, restoring the file to the previous state.
SmoothEdit™ actually allows you to Undo multiple levels so even if you have 
performed a number of tasks, you can undo them to get back to a previous 
state. 

Hitting Ctrl + Z on the keyboard will also undo the last action, you can also 
access Undo via the Edit menu.
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Redo 

The Redo option does the opposite to the Undo option and re-does anything 
that you have just undone. Let’s say that you wanted to use the Undo to 
remove the last three edits but you accidentally clicked on the Undo button 
four times, clicking on the Redo button would restore the last change.

This option only becomes available when Undo has been used.

Redo is also available on the Edit menu and pres pressing Ctrl + Y.

Cut 

As with Copy, the Cut button is used to add a selected area to the Windows 
‘clip board’ to be pasted into a different area of the same file, an entirely new 
file or another application. The difference is that when you use Cut, the 
selected area is not only copied to the ‘clip board’ but also removed from the 
original file with the wave form either side of the Cut area spliced together to 
make a new (shorter) wave form. The two screen shots below should help 
make it clearer.

First, a section is selected, and then the Cut option is selected.
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The total length, which is displayed in the bottom right corner, has dropped 
from 3:34 to 1:40 because we have cut an area of audio out of the middle. 

Cut is only available once a section has been selected.

You can also use Ctrl + X on the keyboard to Cut a selected area.

Copy 

Clicking on the Copy button (or hitting Ctrl + C on the keyboard) copies the 
selected section in the Wave Form Edit Area, to the windows ‘clip board’. This 
copied selection can then be pasted back into another area in the same file, a 
completely new file, or even into another application (that also supports audio 
editing or playback). 

Use of the copy and paste functions should be familiar to anybody who has 
used Windows applications in the past. The only difference here is that we are 
copying a section of audio instead of the usual text or graphics.

The Copy option is only enabled after an area has been selected in the Wave 
Form Edit Area.
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Copy Button Drop Down: Copy to SmoothEdit™ Clip Area

Copy to SmoothEdit™ Clip Area: This option copies the selected area to the 
‘clip board’

Copy Button Drop Down: Export Selection to another Cart

If you select this option, the selected area will be copied to another Cart 
altogether. The Audio Browser will open to allow you to select the Cart Slot 
that you want to copy the selected audio into.
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Find the Cart you want to copy into and then double click on it to begin the 
process. A new Cart will be created in the Slot you picked and the selected 
audio will be copied into the Cart. If you select a Cart that already contains 
audio then you will get a warning box that allows you to decide whether to 
overwrite the Cart details and audio or not.

Export Selection to Wave File 

This Export Selection to Wave File button will close the exiting file and open a 
new file using the selected area. This is really useful if you wish to grab a 
section from an audio file, to use as a basis for your next edit.

Paste 

In both the Copy and Cut options examined above, we mentioned that the 
selected area is copied to the Windows ‘clip board’. This is a special area of 
memory where Windows holds data for short term storage with a view to
using it again either later in the same audio file or in another audio file. In 
general, only one thing can be stored in the ‘clip board’ and the data will be 
lost if the PC is rebooted but the ‘clip board’ does provide a quick, simple and 
convenient way of moving sections of audio around or between audio files.

The Paste in SmoothEdit™ works exactly the same as the Paste in a word 
processor. Let’s take the example above. In the Cut example, we started with 
a complete wave form; we then highlighted a big section in the middle which 
we cut out. Now if we place the audio cursor at the end of the wave form and 
select Paste, the Cut section will be pasted into the wave form at the selected 
point.
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You can also Paste in sections from previous files or even from other 
applications.

The Paste option is also available by pressing Ctrl + V on your keyboard or on 
the Edit menu.

Paste Drop Down: Paste from the SmoothEdit™ Clip Area
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This does the same thing as clicking on the Paste button on the Audio Edit 
Tool Bar. The audio stored on the ‘clip board’ is pasted into the open audio 
wave form at the point that the cursor is currently positioned. See Paste for a 
more detailed description.

Paste Drop Down: Mix Paste from Clip Area

So far we have looked at Copy, Cut and Paste which should be familiar to 
most Windows users as they are common to most Windows applications. The 
Paste Mix option, however, is fairly unique to audio editors. In a word 
processor, you never need to have multiple words on top of each other but in 
audio, that is exactly what you want sometimes.

The Paste Mix option allows you to do this. Once you have a section of audio 
in the ‘clip board’ (see Cut or Copy), you can select the position on the wave 
form where you want the mix to begin, then select the Paste Mix option to mix 
the audio in the Windows ‘clip board’ with the audio that is already on the 
wave form.

In order for this to work, you must select the proportional volume of the two 
pieces of audio using the Mix Paste setting window (that will appear when you 
select Mix Paste).

The top setting determines the amplification level for the section of the original 
audio file that is highlighted. The second setting determines the level of 
amplification applied to the audio that you are about to mix paste into the 
selected area. The reason that you need to do this is that if you mix pasted 
them both at 100%, if the two pasted audio sections happened to both peak at 
exactly the same time, you could end with a mix that is at 200% of the 
maximum volume which would lead to distortion.

Different settings will suit different applications; your best bet is to experiment 
with these settings until you get the mix level that you are looking for. 
Remember, you can use the Undo button to remove a Mix Paste easily.
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Paste Drop Down: Insert From File

This option on the Audio Edit tool bar acts in exactly the same way as a Paste 
but instead of pasting a section of audio that is in the Windows ‘clip broad’, 
the Insert Another File button pastes in the audio contained in a completely 
different file.

To use this option, click in the area of the Wave Form Edit Area where you 
want the Insert to begin, and then select the option from the drop down menu. 
Next select the file you want to be inserted using the file browser window that 
appears.

Finally, click on Open and the file will be inserted in to the wave form at the 
selected point.

Paste Drop Down: Mix Insert from File

Just as Insert another File did the same thing as Paste, using an external file 
instead of the ‘clip board’ so Mix Insert another File does the same thing as 
Mix Paste but using an external audio file as the source for the audio to be 
mixed.

As before, this is done by selecting the point the Mix Insert is to start in an 
open wave form, then selecting the Mix Insert File option. Next select the file 
that you want to Mix Insert.
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Finally, you have to set the respective levels to mix the two audio sources at 
using the popup box (see mix paste for more details).

As with Mix Paste, the levels will depend greatly on the source and 
destination audio as well as the kind of effect you are looking for. 
Experimentation is the key to getting the sound you are looking for.

Paste Drop Down: Insert another Entire Cart

The Insert another Entire Cart works in exactly the same way as Insert from
File but instead of selecting an external audio file to be inserted at the Audio 
Cursor in the Wave Form Edit Area, you select a Cart from the Audio Wall 
using the Audio Browser.



617

To use this feature, select the position that you want to insert the Cart into 
using the Audio Cursor on the Wave Form Edit Area. Next select the Insert 
another Entire Cart option from the Paste Drop Down Menu. Finally, select the 
Cart that you want to insert using the Audio Browse, find the Cart and double 
click on it to begin the insert process. For more details, please review the 
Insert from File section above.

Paste Drop Down: Mix another Entire Cart

This works in exactly the same way as the Mix Insert From File in that it paste 
the audio new over the top of the existing audio, mixing the two audios 
together. The difference is that instead of selecting an external audio file to be 
mixed in, you use the Audio Browser to select another Cart on the Audio Wall 
to be mixed in.

To use this option, position the Audio Cursor on the place in the wave form 
that you want the mix to begin, then select the Mix Another Entire Cart options 
from the Paste Drop Down menu. Next select the Cart you want to mix in by 
finding it on the Audio Browser and then double clicking on it. You will then be 
asked to select the ratio of volume between the original audio and the new 
audio.

Select the appropriate levels and then click on OK to begin process. For more 
details, please refer to the Mix Insert from File documentation above.

Delete Selection 

This option probably needs little by way of explanation. Basically, if you 
highlight a section in the wave form and then select this option, the highlighted 
section will be removed from the wave form and the two adjoining sections will 
be spliced together. You can Undo deleted selections so don’t worry if you 
delete the wrong bit.

You can also delete a selection by highlighting it and the pressing the Delete 
key on the keyboard. 
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Replace With Silence 

As with Delete Selection, this one is fairly self explanatory. If you highlight a 
section of the wave form and then select this option, the highlighted section 
will be replaced with a silence of the same duration.
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Select Channels to Edit (Inc Drop Down Menu) 

If you are working on a stereo audio file then the Wave Form Edit Area will be 
split horizontally into two, with the upper wave form representing the left hand 
side of the audio and the lower representing the right.

By default, any editing that you do in SmoothEdit™ will be applied to both 
channels at the same time but the Select Channels to edit button on the Audio 
Edit Tool Bar allows you to select which channel you want to work with by 
using the drop down list.

If the Only Edit the Left Channel is selected then the right hand side (lower) 
section of the wave form is disabled and your edits will only affect the left 
hand side (top) of the wave form.
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Obviously if you select the Only Edit the Right Channel option, the opposite is 
true.
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Finally, to return to editing both channels, click on the Select Both Channels 

button  to re-enable both channels.

NB: You can also select the left or right channel by moving the mouse cursor 
to the top or bottom part of the upper or lower wave forms respectively. As 
you approach the top of the upper wave form, the mouse cursor changes to 
include an ‘L’ icon to indicate that clicking here would allow you to edit just the 
left hand side of the stereo wave form.
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Moving the cursor to the bottom part of the lower wave form will change the 
cursor to display an ‘R’ icon indicating that clicking here will restrict editing to 
only the right hand side of the wave form.
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If you click on the centre of the Wave Form Edit Area (between the upper and 
lower wave forms) then both left and right hand sides are re-enabled (the 

same as clicking ).

Insert Silence 

The Insert Silence option on the Audio Edit Tool Bar is used to insert a 
specified period of silence at the point in the wave form where the Audio 
Cursor currently is.
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In this example, the Audio Cursor (dotted yellow line) has been positioned at 
the point in the audio file where we want to insert some silence. 

Selecting the Insert Silence option allows you to specify the length of the 
silence you want to insert. In this case we have elected to insert 2 seconds of 
silence.
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As you can see, the silence has been inserted into the wave form.

CAUTION: If you select an area on the wave form (not just put the cursor 
where you want it to start) then Insert Silence, the selected area will be 
replaced with silence. If the selected area is shorter in duration than the 
selected area then the rest of the inserted silent period will be inserted after 
the selected area in the normal way.

Delete Silences 

The Delete Silences tool may not be familiar from other audio editors as not 
many of them have this type of option. The Delete Silences tools will search 
through the selected section of the wave form looking for sections that it 
determines are ‘silent’, and then removes them. This can be used to 
automatically ‘top and tail’ an audio file removing silences from the beginning 
and end of the audio but it will also strip out silent periods from the middle of 
the file. 

First double click (or press Ctrl + A, or select Select Entire Wave from the Edit 
menu) to select the entire wave form.
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Next select the Delete Silences button.

This opens the Delete Silences options window. In here you set the level for 
three things before the process is started. The first option is the audio level 
below which audio is classed as silent. This needs to be set low enough that 
no audio is lost but above the level of general background noise or ‘hum. The 
default is -60dB which is probably a good starting point for most people.

The next option is the duration (in milliseconds) that the audio can be silent for 
before SmoothEdit™ starts to tag the area as silent. This is set to 100 
milliseconds by default as you do not want SmoothEdit™ trimming silent 
periods when they are supposed to be in the audio (e.g. for dramatic pause). 
The final option is the duration that audio has to rise above the silence 
threshold (set in the first option) before SmoothEdit™ determines that the 
silences has ended. This needs to be short as you don’t want SmoothEdit™ 
to be slow to react to a silent period finishing and audio starting. The default 
for this is 25 milliseconds.
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Because we set the Delete Silence parameters fairly loosely, the silences at 
the beginning middle and end remain in place but if we were to tighten up the 
parameters, we can see that the effect is more pronounced.
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Reverse Selection 

The Reverse option on the Audio Edit Tool Bar menu will reverse the selected 
section of the wave form. 

Time Stretch 

The Time Stretch tool in SmoothEdit™ allows you to alter the length of a 
selected part of the wave form. This may be important if you are producing 
audio that needs to be of an exact length (for say split advert breaks) but you 
are having difficulties getting it spot on.

To use the Time Stretch tool, first select the section of the wave form that you 
want to stretch / shrink. If you need the entire file to be of a specific length 
then select the entire wave form.

The overall length is for the audio file is currently 5.32 seconds.

Next, click on the Time Stretch button on the Audio Edit Tool Bar.
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This window shows the current length of the selected area and allows you to 
type in the length that you want it to be after the stretch process. 

You can also decide whether you wish to preserve the pitch of the audio by 
ticking the Preserve the Pitch of the Audio option. Time stretching can be 
done in two ways. The simplest is to slow down or speed up the playback of 
the selected section to get to the desired length. The down side to this is that 
the pitch of the audio changes and if the stretch is too short or long, this may 
be very noticeable. The alternative is a far more complicated process of
repeating / dropping tiny sections of the audio and inserting / removing tiny 
silences to get to the required length. This method does not affect the pitch of 
the recorded audio but tends to be very noticeable if the stretch is more than 
say 5% either way of the original length of the audio.

Whichever method you chose, Time Stretching should only be used to make 
small adjustments to the length of the audio or the results will be apparent to 
the listener.

In this example, we will stretch the audio to a total of 6.0 seconds and 
preserve the pitch by ticking the preserve box.
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As you can see, the new overall length is 6.0 seconds but because we 
stretched it by around ½ a second on a 5 second audio file, that is a change 
of about 20% so the effect on the audio is very pronounced. For best results 
you should try to restrict the time stretch to about 5% of the overall length of 
the original audio.

You may have also noticed that there were a number of preset values to the 
right of the Time Stretch Options window. You can load one of these preset 
values by clicking on them so if you need a time stretch to 10 seconds, just 
click on the 10 seconds preset. You can also save your own presets by 
putting in the values you want to use and then clicking on the add button.

You will then be asked to add a name for your preset.
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Your time stretch will then be added to the list of presets.

You can also delete presets by highlighting them and the clicking on the 
remove preset button.

You can also access the Time Stretching tools from the Time Stretch option 
on the Audio menu. 
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Amplify 

Possibly the most used function in audio editing, the Amplify button on the 
Audio Edit Tool Bar allows you to either increase or reduce the amplitude (or 
volume) of the section of the wave form selected in the Wave Form Edit Area.

Let’s say that we open a file and then decide that we want to reduce the 
volume of the entire wave form. First we double click in the Wave Form Edit 
Area; this will then select the entire wave form as shown below.

Next click on the Amplify button on the Audio Edit Tool Bar, this will then open 
the Audio Amplification window which allows you to set the amount you want 
to increase or reduce the selected area of the wave form by.

In this case, we want to reduce the volume to half it’s original level so all that 
we need to do is set the Amplification level to 50% by using the slider or 
typing the level directly into the percentage box. SmoothEdit™ will alter the 
amplification of the selected area when you click on OK.
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Normalise 

Normalise is closely related to Amplify in that Normalise alters the volume of 
the selected section of the wave form, but in many ways, Normalise is more 
useful than Amplify because it allows you to apply a change in Amplification in 
a safe way that prevents the audio distorting due to over amplification in 
certain sections of the wave form. 

The basic idea is simple. A normal wave form is a graph of peaks and troughs 
and like any graph, there is always a point in the wave form that is the loudest 
single point. When you perform a normalisation, SmoothEdit™ scans through 
the wave form to find this point. It then works out how much it would need to 
amplify this point by in order to reach the percentage level that you have 
specified when setting up the Normalisation. It then applies the same level of 
amplification to the entire wave form. This is important because as the loudest 
point is used to calculate the amplification level, and this level is applied to the 
rest of the wave form, you avoid distortion by over amplification. It is also 
important because if multiple audio files are normalised to the same level, 
they should be pretty even in terms of volume as the loudest point in each file 
will always be at the same level, giving an overall level sound to all songs.

Let’s look at an example. We start with the file that we reduced by 50% in the 
Amplification section.  
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First double click on the Wave Form Edit Area (or hit Ctrl + A) to select the 
entire wave form.

Next, click on the Normalise button on the tool bar . This will open the 
Normalise options window.
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This allows you to set the level that you want to normalise to, i.e. the level on 
the wave form scale that you want the loudest point in the audio file to be 
amplified to. You can see that to the right of the Wave Form Edit Area is a 
scale (one for the top wave form, one for the bottom wave form) which goes 
from -90dB to 0dB. The exact meaning of this scale in not covered in this 
documentation but all you really need to know is that -90dB is silent and 0dB 
is the loudest value you can have on a wave form. The Normalisation 
percentage refers to this scale so if you were to set the Normalisation to 100% 
then the loudest point in the wave form would be amplified such that it was at 
0dB and the then the same amplification value would be applied to the rest of 
the wave form. If you set the Normalisation  value to 50% then the loudest 
point in the wave form would be amplified (or reduced) to make it hit -4dB 
(half way up the scale – don’t ask!) and the same value would be applied to 
the rest of the wave form.

For this example, let’s set the normalisation value to 90% and see what 
happens.
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Here we can see that the entire wave form has been amplified such that the 
loudest section peaks at 90% of the maximum value of the wave form.

There is also a tick option to Remove DC-Bias when Normalising. DC-Bias 
occurs sometimes when you are recording from external sources that are not 
calibrated in the same way as a PC. Basically, the central point of the wave 
form (horizontally) will not be on the -90dB line on the scale. The Remove DC-
Bias option simply moves the entire wave form to the correct values as part of 
the Normalisation process.

Fade In 

The Fade In button on the Audio Edit Tool Bar will alter the selected section of 
the wave form so that the beginning part of the selection will start at zero 
volume and the volume will steadily rise across the selected area to reach the 
starting volume at the end of the selected area. 

This is better explained with an example. Let’s look at our wave form again.

In this case, we have used the mouse to select the first half of the wave form 
(use the left mouse button to select the area).

If we now click on the Fade In  button, the wave form will be altered to fade 
in the volume over the selected area.
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This function is great for smoothing abrupt starts to audio files or for mixing 
two audio segments together.

Fade Out 

As you may have already guessed, this does the opposite to Fade In. 
Basically, if you can select a section of a wave form and then use the Fade 
Out function, the volume of the wave form will be gradually reduced to zero 
over the selected area.
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Becomes:

This function is very useful for ending audio files as it allows you to put a soft 
sounding ending and avoids abrupt ‘cut off’ sounds.
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The Wave Form Edit Area

The Wave Form Edit Area makes up the main part of the SmoothEdit window 
and is used to display either the whole wave form or a part of the wave form,
as well as additional timing information and extra markers such as Intro, Hook 
and Extro points.

The Wave Form Edit Area is used to navigate around the audio wave form 
and to select the areas of the wave form that you want to use SmoothEdit™ to 
edit. A good understanding of the Wave Form Edit Area and the information it
provides is essential to get the most from SmoothEdit and Myriad.

A detailed breakdown of the Wave Form Edit Area can be seen in the 
diagrams below.
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View Scrub Bar

The View Scrub Bar is a very important tool in SmoothEdit™. The bar runs 
along the top of the Wave Form Edit Area and is used to display the length of 
the wave form that is currently visible in the Wave Form Edit Area in 
proportion to the entire length of the file. The full width of the bar represents 
the full length of the audio whilst the light green section of the Scrub Edit Bar 
represents the portion of the wave form that is visible in the Wave Form Edit 
Area.

This means that if the entire wave form is visible then the entire View Scrub 
Bar is coloured green as in the example below.

If however, you zoom in to a particular section of the wave form, then the 
Wave Form Edit Area only shows a portion of the entire wave form and this 
portion is shown in light green on the View Scrub Bar as in this example.

When this is the case, you can move the mouse cursor to the View Scrub Bar 
and the mouse icon will turn into a hand (as above) and you can ‘scrub’ the 
area of the portion of the wave form displayed in the Wave Form Edit Area by 
left clicking and the dragging the light green part of the View Scrub Bar to the 
left or right.

You may also notice that in the example above, there is a slightly darker 
green section on the View Scrub Bar.



641

This represents the section of the current view in the Wave Form Edit Area 
that is also selected (in white in the main wave form).

The Main Wave Form 

The Main Wave Form section of the Wave Form Edit Area shows the actual 
audio wave form for the entire file or the selected section of the audio file.

The audio is represented as a graph with the peaks and troughs plotting the 
value of the samples that make up the digital audio file. Roughly speaking the 
higher the peaks, the louder that part of the audio is.

When dealing with stereo wave forms, the Main Wave Form is divided into 
two sections, the upper section represents the left hand side of the stereo file 
and the lower represents the right.

Audio Cursor

The Audio Cursor is a single point in the audio wave form that is currently 
selected in SmoothEdit™ and is indicated by a vertical dashed yellow line. 
The Audio Cursor can be moved around the wave form by using the left 
mouse button to click on the place in the wave form where you want to 
position the cursor.

The Cursor is important because it is used to indicate where playback will 
commence from in certain playback modes in SmoothEdit™ plus it is also 
used to indicate where other functions such as Paste and Paste Mix will 
begin.
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When SmoothEdit™ is not playing audio, the Current Cursor / Play Time 
indicator shows the position of the Audio Cursor point.

Available Space for Recording

This counter shows the estimated maximum time left for recording in 
SmoothEdit™ based on available hard disk space on the Audio Wall file 
location.

Please note that due to a restriction in Myriad, this will only show a maximum 
3h22min. This is because windows can only record an audio file up to the size 
of 2GB which is equivalent to 3 hours and 22 minutes. So each time you start 
a new recording, you will have 3 hours and 22 minutes to play with unless you 
have less than 2gb of overall free space in the Audio Wall File Location folder.

Length of Audio File

This counter shows the overall length of the Cart currently loaded.

VU Bars

The SmoothEdit™ VU bars show the level of audio playback when 
SmoothEdit™ is playing audio and the level of incoming audio when 
SmoothEdit™ is recording audio.
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The VU’s are intended as an indicator only and should not be used to 
calibrate external audio equipment.

Audio Volume Scale

The scale to the right of the Main Wave Form shows the scale of deviation of 
the wave form around the central axis at -90dB (which is effectively silence) 
and 0dB (which is effectively as loud as a digital file can go before it distorts). 
The scale is a logarithmic scale and should only be used as a visual indicator 
as to the proportional volume of the audio within the Cart.

Selected Area

The concept of selecting an area of the wave form to view or work with is key 
to understanding how audio editing using SmoothEdit™ works. The example 
below shows typical wave form with a section selected.
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The selected area is the area that is in white and the beginning and end are 
indicated by a pair of dashed yellow, vertical lines. When an area of a wave 
form is selected in SmoothEdit™, this area then becomes the section of the 
wave form that is affected by any of the tools on the Audio Edit Tool Bar. The 
selected area can also be used to alter the amount of the wave file that is 
displayed in the Wave Form Edit Area by using the Zoom to Selection option 
on the Zoom Tool Bar.

Selecting an Area to Edit

To select and area of a wave form, use the left mouse button to drag over the 
area you want to select. The length of the selected area is displayed in the 
Length of Select Area Indication (bottom right of Wave Form Edit Area) and is 
also displayed as a dark green bar on the View Scrub Window.

You can also opt to work with only the left or right side of the audio by using 
the Channels To Select option on the Audio Edit Tool Bar (see Select 
Channel To Edit), and then select the part of the wave form you want to work 
with in the normal way.
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De-selecting an Area

You can de-select the selected are by click the left mouse button anywhere in 
the wave form.

Altering the Selected Area

You can also change the selected area without totally de-selecting it by using 
the select tabs at the top of the dotted yellow line at the beginning and end of 
the selected area. As you move the mouse cursor over these, the mouse 
cursor changes to a hand and when this happens, you can use the left mouse 
button to ‘drag’ the beginning or end of the selected area to a different place 
in the wave form.
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Selecting the Entire Wave Form

You can select the entire wave form by either:

 Double clicking anywhere in the wave form.
 Pressing Ctrl + A on the keyboard

Please note that if you wish to perform any type of amplification, time 
stretching, copy / cutting, normalising or virtually any other function, to the 
entire audio file, you must first select the entire wave form using one of the 
above methods.

Current Position / Play Position

This counter performs two different functions depending on whether 
SmoothEdit™ is playing audio or not. When SmoothEdit™ is not playing 
audio, this counter shows the exact position of the Audio Cursor.

When SmoothEdit™ is playing audio, this indicator shows the exact position 
of the currently playing point within the wave form.

File Type Indicator

This section is not visible when working with SmoothEdit from within Myriad.
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Length of Selected Area

This indicator only becomes visible when you have Selected an area of the 
file (see Selected Area). Once an area has been selected, the exact length of 
the selected area is displayed here.

Visible Area

The Visible Area indicator on the View Scrub Bar shows the portion of the 
entire audio file that is currently displayed in the Wave Form Edit Area. For a 
full explanation, see View Scrub Bar.

The Audio Control Tool Bar

The Audio Control Tool Bar includes all the controls you need to control audio 
playback in SmoothEdit™. The buttons on the Audio Control Tool Bar not only 
allow you to control the playback of audio but also to control the way in which 
SmoothEdit™ deals with playing audio.
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Normal Play 

The Normal Play button sets SmoothEdit™ to operate in normal playback 
mode. In this mode, SmoothEdit™ will do the following:

 When a part of the audio file is selected: SmoothEdit™ will play only 
the selected area. Clicking play will start playback from the start of the 
selected are and will SmoothEdit™ will automatically stop playback at 
the end of the selected area.

 When no part of the audio is selected: SmoothEdit™ will start 
playback from the cursor point (the yellow vertical dashed line) and 
continue until the end of the file or until you stop playback manually.

Loop Play 

In Loop Play mode, SmoothEdit™ will do the following depending on whether 
a section of the audio file has been selected:

 When a part of the audio file is selected: SmoothEdit™ will start 
playback from the start of the selected area but when it reaches the 
end of the selected area, it will automatically return to the beginning of 
the selected area and start playback again.

 When no part of the audio is selected: SmoothEdit™ will start 
playback from the cursor point (the yellow vertical dashed line) and 
continue until the end of the audio file. At this point it will return back to 
the cursor point and start playback again.



649

Play to End 

In the Play to End mode, SmoothEdit™ will do the following depending on 
whether a section of the audio file has been selected or not.

 When a part of the audio file is selected: SmoothEdit™ will play 
from the beginning of the selected area but will continue on to the end 
of the audio file regardless of where the selected area ends.

 When no part of the audio is selected: SmoothEdit™ will start 
playback from the cursor point (the yellow vertical dashed line) and 
continue until the end of the file.

Play Hook 

This special mode is only available if you have an audio file that has the ‘hook’ 
point specified. 

When the Hook Play button is pressed, the Hook area is automatically 
selected and playback begins. When the end of the hook is reached, 
SmoothEdit™ automatically stops playback.

Stop 

The Stop button stops SmoothEdit™ playback of the audio file regardless of 
that play mode you are in. This option is only enabled while SmoothEdit™ is 
playing audio.

Play 

The Play button starts playback in SmoothEdit™. The icon on the Play button 
changes to reflect the current play mode of SmoothEdit™. You can also press 
the <Space Bar> to toggle between start and stop.

Pause 

The Pause button temporarily pauses playback and the Pause button turns 
blue. Clicking on the Pause button will resume playback from the point that it 
was paused regardless of playback mode.
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Jump to Start 

The Jump to Start button moves the Audio Cursor point (horizontal dashed 
yellow line) to the very beginning of the audio file.

Record 

The Record button will start SmoothEdit™ recording from the cursor point in 
the audio file. Once recording, you can click on the Record button or the Stop 
button to stop recording. 

While recording, the VU bars change to show the incoming audio level. The 
incoming wave form is also displayed on screen although this is not updated 
in real time.

Jump to End 

The Jump to End button moves the Audio Cursor point (horizontal dashed 
yellow line) to the very end of the audio file.

The Zoom Tool Bar

The Zoom Tool Bar contains the buttons used to zoom in and out of the wave 
form to allow you to view and edit it more accurately. The general layout is 
outlined below.
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Zoom In 

The Zoom In button zooms in to the centre of the wave form visible in the 
Wave Form Edit Area. You can click this button multiple times to zoom in 
further. The Zoom In button always zooms in to the centre of the wave form 
visible in the Wave Form Edit Area. You can then use the View Scrub Bar to 
reposition the zoomed area you are looking at.

TIP: If you use the Zoom to Selection button to zoom in to a selected area, 
you can then use the Zoom in button to continue to zoom in to the centre of 
the selected area.

TIP 2: You can use the wheel on your mouse to zoom in and our of the Wave 
Form Edit Area.

Zoom Out 

The Zoom Out button does the opposite to the Zoom In by zooming the view 
out from the centre of the wave form visible in the Wave Form Edit Area. You 
can click the Zoom Out button multiple times to zoom out further, up to the 
point that the whole wave form is visible. The Zoom Out button only becomes 
visible when you have zoomed in to a section of the wave form.

View Full 

No matter which part of the wave form you are looking at or how far zoomed 
in you are on a section, the View Full button will always zoom all the way out 
so the entire wave form is visible in the Wave Form Edit Area.

Zoom To Selection 

The Zoom to Selection will zoom such that the selected area of the wave form 
fills the entire Wave Form Edit Area. This option is only available once you 
have selected a section of the wave form that you want to take a closer look 
at.

Zoom In To Start Of Selection 

The Zoom in to Start of Selection is similar to Zoom to Selection but instead of 
zooming in so that the entire selected area is displayed in the Wave Form Edit 
Area, this option shows only the beginning of the selected area as well as a 
small section of the wave form before the start of the selected area.
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Zoom In To End of Selection 

This final button on the Zoom Tool Bar does the same as the Zoom in to Start 
of Selection but instead of focussing on the start of the selected area, this 
option zooms in to the end of the selected area and the part of the wave form 
directly following the end of the selected area.

Chapter 6 Summary

The key things that we have covered in this Chapter are basic concepts 
behind the SmoothEdit Screen and how SmoothEdit itself fits into the overall 
Myriad package. We have looked at the general Myriad Cart information such 
as Title and Artist and spent some time looking at the methods used to mark 
the key Timing Information for Carts such as Intro’s, Extros and Hooks. 
Finally, we looked at the SmoothEdit audio editor itself and the Audio Edit 
Area as a whole.

Key things you should take away from this Chapter include:

 An understanding of the general purpose of the SmoothEdit Screen 
and how it fits into Myriad.
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 A knowledge of how to set the basic Cart information and how to add 
enhanced information such as Notes, Copyright details and Pictures to 
a Cart.

 A good knowledge of how to set the Intro, Extro and Hook for a Cart 
(using either of the outlined methods) and how these skills can be 
expanded into setting up Looped sections.

 Have an understanding of the Audio Edit Area.
 Be comfortable zooming in to a wave form, selecting and area and 

using the tools on the Audio Edit Tool Bar to manipulate the audio.
 Be familiar with using SmoothEdit to listen to and review the Cart you 

are working on.

Remember that you can use tool tips on any buttons that you are not sure 
about, just hover the mouse cursor over the button and a little tip will tell you 
what the button does.

Audio editing is a skill in its own right, and the various techniques and skills in 
audio editing fall well outside the scope of this manual. For more details on 
general audio editing, why not type audio editing techniques into Google and 
find out more information?

In the next Chapter, we will turn our attentions to the Audio Browser which is a 
mini version of the Myriad Audio Wall which is used extensively throughout 
Myriad and all the supporting P Squared products.

Chapter 7 – The Audio Browser

The Audio Browser

The Audio Browser is used throughout the Myriad Suite and indeed 
throughout the P Squared product range to provide the ability to browse and 
select Carts listed on the Myriad Audio Wall.

Essentially, the Audio Browser can be considered as a ‘cut down’ version of 
the Audio Wall but in many respects it is actually more powerful than the 
standard Audio Wall, as it combines most of the Audio Wall functions with 
some more specific options for working with and displaying Carts, that are not 
generally available on the Audio Wall.

The Audio Browser can be used to browse Carts as well as search for Carts 
that match specific criteria. The Advanced options also allow you to customise 
the Audio Wall to have control over a great deal of detail as to which Carts are 
displayed.
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The Audio Browser can be configured to display Carts in three distinctly 
different styles and these are designed to reflect the different roles that the 
Audio Browser plays within the Myriad Suite.

Whilst the Audio Browser is used in several different ways in Myriad, the core 
operation is the same everywhere. In this section we will look at how the 
Audio Browser works and the facilities it offers.

The Audio Browser Layout at a Glance

As covered above, the Audio Browser is basically a cut down version of the 
Audio Wall so many of the features and concepts will be familiar to you as a 
Myriad user. In this section we will look at the general layout of the Audio 
Browser and briefly cover what each section does. These will then be 
expanded upon in the subsequent sections as we cover how to do key things 
with the Audio Browser.

Select Cart Button

The Select Cart button is used when the Audio Browser is being used to 
select a specific Cart from the Audio Wall. Clicking on this button will usually 
select the highlighted Cart and close the Audio Browser. 

This option is available in all three view modes but is not applicable in all 
applications for the Audio Browser.
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Refresh List

As the name suggests, this button is used to refresh the list of Carts displayed 
in the Audio Browser. 

NB: The list of Carts listed in the Audio Browser is automatically refreshed 
whenever you use Jump to Cart, change the Find options, or add any 
Advanced Options.

Advanced Options

The Advanced Options button is used to access the Advanced Options for the 
Audio Browser. Clicking this button will open the Advanced Options window.

The Advanced Options are represented on four tabs:

The General Tab

The General tab is used to set more general Advanced Options for the Audio 
Browser. 

The options are explained in more detail below.

Audio File Format
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The Audio File Format option allows you to restrict the Carts displayed in the 
Audio Browser to just Carts of a specific format. To use this feature, use the 
drop down list to select the option you want to use.

 Display All Carts – This is the default and does not restrict the Carts 
displayed in the Audio Browser.

 Display Linear Carts – Only displays Carts that are linear (i.e. not 
compressed) in the Audio Browser.

 Display Compressed Carts – Only displays Carts that are 
compressed.

 Display Carts That Aren’t – Allows you to display Carts that are not of 
a specific sample rate and type. Use the drop down lists to select 
sample rate and mono/stereo type.

 Display Carts That Are – Allows you to display Carts that are of a 
specific sample rate and type. Use the drop down lists to select sample 
rate and mono/stereo type. (N.B. This option is not shown on the 
screen shot above).

Only Show Carts with Extros Greater Than XX Seconds

Ticking this option will restrict the Audio Browser to only displaying Carts with 
an Extro greater then the length that you type into the option box.

Only Show Carts from XX to XX Seconds Duration

This option allows you to select the duration range for the Carts that are 
displayed in the Audio Browser. Just type in the required duration range using 
the option boxes.
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Only Show Carts with Time Discrepancies or Have Not Been ‘Seen’ 
Before

If this option is selected then the Audio Browser will only display Carts whose
actual length is different to the length that Myriad has recorded on the Cart. 
This would normally only ever be the case if the audio file behind the Cart has 
been edited or changed externally (i.e. not through the SmoothEdit screen).

This option will also display any Carts that exist in the Audio File Locations but 
are not displayed on the Audio Wall. This would only happen if the audio files 
for the Carts were manually copied into the Audio Locations directory without 
using Myriad.

In either case, you can tick the ‘Automatically Correct These Discrepancies’ 
option to make the Audio Browser automatically correct these problems as 
they are listed.

Ending Type

This option allows you to restrict the Carts displayed in the Audio Browser to 
only list Carts with the specific Ending type set. 

Use the drop down list to select the Ending type. The options are:

- Ends.
- Fades.
- Sustain.
- Slow Fade.
- Not Specific.

The Played Tab

The Played tab allows you to configure the Audio Browser Advanced Options 
that refer to the dates that Carts have been played.
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In general, these options are used to restrict the Carts listed in the Audio 
Browser to only list Carts played in the last XX days or between a time and 
date range.

Do Not Check the Played Dates

This is the default setting and does not restrict the displayed Carts by last play 
or date range.

Only Display Carts Played In the Last XX Days

This option allows you to restrict the Carts displayed in the Audio Browser to 
only display Carts the last XX days. If you tick this option, you can then use 
the drop down list to select the time frame that you are interested in.
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Selecting this option will mean that the Audio Browser will display all the Carts 
played between the selected start time period and the current date.

Only Show Carts Played Between XX Date Range

This option allows you to only display the Carts that have been played 
between two specific date ranges. This is great if you wish to see all the Carts 
played last week for example.

To use this feature, tick the option and then use the drop down calendars to 
select the start and end dates that you want to use.



660

The Last Modified Tab

The Last Modified tab allows you to configure Audio Browser options that 
relate to the last modified date of the Carts displayed.
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Do Not Check the Last Modified Date

This is the default option and when it is ticked, the Audio Browser does not 
take ‘last modified’ information into account when listing Carts.

Only Show Carts Modified In the Last XX Days

This option allows you to restrict the Carts listed in the Audio Browser to only 
include Carts modified in the last XX days.
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To use this option, select the time range that you want using the drop down 
list. This option will list all Carts modified between the selected start time 
period and the current date.

Only Show Carts Last Modified Between XX Date Range

You can use this option to make the Audio Browser only display Carts last 
modified between a specified date range. 

Tick this option and then use the calendar drop downs to select the start and 
end dates that you wish to use.
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The Advanced Tab

The Advanced Tab allows you to set a number of additional criteria to include 
or exclude the Carts listed in the Audio Browser. The Advanced tab includes a 
comprehensive list of criteria taken from the Edit Cart screen and you can 
select whether to display Carts that do or don’t have the selected criteria set.

This tab is split in to two columns; the left hand column allows you to include 
Carts that do have the selected criteria set on them. The right hand side 
allows you to select the criteria that Carts must have missing in order to be 
listed.

This is a really useful feature. Let’s say that you are doing a copyright report 
and you want to see all the Carts that have some of the copyright criteria 
missing. All you would have to do would be to tick the appropriate copyright 
criteria on the right hand column and then click on OK.

The Advanced tab opens up a whole host of powerful possibilities when 
working with the Audio Browser.

Toggle View Mode

There are three possible view modes when working with the Audio Browser. 
They are:

Standard Mode – Most like the standard Audio Wall.
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Slim Cart Mode – Slimmed down Audio Wall that allows you to see more 
Carts.
List Mode – Lists the Carts on the Audio Wall in a standard windows explorer 
style. 

You can switch between the different views at any time by clicking on the 
View Mode buttons. Any mode can be used in any situation although you may 
find that certain modes are better suited to different situations. 

For more on the three View Modes, check out the section on View Modes 
later in this Chapter.

Play Cart Options 

The Play button is used to play the selected Cart on the Audio Browser using 
a free Cart Player.

When you click on the Play button, the highlighted Cart will be loaded into one 
of the free Cart players and playback will start immediately.
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You can also use the drop list to select other Play Cart options.

This allows you to add the highlighted Cart to the Pad (see Chapter 1 –
Viewing and Using the Pad).

If you select this option, the highlighted Cart will be added to the current Pad 
run. This will happen even if the Pad is not currently visible.
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Search Notes

The Search Notes button allows you to toggle searching the additional Notes 
fields for Carts on and off, when using the Audio Browser’s Find facility.

If this button is depressed then when you perform a Find Cart (see Finding 
Carts Using The Audio Browser), the Audio Browser will return any Carts that 
match the search criteria in either then main description lines (Artist, Title & 
Description) or in the additional Notes fields (Presenter Notes, DAB Notes, 
Web Notes, Artist Web Page or Online Store Reference).

You can combine this option with any of the Advanced options or the Search 
Copyright Details toggle (see below).

Search Copyright

As with the Search Notes field above, this option is used toggle between 
including and not including the additional Copyright information when using 
the Find facility on the Audio Browser.
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With this option depressed, all of the Copyright details will be included when 
the Audio Browser is searching the Audio Wall for a Cart that matches the 
Find criteria. 

As with the Search Notes, this option can be combined with the Advanced 
options as well as the Search Notes option.

Display Blank Carts

The Display Blank Carts button on the Audio Browser allows you to toggle 
between whether the Audio Browser displays empty Carts and whether it 
filters them out and only displays Carts that are actually populated. When this 
option is off (not pushed in), the Audio Browser will only display Carts that are 
populated so the Cart’s Slot Numbers listed in the browser may not run in 
sequence. If the Display Blank Carts button is depressed then all Carts will be 
displayed in the browser regardless of whether they contain audio.

This option is applicable on all three playout modes but is usually most 
obvious in List mode.

Stop Search

This button is only enabled while the Audio Browser is performing a search 
and it is used to stop the search process. If you stop a search mid way 
through, the Carts that have already been found (that match the search 
criteria) will remain visible in the Audio Browser.
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Page Up / Page Down

Just as you would expect, these buttons are used to scroll up or down the 
Audio Wall a page at a time. You can also use the <Page Up> and <Page 
Down> buttons on the Audio Browser to do the same thing.

Jump to Cart

This option is used to allow you to jump to a specific Cart Slot Number. To do 
this, type in the Cart Slot Number that you wish to jump to in this field, and 
then click on the Jump button (see below). You can also press the <Enter> 
key on your keyboard when the Jump to Cart field has focus, to initiate a 
jump.

Jump Button

The Jump button is used to trigger a jump in the Audio Browser to the Cart 
Slot Number that is displayed in the Jump to Cart field. In the example below, 
when the Jump button is pressed, the Audio Browser will be updated to 
display the Carts around Cart 500 and Cart 500 itself will be the highlighted 
Cart.
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Carts

The Carts from the Audio Wall are displayed in the main section of the Audio 
Browser. The Carts can be displayed in three different ways depending on 
what you are using the Audio Browser for and what you prefer.

The three view modes for the Audio Browser are shown below.

Standard Mode
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Slim Cart Mode

List Mode

You can toggle between these modes at any time using the Toggle View 
Mode buttons.
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Find Cart

The Find Cart button allows you to use the Audio Browser to search for a Cart 
on the Audio Wall that contains a specific word or phrase in the main Cart 
description lines (Artist, Title and Description) as well as optionally in 
extended fields such as the Notes or Copyright details.

To use the Find Cart, type the word or phrase that you want to search for in 

the Find box and then click on the Start Search button (see below).

The Carts that match your Find criteria are displayed in the Audio Browser 
once the search has finished.
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You can combine this facility with the Advanced Options, the Search Notes 
and Search Copyright options for more accurate and powerful searching. For 
more details on Find Cart, see Finding Carts Using the Audio Browser.

Start Search

The Start Search  button is used to initiate a search of the Audio Wall
using the Audio Browser. Once you click on this button, the search begins and 
the progress is displayed as a progress bar running along the bottom of the 
Audio Browser window. The Stop button is also enabled once the search 
starts which allows you to stop the search before it has finished.

Cart Range (List Mode Only)

The Cart Ranges options are only available when the Audio Browser is in List 
mode and they are used to enter a range of Cart numbers to limit the display 
results to. Let’s say you wanted to look for all the songs on your system that 
contained the word ‘love’. If you just typed ‘love’ into the Find box and hit 
<enter> then all the Carts on the Audio Wall that contained the word ‘love’ 
would be displayed but if you used the Range option in List View mode to limit 
the search to only include Carts in area of the Audio Wall you use to store 
songs (3000 – 5000 in this example) then only the songs that contained the 
word ‘love’ in the Title, Artist or Description would be displayed.
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As with all the other options, you can combine the Range criteria with other 
search criteria for more accurate results.

The Three View Modes for the Audio Browser

The Audio Browser can be used in three different view modes each of which 
displays the Carts on the Audio Wall in a different way. You may find that one 
of the display modes suits your tastes better and that you favour that mode or 
you may find that different situations are better suited to certain display 
modes. 

The three view modes for the Audio Browser are shown below.

Standard Mode
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Slim Cart Mode

List Mode

You can switch between these three modes at any time by clicking on the 
Audio Browser Mode Select buttons on the Audio Browser Tool Bar.
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Using the Audio Browser to Move around the Audio Wall and
Find Carts

As we have already covered, the Audio Browser is a very powerful tool that is 
used in many different environments within the Myriad Suite of products. 
Essentially it provides access to the central Myriad Audio Wall and allows you 
to browse and search for Carts and to select Carts when the circumstances 
call for such ability. 

In this section we will look at how you can use the Audio Browser to move 
around the Myriad Audio Wall.

Moving Around the Audio Wall Using the Audio Browser

You can manually scroll around in the Audio Browser a page at a time using 
either of the methods outlined below.

1. Use the <Page Up> and <Page Down> keys on your keyboard or 
Myriad keyboard to scroll through the Audio Wall page at a time.

2. Use the scroll button on the Audio Browser to scroll backwards and 
forwards through the Audio Wall page at a time.
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3. When you are using the Audio Browser in the List Mode, you can use 
the standard scroll bar to the side of the window to scroll up and down 
the list of Carts.

When in this mode, the <Page Up> and <Page Down> keys on your 
keyboard will also work but the Scroll buttons on the Audio Browser are 
disabled. If you have a wheel mode, this will also scroll up and down 
when the Audio Browser has focus and is in List mode.

Jumping To a Specific Cart

You can also use the Audio Browser to jump to a specific Cart Slot Number 
on the Audio Wall using the Jump to field on the Audio Browser.

To jump to a specific Cart Slot Number, type in the Cart Slot Number that you 
want to Jump to into the Jump To field and then either press the <Enter> key 
on the keyboard or click on the Jump button.
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This will then move the Audio Browser to display the appropriate area on the 
Audio Wall and highlight the selected Cart.

This procedure works the same regardless of what view mode you are using 
to view the Audio Browser. In the example below we can see how it looks in 
the List mode. As you can see, the Jump to field works in exactly the same 
way but the Cart Slot that is jumped to is highlighted in a slightly different way.
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As with the Jump to Cart facility on the Audio Wall Screen, you can use the 
<Alt> + <J> keys to initiate a Jump to Cart. The only difference is that 
pressing <Alt> + <J> on the Audio Wall will open the Jump To Cart window 
where as on the Audio Browser, <Atl> + <J> places focus in to the Jump To 
field to allow you to type in the Cart Slot Number you want to jump to. You can 
then press the <Enter> key (or click on the Jump button) to jump as normal.

Using Cart Ranges When In List View Mode

When you are using the Audio Browser in List mode, you can also limit the 
range of Carts displayed in the Audio Browser to a specific number range. 

This is done using the Range options that appear on the Audio Browser tool 
bar when you switch to List mode.

To restrict the Carts displayed in the Audio Browser to a specific range, type 
in the Cart Slot Number Range and then press the <Enter> key or click on the 
Refresh button (see Audio Browser Tool Bar At A Glance).
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The Audio Browser will then only display Carts found within the selected Cart 
Slot Number Range. You can combine this with the Find function to perform 
very specific searches within a restricted Cart range. This is useful if you are 
looking for a specific song as you could type the song title and select the 
range of Cart Slots where your songs are stored so that no other Carts that 
match the Find criteria are displayed.

Finding Carts Using the Audio Browser

In addition to browsing the Audio Wall, the Audio Browser also allows you to 
search for Carts that contain specific words or phases in the three main 
description lines as well as optionally, the Notes fields and Copyright details.

This works in a very similar way to the Find Cart window on the Audio Wall 
but instead of displaying the results in a list, the Carts that match the search 
criteria are displayed in the Audio Browser.

Here’s how it works:

1. Click on the Carts button to open the Audio Browser.
2. Type in the word or phrase that you want to search for. By default, the 

Find will look at the main three Description lines on the Carts (i.e. 
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Artist, Title and Description). You can also set the Audio Browser to 
search the Copyright Details and Notes fields.

You can also use the drop down list to see words or phrases that have 
been searched from recently. You can highlight one of these previously 
searched for phrases if you prefer.

3. Click on the Find button or press the <Enter> key on the keyboard to 
start the search.

4. The search progress is displayed by a progress bar that runs along the 
bottom of the Audio Browser. Any Carts that match the search criteria 
are displayed as they are found and you can stop the search at any 
time by clicking on the Stop button.
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If no Carts are found then the Audio Browser will remain blank at the 
end of the search - see above.

5. If several Carts meet the search Criteria then they will all be displayed 
in the Audio Browser.
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In this example, we can see that a search for ‘minogue’ has returned 
Carts that contain songs by both Kylie and Dannii Minogue. Had the 
search criteria been shortened to ‘mino’ then the results would also 
have included such Carts as ‘Morris Minor & The Majors’ as this also 
contains the ‘mino’ search criteria.

The results are displayed in the same way regardless of which mode 
you are using the Audio Browser in.

6. You can also set the Audio Browser to include Copyright details and 
Notes when looking for the search criteria. To include the Copyright 
details in the search, click on the Copyright toggle button.
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To include the Notes in the search, click on the Notes toggle button.

You can also combine these options by clicking both toggle buttons;
this will then include all Carts that contain the search word in the 
Description fields, the Copyright details or the Notes sections.

The Audio Browser in Other Products

The Audio Browser is fairly unique in that whilst all P Squared products should 
feel familiar to regular users, only the Audio Browser spans the entire Myriad 
Suite as well as some P Squared products that are not directly related to 
Myriad. The List below shows the P Squared products where the Audio 
Browser can be found.

 Myriad Manager
 Log Importer
 Myriad STS
 OCP
 Advert Manager
 AutoTrack
 AutoTrack Pro
 Scoop Capture
 Scoop Edit

Chapter 7 Summary

In this Chapter we have looked at the Audio Browser in some detail. We have 
seen the different ways in which the Audio Browser can be configured and the 
tools it provides for browsing the Audio Wall and locating Carts. We have also 
touched on how the more advanced features can be used to provide detailed 
information about the Carts on your Audio Wall.
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The key things that we have covered include:

 The layout of the Audio Browser and the primary function of all of the 
main elements.

 The three different view modes for the Audio Browser and how to 
switch between then.

 How to use the Audio Browser to move around the Audio Wall and 
jump to specific Cart Slot Numbers.

 How to search for Carts that contain words or phrases and how you 
can configure the Audio Browser to search a range of additional fields.

 We also touched on the fact that the Audio Browser is used in other P 
Squared products including AutoTrack Pro and Scoop.

The Audio Browser is used in a number of different situations in Myriad so a 
good working knowledge of this Chapter will be a big help in understanding 
how to get the most from your system.

Chapter 8 – The Menu System

In this Chapter we will look at the Menu system in Myriad and how it is used to 
configure and customise Myriad and also the tools that it offers in every day 
use. 

When we talk of the menu system we mean the series of menus and sub-
menus that are accessible from the top left of the left hand screen in Myriad.

This may seem very obvious as most people will have used menu systems in 
other applications, but in fact, Myriad v3 is the first version of Myriad to 
include a menu system so long term Myriad users who switch to Myriad v3 
may find the menu system a little unusual at first.

The menu system offers a range of diverse options from providing access to 
information, to totally re-configuring Myriad. Because of this, this Chapter will 
be fairly eclectic in content. Not all options covered in this section will be 
applicable to all stations or users so just take from this Chapter whatever you 
need.

Please note that many of the file options are also only available if the logged 
in User has enough access rights within the P Squared Directory. For the 
purposes of this documentation, it is assumed that the User has full access 
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rights to all sections of the menu system but general Users may well find that 
some of the options are not available to them.

Menu System General Overview

As mentioned in the introduction, the menu system covers a great many areas 
of Myriad. In order help with navigation, the menu options are arranged into 
menus and sub-menus to group together similar options, or options that refer 
to similar parts of Myriad. The main menu sections are outlined below.

 File – The File menu is common to almost all Windows™ applications 
and is usually used for opening, closing and saving files. In Myriad, as 
you do not open or close files, it is used for a slightly different 
application. The File menu allows users to log in and out of Myriad and 
also allows users with appropriate access rights to open and close 
Station Databases. You can also exit from Myriad from this menu.

 Log – The Log menu concentrates on providing User options relating 
to the Log Screen in Myriad. Most of the options on this menu relate to 
usability of the Log rather than setting up or altering the way the Log 
works. In general, most Users will have access to most of the options 
on the Log menu.

 View – The view menu contains a range of options relating to either the 
sections of Myriad that are visible to the User (such as the Pad or 
Instant Carts) or access to additional information sources such as 
Scripts, Intranet sites or even web sites. The View menu is fairly unique 
in that it is the only menu that a station can customise to their needs, 
adding in or removing information pages that they want their presenters 
to have access to.

 Tools – The Tools menu offers tools aimed at the User (as opposed to 
the system administrator).These include the ability to customise Myriad 
to a certain extent, change their password or record into their personal 
area.

 On-Air Control – This menu is only visible on workstations that have 
been configured in such a way that they are able to take or release On-
Air (or Station) Control. So if your station uses several studios and you 
need to switch on-air control between them then you would configure 
Myriad accordingly and the On-Air Control menu is enabled. If your 
workstation is always ‘on air’ or never ‘on air’ then there is no need for 
this menu option and it is disabled.

 Settings – This is where the bulk of Myriad’s settings and configuration 
options are housed (other than the Customise options on the Tools 
menu). Unlike previous versions of Myriad, Myriad v3 does not have a 
separate configuration tool so the entire configuration is done via the 
Settings menu. General Users would not normally be allowed access to 
this menu.
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 Help – This provides access to the P Squared Support File Generator 
and other ‘online’ support services from P Squared. It is also where you 
can check your Myriad version number using the About Myriad option.

So as you can see, the menu system provides a wealth of diverse options and 
facilities. Individual descriptions of each of the options follow in the next 
section.

The File Menu

The File menu is one of the simpler menus in Myriad in that the options are 
fairly straight forward and not all Users will have access to all of them.

The File menu can be seen in extended form below.

Logged In As XXXX

The Logged in as XXXX section of the File menu is really more for information 
purposes as the option cannot be selected. As you can see from the screen 
shot above, the Logged in as section of the menu shows the Login Name of 
the User currently logged into Myriad. In the example above, the User logged 
in is called ‘Liamb’.

Logout

The Logout option is used to log the current User out of the system. When 
you select this option, you are immediately logged out of Myriad and the new 
User Login box is put on screen to allow the next User to log in. If you are 
playing a Cart at the time, the Cart will continue to play even while you are 
logged out. If you are running with the Log Screen in one of the Active Playout 
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modes or you are running a Pad run the Myriad will perform any automated 
segues that it needs to while you are logged out.

As you can see from the screen shot, the Audio Wall is hidden while you are 
logging in, don’t panic, this is because each User can customise the Audio 
Wall to look different so while no User is logged in, there is no Audio Wall to 
view. 
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To log in to Myriad: type in a valid Login Name and password, and then click 
on OK. The Login Name and Password will be checked against the P 
Squared Directory and assuming the Login Name and Password match, the 
new User will be logged into Myriad and all their customisation settings will be 
loaded. 

You can opt to change your password directly after logging in by ticking the 
‘After Login, I Want To Change My Password’ option.

If you forget, you can also change you password using the Change Password 
option on the Tools menu.

If you accidentally click on the Cancel button at this stage, the Audio Wall will 
remain blank:
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What you will see in this case is a blank blue screen with the Cart Players 
along the bottom of the screen and nothing else. Don’t panic, click on the File 
menu and select the Login option to re-open the Login box.

Open Station Database

The Open Station Database option on the File menu is used for opening the 
Station Database. 

By now you will hopefully have had a play with Myriad and glanced through 
the preceding Chapters in this documentation. If so then you should be fairly 
familiar with the concept of the Schedule Log that is displayed on the Log 
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Screen. The Schedule Log is effectively a list of Songs, Links and other Log 
Items that can be played in either ‘live’ shows or ‘automated playout’. The 
Station Database is the database that contains the Schedule Log but more 
than that, it also contains a great deal of additional configuration settings 
about the way Myriad work and will deal with audio. 

Basically, you need a Station Database per radio station that you are running 
with your Myriad system, and whilst for the majority of stations, that means 
that they will only have one Station Database, if you were to run two or more 
radio stations at the same site (like an AM and an FM for example) then each 
station would have its own Station Database with separate Schedule Log and 
configuration options.

Just because you are running two radio stations, does not mean that you 
need twice as many Myriad workstations because you can use the Open / 
close Station Database options on the File Menu to switch between Station 
Databases at your leisure.

To open a Station Database, select the Open Station Database option on the 
File menu to access the Choose Database window.

If you use the Open Station Database option while you have a Station 
Database open, Myriad will automatically close the one that is currently open.

To select the Station Database to open click on it to make sure it is 
depressed, then click on the Ok button. 
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Myriad will then open back up with the new Station Database loaded.

Myriad will let you Open a new Station Database even if you are in one of the 
Active Playout Modes. The Cart that is currently playing will continue to play 
as normal but as the Station Database is closed, the Schedule Log will be 
closed with it so at the end of the Cart, Myriad will have nothing to play. 
Therefore you really need to get the new Station Database open and get back 
into an Active Playout Mode (or at least cue a Cart from the Audio Wall).

NB: In general, it is not advisable to change the Station Database on a ‘on air’ 
workstation but if you need to you can.

Adding, Copying & Deleting Station Databases Using the Choose 
Database Right Click Menu

You can use the Choose Database window to perform a number of functions
on the Station Databases that you have via the right click menu.

The options are:

 New Database – Create an entirely new Station Database. If you 
select this option you will be asked to provide a File Name and 
Description for your new Database. The Database will then be 
automatically generated in the appropriate place by Myriad. When you 
first go into your new Database, the Station Database Settings window 
will appear to allow you to alter the settings for your new Station 
Database; the default settings will already be set so you can click on 
OK straight away if you are happy with defaults.

 Copy Database – If you right click on a Database and the select Copy 
Database then a duplicate of the Database will be made. All you have 
to do is give it a new File Name.
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 Change Database Title – This option allows you to alter the Database 
Title which is displayed on the Choose Database screen.

 Change Database Filename – This option allows you to alter the file 
name of the station database.

 Delete Database – This option will delete the Station Database from 
the system. You will be asked twice to confirm your action but if you 
say yes then the Station Database will be deleted from the system and 
cannot be recovered.

Please note that only Users with appropriate access rights can open, close 
and edit Station Databases.

Close Station Database

The Close Station Database option will close the currently open Station 
Database leaving the Log Screen with a button on the middle to allow you to 
access the Choose Database window.
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Click on this button to open the Choose Database window, select the 
database you want to open (by clicking on it) and then click on OK to open the 
Station Database.

Exit

The Exit option is used to close Myriad altogether and return to the Windows 
Desktop.
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When you select the Exit option, you get a window that allows you to confirm 
that you wanted to exit from Myriad and not just log out.

If you wanted to exit from Myriad, click on the ‘Quit from Myriad’ option and 
then click on Ok.

If Myriad detects that it is still playing a Cart, it will offer an additional warning 
to let you know that quitting now will also end playback of the Cart.

Click on Yes to quit anyway or click on No to return to Myriad.

The Log Menu

The Log menu brings together a number of tools and options that relate to the 
Log Screen in Myriad and using the Log Screen in one of the Active Playout 
Modes.
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The options on the Log menu are primarily aimed at the presenter using the 
Log Screen rather than the system administrator who would be setting up and 
maintaining the Schedule Log and the Log Screen. This means that the 
options on the Log menu refer to using the log, not configuring them.

In general, all Users will have access to the Log menu.

Go!

The Go option on the Log menu is used to trigger a Go Event in the Log 
Screen. When a Go Event is triggered, Myriad will start the next Log Item in 
the Schedule Log and, depending on the configuration, fade out the previous 
one.

Selecting the Go option has the same effect as pressing the Go button or 
pressing the Play button on the Cart Player that the next Log Item is loaded 
into.

Display Seg Editor

The Display Seg Editor option on the Log menu is used to toggle between 
Mini Segue Editor and Full Segue Editor Mode.
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Mini Segue Editor mode

Full Segue Edit mode

Selecting the Display Seg Editor has the same effect as clicking on the 
SegEdit button on the Log Screen.

Print Current Hour

The Print Current Hour option allows you to send a list of all the Log Items in 
the hour of the Schedule Log that is currently highlighted, to your computers 
default printer.

Once the information has been sent to the printer, Myriad confirms with a 
message box.
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Add Hour to Log

The Add Hour to Log option in the Log menu allows you to manually add an
Hour Start Marker and Absolute Time Marker to the Schedule Log in order to 
create a beginning and end of an hour that you can then manually populate.

Take a look at the screen show below.

Here we can see that the Schedule Log ends at 23:56 with a Queen Song. If 
we do not add some more Schedule Log before Myriad gets to that point, it 
will stop and wait for more Schedule Log to be added. Normally, this would be 
imported from your scheduling system long before it is needed but if we 
wanted to add an hour to the Schedule Log manually, we would need to use 
the Add Hour to Log option. The process is as follows:

Select the Add Hour to Log option.
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You will then be asked to set the date and time that you want to add to the 
log. In the above example, we want to add the 00:00 hour on the 15th of 
February so we select that date and time.

Then click on OK.

You will next be asked whether you want to add some audio to the hour being 
added. This allows you to select a point in the Audio Wall using the Cart 
Browser and Myriad automatically adds the appropriate number of Carts to fill 
the hour, by adding each sequential Cart on the Audio Wall starting at your 
selected point. Just for now we will say no so that Myriad will only add the 
Hour Start Marker and Absolute Time Marker (for the end of the hour).
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As you can see, the Hour Start and Absolute Time have been added to the 
Schedule Log, we can now start to add Log Items manually by either dragging 
them from the Audio Wall or Audio Browser or using the right click Insert 
options (see Chapter 5 for more details).

Let’s see what happens if we decide to add another hour but this time get 
Myriad to add some audio as well. 

Select the Add Hour to Log option again and select the 01:00 hour using the 
Time / Date selection window.

Select Yes when asked whether we want to add audio to the log.
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The Audio Browser will then open to allow you to select the starting point in 
the Audio Wall that you want to use to start adding Carts to the Log.

In this example, we will start with Rachel Stevens by double clicking on Cart 
3000.

You will then be asked how many Carts you wish to add.
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We will add 5 in this example.

Here you can see that five Songs have been added to the Schedule Log.

Please note that if you attempt to add an hour to the Log that already exists, 
Myriad will inform you that it cannot comply.
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The Advanced Menu

The Advanced menu option expands to offer some more advanced Log 
related options. These options will not normally be needed but you may be 
asked to look at them if you are receiving technical support from P Squared 
engineer.

Re-Calculate Timing

The Re-Calculate Timing option on the Log > Advanced menu forces Myriad 
to recalculate the estimated play time information for the Log Items in the hour 
that you are currently looking at. This may be useful if you know that the 
length of one or more Carts scheduled to play in the hour has changed but the 
changes have not been updated on the Log Screen. This can happen as 
Myriad usually only recalculates timing information on the current hour when 
in Active Playout mode or in a non-current hour if a change is made to the 
Schedule Log. 

This means that if you are looking at an hour in tomorrows Schedule Log and 
no changes have been made to the Schedule Log then the timing information 
will remain the same as when scheduled. If the length of one or more Carts 
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has been altered since then, then the timing information may not be accurate. 
This is not usually a problem as Myriad will recalculate the timing before it 
comes to use the hour (tomorrow) so it will not affect ‘on air’ but if you are
looking to Voice Track in to the hour, it may be a problem.

The Re-calculate Timing option will force Myriad to re-calculate the timing so 
that it is all up to date.

You can actually achieve the same thing by adding or removing any Log Item 
to or from the Log.

Display Log Item Details

The Display Log Item Details option need only be used at the request of a P 
Squared support engineer. Selecting this option opens the Log Details 
window which offers a range of technical information about the Log Item in the 
Schedule Log.

This technical information can be used by P Squared engineers to discern 
certain details about the Log Item and how it was (or will be) processed by 
Myriad. The information contained in the Log Item Details window is of a 
highly technical nature and an explanation of the information is not open to 
general Myriad customers.
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Display Q Audio Engine

The Display Q Audio Engine option provides access to another technical 
diagnostic tool used by P Squared engineers when they are working on 
technical queries. The Q Audio Engine is the audio and timing engine that 
Myriad uses when the Log Screen is in one of the Active Playout mode. The 
Q- Audio Engine is responsible for cuing and playing all log items, managing 
sweepers and Voice Tracks and also back timing when in AutoFade mode. 

Selecting the Display Q Audio Engine option opens up the Q Audio Engine 
browser which provides a whole host of real time information on how the Q 
Audio Engine is running and what Myriad is ‘thinking’.

This information will be largely useless to end Users but a P Squared 
engineer may ask you to view the data whist diagnosing any Q Audio Engine 
related problems or faults.

The View Menu

The View menu is fairly unique in Myriad in that it is the only menu that can be 
customised to your stations needs. In general, the View menu is used to 
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access additional text information and also to toggle certain elements on the 
Audio Wall on and off.

The interesting thing about the View menu is that you can add a number of
local and web based HTML pages to the menu along with a bunch of HTML 
scripts. This allows you to customise the View menu to offer Users access to 
key information pages and web sites. In the screen shot below, the 
customised elements are indicated with the red boxes.

Audio Browser

The Audio Browser option on the View menu opens a ‘floating’ Audio Browser 
which allows you to browse the Audio Wall. The Audio Browser is used 
extensively throughout Myriad and other Audio Wall compatible P Squared 
applications and is covered in detail in Chapter 7.

Customisable Information Menu Options (Contact Details, Station 
Info etc)

In the example above, you will see a range of information base menu options 
including Contact Details, Station Information, ‘What’s On’ Guide and P 
Squared Web Site. Clicking on these options will open a special web page 
viewing and allow you to view the content of the pages the menu options are 
linked to.
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Nothing too unusual here except for these menu options are not ‘hard coded’ 
into Myriad but rather can be configured to be different on each Myriad 
workstation at your station. 

Let’s take a look at the Settings menu > Myriad Settings > View Menu tab for 
the workstation we are working on.
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Here we can see that the options on the View menu have been configured in 
this window. Each option on the View menu corresponds to an entry in this 
table with the Name column being used for the Name on the view menu and 
the Location column being used for the location of a local or web based HTML 
page that the View menu option will open when selected. You may also note 
that the Separator Line entry between the ’What’s On Guide’ and the ‘P 
Squared Website’ causes the line between the options on the View menu.

Let’s say for example that we want to add another option on the View menu 
that links to a ‘weather’ HTML page stored on the local computer and we also 
want to add a separator line between the P Squared Web Site option and the 
new Weather option.

First click on the Add Option button and tick the Separator Line option to add 
the separator line to the list.
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Next click on the Add Option button again and this time type in the Name and 
Location of the Weather option we wish to add.

Note that if the HTML file you are linking to is a local or network file then you 
can click on the Select button to browse your local drives and network 
connections. Click on OK once you are done.

Our View Menu settings window now looks like this with the new Weather 
option added to the bottom of the list.
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Click on OK to save the changes. We can now see the end results on the 
View menu.
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And if we click on the Local Weather menu option:



713

You can actually edit text in the file from this window by clicking on the Edit 
button.

You can then type and edit the text in the main window, and when you are 
done, click on the Save button to save your changes.

Fore more details on the View Menu tab on the Settings > Myriad Settings 
window, please refer to the Settings Menu section of the documentation.

Live Read Scripts

The Live Read Scripts option on the View Menu is another part of the menu 
that can be changed to suit your station’s needs. The difference is that unlike 
the previous section where we looked at adding more options to the View 
menu, the Live Read Scripts section of the menu is a lot more dynamic in that 
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it basically offers access to all of the HTML files in the special Scripts folder 
within your main Myriad System folder. 

In the example above, the Live Read Scripts menu contains two options, 
Cinema Listings and Todays Weather. If we look at the main Myriad System 
file location (the folder location where Myriad stores all the Myriad files and 
databases) and the Scripts sub folder.
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Any HTML pages copied into this folder will automatically be added to the Live 
Read Scripts section of the View menu with the filename being the option 
name on the menu.

This means that support staff at a station can write HTML scripts in any word 
processor, copy them to this folder and they will instantly be available to the 
presenter in the studio (and all other workstations). 

If you click on a Live Read Script option, the script is loaded into the special 
script viewer window.
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As with the Customisable View Options, you can edit the text in the script by 
clicking on the Edit button and save your changes by clicking on the Save 
button.

Show Schedule

The Show Schedule option is usually only useful if you are using either 
AutoTrack or AutoTrack Pro to schedule music and links for your Schedule 
Log.  If you are using either of these products then the Show Schedule option 
can be used to display the ‘Clock Assignment’ which is effectively your 
station’s Show Schedule.
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Display Instant Carts

The Display Instant Carts option on the View menu is used to toggle the 
reduced Instant Cart display on the Audio Wall between visible and hidden.
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For details on what Instant Carts are and how to use them, please refer to 
Chapter 3 of this documentation.

Display Pad 

The Display Pad option on the View menu is used to toggle the Pad on the 
Audio Wall between visible and hidden.
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When the Pad is visible, this is indicated by a tick on the Display Pad option 
on the View menu.
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The Tools Menu

The Tools menu offers a range of tools that are oriented around the User 
logged into Myriad at the time. The principle option on the Tools menu is the 
Customise option which allows users to customise certain aspects of the 
Myriad experience to their personal preferences.

It is important to make the distinction between Customising Myriad and Myriad 
Settings. Customisation options are only applicable to the User logged in at 
the time. When they log out, the Customise settings will be saved and 
automatically reloaded the next time they log in.
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We will now look at the various Customise options in Myriad.

Customise Myriad

The Customise Myriad window is split into two main tabs (vertically along the 
right hand side). The Myriad tab is used to display Myriad Interface 
Customisation options that refer to the way Myriad looks. The Audio tab refers 
to a range of options that refer to the way Myriad deals with Audio and Carts 
on the Audio Wall. Each of these major tabs are then divided in to sub tabs 
within the main section of the window.

The Reset All button is used to reset all Customisation options back to the 
default settings. The Ok button is used to save the changes and close the 
window and the Cancel button is used to close the window without saving the 
changes.

Myriad Tab > General Tab

This tab allows you to customise General Myriad interface options.

Display Today’s Date On the Clock Strip

You can use this customisation option to toggle whether the date is displayed 
below the time on the general Myriad interface.
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Myriad Tab > Log Display Tab

This tab allows you to customise the Log Screen interface options.

Switch Back To Following the Log after XX Seconds of Inactivity

When you are working with the Schedule Log on the Log Screen, the Log 
Screen display will normally automatically update to follow the currently 
playing Log Item as each item in the Log is played. This means that when it is 
in an Active Playout mode, Myriad makes sure that the currently playing Log 
Item is always visible.

If you move to a different part of the Log to review the Schedule Log for later 
in the day or to edit tomorrows show, the last thing you want Myriad to do is 
keep jumping back to the currently playing Log Item each time it performs a 
segue. This option allows you to set a time (in seconds) after which, if you 
have not moved around in the Schedule Log or edited it in any way, it will 
jump back to display the currently playing Log Item.
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Let’s say for example that you are presenting a show and you want to look at 
tomorrows Schedule to make some changes and record some Voice Track. 
You use the Goto button to jump to tomorrow in the Schedule Log and start 
editing the Schedule Log. While you are working with the Log, Myriad is 
happy to leave the display showing tomorrows schedule but once you have 
finished, if you go off to make a cup of tea, Myriad will automatically jump 
back to the Currently Playing Log Item (just like pressing the Home button) 
after XX seconds of inactivity.

The default for this setting is 60 seconds but you can customise it to your 
individual needs.

Display the Information Panel

This customisation option allows you to decide whether you wish the Notes / 
Information panel to be displayed on the Log Screen.

When this option is un-ticked, the Notes / Information Panel is hidden on the 
Log Screen and the Mini Mode Segue Editor stretches to fill the entire screen.

Audio Tab > Navigation Tab

The Navigation tab allows you to customise elements of Myriad that refer 
moving round and searching the Audio Wall.
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Initially Display the Last Viewed Cart

If you tick this option, each time you log into Myriad, the Audio Wall will 
automatically jump to the last Cart on the Audio Wall that you had highlighted.

Initially Display a Specific Cart

This customisation option allows you to specify a particular Cart to be 
highlighted each time you log in to Myriad regardless of the last Cart you were 
looking at.

To use this option, tick the box and then type in the Cart Slot Number that you 
wish to use each time you Login to Myriad.

When Searching Carts Search the Notes / Copyright Details
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This customisation option allows you to customise the Find Cart default 
options that will be ticked each time you open the Find Cart window on the 
Audio Wall.

If you tick the Search the Notes option then when you open the Find Cart 
window for the first time in a single Login session, the Search Notes option on 
the Find Cart window will be ticked. The same goes for the Search Copyright 
Details option.

Please note that just because you set them here, you can still turn them on 
and off as you need to in Myriad, this just sets the initial state when you first 
log in to the system.

Cart Range Display: Personal Range

The Personal Range allows you to set a range of Carts to be your own 
personal area. This range is used for two very important uses. Firstly, when 
you click on the Home button on the Audio Wall Main Tab Strip, Myriad will 
jump to the first Cart in your Personal Range.
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The second and more important use for this Personal Range is that when you 
click on the Quick Record button on the Record Cart Player, Myriad will 
automatically assign the next free Cart in your Personal Range to be recorded 
in to.
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If there are no free Carts in your Personal Range then Myriad will let you 
know.

Please note even if your Personal Range is set to be a specific range of 
Carts, you still need to have Edit Cart Rights for that range in order to allow 
you to record or edit the Carts. This is set in the User Security Settings 
section of the Contact / Directory in Myriad Manager.

Allow Carts to be moved By Drag ‘n’ Drop

This option can be ticked to allow you to use ‘drag n drop’ on the Audio Wall 
to move Carts from one Cart Slot to another.

Please note that this option is useful if you are doing a lot of moving around 
on the Audio Wall but is not recommended for general day to day use as it 
makes it very easy to move a Cart by mistake.

Audio Tab > Cart Display

The Cart Display tab allows you to customise the size of the Carts on the 
Audio Wall and the size of the fonts used on the Carts. This is a very useful 
option as it allows users who have trouble reading the Audio Wall screen to 
make everything bigger. And as this is a customise option, the changes made 
will only apply to the User currently logged in.
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Minimum Width / Height in Pixels

In this section you can set the minimum Cart size for the Audio Wall. This is 
the smallest that the Carts will appear on screen but they may well appear 
bigger as Myriad will fit the maximum amount on screen that it can (allowing 
for your minimum size) and any space left over will be shared between the 
visible Carts

To alter the minimum width and height, type in the size in pixels, in the Width 
and Height.
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Unfortunately, the only way to test you new size is to click on the OK button 
and see how the Audio Wall looks!

Font for the Audio Wall

This customise option allows you to set the font and font size for each of the
description lines displayed on the Carts on the Audio Wall. To alter the font or 
font size, click on the Font button and select the font and font size you wish to 
use.
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Once you are happy with the new font, click on the OK button. A preview of 
the font and font size is displayed on the sample Cart in the centre of the 
window.

Font for the Others

This setting is used to set the font and font size used for Carts in the Audio 
Browser when it is in single line Cart Display mode. 
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To alter the font or font size, click on the Font button and select the font from 
the font selection window.
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Audio Tab > Playback / Recording Tab

The Playback / Recording tab is used to customise the way that Myriad deals 
with certain aspects of playback and recording. You can customise the way 
Myriad acts when Carts are ejected from Cart Players, the level at which 
Myriad will ‘trigger’ recording when using the Record Cart Player and also 
whether Myriad will automatically display the wave form when viewing the 
SmoothEdit Screen.

When Ejecting A Cart

This section of the Playback / Recording tab allows you to customise the way 
that Myriad acts when you either click on the Eject button on a Cart Player or 
use the keyboard shortcut key for ejecting a Cart on a Cart Player. Basically 
there are two possible scenarios.

 The Cart Is Faded – When the Eject button is clicked on or the Eject 
key is pressed, Myriad will slowly fade the Cart out over X seconds.

 The Cart Is Immediately Ejected – The Cart is immediately ended 
and ejected from the Cart Player.
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The When Ejecting customise options allow you to set Myriad to Fade Carts 
when either the mouse is used, or the keyboard is used (or both) and to also 
customise the duration over which Myriad performs the fade.

In the above example, the ‘Fade the cart when using the mouse’ option is 
ticked and it is set to take 2 seconds to fade out. The ‘Fade the Cart when 
using the keyboard’ option is not ticked so when you press the Eject button on 
the keyboard, the Cart will stop and be ejected immediately.

So if you ticked both options the Myriad would fade out the Cart regardless of 
whether you use the keyboard or mouse to eject the Cart and by adjusting the 
‘Take X sec to fade out’ option you can adjust the duration taken to fade out 
the Cart.

If none of the options are ticked then Myriad will immediately stop and eject 
the Cart regardless of whether the mouse or keyboard is used.

The ‘Only allow Carts to be Ejected from the players when paused or cued’ 
customise option allows you to set Myriad to only allow you to Eject a Cart 
from a Cart Player when the Cart Player is either cued ready to play, or 
paused, i.e. do not let a Cart be Ejected whilst it is playing. This option allows 
you to customise Myriad to act like many pro CD players.

If this option is not ticked then Myriad will allow Carts to be ejected at any 
time.

When Recording New Audio

This set of customise options allows you to alter the way in which Myriad acts 
when you are using the Record Cart Player to record audio into a Cart Slot.
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Using the drop down option, you can select whether Myriad should use 
‘trigger level’ recording (only start recording when the incoming audio volume 
exceeds the Trigger Threshold) to start recording into the Cart.

The options on the drop down list are:

 Never Use – If this option is selected, Myriad will never use ‘trigger 
level’ recording and start recording as soon as you click on the record 
button on the Record Cart Player.

 Ask First – The Ask First option will offer the user the opportunity to 
decide whether to use trigger recording or not.

This is done via the dialogue box. Click Yes to use trigger level 
recording, click No to not use trigger recording (start recording 
immediately), or Cancel to abandon recording.

 Always Use – If this option is selected then Myriad will always use 
trigger level recording.

The ‘Trigger Threshold’ setting allows you to customise the incoming audio 
level at which Myriad will start recording when using trigger levels. The 
Trigger Threshold is set as a percentage with 0% being silence and 100% 
being the maximum input level of the sound card being used. The higher the 
trigger threshold, the more likely that Myriad will ‘clip’ the beginning of your 
recording. Ideally, you need to set the level to be above any background noise 
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but as low as possible. Unfortunately, the trigger threshold will need to be set 
individually depending on your sound card and external audio equipment. The 
default setting is 10%.

SmoothEdit Options

The SmoothEdit section of the Audio Tab allows you to customise the way 
Myriad will display wave forms on the SmoothEdit Screen and indeed whether 
the wave form should be displayed automatically when you switch to Edit 
Cart.

The ‘Open the audio file for editing immediately’ customise option is used to 
set whether Myriad will automatically open and display the wave form for a 
Cart when you click on the Edit button on the Main Tab Strip.

If you un-tick this option then when you click on the Edit button, the 
SmoothEdit Screen will display the Cart details but will not show the actual 
wave form. This is useful if you need to alter the title or timing info but do not 
need to alter the actual audio. In this mode, you can still load the wave form 
by clicking on the ‘open the file for audio editing’ option on the SmoothEdit 
Screen.
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Regardless of how this customise option is set, you can access the 
SmoothEdit Screen in both modes using the right click menu on the Audio 
Wall.
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You can also use the ‘Use improved display scales’ option to customise the 
way in which the SmoothEdit Screen displays the wave form in respect to the 
scale used down the right hand side of the Wave Form Edit area to show the 
relative size of the wave form. There are basically two ways in which Myriad 
will display this information.

 Display Scale In Samples – This shows the value of each ‘peak’ in 
the wave form in terms of the actual data per sample. This is 
technically accurate but has very little ‘real world’ value. 

If the ‘Use improved display scale’ option is not ticked then the 
SmoothEdit Screen will display the scale in this way.

NB: The time scale along the bottom is also displayed in samples in 
this mode.

 Display Scale In Percentage – The scale on the right hand side of the 
Waver Form Edit Area is displayed as a percentage ranging from 0% 
(silence) to 100% (full range).
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When the ‘Use improved display scale’ option is ticked, the vertical 
scale is displayed as a percentage and the horizontal scale is 
displayed in seconds.

This option is usually preferable as it is far more understandable in ‘real 
world’ terms.

Change Password

The Change Password option on the Tools menu allows you to change the 
password for the User currently logged into Myriad.
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To change the password, you will first need to type in your current password 
and then the new password that you wish to change to. Next, confirm the new 
password by re-typing it and then click on the Ok button to complete the 
change.

Quick Record Into the First Available ‘Personal’ Cart

The Quick Record option on the Tools menu provides a fast way of starting to 
record into the first free Cart in your personal range (see Audio Tab > 
Navigation Tab > Cart Range Display). When you select this option, Myriad 
will automatically find the first empty Cart in the ‘personal’ Cart Range you 
have set and start recording into that Cart using the Record Cart Player.

If you have customised Myriad to use ‘trigger level’ recording (see Audio Tab 
> Playback / Record > When Recording New Audio) then Myriad will assign 
the Cart in the Record Cart Player and will then wait for the incoming audio 
level to raise above the ‘trigger threshold’ before starting to record.
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If you have customised Myriad to ask you each time, you will be asked 
whether you wish to use ‘trigger level’ before proceeding.

If you have customised Myriad to never use ‘trigger level’ then when you 
select the ‘Quick Record’ option on the Tools menu, Myriad will automatically 
start recording in to the next empty Cart in your ‘personal’ range.

Stop Recording

The Stop Recording option on the Tools menu is only enabled when the 
Record Cart Player is recording in Myriad. You can use this option to stop 
recording and select whether to save the recorded Cart or to discard the 
recording and start again.
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NB: This option can be used whenever the Record Cart Player is active, 
regardless of how you initiated the recording.

The On-Air Control Menu

The On-Air Control menu is only visible when you have configured Myriad to 
allow the user to switch On Air Control between on and off air using either 
Simple On Air Control or Advanced On Air Control (see Settings Menu > 
Myriad Settings > On Air Control tab).

The On-Air Control menu is used to take and release On Air Control and 
performs the same function as the On-air / Off Air buttons on the Log Screen.

Please note that if you have configured the Myriad workstation you are 
working on to either always have On-Air Control or never have On-Air Control 
then this menu option will not be visible.

Take Control

This option is only enabled when you do not have On-Air Control and 
selecting this option will take On-Air Control for the workstation you are 
working on.

Release Control
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The Release Control option is only enabled when the workstation you are 
working on has On-Air Control and it is used to release the On-Air Control.

Send Manual Information

This option is only available when you have On-Air (Station) Control and you 
have configured Myriad to communicate information to OCP. Selecting this 
option will open the Send Manual Info window which is used to manually type 
information that you want OCP to update your web site / DAB transmission 
with.

The General Tab allows you to type in information such as Title and Artists as 
well as select the Item that you want to update (current, next etc) as well as 
the type of information you are sending (as OCP can handle song and link 
information differently).

The Show / Presenter tab allows you to manually update the show reference, 
presenter name etc that OCP will be using.
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When you are happy with the information, click on the OK button and the info 
will be sent to OCP.

The Settings Menu

The Settings Menu offers access to all of the various configuration options 
and settings available in Myriad and is the principle method for viewing and 
altering the way Myriad works.

The Settings menu offers an extensive range of configuration options and 
settings so to help you navigate around them and find the options you are 
after, the settings are divided into several different menu options each 
covering a different aspect of Myriad.
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The Settings Menu Overview

Broadly speaking, the menu options offer access to the following settings in 
Myriad.

 Audio Settings – The Audio Settings option opens the Audio Settings 
window which allows you to configure Cart Player assignments, play-
back and sweeping options, recording and editing settings as well as a 
range of additional advanced audio related options. The Audio Settings 
window is divided into four tabs:

o Cart Players – The Cart Players tab allows you to configure 
how many Cart Players are visible in Myriad and which 
soundcard outputs to use for each Cart Player. You can also 
use this tab to tell Myriad which Cart Players to use for special 
items such as Instant Carts and AutoHooks etc.

o Playback Settings – The Playback Settings tab allows you to 
alter the way in which Myriad deals with sweepers and Voice 
Tracks as well as the order in which the Cart Players are used. 
You can also set whether to allow Users to customise the way in 
which Myriad ejects Carts or whether to use a global method.

o Record / Edit Settings – This tab allows you to set the audio 
quality and format that Myriad will use when recording, ripping or 
importing audio into the system. You can also optionally give the 
User the ability to alter this on a ‘per recording’ basis. You can 
also configure an external audio editor (such as Adobe 
Audition™) for Myriad to use.

o Advanced - The Advanced tab provides some miscellaneous 
advanced audio related options that should only really be altered 
at the direction of a P Squared engineer. This tab also allows 
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you to switch Myriad to ‘debug’ mode where the system writes a 
varying degree of information to a text file while it is running. 
This can be useful for P Squared engineers tracing a fault. 
Debug mode should be left ‘off’ by default as it slows Myriad 
down and creates a large amount of unnecessary data when the 
system is operating normally.

All of the settings on the Audio Settings window are ‘local box’ settings 
which only affect the local Myriad workstation that you are working on. 

 Audio Wall File Locations – The Audio Wall File Locations menu 
option allows access to the Audio Wall File Locations window which 
allows you to browse and select the data location for the audio and 
data files that comprise your Myriad Audio Wall. These are usually all 
stored in a single location but Myriad can be configured to store each 
‘chunk’ of a thousand Carts in a different location (up to 9999 beyond 
which they are all stored in a single folder). The Audio Wall File 
Locations are ‘local box’ settings and only apply to the Myriad 
workstation you are working on.

The Audio Wall File Location option also offers access to the Global 
Audio Wall Settings window which allows you to alter a range of ‘global’ 
(affects all Myriad workstations on your network Audio Wall) related 
settings. The Global Audio Wall Settings window is divided into three 
tabs:

o General – This tab allows you to set the number of Carts on 
your Audio Wall (up to 99,999) and the picture format that 
Myriad will use for pictures associated with Carts.

o Import Audio – This tab allows you to set up Myriad to acquire 
Title and Artist information from an ‘online’ database such as 
Free DB when ripping in audio from CDs. It also allows you to 
set the default Normalise level for all audio imported in to 
Myriad.

o Advanced – The Advanced tab offers some advanced Global 
Audio Wall settings that should not normally be altered unless 
directed by a P Squared support engineer.

The Audio Wall File Locations are a ‘local box’ setting so they only 
apply to the workstation you are working on. The Global Audio Wall 
Settings are ‘global’ and apply to all Myriad workstations within your 
system.

 Hardware Card Settings – The Hardware Card Settings option on the 
Settings menu allows you to access the Hardware Settings window 
which in turn allows you to configure the inputs and outputs for up to 
three hardware I/O cards or devices. You can use this window to 
assign specific events in Myriad to certain hardware triggers and also 
to label hardware outputs in Myriad that can be used to control external 
devices.
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The Hardware Settings options are ‘local box’ settings and only apply 
to the workstation you are working on.

 Station Database Settings – The Station Database Settings option 
offers access to the Station Database Settings window for the Station 
Database that is currently open in Myriad. As discussed previously, the 
Station Database is a database that contains the Schedule Log (as 
displayed on the Log Screen), as well as a range of additional 
information and settings. Normally, you would have one Station 
Database per radio station you are running so if you operate an AM 
and FM station from the same building, you would have two Station 
Databases (one each) and you would switch between them in Myriad 
to work on either the FM or AM Schedule Log. This allows a single 
Myriad workstation to be used to work with multiple radio stations at a 
single physical site.

The Station Database Settings window offers a range of settings 
relating to the Schedule Log and the way in which Myriad will operate 
in both Live and Auto/AutoFade Playout modes.

The Station Database Settings Window is divided into seven tabs:

o General – The General tab plays host to a range of 
miscellaneous settings and options. These include how Myriad 
should handle ‘sweepers’ in Live and AutoFade mode, whether 
Users can add specific Log Item Types to the Schedule Log and 
the configuration options for Voice Tracking in Myriad. You can 
also set Myriad to automatically restart Active Playout in the 
event of an unexpected shutdown.

o Q-AE – The Q-AE (o Q –Audio Engine) tab is used to alter a 
range of settings relating specifically to the way that Myriad 
operates when in one of the Active Playout modes. The settings 
on this tab allow you to alter the way Myriad ‘cross fades’ Log 
Items, the rules it follows when selecting Log Items to drop or 
fade in AutoFade mode and also how far in advance Myriad will 
cue the next Log Item it needs to play.

o Log Entries – The Log Entries tab is used to assign the colours 
for Log Items on the Log Screen. It is also used to set which 
Cart Players certain Log Item Types are allowed to be played 
out of. For example if you wanted all Songs to be played out of 
Cart Players 1 to 3 but all Adverts only out of Cart Player 4.

o Log Layout – The Log Layout tab allows you to configure the 
font, size and colour of text on the Log Screen as well as 
whether Myriad should use the timing information from Carts on 
the Audio Wall or the timing information included in the 
Schedule Log (not recommended).

o Hooks – This allows you to set the settings for the Hook Player 
that is available using the right click menu on the Log Screen as 
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well as the default settings for any AutoHook Log Items that you 
may insert.

o OCP / STS – This OCP / STS tab allows you to configure 
options relating to the way in which Myriad communicates with 
OCP or Myriad STS (for split networks) as well as the 
information that is passed to either external program.

o Import Log – This tab allows you to enter the location and 
configuration options for external schedule or adverts that need 
to be imported in to Myriad using the Log Importer application. 
You will need to configure these options if you are using Myriad 
with a 3rd party music scheduling system (like Selector™ or 
Powergold™) or a 3rd party advert schedule (such as 
Broadnet™). If you are using AutoTrack Pro or AutoTrack or the 
P Squared Advert Manager then you do not need to worry about 
these settings.

The Station Database Settings are stored in the Station Database itself 
and in general apply to all Myriad workstations which have that Station 
Database open. This means that in practice they are ‘global’ but 
because Myriad can be configured to work with more than one Station 
Database, you can make a change in the Station Database on a 
workstation that is using the ‘FM’ Station Database and the change will 
not affect any workstations working with the ‘AM’ Station Database.

 P Squared Directory Settings – The Directory Settings menu option 
offers access to the P Squared Directory Settings window which is 
used to set the location of the P Squared Directory that Myriad will use 
and also to alter some of the settings within that directory. The fact that 
the same window is used to set the location of the P Squared Directory 
as well as settings within the Directory means that there is a mixture of 
‘local box’ and ‘global’ settings on this window. The location (path) of 
the Directory and the Automatically Create User options are local but 
all other settings are global.

The P Squared Directory Settings window is divided into three tabs:

o General – The General tab allows you to set the location of the 
P Squared Directory using the Path setting. You can also set 
whether Myriad should automatically create a P Squared 
Directory User based on the Windows Login name. The final 
section on this tab allows you to add additional ‘stand alone’ 
Directory Manager licenses to your system to give access to the 
P Squared Directory on PCs that do not have Myriad installed. 
These stand alone licenses are available for a small cost directly 
from P Squared Ltd (email sales@psquared.net for more 
information).

o Security Groups – The Security Groups tab allows you to add, 
view and manage security groups within the P Squared 



748

Directory. Security Groups provide a quick and simple way of 
specifying access rights for multiple Users on the system.

o Backup – The Backup tab allows you to setup and manage the 
automatic backup of the P Squared Directory.

 Myriad Settings – Another very important section of the Settings 
menu, the Myriad Setting option is used to access the Myriad Settings 
window which hosts a vast array of settings and configuration options 
relating to the general behaviour and operation of Myriad. The majority 
of the settings on the Myriad Settings window are ‘local box’ settings 
with the exception of some of the options on the View Menu, Advanced
and Other Settings tabs.

The Myriad Settings window is divided into eight tabs, each of which 
refers to a different area in Myriad. These tabs are:

o Data Location – The Data Location tab allows you to browse 
and select the base level file location for the data files and 
databases that Myriad uses to store its data. All Myriad 
workstations should be ‘pointed’ at the same Data Location 
which would normally be located on a server or a RAID disk 
array on one of the local boxes.

o General Options – The General Options tab contains a number 
of miscellaneous settings and options pertaining to a wide 
variety of areas in Myriad. 

o Audio Wall – The Audio Wall tab allows you to set Audio Wall 
related options in Myriad (not covered in the Audio Wall Global 
Options). Of particular interest are the ‘Recent Play’ settings 
which can be set up to make Myriad mark Carts played in the 
last X hours as having been played recently on the Audio Wall. 
These Carts have a special ‘Recently Played’ icon on them.

o Station Database – The Station Database allows you to set 
whether Myriad will automatically open a specific Station 
Database when it starts up, ask the User to select a database or 
not open a Station Database at all. You can also set whether 
you want Users to be able to edit the ‘currently on air hour’ on 
workstations other than the one that is ‘on air’ using an option on 
this tab.

o View Menu Tab – The View Menu tab allows you to customise 
the options on the main View Menu (as seen earlier in this 
Chapter). Basically, you can use this tab to add new local or 
web based links to the View Menu and also to decide whether 
the list should apply just to the workstation you are working on 
or to all Myriad workstations on your system.

o On Air Control – The On Air Control tab allows you to select 
the On Air control method that you wish to use (simple or 
advanced) and also to set up the way the on air control will 
work.
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o Other Settings – The Other Settings tab covers two main 
areas. Firstly it allows you to maintain a global list of all the 
Myriad workstations on your network and to assign a Computer 
Name to the workstation you are working on. The second area 
covered on this tab is the Command interface which allows you 
to add and manage the Commands that you want to be 
available to users via the Log Screen.

o Advanced – The Advanced tab offers some more advanced 
configuration options that would not be altered by Users in 
normal operations. These include managing Configuration 
Profiles (for multi-configuration setups), altering system priority 
for Myriad, setting debug information. You can also configure 
Myriad to automatically log in to Windows when the PC starts up
and get time sync information from a PC time source.

 License Details – The License Details option on the Settings menu 
offers access to the License wizard, which is used to review and 
renew the License Code for the Myriad workstation you are working 
on.

Audio Settings

The Audio Setting option on the Settings menu provides access to the Audio 
Settings window which in turn allows you review and edit a range of Myriad 
settings, all of which relate to audio playback, audio recording or the Cart 
Players in Myriad.
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The Audio Settings window is divided into four tabs which are:

 Cart Players – For editing the number of Cart Players Myriad 
shows and which sound card outputs Myriad should use for each 
Cart Player.

 Playback Settings – For adjusting the way Myriad deals with 
‘sweepers’ and Voice Tracks and well as the order Myriad should 
use Cart Players in and whether to allow Users to customise the 
way Cart Players eject Carts.

 Record / Edit Settings – For setting the audio quality and format 
that Myriad uses when it records, rips or imports audio into the 
Audio Wall. Also allows you to configure an external audio editor 
(such as Adobe Audition™) to use in addition to the SmoothEdit 
Screen.

 Advanced – For a range of more technical and advanced audio 
related settings that should normally only be adjusted at the advice 
of a P Squared engineer.

We will now look at the options on each of these tabs in more detail.

The Cart Players Tab

The primary role of the Cart Players tab is to allow you to set how many Cart 
Players will be used on the Myriad workstation you are working on, which 
sound card outputs each Cart Player should use and also which Cart Plays 
Myriad should use for certain special events such as Editing Carts, playing 
Hooks etc.
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You can also configure Myriad to display the Cart Players along the top of the 
screen if you wish.

Number of Cart Players to Use

The ‘Number Of Cart Players’ option allows you to set the number of Cart 
Players that will appear on screen and therefore the amount of Cart Players 
that are available in Myriad.

When you run Myriad for the first time, Myriad will automatically scan your PC 
for soundcards and set the amount of Cart Players based on the amount of 
audio playback channels it finds. If your PC is fitted with one of the standard 
soundcards that P Squared uses (Midiman Delta 10/10 or Echo Layla 3g) 
then Myriad will automatically pick the correct amount of Cart Players and 
assign the Cart Players to the correct audio channels (in theory – but it can be 
confused by other audio devices such as fax / modems or Bluetooth 
adaptors).

To alter the amount of Cart Players Myriad will use, click on the Change 
button.
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You can then type in the number of Cart Players that you wish to use.

You can enter a number between 1 and 12, however keep in mind that you 
should have an individual soundcard playback channel available for each Cart 
Player you enable, and also that Myriad will need to fit them all on screen. If 
you select more Cart Players than can be fitted on screen, Myriad will do its 
best to fit them in but you may find that they are not practically useful.

Once you have typed in the appropriate number of Cart Players for use, click 
on the Set button.

NB: Please note that changing the amount of Cart Players on an ‘on air’ PC is 
not recommended and the changes will not come into effect until you next 
restart Myriad.

Manual / Automatic Allocation of Sound Devices to Players

The ‘’Allocation Of Sound Devices To Players’ drop down list allows you to 
switch between Myriad automatically assigning a soundcard output to each 
Cart Player and you manually assigning a sound device to each Cart Player.
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To set this option, use the drop down list to select Manual or Automatic 
assignment.

When the setting is set to Automatic, the Cart Players are automatically 
assigned to sound card outputs and the sound card assignment section is 
’greyed’ which prevents you from altering these settings.

Once you switch to Manual, the Player Soundcard Assignments section 
becomes white and you can edit the sound card assignments for each Cart 
Player using the drop down lists (see next section).
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Allocating Sound Devices to Cart Players

When Myriad is running on a workstation that is intended for use ‘on air’ then 
each Cart Player must be assigned to a separate sound device playback 
channel to allow Myriad to individually fade and control each Cart Player, and 
to allow you to physically wire each Cart Player to a separate channel on your 
mixing desk. The screen shot below shows a typical setup using a multi-
channel sound card (in this case an Echo Layla 3G).
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Note that each of the ‘Player’ rows is assigned to a different output on the 
multi channel sound card.

To alter the sound device that a Cart Player uses, click on the sound device 
column and select the sound device you want to assign to the Play row you 
are working on.
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In the example above, we are changing the sound device assigned to Cart 
Player 1.

Please note that the Cart Players, the Edit Soundcard and the Record 
Soundcard can be assigned to sound devices, whereas the Hook Player, 
Instant Cart Player and Preview Player can only be assigned to Cart Players 
(which of course are assigned to sound devices). The list below should help 
identify what each option is for.

 Player 1 – X – Each ‘Player’ row represents a Cart Player so if you 
have Myriad configured to use six Cart Players, you will see ‘Players 1 
to 6’ in the list.

 Edit Sound Card – The sound device playback channel used by the 
SmoothEdit Screen when editing the audio. This is often set to the 
same channel as Cart Player 4 but if you have a sound device free 
then having an ‘edit’ fader on your desk may be useful.

 Record Soundcard – This is the audio input channel that Myriad will 
use for recording audio in Myriad. This is used by both the Record Cart 
Player and the SmoothEdit Screen. Many multi-channel soundcards 
actually have multiple inputs as well as outputs but Myriad will only use 
one audio input.

 Hook Player – Use this option to select the Cart Player that Myriad will 
use when you manually load the Hook Player or an AutoHook Log Item 
is encountered in the Schedule Log. It is a good idea to either set this 
to ‘Any Player’ or if you always want to use a specific Cart Player, 
select a high number Cart Player as if you set this to a specific Cart 



757

Player and that Cart Player is not available when Myriad comes to use 
the Hook Player then Myriad will not be able to play the hooks.

 Instant Cart Player - This allows you to set a default Cart Player that 
will be used in preference whenever an Instant Cart is triggered in 
Myriad. Unlike Hooks however, Instant Carts will play through other 
Cart Players if the default Instant Cart Player is not available.

 Preview Player – The Preview Player option is used to select the Cart
Player that is used when you preview a Log Item on the Log Screen. 
As with the Hook Player, it is a good idea to leave it set to Any Player 
or a higher number Cart Player as Myriad if you specify a Cart Player 
and the Cart Player is in use, Myriad will not be able to Preview items 
from the Log.

Please note that sound device assignment changes and changes to the 
amount of Cart Players on screen do not take effect until you have restarted 
Myriad.

Player Display Alignment

The Player Display Alignment option is used to set whether the Cart Players 
in Myriad are displayed along the bottom of the screen (default) or along the 
top of the screen.
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Playback Settings Tab

The Playback Settings tab is used to review and alter a range of playback 
related settings in Myriad. 

The tab is divided in to three general areas:
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 Playback Volume – Allows you to alter the way in which Myriad deals 
with special event Carts such as ‘sweepers’ and Voice Tracks. Also 
allows you to alter the segue (cross fade) point which has a direct 
effect on how ‘tight’ Myriad will sound in automated segues.

 Cart Player Usage Order – By default, when Myriad needs to use a 
Cart Player for automated playback (on either the Log Screen or the 
Pad), it will try to find the lowest Cart Player Number available. This 
means that the first Cart would be played in Cart Player 1 and then the 
next Cart would be played in Cart Player 2. By the time this Cart has 
finished, Cart Player 1 should be empty again so Myriad will use that 
next. The system will only use the higher numbered Cart Players if the 
lower number Cart Players are in use. The Cart Player Usage section 
allows you to set Myriad to do this in reverse order (start with the 
highest number Cart Player and work backwards) and also to restrict 
the system so it does not use all of the available Cart Players.

 Option Options – The Other Options section allows you to configure 
Myriad to use or over rule Cart ejection Customise options.

We will now look at the options on the Playback Settings tab in more detail.

Play Normal Carts at XX% of Maximum Volume

This setting allows you to set the audio playback volume for normal Carts 
played by Myriad as a percentage of the maximum volume of the sound card.

In this instance ‘normal Carts’ refers to any Cart played by Myriad that is not 
to be played as a ‘sweeper’ or a Voice Track, and also Adverts in some 
configurations.

The reason for the distinction is that sweepers and Voice Tracks are intended 
to be played ‘over the top’ of other Carts and so ideally should be louder than
the Carts they are playing alongside. Myriad Can be configured to do this is 
two different ways.

1. All normal Carts are played out at a standard volume (say 100% for 
example) and then every time a sweeper of Voice Track is played, the 
sweeper or Voice Track plays at the standard volume but all other 
Carts are faded down to a lower audio volume to allow the sweeper or 
Voice Track to be heard.

2. All normal Carts are played at a lower audio volume and Myriad plays 
sweepers and Voice Tracks at a higher audio volume. (Usually this 
would have to be combined with an external audio processor in order 
to create the right sound.)

Of the two methods, the first is the most desirable as it does not rely on 
external equipment, and is also much closer to the way a presenter may work 
in a live show. Obviously, whichever method you wish to use, the Play Normal 
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Carts at XX% Of Maximum option is important as it allows you to set the base 
level audio volume for playing normal Carts in Myriad.

When Playing a Sweeper Duck to XX% / Play at XX%

In the last section (Play Normal Carts at XX %) we looked at the two different 
ways that Myriad can be set to play sweepers and Voice Tracks. We also set 
the playback volume for ‘normal’ Carts.

The ‘When Playing a Sweeper’ option allows you to select the method that 
you want Myriad to use, as well as set the audio volume percentage for each 
method. The options are:

 Duck the Other Cart to XX% Of Maximum Volume – If you select 
this option then Myriad will fade or ‘duck’ all other Carts to the 
prescribed audio volume percentage whenever a sweeper or Voice 
Track is playing. The sweeper or Voice Track will be played out at the 
‘normal’ Cart volume.

 Play Sweeper At XX% Maximum Volume – If you select this option 
then sweepers and Voice Tracks will be played at this audio volume 
and all other Carts will be played at the ‘normal Cart’ volume with no 
ducking or volume changes of any kind. This method should usually be 
combined with external audio processing in order to ‘lift’ the audio 
volume of ‘normal’ Carts to an acceptable level. The screen shot below 
shows a typical setup for using Myriad in this way.
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So with these settings, all ‘normal’ Carts in Myriad will play out at 80% 
of full volume on the sound card but sweeper and Voice Tracks (and 
optionally adverts) will play out at 100% volume on the sound card.

When Segueing Carts, Fire the Next When the Current Has Faded 
To XX%

This setting actually affects the entire way that Myriad will sound in manually 
triggered segues in any of the Active Playout Modes, as well as when you 
‘soft’ Eject a Cart that is part of an active Pad run. When you trigger a Go 
event in an Active (or soft Eject a Cart in a Pad run), Myriad will start to fade 
down the currently playing Cart but will not start the new Cart straight away, 
this is intended to give a smooth sounding transition between the two Carts.

The diagram below should help to illustrate:



762

In this example, when the Go button is pressed in Live Playout Mode, Myriad 
will start to fade out the Cart that is currently playing. When the volume of the 
Cart being faded drops to 65%, the next Cart is automatically started.

This means that by setting this value higher, the transition between the two 
Carts will be faster with the next Cart cutting in while the current Cart is still 
playing at a high volume, this may be more suitable for ‘hot’ sounding 
stations. Set this setting lower and the transition will be slower giving a more 
relaxed transition, more suited to a ‘gold’ style station.

Please note that Myriad can be configured in such a way that when you 
trigger a Go event, the next Cart starts straight away and the current Cart is 
not faded at all, if you configure Myriad in this way, then the ‘When Segueing 
Carts’ setting will not be used.

Play Carts Starting With Cart Player X

The Cart Player Usage section of the Playback Settings tab allows you to 
configure the default way in which Myriad will load Carts in to the Cart Players 
when in Active Playout Mode or when you cue a Cart without specifying which 
Cart Player to use.
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The default setup is for Myriad to always start with Cart Player 1 and work its
way up to the ‘Last Cart Player’. In practice, this means that if you have 
configured Myriad to have four Cart Players, the first Cart would be played 
using Cart Player 1, the next Cart would have to be cued in Cart Player 2 prior 
to starting (as Cart Player 1 is still in use playing the first Cart). Once the 
second Cart Player is playing, Cart Player 1 would finish what it is doing and 
become empty again. At this point, Myriad would be free to cue the next Cart 
back in Cart Player 1. Myriad will continue in this way ‘flip flopping’ between 
Cart Players 1 & 2. If at any point, Myriad needed to cue a Cart and both Cart 
Players 1 and 2 were in use then it would cue the next Cart into Cart Player 3. 
In extreme conditions, if Myriad was using three Cart Players and needed to 
cue another Cart, it would make use of Cart Player 4 and so on and so forth. 

So basically, Myriad will always try to use the lowest number available Cart 
Player and the higher number Cart Players will only be needed under heavy 
load conditions, leaving them free for you to use manually.

The Cart Player Usage settings allow you to change this default behaviour to 
restrict the Cart Players that Myriad can use or alter the order in which it uses 
the Cart Players.
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The ‘Play Carts Starting With’ drop down list allows you to select the Cart that 
Myriad will attempt to use first when cueing audio. If you set this to Cart 
Player 2 then Myriad would always start from Cart Player 2 and work its way 
up leaving Cart Player 1 free at all times. If you selected ‘the last Cart Player’ 
option then Myriad will start with the highest number Cart Player first.

And Finish With Cart Player X

You can use the ‘and finish with Cart Player X’ drop down list allows you to 
select the last Cart Player that Myriad will use for automatically cueing Carts.
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In the above configuration, Myriad will first try to cue Carts in the highest 
number Cart Player (Cart Player 4 for example), then the next highest and so 
on until it has to use Cart Player 1. With this configuration, under normal 
circumstances, Myriad would alternate between Cart Players 4 and 3 
(assuming Cart Player 4 is highest) and only use the lower number Cart 
Players when Cart Players 4 and 3 are already in use.

You can also use this option to restrict the Cart Players that Myriad will use to 
automatically cue Cart up in.

In the configuration below, Myriad will automatically cue Carts in Cart Players 
1 to 3 but will not automatically cue Carts in Cart Player 4 leaving it free for 
manual use.
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NB: Please note that changes made to the Cart Player Usage section will only 
take effect the next time that you restart Myriad.

When Should Carts Be Allowed To Be Ejected

This option allows you to set the conditions under which a User can eject a 
Cart from a Cart Player. To set this option, use the drop down list to select the 
option that you wish to use.
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The options are:

 Allow Cart To Be Ejected At Any Time – When this option is set, the 
User can Eject the Cart at any time, even when it is playing.

 Only Allow When Paused Or Cued – When this option is set, the 
User can only Eject the Cart while the Cart Player is in cue or pause 
mode. This means that you cannot Eject a Cart that is playing without 
stopping it first.

 Use The Users Directory Preferences – If this option is selected then 
Myriad will use the individual Users preference for Ejecting which is set 
on a per User basis using the Customise options on the Tools menu 
(see Tools Menu > Customise > Audio Tab  > Playback & Recording).

Changes to this setting will only take effect once you have restarted Myriad.

The Record / Edit Settings Tab

The Record / Edit Settings tab allows you to set a range of options that refer 
to the method and format that Myriad uses when recording or importing audio 
into the system. It also allows you to configure an external audio editing 
software program to use for more advanced audio editing techniques that may 
not be available in the SmoothEdit Screen.
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Record Audio Settings > New Audio Will Be Recorded Using the
Audio Format

This setting allows you to select the audio quality level and compression 
format for all audio recorded, ripped or imported into Myriad. This setting is 
very important as it is used to set the quality and format for several areas in 
Myriad. These include:

 Recording audio via the Record Cart Player.
 Ripping CD tracks using the Import Audio wizard.
 Importing audio files using the Import Audio wizard.
 Recording audio using the SmoothEdit Screen.

But it does not set the quality the Voice Tracks will be recorded in at when 
using the Segue Editor (in Full Segue Editor mode). This is set as part of the 
Station Database settings (see Settings Menu > Station Database Settings > 
General tab).
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To select the audio quality and format to use, click on the Choose button to 
open the Choose Audio Format window.

You can use this window to set the audio format, quality and other associated 
audio quality settings.

 Audio Format – This allows you to set the basic audio format type that 
you wish to use. In Myriad v3.0.x, the only option on this drop down list 
is Windows Wave (WAV) format as that is the only format that Myriad 
supports. Myriad v3.1 or higher supports other audio formats including 
MP2, MP3, WMA, Ogg Vorbis, AAC and AC3 (see future versions 
below).

 Format – When working with WAV format options, the Format drop 
down list is used to select whether you wish to use PCM (linear / non 
compressed) format or IMA ADPCM (4:1 compressed) format.
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The advantage of PCM is that it offers the highest quality audio but 
also takes the most hard disk space per minute recorded on to the 
system. IMA ADPCM offers 4:1 compression which means that four 
times as much data can be stored in the same space as PCM. The 
down side is that compressed audio is not as high a quality as linear 
audio (although IMA ADPCM is a very light compression scheme).

 Sample Rate – The Sample Rate drop down list allows you to select 
the sample rate that you wish to use for recording / importing audio in 
to Myriad.

The drop down list shows all of the Sample Rates that Myriad supports 
but it is highly recommended that you stick with 44,100Hz as this will 
offer the best audio quality.
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NB: 48,000Hz and 96,000Hz may not function on all configurations.

 Stereo / Mono – This allows you to select whether Myriad should 
record audio in stereo or mono.

Future Releases: Myriad v3.0.X only supports WAV format audio files but 
future releases will support a range of other compression formats including 
MP2, MP3, WMA and Ogg Vorbis as well as PCM Wav and ADPCM Wav 
formats. Once these additional formats are supported, the settings on the 
Choose Audio Format window will change to accommodate the options for the 
selected format. The screen shots below show the configuration options for 
MP3 and Windows Media formats. Remember, these options are not available 
in versions earlier than Myriad v3.1 which is due for release in late summer in 
2006.

Also Allow Users to Choose a Different Format to Record Audio 
With

This tick box option enables a new option on the Audio Wall right click menu 

With this option ticked the right click menu on the Audio Wall changes to give 
users the option to either record using the default audio format or to select an 
alternative audio format for the recording.
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If a User opts to use a different format, the Choose Audio Format window 
appears prior to Myriad starting recording.
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Record Files to the Local Disk Then Transfer Them to the Network

By default, when Myriad records audio onto the Audio Wall, the audio is 
written directly to the folder that the Audio Wall files are stored in regardless of 
whether it is a local disk drive or a network drive. This has the advantage that 
once you have finished recording, there is virtually no ‘save time’ as the audio 
is saved to the disk (as it is saved in real time) and the audio is available to all 
Myriad workstations almost immediately.

The only time that this configuration can be problematic is if you are saving to 
a network location and you have a very slow network or your network is very 
busy. Under these circumstances, you may find that the recordings contain 
small gaps or jumps which is when Myriad was not able to write to the 
network location because the network was busy or too slow to keep up with 
the data being written. 

In order to avoid this situation, you can use the ‘Record Files to the Local 
Disk’ option to configure Myriad to record audio to a temporary file on the local 
hard disk drive and then transfer the file to the network location once the 
recording is complete. This has the advantage that a busy or slow network will 
not cause problems when recording but there will be an increased ‘save time’ 
as the file is transferred to the network after recording has finished. On longer 
files, this may also have a negative effect on playback in Myriad so it is 
recommended not to use this option unless you have to.

As Well As SmoothEdit™, Also Allow an External Audio Editor to
Be Used

Myriad v3 introduces the SmoothEdit Screen for editing Cart details and also 
performing simple audio editing functions using the Wave Form Edit Area. 
The audio editing functions in SmoothEdit are designed cover a range of 
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common tasks used in everyday studios but if you want to do production work 
then you may find the audio editing capabilities in SmoothEdit to be a little 
limiting. In this situation, you can configure Myriad to offer access to an 
external audio editor such as Adobe Audio Audition™. 

If you configure Myriad in this way then the SmoothEdit Screen acquires an 
External Editor Button on the main Edit Cart Tool Bar.

When you click on this button, Myriad automatically starts your selected audio 
editor program, loading the audio file you are working on. Myriad then 
minimises until you have finished working on the audio, saved the file and 
exited the external audio editor.

To set up this option, tick the ‘As Well As SmoothEdit™, Also Allow An 
External Audio Editor To Be Used’ option and then type in the location of the 
program (exe) file for the audio editor that you wish to use.

You can also use the Choose button to browse your computer for the audio 
editor program that you wish to use.
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TIP: Whilst programs can be installed anywhere, the most common location 
for applications to install is the c:\Program Files\[Application Name] folder. 
You can see this in the example above where we have configured Myriad to 
use Cool Edit 2000 which is located in the c:\Program Files\Cool2000 folder 
and the actual program is called Cool2000.exe. If you are unsure as to the 
location of your external audio editor or the name of the application program, 
please refer to the audio editor documentation for further details.

Priority: P Squared Product / Editor Runs Faster

The Priority setting is used to prioritise computer processing power for either 
running Myriad or for running the external audio editor (see above). The 
reason for doing this is that editing audio can be a fairly intensive process and 
if you are working on a Myriad workstation that is also playing out at the same 
time, intense audio editing could affect playback in Myriad. 

The Priority setting allows you to divert computer power more towards Myriad 
or your external audio editor which should allow you to balance between the 
two applications to allow Myriad to play out reliably even when editing

The default for this setting is for the audio editor to run as fast a possible with 
Myriad running at a lower priority in the background. For the vast majority of 
workstation configurations, this setting will work just fine but if you are having 
problems then move slider more towards the Myriad side to alter the priority 
between the two applications.
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The Advanced Tab

The Advanced tab offers access to some of the more advanced configuration 
options in Myriad, relating to audio, audio playback and editing. In general, 
there is no need to alter any of these settings unless you are trying to fix a 
particular problem or you are advised to do so by a member of the P Squared 
technical support team.

This tab also offers access to the Advanced SmoothStream settings which 
allow you to alter the settings for Myriads’ proprietary audio engine 
SmoothStream.

The SmoothStream settings are for advanced users only and you should not 
‘tinker’ with them unless advised to do so by a member of the P Squared 
technical support team.

The final option on the Advanced tab is the Debugging Mode options which 
allows you to set Myriad to generate various levels of debugging log files to 
help track down problems in the audio engine or with playback in Myriad. 
When in debug mode, Myriad generates large quantities of data as special 
files that can be sent to P Squared to help solve problems. Generating these 
files will cause Myriad to run more slowly than usual and also fill up the local 
hard drive so it is not a good idea to run in debug mode for long and you 
should only ever do so at the request of a P Squared technical support 
engineer. The options on the Advanced Tab are outlined below:



777

Audio Files > Use ‘Legacy’ Mode to Copy / Move Carts 

If this option is ticked, Myriad will use an older, slower method for moving and 
copying Carts on the Audio Wall. The reason for this option is that over time, 
the Myriad move / copy functions have been optimised to take advantage of 
modern hardware and operating systems (OS). Unfortunately, this means that 
some hardware configurations may exhibit problems when moving and 
copying Carts on the Audio Wall. If you are experiencing problems when 
moving or copying Carts, select this option and see whether matters improve.

When this option is ticked, Myriad will use a more generic method for moving 
and copying Carts which will be more reliable on older configurations but will 
also be a bit slower.

SmoothStream > Increase the Size of the Buffers That 
SmoothStream Uses

SmoothStream is the audio engine that Myriad uses for all audio playback and 
recording. Developed exclusively by P Squared, SmoothStream sits at the 
heart of all P Squared products, delivering fast, reliable playback and 
recording that allows Myriad to interact and control directly with your PCs 
soundcards.

Some configurations of hardware (particularly Windows 2000 installs) can 
have problems with playback when there is a lot of graphical manipulation 
happening on screen. This most commonly occurs when you minimise or 
maximise a window and the audio stops for a fraction of a second.

In order to overcome this, you can tick the ‘Increase The Size Of Buffers’ 
setting to set Myriad to use slightly larger audio buffers for playback which 
allow the computer to be ‘busy’ doing other things for slightly longer before 
playback is affected. The only down side to this is that you may find that 
cueing Carts takes fractionally longer (and we mean a very small fraction of a 
second) and also that the ‘VU’ bars on the Cart Players are a little less 
accurate.

If you experience ‘choppy’ playback in general, it is worth switching this option 
on to determine whether it is a resource issue or if the problem originates 
elsewhere.

External Editor > Run the External Editor Process at Idle Priority

This option is very similar to the Priority option we looked at on the Record / 
Edit Settings tab a little while ago. Ticking this option will cause the external 
audio editor that you have configured Myriad to use to be launched at a very 
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low priority which will mean that it will run slower leaving more computer 
processing power for Myriad.

Advanced SmoothStream Settings

Clicking on the Advanced SmoothStream Settings button gives you access to 
the Advanced SmoothStream settings window which contains a number of 
advanced settings regarding the SmoothStream audio engine.

The options on this window are covered in the Advanced SmoothStream 
Settings section of the documentation below.

Audio Debugging Mode

The Audio Debugging Mode option on the Advanced tab allows you to switch 
Myriad between several different debugging modes to help P Squared 
technical support engineers to track down problems you may be having with 
playback and recording on the system.

When in debug mode, Myriad automatically generates a text based file for 
each Cart Player which is stored in the root of your workstation C drive. These 
files are called:

C:\Smplyer1.dbg – Debug file for Cart Player 1
C:\Smplyer2.dbg – Debug file for Cart Player 2
C:\Smplyer3.dbg – Debug file for Cart Player 3
C:\Smplyer4.dbg – Debug file for Cart Player 4
…etc

The type and amount of data written to these log files depends on the level of 
debugging that you select from the drop down list.
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The options are:

 Play Normally – The default mode for Myriad with no debug files being 
created.

 Use Basic Debugging – The recommended level of debugging for 
tracking down occasional problems as only top level functions are 
added to the debug log files.

 Use Medium Debugging – More intensive than basic, medium 
debugging provides more details in the debug files but can slow the 
workstation down and fill up your hard drive.

 Use Full Debugging – When using this option, Myriad will write a 
great deal of detail to the debug log file and is likely to run very slowly 
and fill up your hard drive very quickly. As an example, in full debug 
mode, simply cueing and playing around 30 seconds of a Cart will 
generate more than 7000 lines of debug code!

It is recommended that you only use debug modes when requested to do so
by a P Squared technical support engineer and they will advise you as to the 
level of debugging you should use.

Due to the nature of the debug file, left unchecked they could get very large,
very quickly so Myriad includes an inbuilt management system that monitors 
them and if they get too big, deletes them and starts again. Myriad also 
deletes them and starts again each time you re-start the system so if you are 
running debug mode to track down a particular problem, it is recommended 
that as soon as the problem occurs, stop Myriad and copy the appropriate 
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debug file to a save location prior to re-starting Myriad. That way you can go 
back to using Myriad and send the debug file to P Squared technical support 
at your leisure.

SmoothStream Advanced Settings Window

The SmoothStream Advanced Settings window is accessed via the Advanced 
SmoothStream Settings button on the Advanced tab of the Audio Settings 
window.

When you click on this button, it first warns you that you are about to access 
the Advanced SmoothStream settings window and that you should only do so 
if you have been advised to by a P Squared support engineer.
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It also advises that you should make a backup of your system before altering 
these settings. This is done by copying the System folder in your Myriad Data 
Locations (see Myriad Settings > Data Location tab).

If you wish to proceed, click on the Ok button.

SmoothStream Information

The top section of the window shows you some technical details about the 
SmoothStream system running as part of your Myriad installation. The 
SmoothStream version and Smoothey version numbers will be particularly 
important to P Squared technical support engineers when diagnosing 
potential faults with the SmoothStream audio engine.

Fade Mode

The Fade Mode option on the SmoothStream Settings window allows you to 
alter the way in which the audio engine performs audio fades by changing the 
way the fade information is passed to the sound card that is being used to 
play the audio.
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Under normal conditions Myriad fades Carts out in a linear fashion so that it 
starts at 100% of full volume, then fades it down steadily to 0% volume. This 
assumes that the sound card performs in the same way but some sound 
cards do what is called logarithmic fading which is where the rate at which the 
audio fades out is not constant across the entire duration of the fade. If this is 
the case then Myriad tells the card to fade to 90% of volume but because the 
drop in volume between 100% an 90% is much greater then the drop in 
volume from 90% to 80% the overall affect is that you get a very fast and 
rough sounding fade out. This is not good for automation because it relies on 
smooth fading to sound ‘live’.

To help to combat this, SmoothStream can be tweaked so that it actually uses 
a logarithmic method of fading so that the actual drop of volume over the first 
10 % (100% - 90%) is the smallest drop of all with the drop steadily increasing 
over the duration of the fade out or vice versa. 

The graph above shows a rough approximation of what happens when the 
‘Start fading quickly and then slow down’ option for Fade Mode option is 
switched on. The sound card fades out the volume slowly at first then more 
quickly as time goes by. Conversely, SmoothStream fades out rapidly at first 
and decreases the rate of fading as time goes by. The net result is a basically 
linear fade which is what we wanted in the first place.

The opposite happens if you select ‘Start fading slowly and then speed up’ for 
use with soundcards that use logarithmic fading in the opposite way.

Use the drop down list to select the option and test it before putting it ‘on air’ 
as it is essentially a work around for a short coming of some sound card 
drivers and assumes that the sound cards are doing a perfect logarithmic fade 
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which may not be the case. Many people have found that this tweak does get 
around ‘dodgy’ sounding fades on their system.

Of course, if your sound card works the way it is supposed to then it will have 
a linear fade and when Myriad says fade to 50%, it will reduce the audio 
volume to 50% of maximum volume in which case ‘Normal fading’ should be 
selected from the drop down list.

Flush the Audio Engine with Silence Prior To Each Cue

This option has been added to specifically cure a bug in the actual multi-
media sub system of Windows 2000™ when a soundcard is using WDM 
(Windows Drive Model) drivers. The WDM initiative is supposed to allow 
manufacturers to make a single driver for a device that works across all the 
different operating systems. Our internal testing has highlighted a few of 
problems common to all WDM drivers which would suggest the problem lies in 
the WDM system itself. 

One of the most common problems occurs under Windows 2000 using WDM 
drivers. If you recue a Cart when it is halfway through playing and the press 
Play again, a fraction of a second of the middle of the song plays before the 
start of the song. This is very annoying in a broadcast environment so we set 
about working around the problem. The solution is to flush the buffers in the 
Audio Engine each time an item is re-cued. This has practically no effect on 
Myriad but does appear to fix the problem in all the cases that we have tested. 

The problem does not exist on most Windows XP (SP2) installations but if you 
experience problems similar to those described above then try setting this 
option.

If you tick this option, you can also set the size of the audio used to flush the 
Audio Engine. It is highly recommended that you leave this setting at 1 
millisecond unless advised otherwise by a P Squared engineer.

If you make any changes to the Advanced SmoothStream Settings window, 
click on the Save Settings button to save the changes you have made. You 
may have to restart Myriad in order for the changes to take effect.

Audio File Locations

The Audio File Locations option on the Settings menu offers access to the 
Audio File Locations window which is used to set the folder locations of the 
audio and data files that are used to make up the Myriad Audio Wall. 

The Audio File Location can be set for all Carts on the Audio Wall or 
individually per ‘chunk’ of a thousand Carts on the Audio Wall (up to 10,000).
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The Audio Wall Locations window also offers access to the Global Audio Wall 
Settings window which (as the name suggests) allows you to set a number of 
global Audio Wall related options that affect your entire system.

The Audio Wall Locations are set on a ‘per box’ basis so if you want all of the 
Myriad workstations in your station to use the same Audio Wall, set the file 
locations to be the same on each box. The Audio Wall File Locations would 
normally be set to either a shared drive on a server or a local hard disk. 
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NB: It is highly recommended that you store your audio files on a hard 
disk array that is protected by either hardware mirror or RAID 5. You 
should also make sure you implement a regular backup routine to 
ensure against valuable data loss.

Carts 1 to 1000

The Carts 1 to 1000 section allows you to type in the location of the folder 
where you want to store Carts 1 to 1000 from your Audio Wall. This location 
could be a local hard disk and folder or a network path or UNC.

You can also use the browse button to open the folder browser window to 
allow you to select the folder that you wish to use.

This will open a standard Windows file browser window which allows you to 
view and navigate the local and network file locations available to your 
system.



786

Select the folder that you want to use and click on the OK button.

TIP: You can use the right click menu on this window to copy, rename, delete 
or create a folder.

Carts 1001 to 10000+

You can also set alternative folder locations for each ‘chunk’ of 1000 Carts on 
the Audio Wall up to Cart 10000 after which only a single file locations can be 
set. To enable this option, un-tick the ‘Store All Carts in the Same Location’ 
option and then you can set a different folder location for each ‘chunk’ of the 
Audio Wall.
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If you have configured Myriad to have more than 10000 Carts then the ‘Carts 
10001 to….’ option becomes enabled which allows you to set the location for 
all Carts over 10000. As before, you can use the browse buttons to access 
the Browse Folder window to select the location that you wish to use.

Global Audio Wall Settings

The Global Audio Wall Settings button opens the Global Audio Wall Settings 
window which is used to set a number of Audio Wall related options that are 
used by all Myriad workstations configured to use the same Audio Wall 
locations for Carts 1 to 1000.
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The Global Audio Wall Settings window is divided in to three main tabs that 
explained in more detail below.

General Tab > Audio Wall Size

This option allows you to set the number of Cart Slots that will be available on 
your Myriad Audio Wall. This can be set to any number from 1 to 99999 but 
the default value is 9999 which effectively gives you 10000 Carts.
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To change the number of Cart Slots on your Audio Wall, click on the Change 
button and type in the new number of Cart Slots that you want to use.

Once you are happy with the number, click on the Set button to save the 
changes. Once you have finished in the Global Audio Wall Settings window, 
click on the OK button and Myriad will warn you that the changes you have 
made will affect all users.

Click on Yes if you wish to continue.

NB: Whilst Myriad restricts you to 99,999 Carts, practical restrictions such as 
hard disk space and the time taken to find Carts on the Audio Wall mean that 
it is usually better to set this number only as high as you think you need it to 
be. You can always expand the Audio Wall in the future if you need to.

General Tab > Audio Wall Picture Filename Extensions
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The Audio Wall Picture Filename Extensions option allows you to set the 
picture file format that Myriad will use for importing and storing pictures 
associated with Carts on the Audio Wall. 

To select the format that you wish to use, click on the drop down list and
highlight your preferred format.

The options are: 

 JPG – Jpeg compressed picture files. This is the most common format 
on the Internet and is the default format for Myriad.

 GIF – Compressed pictures that allow transparent backgrounds but are 
not as common on the Internet now.

 BMP – Bitmap is the default Windows picture format but is essentially 
uncompressed so BMP pictures will be much larger than JPG or GIF in 
terms of the space used on your hard disk per picture.

Myriad is only able to use one picture file format so it is best to pick the format 
you think will be the most use and stick with it.

And as we are dealing with pictures, he is a special treat just for reading such 
an obscure part of the Myriad manual. Britney and Atomic Kitten:
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And so no one feels left out, A1 and Roger Sanchez.

Now back to business!

Importing Audio Tab > CD Ripping > Allow the Internet to Be 
Queried For CD Title (CDDB Details)

This section of the Importing Audio tab allows you to set whether Myriad can 
‘look up’ information such as Title and Artists from special audio CD 
databases on the Internet when ripping audio in to the system from CD.

Basically, CDDB is a generic term for a CD Database which is a database of 
commercially available CDs along with the track information contained on the 
CD. Each commercially produced CD is given a unique reference number and 
Myriad can read this number as part of the CD ripping process and 
automatically download Artist and Title information from your selected 
database site.

This will only work with commercially produced CDs, as a CD burnt at home 
does not have a unique ID and the details of the tracks it contains are not 
publicly known. Some more obscure CDs may also not be listed on the online 
databases.

To enable Myriad to use this facility, tick the ‘Allow the Internet to Be Queried 
for CD Title’ option and select the CDDB that you wish to query using the drop 
down list.
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All of the options in this list operate a free service that is updated by users of 
the service, so whilst it is free to use, there is no guarantee of the quality or 
accuracy of the information downloaded into Myriad. 

The default database is ‘feedb.freedb.org’ as Myriad users have indicated that 
it offers the most accuracy.

All of the CDDB services available for use in Myriad require users to submit a 
valid and working email address as part of the enquiry. This database is not 
used for any marketing services (that we are aware of) but if you require more 
information, you should contact the CDDB services directly. To set the email 
address for Myriad to submit with enquires type in the address in to the Email 
field.
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Import Audio Tab > CD Ripping > Automatically Trim Silence at the
Start (Top) Of Audio

This setting is used to determine whether Myriad should automatically remove 
any silence from the beginning of audio ripped from CD and also when Myriad 
imports audio data files.

If you un-tick this setting, a CD track that includes 3 seconds of silence at the 
beginning will also have 3 seconds of silence at the beginning as a Cart on 
the Audio Wall meaning you may have to manually edit it. Turn this setting on 
and the 3 seconds would be automatically removed as part of the ripping 
process.

Import Audio Tab > Other Options > Normalise the Imported Audio 
to XX Percent

This section allows you to configure Myriad to automatically normalise audio 
that is imported in from data files or ripped from audio CDs.
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To configure Myriad to normalise imported / ripped audio, tick the Normalise 
option to enable the setting and type in the percentage of maximum audio 
volume that you wish Myriad to normalise to.

The default in Myriad is 63% which tests indicate is around digital zero or -
14dB analogue but this will vary with your equipment. The level is not as 
important as the fact that all of your audio is normalised to the same level.

For details on what normalising is and how it affects audio, please refer to 
Chapter 6 – Normalise. 

Advanced Tab > Allow Users to Link to Other Files Not Stored In 
the Audio Wall 

This option is used to enable linking to files in Myriad. Under normal 
circumstances, many of the Carts that appear on the Audio Wall have a 
corresponding audio file stored in the appropriate Audio Wall File Location. 
But Myriad can also be configured so that Carts on the Audio Wall ‘link’ to an 
external audio file that is not located in the main Audio Wall File Locations. 
This means that the file is not copied to the Audio Wall File Location and 
Myriad instead uses the original file wherever that may be stored.

The disadvantage is that you can end up with a very complicated system 
which will run fractionally slower than the standard setup.

Advanced Tab > Store A Copy of Each Carts Information in an
Individual File

This is a legacy setting that should not be switched on in modern versions of 
Myriad unless directed by a P Squared Technical Support engineer.

Basically, the Title, Artist and timing information for a Cart in Myriad is stored 
in two separate places. Firstly, the information for each Cart is stored in a 
special data file called a Cart List (carts1.lst etc) file that is located in the 
Audio Wall File Locations folder. This file contains all of the vital information 
about the Carts and is used by Myriad when browsing or searching the Audio 
Wall. In addition, key Cart information (such as Title, Artists and Timing) are 
also embedded into the audio files themselves and Myriad can use this 
information to re-build the Audio Wall should the need arise.

The ‘Store a Copy’ setting is used to activate a third option for storing the 
information with an individual Cart List file being generated for each individual 
Cart on the Audio Wall.

This method will slow Myriad considerably in day to day use and is no longer 
necessary as the information is embedded into the audio files themselves.
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CAUTION: Do not use this option unless instructed by a P Squared 
engineer.

Advanced Tab > Use / Store Copyright Details in ‘Cart Chunk’

As mentioned above, Myriad automatically embeds key Cart information into 
the audio files to allow it to recover the information if needs be or to allow 
another Myriad system to import the audio and Cart information at the same 
time. This is done using an international standard called Cart Chunk which 
defines where the Cart information should be stored within the audio file. In 
theory, this means that you could export a Cart from Myriad and then import it 
in to another 3rd party playout system that is Cart Chunk compatible and all 
the title and timing information would be imported as well.

The problem is that there are not enough fields in the Cart Chunk specification 
to cover all of the information that Myriad allows you to add to the Cart. The 
main problem is that Cart Chunk does not differentiate between the Cart Title 
& Artists fields and the Copyright Title and Artists fields. In practice, these are 
normally the same so it makes little difference but there may be 
circumstances when it is important.

When this option is switched off, Myriad will use the Title and Artists 
information from the General tab on the SmoothEdit Screen for embedding in 
to the audio file. If you switch the option on, Myriad will use the Title and Artist 
information from the Copyright tab on the SmoothEdit Screen for embedding 
in to the audio file.

If you are most likely to transfer audio between Myriad systems then you 
should leave this option off. If you think you will need to transfer audio 
between Myriad and other third party systems then turn this option on as 
strictly speaking, Myriad is not fully Cart Chunk compliant with it off (but only 
on a technicality so don’t worry).

Hardware Card Settings

The Hardware Card Settings option on the settings menu opens the Hardware 
Settings window which allows you to set up the hardware I/O card(s) in your 
Myriad system and configure the inputs and outputs to do certain things. To 
understand this section of the configuration, you will need a passing 
knowledge of logic based hardware and Myriad as a whole. 
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Type: Setting Up Hardware Cards

Each Myriad workstation can be fitted with up to three hardware I/O devices 
and Myriad supports several different types of hardware I/O devices. The 
individual inputs into each card can be configured to do a range of things in 
Myriad whilst each output can be labelled to make using them in AutoTrack 
and AutoTrack Pro easier.

To set up Hardware Card 1, select the Hardware Card 1 and select the Type 
of card that you have fitted from the drop down list.

The options are outlined below:



797

 Disabled – No hardware I/O device is configured for this Hardware 
Card tab.

 RS232 Based Controller – Uses a specific RS232 (serial) hardware 
I/O device to provide a limited amount of hardware inputs and outputs. 
Contact sales@psquared.net for details of compatible devices.

 Advantech Card (i.e. PCI1750 etc) – A range of professional 
hardware I/O cards commonly used with Myriad. The PCI1750 is the 
standard card that is used and it offers up to 16 inputs and 16 outputs. 
Other cards in the range may also be compatible, please contact 
sales@psquared.net for more details.

 Joystick Port – This uses the inputs on a standard joystick port to 
trigger events in Myriad. This provides a low cost alternative to a 
hardware card but it only offers inputs.

You can select the type of hardware device you wish to add using the drop 
down list.

Once you have selected the Type that best describes your Hardware Card, 
you can start to configure what the inputs actually do and label the outputs.

The most commonly used hardware card in Myriad is the PCI1750 by 
Advantech so this example will concentrate on setting up for using this card,
however the other Hardware device options are basically the same so the 
information will apply to them all (with the exception that the joystick port 
option only offers inputs so the output section will not apply).
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The Device Number (Hex)

This will automatically be detected by Myriad so don’t worry about manually 
entering a device number.

Configuring Inputs - Type

The grid below the Device Number lists the Hardware Card’s available I/O 
ports in the form of Inputs and Outputs. In the case of the PCI 1750, it has 16 
Logical Inputs and 16 Logical Outputs (IDI0-15 & IDO0-15 respectively, see 
pinout in the PCI1750 Hardware I/O Card Information section below). If you 
scroll down the list you will see that, in the case of the PCI 1750, the Outputs 
start at number 17 onwards.

Active Low ‘L’

The ‘L’ column refers to whether the Input needs to be ‘active low’, this means 
that the logic’s natural state is high and Myriad actually only responds to the 
falling edge of a logic change to low state. To make an Input ‘active low’ click 
in the ‘L’ column for the Input and a ‘Y’ (for Yes) will appear. If the column is 
left blank for an Input then the Input will be ‘active high’ i.e. the logic’s natural 
state will be low and will respond to the rising edge of logic state that changes 
from low to high. The fact that Myriad only responds to the change from its 
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natural state to the active state means that Myriad will work with either pulsing 
or latching logic, whichever is easiest for you.

Description

The Description column has two different functions depending on whether the 
I/O line that you are configuring is an Input or an Output. If the line is an Input 
then the Description automatically displays a suitable description of the 
function of the Input.

For Outputs, the Description allows you to label the Output so that it is easier 
to use in Myriad as a whole. Let’s say for example, we decide to use line 22
for controlling an external audio switch that switches the IRN news service on 
or off. We can enter a label onto the Description column that shows what the 
Output controls, so that elsewhere in Myriad and AutoTrack Pro we don’t have 
to remember that Output 22 is connected to the IRN switcher because it will 
already be labelled.
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Action

The Action column is where things really start to get exciting. The Action for 
an individual Input dictates what it will do when it is triggered. Some Actions 
apply specifically to Inputs (such as Cart Controls) and some apply 
specifically to Outputs (like Cart Displays).

To change an Action that occurs when an Input hardware line is triggered or 
to change the Output when an Action occurs, use the drop down menu in the 
Action column to select the action you want.

For each Action, the Info 1 & Info 2 columns can be used to specify the Action 
more directly. In the example above, Input line 2 has been set to Cart Player 
Control, which tells the system that this hardware will be used to control one 
of the Cart Players. In the case of Cart Controls, Info 1 column is used to 
select a specific Cart Player and Info 2 column is used to select exactly what 
to do to the Cart Player when triggered. Use drop down menus to select 
options from Info columns 1 & 2.
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The full list of Input Actions available is:

Input Action Info 1 Info 2 Description
IC Trigger IC Number N/A Fires specified IC when 

triggered
Command Select the 

Command 
N/A Allows you to set a specific

Command to be triggered by 
the Input. Commands can be 
instructions, external programs 
or RS232 / TCP IP messages.

Player Control Cart Player 
No

Play / Pause 
/ Cue / Eject 
/ RR / FF / 
Inhibit 
Logging 

Controls specified Cart Player 
when triggered. The Inhibit 
Logging option stops Myriad 
from logging Carts as played in 
the play logs (ideal for 
previews)

Cart Control Play / Cue Cart 
Number

Plays or cues a specific Cart 
from the Audio Wall

Log – Set 
Mode

Stand by / 
Use Log 
Mode / Live 
Assist / 
Automation / 
Auto Fade

N/A Set the active playout mode for 
the Log Screen using hardware

Log - Other Log Go / Log 
SegEdit / 
Log Jump 
Home

N/A Triggers Log Go event, toggle 
between standard and Full 
Segue Edit mode and Jump to 
Home in Log using hardware

On Air Control Take Control 
/ Release 
Control

N/A Allows you to take or release 
On Air Control (on air / off air) 
using hardware

Set Time Off-set:0 
(sec)

Set on 
active / Set 
on clear

Will reset the system clock 
when triggered 

Miscellaneous Exit Looping 
Carts 

N/A Exit looping Carts or generate 

The full list of Output Actions available is:

Output 
Action

Info 1 Info 2 Description

IC Display IC Number N/A Enables Output if IC exists in 
specified IC number

Cart Display Cart Player 
No

Playing / 
Playing & 
Flashing In
Extro / Is 
Cued Ready 
/ Cued & 

Enables Output when specified 
Cart Player is in condition 
specified in Info 2
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Flashing In 
Extro / 
During Intro 
/ After Extro

Display Log 
Mode

Stand By / 
Running / 
Live Assist / 
Automation / 
Auto Fade

N/A Enables Output when the Log 
Screen is in Active Playout 
Mode specified in Info 1

On-Air
Control

Has Control N/A Output enabled when the 
workstation has On Air Control

Miscellaneous Heartbeat 
Pulse / 
Audio Run 
Ended

N/A Outputs a hardware pulse at 5 
Hz or when a Pad run comes to 
an end

TIP: You can highlight several Inputs or Outputs at once by using the left 
mouse button to move down the column, then selecting the Action or Info from 
the drop down menu. The system will even enumerate the numbers for you, 
e.g. if you highlight Input lines ‘1 to 4’ and select Cart Controls, then it will 
automatically assume that you want to actually set the four lines for the 
respective Cart Players 1 – 4 and fill in the Info 1 & 2 columns for you. 

PCI1750 Hardware I/O Card Information

Although strictly speaking, the PCI 1750 card has nothing to do with Myriad, 
we thought that we would take the opportunity to add a pinout for the card and 
briefly explain how to wire it up. For full details you should consult your 
hardware card manual or visit www.advantech.com.
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IDI 0-15 are the 16 Inputs (represented as 1-17 on the Hardware Settings 
screen),
IDO 0–15 are the 16 Outputs (represented as 17-32 on the Hardware Settings 
screen),
IGND is independent ground and should be connected to the PC case in 
some way,
Com 1 & 2 are not used in Myriad

To connect up an Input, connect the positive input from the mixing desk or 
other external equipment to the desired IDI and the negative to one of the 
IGND pins. A closure from IDI pin to IGND counts as a valid Input.

To connect up an Output, connect the positive input from the mixing desk or 
other external equipment to the desired IDO and the negative to one of the 
IGND pins. An Output from the system will close the IDO pin to IGND. If you 
are using Outputs, you should always ground the IGND pin to the PC case 
with an external grounding fly wire.
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For more information on the PCI 1750 or other hardware I/O cards, please 
consult the documentation supplied with the card.

Station Database Settings

The Station Database settings option on the Settings menu opens the Station 
Database Settings window which includes a large number of settings that 
cover a diverse range of functions in Myriad. The one unifying factor is that all 
of the settings on the Database Settings window refer only to the Station 
Database that the Myriad workstation you are working on currently has open. 
Because of this, changes made in this section will affect all Myriad 
workstations that access the Station Database you are working on.

The General Tab

The General tab of Station Database Settings window covers many of the 
general Log Screen settings, affecting the way the system works. 
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General Settings > Play the Adverts at the ‘Sweeper Volume’

Myriad has two different ways of playing out ‘sweepers’. The first mode will 
dynamically ‘duck’ the volume on songs while a ‘sweeper’ Cart or Voice Track 
is playing. The second is for all songs and jingles to be played at one volume 
and all ‘sweepers’ and Voice Tracks to be played at another (higher) volume. 
If this method of ‘sweeping’ is selected (see Sweeper Style section below) 
then you also have the option of having adverts played back at the higher 
‘sweeper’ volume. This option is off by default.

General Settings > Jump ‘Home’ Before Starting Automation

If you set this option then whenever you select one of the Active Playout 
modes on the Log Screen, Myriad will automatically jump to the Log Item that 
should be playing before it cues that Log Item up ready to be played. This 
basically has the same effect as if you click on the Home button before you 
switched to one of the Active Playout modes.

General Settings > Set New Items to ‘Stop’ In Live Hours
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By default, when you are in Live Playout Mode (or Preview Live mode), new 
Log Items that are added to the Schedule Log will be added with a Green 
(Go) Segue type meaning that when Myriad plays them it will automatically 
segue on to the next item once it has finished. 

If you tick this option then new Log Items added to the Schedule Log will be 
added with the Red (Stop) Segue Type which means that Myriad will 
automatically stop at the end of the item and will not start the next Log Item 
until you tell it to (by pressing the Go button etc).

This setting does not apply in Auto, AutoFade or Preview Auto modes as all 
segue types are Green (Go) Segue types in these modes.

General Settings > Sweeper Style

The Sweeper Style option allows you to tell Myriad how it should deal with 
‘sweepers’ when it encounters them. There are three options available from 
the drop down list.

 Timed To Intro End - If this option is selected, Myriad will start 
‘sweepers’ so that their end coincides with the end of the Intro of the 
song. These are sometimes referred to as power intros. Myriad will 
check to see that the ‘sweeper’ will actually fit into the Intro of the song; 
if it will not fit then it will play the ‘sweeper’ dry before playing the song.

 Start At Intro Start - This option will start the ‘sweeper’ at the same 
time as the song unless the ‘sweeper’ length is longer than the length 
of the Intro of the song being ‘swept’ into. If this is the case then Myriad 
will play the ‘sweeper’ dry before starting the song. 

 Dry - The Dry option will play all ‘sweepers’ dry and never overlap 
‘sweepers’ over the Intro’s of songs.

Options > Allow Users to Add Carts from the Audio Wall

The Allow Users to Insert Carts from the Audio Wall option allows you to 
specify whether or not the User can insert entries into the Schedule Log from 
the Myriad Audio Wall or Cart Browser. This also affects ‘drag n drop’ from the 
Audio Wall (on dual screen systems).

Options > Allow Users to Add Links from the Database

This option works the same way as the option below by letting the User select 
a Link from a list of all the Links stored in the Database screen. 
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Options > Allow Users Add Songs from the Database

This option allows a User to insert new entries into the Schedule Log from a 
list of all the songs in the Database Screen. This option will allow the User to 
choose from an alphabetical list of songs or search for an artist or song name. 

Third party music scheduling system users (such as Selector™ users) should 
disable this option.

Segue Editor / Voice Link Settings 

As the name suggests, the settings in the Segue Editor / Voice Link section of 
the General tab allows you to adjust the settings specifically for the Full Segue 
Editor on the Log Screen in Myriad.

Segue Editor / Voice Link Settings > Update the Segue Display 
While Recording New Voice Links

When this option is ticked, a visual representation of the voice link that is 
being recorded is superimposed in ‘real time’ over the original segue as a 
voice link is recorded.

This option can be turned off on slower machines to allow the computer to 
concentrate on recording the voice link although the default is for the option to 
be ticked.

Segue Editor / Voice Link Settings > When Previewing the
Outgoing Track, Play the Previous XX Seconds of That Cart

As the name suggests, this setting allows you to set how many seconds of the 
end of the previous track you hear when recording a voice link.

Segue Editor / Voice Link Settings > Voice Links Should Store 
Carts Between Cart XXXX and Cart XXXX

Voice links are automatically stored on the Audio Wall as Carts so that they 
can be played back later on the Log Screen. This option allows you to specify 
the area of the Audio Wall that the voice links will be recorded onto.

It is recommended that you select an area of the Audio Wall that is not in 
general use by any other P Squared products or in regular use by presenters. 
The voice links will automatically be recorded into the lowest empty Cart in the 
specified range but voice links will not automatically be deleted and you will 
not be able to record more voice links once the range is full so make sure the 
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range is sufficiently large to allow you record all the voice links you will need 
between manually clearing out the ‘used’ Carts by deleting them.

Segue Editor / Voice Link Settings > Automatically Start Recording 
When the Audio Level Rises Above XX %

When recording Voice Links using the Full Segue Editor, you can either opt to 
manually start recording your voice link (by pressing the <SPACE BAR>) or 
have the system automatically start recording as soon as you start to speak 
into the microphone. This option is the default and the preferred option 
because when the link is played back by Myriad in automation, Myriad can be 
configured to ‘duck’ the audio level on the songs around the link starting at the 
beginning of the voice recording. It is therefore desirable to start to speak as 
close to the beginning of the recording as possible to get the best effect.

Ticking the Automatically Start Recording option minimises the problem by 
making the system ‘listen’ to the incoming audio level and then start recording 
as soon as it hears it. The percentage setting allows you to set a threshold 
that the incoming audio level must reach before recording is started. This 
allows you to set the threshold above background noise or cross talk ensuring 
that it only starts recording when the presenter speaks. 

Unfortunately, there is not really a recommended threshold setting as it 
depends on your audio set up. You need to set this option as low as possible 
but above the threshold volume that would mean that Myriad would start 
recording on background noise alone. A little trial and error is probably the 
best way to get the right setting but start off at about 5% and see how you get 
on.

Audio Format

The Audio Format option is used to select the audio format and quality that 
your recorded voice links are recorded in. To select the Audio Format that you 
want to use, click on the Choose button.
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From this window, you can select whether you want the recordings to be 
linear (PCM) or compressed (IMA ADPCM etc) using the Format drop down 
menu, you can also select the recording quality by using the Sample Rate 
drop down menu and whether you wish to record in mono or stereo.

Once you have the format and quality that you like, click on the OK button.

NB: This Audio Format window allows you to select any of the formats and 
qualities that are available to windows but not all are suitable for voice links 
and not all will work with Myriad. We suggest you stick to the settings listed 
below.

Linear PCM
Compressed IMA ADPCM
Qualities  44.100 KHz 16 Bit Stereo (CD Quality)

44.100 KHz 16 Bit Mono (CD Quality Mono – saves space)

Using other formats or qualities is done at your own risk but feel free to 
experiment as other formats and qualities do work.

Miscellaneous Settings > If Myriad Shuts Down Automatically 
Restart After XX Seconds

Every time Myriad is switched into an Active Playout mode, it sets an ‘Active 
Flag’ on the system to say that it has been activated. When it is put back into 
‘Standby’ mode, it clears the flag to say that it has been stopped correctly. If 
the PC reboots or the power to the PC is interrupted when in ‘Active’ mode 
then because Myriad has not had the chance to shut down properly the 
‘Active Flag’ stays on. 

When Myriad does eventually restart, it checks to see if the ‘Active Flag’ is 
set, to determine if it was shut down correctly the last time it was used. If
Myriad determines that it was not shut down correctly then it will search 
through the Schedule Log to find the entry closest in time to now, and then put 
a warning box on screen for XX seconds. This gives the User the option to 
cancel the automatic restart. If the User does not cancel the automatic restart 
then Myriad will switch to the scheduled Active Playout Mode and start 
playback. It will also leave a warning message on screen to inform then next 
User that it automatically restarted.

This option is on by default with a delay of 10 seconds.

NB: For this to protect against power failures, Myriad must be in the 
Windows™ Startup Menu so that it is automatically run when the PC restarts.  
You should also configure Myriad to automatically login to Windows, 
otherwise if your PC reboots, it will just sit on the Windows Login prompt and 
not restart Myriad.
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The QAE Tab

QAE stands for Q Audio Engine, which is the engine that runs the Log Screen 
in Myriad. It decides what songs to fade, how to ‘sweep’ a ‘sweeper’ and how 
to play audio in general. For the most part, the QAE requires very little input 
from the User but there are a few settings that can be changed in the QAE
Settings tab in Station Database Settings window.

Cue The Next Item When There Is Less Than XX Sec Remaining…

Myriad will always cue up the next item in the Station Log before it actually 
needs to play it to allow it to do smooth segues. How far in advance it loads 
the next item is determined by this setting by entering the time in seconds. 
The default is 20 seconds although many stations set this a lot higher so that 
presenters can end songs earlier.

The presenter will still have several options for manually cueing the next item 
and even once an item has been cued, it can still be replaced or removed 
should the presenter wish to.
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Only Calculate Fading If There Is At Least XX Seconds 
Remaining…

Myriad has the ability to manipulate an automated hour (in AutoFade mode) to 
ensure that it ends exactly at a specified time. This is most commonly used for 
hitting the top of the hour to take an external news service such as IRN. It 
does this by going through the hour and adding all the remaining audio 
together until the next absolute time marker. This is then compared to how 
long is left until the next absolute time marker and the excess audio is 
disposed of, by dropping some songs and fading other songs early. The QAE 
performs this calculation at every single segue where the next item’s duration 
is longer than the time in seconds specified in this setting.

In the example screen shot above, the setting is set to 15 seconds which 
means that the QAE will be recalculated to make sure that it has all the 
timings right whenever a segue occurs into an item longer than 15 seconds. 

This setting is primarily there so that you can decrease the amount of times in 
an hour that the QAE recalculates the fading on a slower machine. By 
increasing the time and therefore reducing the likelihood that it will recalculate 
on any segues other than going from a song to a song.

Fade the Current Item After ‘Q-NXT Go’ Is Pressed and Take XX 
Seconds

If you tick this item then whenever you manually segue from one Log Item in 
the Schedule Log to the next (using Go, Cart Controls, or Fader Starts) it will 
automatically fade out the previous item. You can also specify the time period 
that the previous item is faded out over by adjusting the XX seconds setting.

If you do not have this option ticked, when you manually start the next item, 
the previous Log Item will continue to play at the normal volume until it 
reaches the end of the Cart; it is assumed that you will control the volume 
using the fader on your mixing desk.

The default is for this option to be ticked and for the fade to over 4 seconds.

Take XX Seconds to Completely Fade Out Each Track When Using 
AutoFade or ForceFade
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This setting tells the system how long to take to Autofade tracks that are being 
faded early to hit an absolute time marker. If you set this to 4 seconds, for 
example, the songs that are faded out automatically by the system will fade 
out over a period of 4 seconds. The longer this setting is set to, the longer the 
fade (and therefore the cross fade) and the ‘looser’ the mix will sound. On the 
other hand, if you set this setting shorter then the mix will sound very abrupt 
and forced. The default setting is 4 seconds, which has proven to be a good 
compromise between the two. 

Fading Rules

The Fading Rules section of QAE tab allows you to set the way in which 
Myriad deals with fading Songs when in various Active Playout modes.

The options available from the drop down list are as follows.

Fading Rules > Only Fade Out Songs That Have ‘Fade’ Endings 
and Need to Be Trimmed To Run To Time

If you select the first option in the drop down list then Myriad will only fade out 
the volume on the previous song if that song is marked as having a ‘Fade’ 
ending on the Cart itself (or in the log generated by the music scheduler if you 
have configured Myriad to use this information instead) and the system has 
determined that it needs to fade the item early in order to hit an Absolute Time 
Marker. Experienced Myriad users may recognise this option as AutoFade 
only from previous versions.
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Fading Rules > When In A-Fade Mode, Fade Out All Songs with
‘Fade’ Endings When the Next Item Starts

The second option will cause Myriad to fade out the volume on every song in 
the Schedule Log that has a Fade Ending Type as it starts the next song in 
the log but only when it is in AutoFade playout mode.

This option is the default setting in Myriad.

Fading Rules > When In A-Fade Mode, Fade ALL Songs Once the
Next Item Starts

This option will force Myriad to fade out every song in the Schedule Log as 
the next is started but only when in AutoFade mode.

Fading Rules > Always Fade Songs with ‘Fade’ Endings Once the
Next Item Starts, In Any Playout Mode

With this Fading Rule selected, all Songs that have ‘Fade Endings’ will be 
faded out when the next songs starts regardless of the selected Active 
Playout mode in Myriad.

Fading Rules > Always Fade ALL Songs Once the Next Item Starts, 
In Any Playout Mode

This final mode will cause Myriad to fade out all songs once the next item has 
started regardless of what playout mode is selected.

Options > Fading Rules > If No Songs Are Fadeable, Fade The Very 
Last Track…

The options sections allow you to set a range of options relating to how 
Myriad deals with audio and fading and also what rules it should employ when 
in AutoFade mode.

When you tick this option, it allows Myriad to consider fading the very last 
Song in the hour even if it has an ‘Ends’ ending type. This would only happen 
if there were no other fadeable songs in the hour and Myriad had little choice.

It is recommended that this option is left switched on as it provides a ‘safety 
net’ for AutoFade mode where Myriad is able to take drastic action if it needs 
to. If you turn this option off and there are no fadeable songs in an hour that 
has to ‘run to time’ then Myriad will not be able to comply and will over shoot 
to end of the hour (possibly crashing the news).

This option is set by default.
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Options > Fading Rules > Use the Fading Information from the Log 
Rather Than the Carts

To work effectively, Myriad needs to know whether each item in the Schedule
Log comes to an abrupt end (Ends) or slowly fades out over a few seconds 
(Fades). This information is usually stored on each individual Cart on the 
Audio Wall and Myriad checks this information as it plays it but, if you tick this 
option then Myriad will not look on the Audio Wall but rather take the 
information about how the item ends from the log that is generated by the 
music scheduling program (AutoTrack Pro, Selector etc).

The default for this option is to be left unchecked.

Options > AutoFadeable Items > Fade the Ticked Items Below 
Regardless Of End Type

This setting actually refers to the options directly below it. Basically, this 
section allows you to set the Log Item Types that Myriad can fade early when 
in AutoFade mode and this setting allows you to set Myriad to be able to fade 
these Log Items early, regardless of what the End Type is set to on the Item.

If you tick this option, Myriad will have free reign to fade any Log Item of the 
allowed type, regardless of whether the Log Items End or Fade.

In the example above, Myriad is has been configured to allow it to fade both 
Songs and Carts early and it can fade any Song or Cart in the Schedule Log 
regardless of whether they have an End or Fade Ending Type.
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Options > AutoFadeable Items > Allow Adverts to Be Faded Early

If this option is set, then Myriad is allowed to fade Adverts out early when in 
AutoFade mode in order to hit Time Critical Events (Absolute Time Markers).

This option is off by default.

Options > AutoFadeable Items > Allow Carts to Be Faded Early

If this option is set, then Myriad is allowed to fade Carts out early when in 
AutoFade mode in order to hit Time Critical Events (Absolute Time Markers).

This option is off by default.

Options > AutoFadeable Items > Allow Links to Be Faded Early

If this option is set, then Myriad is allowed to fade Links out early when in 
AutoFade mode in order to hit Time Critical Events (Absolute Time Markers).

This option is off by default.

Options > AutoFadeable Items > Allow Songs to Be Faded Early

If this option is set, then Myriad is allowed to fade Songs out early when in 
AutoFade mode in order to hit Time Critical Events (Absolute Time Markers).

This option is on by default.

Always Fade XX seconds off of the last fadeable track before 
fading others…

As outlined above, the QAE will drop and fade songs throughout an hour to 
ensure that it hits any specified absolute time markers, but before it goes off 
and does all of the calculations (see above), it will see if it can just fade a 
‘chunk’ off the last fadeable track in the hour. The amount that it will fade off 
the final fadeable track before looking elsewhere is set in this setting.

The default for this setting is 30 seconds.

Selecting this option disables the Fade at Most XX option and vice versa.

Fade At Most XX Seconds From Each Fadeable Track, Then The 
Remaining…



816

Alternatively, the Fade At Most XX Seconds From option instructs the QAE to 
only fade the maximum stated amount from each fadeable song in the hour 
with the balance being faded from the last fadeable song in the hour. Say you 
set this to 10 seconds then up to 10 seconds will be faded from all the other 
fadeable songs in the hour with whatever additional time needed being faded 
from the final fadeable song.

Example: 2 minutes to get rid of with this option set to 10 seconds and the 
being 9 songs in the hour that are fadeable.

In this situation the QAE would fade 10 seconds of off each of the first 8 
fadeable songs and 40 seconds off of the final fadeable song in the hour.

Selecting this option disables the Always Fade XX from the Last option and 
the default is 20 seconds.

The Log Entries Tab

The Log Entries tab deals with two important elements of the Log Screen in 
Myriad. This first of these is setting the colours of the individual Log Item 
Types displayed in the Schedule Log. 

The second is to allow you to dictate the range of Cart Players that certain 
types of Log Item Types in the Schedule Log are allowed to use. This means 
you can make Adverts come out of a different set of Cart Players to Music etc.
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On this screen the main Log Item Types are listed along the left had side of 
the screen. Each item is on a colour-coded panel, which reflects the way it 
looks in the Schedule Log. 

Next to the item name is a drop down list that allows you to select the first in a 
range of Cart Players that the specific type of item will use. To the right of this 
is another drop down list, which allows you to select the final Cart Player in 
the range for the items.

Finally, to the right hand side is a Change Colour button that allows you to 
change colour of the panel that the item appears on in the Schedule Log.

Example: Playing Songs and Adverts in Different Cart Players 

Let’s say we want to make it so that Songs, Carts, and Vocal Links come out 
of the first four Cart Players on a six Cart Player system but the Adverts all 
come out of the top two Cart Players. We also need to set which Cart Players 
the Voice / Segue Editor reserves when you are editing segues or recording 
voice links. Let’s say that in this example, we are happy for it to reserve as 
many Cart Players as it needs but want it to start at the highest Cart Player 
and work it’s way down to Cart Player 1. In this example, we would have to 
set the following options.
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Changing Log Item Colours in the Schedule Log

Now let’s say we wanted to change the colours of Songs in the Schedule Log, 
all we have to do is click on the Change Colour button and selected the new 
colour from the colour selector window.
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By default, all the colours in the Schedule Log are pastel shades that have 
been selected for their ease of use but please feel free to experiment. All of 
the items in Myriad will use the lowest Cart Player first and end with the 
highest Cart Player unless you change the default settings, the exception is 
the Voice / Segue Edit Cart Player range which defaults to the highest Cart 
Player and then works its way down.

You can also set the system to display the colours for the individual Carts on 
the Audio Wall instead of default colours in the Schedule Log. 

The Log Layout Tab

The Log Layout tab allows you to set the font size and style for the text that 
appears on the Log Screen. It also allows you to configure text colours for key 
information on the Log Screen and set where Myriad should get the timing 
information that it uses.
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Preview of the Log Display

The Preview of the Log Display allows you to configure the font and font size 
and text colour for the text that appears on normal Log Items in the Schedule 
Log.

To change the font and font size for standard Log Items, click on the Font 
button.
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This will open the Font Selection window which allows you to select the font 
and font size to be used.

Please note that Myriad automatically sets the size of individual Log Items on 
the Log Screen depending on the size of the font selected here. This means 
that if you pick a larger font size, the Log Items will appear larger on the Log 
Screen (but less of them will be displayed on screen).

Preview of the Highlighted Log Item

This section allows you to preview the way a highlighted Log Item in the 
Schedule Log will look. You can set the background colour for highlighted Log 
Items using the Back Colour button.
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You can then select the colour using the Colour Palette window.

You can also set the colour for the text that will be displayed using the Text 
Colour button. 
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Currently Playing Information (Change Text Colour)

The Currently Playing Information section allows you to set the text colour for 
the Currently Playing Information (Overrun, Next Segue & Time Remaining) 
which is displayed at the bottom of the Schedule Log.

To alter the text colour, click on the Change Text Colour button and select the 
desired colour using the Colour Palette window.

NB: Please note that you cannot change font or font size for this option.

Time Display > Display the Time Information from Log

If you tick this option then instead of using the timing information from the 
Carts on the Audio Wall, Myriad will use the timing information from the 
Schedule Log and not the information on the Audio Wall. This option should 
only be used in exceptional circumstances.

The default setting for this option is not set.

The Hooks Tab
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The Hooks Tab is used to set the default setting for Hook runs set up by the 
Log Screen and Auto Hook Log Items inserted in to the Log.

These settings are used in one of the two following circumstances:

 When you right click on the Log and select the ‘Cue No More 
Than X ‘Hooked’ Items in A Hook Player’ menu option. When 
you select this option, the settings here are applied to the Hook 
Run that is cued in the Hook Cart Player.

 When you insert a AutoHook Log Item in to the Schedule Log 
using the right click menu. In this case, the settings here are 
used as the default setting for the AutoHook but you can change 
them.

Hook Player Start Cart

This allows you to set a Cart to be played first in the Hook Run or AutoHook 
Log Item. If you leave this blank then the first Hook will be played at the 
beginning of the Hook Run or AutoHook.
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Hook Player Separator Cart

This allows you to specify a Cart to be played between each Hook in the Hook 
Run or AutoHook Log Item.

If you leave this blank then the Hooks will be played ‘back to back’.

Hook Player End Cart

This allows you to specify a Cart to be played after the last Hook has finished.

If you leave this blank then the Hook Run or AutoHook Log Item will end after 
the end of the last Hook.

Hook Player Number Items

This option allows you to set the maximum number of Songs that contain 
Hooks that will be added to the Hook Run, and the default number of Hooks to 
use when inserting AutoHooks. When you are working with AutoHooks, all of 
these options can be altered when you add the AutoHook or at any other time 
by double clicking on the AutoHook in the Schedule Log. Hook Runs are less 
flexible in that these settings are used each time.

The OCP / STS Tab

The OCP / STS tab Station Database Settings is concerned with Myriad 
communicating with the Myriad STS and OCP which both allow you to expand 
your overall Myriad system. The role of Myriad STS and OCP is outlined 
below:

 OCP (Online Content Processor) – OCP is part of the standard 
Myriad package and is used to provide additional text and visual 
information to a range of digital broadcast platforms. In simple terms 
this means displaying text and picture information about what is playing 
and what will play next to web sites and DAB transmitters. As OCP is 
part of the standard Myriad package, if you have purchased a full 
Myriad license then you are also entitled to an OCP license.

 Myriad STS (Split Transmission System) – Myriad STS is not part of 
the standard Myriad system and should be purchased as an upgrade 
(email sales@psquared.net for more details). The role of Myriad STS is 
to provide split advertising and branding capabilities to the Myriad 
system. Basically, the central Myriad system plays music and other 
content but split adverts and branding are played by Myriad STS 
workstations (either locally or remotely).
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The OCP / STS tab is used to configure Myriad to communicate with these 
two external programs and also what information it should share with them.

CAUTION: You must be using Advanced on Air Control in order to use Myriad 
with OCP or Myriad STS. For more details please refer to the Settings Menu > 
Myriad Settings > On Air Control Tab for more details.

What type of On-Air Controller are you using

The first thing that you must do is choose which of the two types of On-Air
Controller programs you want Myriad to connect to. The options are as 
follows:

 There Is No Computer To Connect to - The first option is that there is 
no computer to connect to. If this option is selected then Myriad will not 
attempt to communicate with any external programs. If you select this 
option then the rest of the settings in this section are disabled, as they 
will not be needed. This is the default setting.

 The Computer Is Running P Squared’s OCP - This option tells 
Myriad that the computer it will try to communicate with will be running 



827

OCP for generating and sending additional multimedia information in a 
variety of formats.

 The Computer Is Running P Squared’s Myriad STS - This option 
tells Myriad that the specified PC will be running Myriad STS so the 
appropriate information for split transmission advert breaks and jingles 
should be sent to it.

NB: As implied by the nature of this drop down box, Myriad can only send to 
either OCP or STS but not both at the same time. Should you wish to do this 
then you should set your Q-NXT system to talk to the master STS system that 
in turn will talk to the OCP system passing on information from Myriad. You 
would also only connect to one STS system even though you may have 
several different Myriad STS workstations servicing different areas. This is 
known as the Master STS machine and this in turn relays Myriads commands 
to any other Myriad STS systems on the network.

For more information on STS and OCP network topologies, please consult the 
individual product’s documentation or a P Squared support engineer.

Computer Name / TCP-IP Address

Once you have decided what type of On Air Control service you want to
connect to, you must tell Myriad the computer name or IP address of the PC 
that the software is running on so that it can send the information to the 
correct place. This is done in the form of a UNC computer name or a TCP-IP 
address. Both of these addresses are unique for each machine on your 
network so Myriad will always send information to the right PC and all other 
PCs on the network will ignore it. For more information on specific computer 
names and TCP-IP addresses on your network, you should consult your local 
network administrator or the Windows™ documentation on ‘network names’.

Tip: The TCP-IP address 127.0.0.1 is special because it means ‘the same 
address as this computer’. You should use this address if OCP is running on 
the same physical PC as Myriad. This is known as a loop-through TCP-IP 
address.

Connect Using: Port X

Next to the specific address you can also specify a Port Number by using the 
drop down list. The Port Number system allows a single OCP system to 
accept data from several Myriad or STS systems at the same time. As long as 
each one has a unique Port Number then it can tell the difference between the 
data it receives from each. You must make sure that each Myriad or Myriad 
STS system that links to a central OCP program has a unique Port Number.

The reason for doing this is if you are running an FM and AM service from 
your Myriad network then you can configure a single OCP+ application to 
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provide multimedia information for both. Each station would need to run on 
different Port Numbers in order for OCP+ to be able to tell the difference 
between the information being received and update the correct service 
accordingly.

Number “Next” Items to Send

This option allows you to specify how many Schedule Log Items ahead of the 
current entry to send to OCP. The default is 1 which means that only the 
current and next item information would be available to OCP but if you wanted 
to list the next five Log Items on your web site, you would have to change this 
setting to be 5 (and add in all the extra OCP information accordingly).

Other On-AIR / STS Options

The Other On-Air / STS Options Section offers a number of tick options to 
allow you to configure the information that Myriad supplies to OCP or Myriad 
STS. Tick each option that you wish Myriad to use.

The roles of the options offered in this section are outlined below.

 Allow The User To Manually Update The Information – Setting this 
option will allow a User to manually send information to OCP from 
Carts on the Audio Wall, Carts that are in Cart Players, Log Items or by 
manually typing in information using the Send Manual Information on 



829

the On Air Control menu. Once this option is set and Myriad has control 
of an OCP application, a new right click menu options become 
available when right clicking on Carts, Cart Players or Log Items. 

Selecting the ‘Send the Cart / Log Item’s Information to OCP’ option
will update OCP with the text and picture information for the Cart or 
Log Item that you right clicked on.

You can also manually type in the information that OCP will use by 
selecting the On-Air Control Menu > Send Manual Information option.
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You can then type in the information and then click on OK to send the 
information to OCP.

 Send Now Playing Information For Advert Log Items – Tick this 
option to send the information to OCP for Advert Log Items that are 
currently playing.

 Send Now Playing Information For Cart Log Items – Tick this option 
to send the information to OCP for Cart Log Items that are currently 
playing.

 Send Now Playing Information For Link Log Items – Tick this option 
to send the information to OCP for Link Log Items that are currently 
playing.

 Send Now Playing Information For Songs Log Items – Tick this 
option to send the information to OCP for Song Log Items that are 
currently playing.

 Send Next Playing Information For Advert Log Items – Tick this 
option to send the information to OCP for Advert Log Items that will 
play next.

 Send Next Playing Information For Cart Log Items – Tick this option 
to send the information to OCP for Cart Log Items that will play next.

 Send Next Playing Information For Link Log Items – Tick this option 
to send the information to OCP for Link Log Items that will play next.

 Send Next Playing Information For Song Log Items – Tick this 
option to send the information to Song for Advert Log Items that will 
play next.

 When Triggering Split (STS) Items: Wait For STS To Finish Playing 
The Item – This option instructs Myriad whether it should wait for split 
advert breaks to play before continuing with this next Log Item in the 
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Schedule Log. If this option is ticked and the Schedule Log contains a 
Split Advert Break Log Item, when Myriad starts the Split Advert Log 
Item, it will not continue on to the next Log Item in the Schedule Log 
until the connected STS Master tells Myriad that the break has finished. 
If the option is not ticked then Myriad will trigger the Split Advert Log 
Item and then immediately start the next Log Item in the Schedule Log.

The Log Import Tab

The final tab on the Station Database Settings window is the Ads / Log Import 
tab which allows you to set up the information needed to import both music 
schedule and advert logs from a third party software vendor systems such as 
RCS Selector™ and Broadnet™.  You will not need to use these settings if 
you use AutoTrack or AutoTrack Pro for music / link scheduling or the P 
Squared Advert Manger for advert scheduling.

Song / Jingle Log Files (Music)

There are two sections, the first deals with the settings for importing a music 
log from a third party music scheduler such as Selector™ or Powergold™. 
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Although you can alter these settings from inside Myriad it is recommended 
that you use the settings facility on the actual Log Importer program which is 
used to import the logs.

Logs Last Sent

This information panel shows the last data the 3rd part music / link logs were 
imported into Myriad.

Logs Directory

The Logs Directory setting allows you to select the folder and drive where the 
music scheduling system exports its log file to. To alter this setting, click on 
the Browse button.

Log Filename Prefix

The Log File Prefix allows you to set the prefix that log files are exported with 
from the third party music / link scheduling program. A common file format for 
the exported log is to have a two-letter prefix followed by the date for the file 
so an example might be FM060411.log for a log file for the 11th of April 2006. 
In this case the Log Filename Prefix would have to be set to FM.

Filename Date Format

As mentioned above, the most common form of log file outputted from third 
party music scheduling systems has a file name prefix and the date of the log 
embedded in to the file name (e.g. FM060411.log for 11th of April 2006). This 
option allows you to change the date format that the import utility will use.

Amount To Add To Cart Numbers

This option allows you to off-set the Cart Slot Numbers that are listed in the 
log file generated by the third party music scheduler so that they match with 
the Cart Numbers in Myriad. Let’s say that the music listed in your Selector™ 
system starts at one but your music starts on the Audio Wall at 3001 then by 
adding 3000 to this setting, the numbers will tally up. This option is usually 
only needed if you are adopting a schedule database from another playout 
system, most of the time you would go through and add the correct Cart 
Numbers to each item in your music database.

Use Log Importer Cart Range When Adding Carts
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If you enable this option then when you drag Carts from the Audio Wall in to 
the Schedule Log, it will place them in the log as songs, link or sweepers Log 
Items based on the Cart range that are stored in the Log Importer settings 
section of the Log Importer utility. This means that if your Log Importer is set 
up to treat all Carts between 3000 – 6000 as songs, any Cart dragged into the 
Schedule Log from that Cart range will be added as a Song Log Item.

Advert Log Files

The bottom half of the screen is dedicated to the settings needed to import 
advert logs from a third party advert scheduling systems such as Broadnet™. 
Although you can alter these setting from inside Myriad it is recommended 
you use the settings facility on the Log Importer utility itself.

Logs Last Sent

The Logs Last Sent info panel shows the time and date of the last advert log 
file imported into the system.

Logs Directory

The Logs Directory setting allows you to specify the drive and directory where 
the advert log file generated by your 3rd party advert scheduler is located. To 
select the database you want to use, click on the Browse button and select 
the desired folder location using the Windows Folder Browser window.
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Log Filename Prefix

The Log Filename Prefix allows you to set a text character prefix to the advert 
log file name. Typically, advert log files have a unique prefix and the date of 
the log embedded in the actual filename so an example might be 
AD110406.log for the adverts fir the 11th of April 2006. In this example the Log 
Filename Prefix would have to be set to AD.

NB: The overall filename format needs to tally with the filename format 
generated by your advert scheduling system.

File Date Format

As outlined in the Log Filename Prefix, advert log files usually include the date 
that the file covers in the actual filename and you have one file per day. The 
File Date Format allows you to select the format that this date follows. 

NB: This needs to tally with the date format used by your advert scheduling 
system.

Amount To Add To Cart Numbers

This option allows you to set an ‘off set’ on the numbers that come from the 
advert log generated by a third party advert scheduling system, and the 
adverts that are stored as Carts on the actual Audio Wall. If the first advert on 
your advert scheduling system is number one but the adverts start at 4001 on 
your Audio Wall then you would put 4000 into this setting to make it work. It is 
common practice to put the correct Cart numbers in to your advert scheduling 
system in which case then this setting can be left blank.

Only Use Adverts Marked For Transmission Chain

This setting is concerned with the use of Transmission Chains Codes, which 
are used by some third party advert scheduling systems when scheduling 
adverts for multiple transmission chains. For details on the use of 
transmission codes, please consult your advert scheduling system 
documentation.

Other Settings > Remove Old Log Entries After X Days

This setting allows you to set, on a per Station Database basis, the amount of 
expired Schedule Log information Myriad should keep available on the Log 
Screen.
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If you set this to seven days then Myriad will delete all Log Entries from the 
Log Screen that were played (or where scheduled to be played) seven days 
or more ago. 

Please note that this process only when Myriad you import new music logs in 
to Myriad using the Log Importer utility.

Other Settings > Report Hours That Are Less than XX Minutes

This setting also only applies when you are using the Log Importer utility to 
import 3rd party music / advert logs in to your Schedule Log using the Log
Importer. When you use the Log Import utility to import music or advert logs, 
the system checks the total length of audio Log Items for each hour being 
imported and any hours that have less than the value set here will be reported 
as being potentially short hours. This is particularly useful for automated hours 
where you have more audio content than is needed and it is essential to allow 
Myriad to reach Time Critical Events at the correct time.

Directory Settings

The Directory Settings option on the Settings menu offers access to the 
Directory Settings window which is to instruct Myriad as to which P Squared 
Directory it should be using to configure the use of the Directory itself.
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What is The P Squared Directory?

The P Squared Directory is essentially a contacts database that is used to 
keep contact details and access rights for all the Users of your Myriad system 
as well as Users for other P Squared products and general contacts that you 
may wish to add to the database.

For Users familiar with previous versions on Myriad, the P Squared Directory 
replaces the old Users Database from Myriad v2.6.

The main advantage to the P Squared Database structure over the older 
Users Database system is that the P Squared Directory is common across all 
Directory activated P Squared products (which includes, Scoop, Myriad and 
Powerlog) so you can have a single database for Users for all the P Squared 
Products at your station. The other advantage is that P Squared offer a stand 
alone Database Manager application that can be purchased for installation on 
other (non Myriad) PCs at your station providing you with a low cost central 
contacts database that can be accessed by any enabled PC.

The P Squared Directory is used more heavily in information focused products 
such as Scoop. In Myriad its primary role is to allow you to add Users to your 
system and administer the access rights that they have.

The Directory Settings window is split into three tabs which are examined in 
more detail below.

The General Tab

The General tab is used to set the location of the P Squared Directory 
database file that you wish Myriad to use as well as what Myriad should do 
when you first set up your Directory.
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You can also administer any stand alone P Squared Directory Manager 
software licenses that you may have purchased in addition to Myriad.

Directory Database Path

This Path setting is used to set the location of the P Squared Directory 
Database that Myriad will use to access the Database.

To alter this setting, click on the Change button and then use the Browse for
Folder window to select the folder that your Directory Database is located in 
or the folder that you wish to create it in if you are working on a new database.

Once you are happy with the location, click on the OK button.
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Please note that if you select a Directory Database Path in here that does not 
contain a valid P Squared Database File, Myriad will ask you whether it 
should create a Directory in the folder then next time it restarts.

Click on the Yes button to create a P Squared Directory in the selected folder.

Automatically Create Users When They First Use Directory 
Enabled Software

This setting is only used if you have configured Myriad to automatically 
attempt to login to Myriad when it starts, using the Windows Login name that 
is currently logged in to Windows (see Settings Menu > Myriad Settings > 
General Options tab).
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In this condition, Myriad will attempt to login using the Username and 
Password from the Windows Login but will fail if the Login name is not also in 
the P Squared Directory.
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If you tick the ‘Automatically Create Users’ option on the General tab of 
Directory Settings then Myriad will also create a User contact for the Windows 
login name and password.

Other Licensed Computers > Number of Computers Allowed

This is a very strange setting to find in Myriad as it does not relate directly to 
Myriad in the slightest but rather to the stand alone P Squared Directory 
Manager application which enabled standard PCs to access the P Squared
Directory without any other P Squared products being installed.

The stand alone Directory Manager licenses can be purchased for a low cost 
from sales@psquared.net. Each PC that has the Directory Manager installed 
needs a separate license but the licensing model used for the Directory 
Manager is much simpler than the model used for Myriad. This means that if 
you purchased 10 Directory Manager licenses (they are £30 each at time of 
writing) then you would have a single license code that actually allowed up to 
10 PCs on your network to ‘hold’ a Directory Manager license at any one time. 

The license code issued by P Squared can be entered in this section, you can 
also assign one of the licenses to the PC you are working on (but you would 
not need to as the Myriad Manager offers the same functionality and you  
already have that licensed!).

The Other Licensed Computers panel shows a summary of the amount of 
stand alone Directory Manager Licenses you have and how many have been 
assigned. You can enter, or update your Directory Manager License code by 
clicking on the Change button.
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This opens the Computer Licenses window. To alter the License Name or 
License Code, click on the Change button and type in the relevant details.

Once you are happy, click on the Set button.

The Lower section of the window shows a list of PCs that the Directory 
Manager licenses are currently allocated to.
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The buttons to the right of this list allow you to manage your license 
allocations.

 Edit PC Name Details – Allows you to alter the PC name that the 
license is allocated to. Make sure you type in a valid PC network name.

 Remove License Allocation – This removes the highlighted allocation 
freeing the license to be used by another computer.

 Update List – This option updates the list based on the latest network 
information.

When you are happy, click on the Ok button to save the changes and close 
the window.

The Security Tab

The Security tab shows a list of all the available Security User Groups with the 
currently selected P Squared Directory and allows you to add new Security 
User Groups, edit the existing groups and delete groups entirely.
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The buttons down the right hand side of the window allow you to add, edit and 
remove Security User Groups. These options are examined in more detail 
below.

Adding a New Security User Group

To add a new Security User Group, click on the Add Group button.

Myriad will then add a Security User Group to the list with a default title, type 
in your preferred User Group title and press the <Enter> key on your 
keyboard.
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Your new Security User Group is added to the system.

Important Note: Please note that the top User Security Group in this list is 
the default User Security Group for all new Users added to the system so this 
Security Group should only include the minimum security permissions that 
you want Users to have. That way, if you create a new User but forget to 
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assign a Security User Group, they will only have minimal access rights on 
your system.

Renaming a Security User Group

To rename an existing Security User Group, highlight the group that you want 
to rename and then click on the Rename Group button.

You can then type in a new title for your Security Group.

When you are happy, press the <Enter> key on your keyboard to confirm the 
action.

Edit Security User Group Settings
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Clicking on this button will open the Security User Group Permission window 
which is used to assign security permissions for individual Users or Security 
User Groups.

This important window is covered in detail in the Security Permission Settings 
section of this Chapter.

Delete Security User Group

This option is used to delete the highlighted Security User Group from the 
system. When you click on this option, you will be asked to confirm that really 
do want to delete the User Group.

If you click on Yes then the Security User Group will be deleted but this can 
only happen if there are no Users within the Security Group. If there are one 
or more Users still within the Security User Group the Myriad will not allow the 
Group to be deleted.
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Use Myriad Manager to move all Users from the User Group that you wish to 
delete and then try again.

The Backup Tab

The Backup tab allows you to configure the regularity with which Myriad takes 
backup copies of the P Squared Directory database in case of emergency or 
accidental deletion.

To enable Myriad’s automatic backup of Directory databases, tick the 
‘Automatically backup the Directory database periodically’ option at the top of 
the tab.

Caution: Think carefully before disabling this option. Myriad will automatically 
create backup files and automatically delete older backup files to the whole 
process is maintenance free so there is little point disabling this useful feature!
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How Often Should These Backups Be Created

This section of the window allows you to set the regularity with which Myriad 
backs up your Directory database. The options are:

 Backups Should Be Created Once An Hour – Myriad will take a copy 
each hour of the day. This is the safest option but it generates a lot of 
backup files. You probably do not need to use this option unless you 
add and remove a lot of Users each day.

 Backups Should Be Created Once a Day (Recommended) – Myriad 
will take a backup copy once a day. This is the recommended option as 
it keeps your database safe but does not generate too many backup 
files.

Delete Backups After X Days

This section allows you to set the amount of days after which Myriad will 
automatically delete older backup files. This means that if you set this to 7 
days (for example), Myriad would keep a rolling 7 days of backup files.

You can set this to 0 (zero) then Myriad will not automatically delete any 
backups that it creates.

Security Permissions Settings (User or User Group)

The Security Permissions Settings window is used to set specific Myriad 
related security permissions for an individual User or members of a User 
Security Group.

To change the Security Permissions for an individual User, you will need to 
access this window through the Contacts section of Myriad Manager but if you 
wish to edit the Security Permissions for a Security Group then you can to that 
via the Edit Group button on the Security tab of Directory Settings.
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The Security Permissions window is used to set Security Permissions for 
Myriad but it is also used for setting permissions for other Directory enabled P 
Squared products such as Scoop and Powerlog. If you have other P Squared 
products installed on your PC then you may well have more than just Myriad 
related options in this window but as we are mainly concerned with Myriad 
right now, we will stick with the Myriad based options.

The left hand side of the window shows a list of the P Squared products that 
are available to be configured. You will notice that as well as Myriad, the 
Audio Wall and Directory are listed separately. This is because both the Audio 
Wall and the P Squared Directory are shared by several P Squared products 
and so the settings need to be configured separately from Myriad. To select 
the application (or element) you want to configure permissions for, simply click 
on if on the left hand list. The Security Permissions options are displayed on 
the right hand side of the window.
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Audio Wall > Read Cart Ranges

To view this option, make sure that the Audio Wall is selected in the left hand 
list.

This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to view and play on the 
Audio Wall. 

To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!



851

Audio Wall > Write Cart Ranges

This section allows you to add one or more ranges of Cart Slot Numbers that 
the User or members of a User Group is allowed to record in to or edit.

To add in a new range, click on the ‘+’ button and then add the start and end 
Carts for the range you wish to add.

You can edit the details of a Cart Range previously added by highlighting it 

and then clicking on the Edit Range button .

To remove a Cart Range, highlight the Cart Range and click on the ‘X’ button.

Caution: You will not be asked to confirm so be careful!

Audio Wall > Can Add / Edit / Delete Shared Instant Cart Sets

If this option is ticked, the User or members of a User Group are allowed to 
add, edit or delete shared Instant Cart Sets from the Instant Carts Screen.

Directory > Can Have Personal Contacts
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The User or members of a User Group are allowed to have personal Instant 
Carts on the Instant Carts Screen in Myriad.

Directory > Can Add / Edit / Delete Contacts

The User or members of a User Group are allowed to add, edit or delete 
contacts in the P Squared Directory.

Directory > Can Add / Edit / Delete Users

The User or members of a User Group are allowed to add, edit or delete 
Users in the P Squared Directory.

Directory > Can Add / Edit / Delete Contact Categories

The User or members of a User Group are allowed to add, edit or delete 
Contact Categories in the P Squared Directory.

Directory > Can Have Personal Websites

The User or members of a User Group are allowed to add personal websites 
to the website lists in Myriad Manager.

Directory > Can Add / Delete Websites

The User or members of a User Group are allowed to add or delete websites 
from the shared websites section of Myriad Manager.
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Directory > Can Add / Edit / Delete Websites

The User or members of a User Group are allowed to add, edit or delete 
websites categories from the shared websites section of Myriad Manager.

Directory > Can Edit P Squared Directory Settings

The User or members of a User Group are allowed to edit settings in the 
Directory Settings window.

Directory > Can View P Squared Directory History

The User or members of a User Group are allowed to view P Squared 
Directory History which is a history of Users movements and actions in 
Myriad.

Myriad v3 > Can Edit the Main Myriad Settings

This option allows a User or member of the User Security Group to access the 
Myriad Settings option on the Settings menu.

Myriad v3 > Can Edit the Information Views
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This option allows a User or member of the User Security Group to edit the 
options that appear in the View Menu. These are edited using the View Menu 
tab on the Myriad Settings window.

Myriad v3 > Can Edit the Station Database Settings

This option allows a User or member of the User Security Group to access the 
Station Database Settings option on the Settings menu.

Myriad v3 > Can Choose Between Different Station Databases

This option allows a User or member of the User Security Group to switch 
between Station Databases using the options on the File menu in Myriad.

Myriad v3 > Can Edit the Schedule Log

This option allows a User or member of the User Security Group to edit the 
Schedule Log on the Log Screen in Myriad. If this option is not ticked then the 
User cannot add or remove Log Items or move Log Items around within the 
Schedule Log.

Myriad v3 > Can Remotely Edit the Schedule Log

This option allows a User or member of the User Security Group to remotely 
edit the Schedule Log and record Remote Voice Tracks using the P Squared 
Remote Voice Tracking system.

Please note that not all Myriad systems include the capabilities for this option.

Myriad v3 > Can Import / Export Sections Of The Schedule Log

This option allows a User or member of the User Security Group to import or 
export sections from the Schedule Log on the Log Screen in Myriad.

Please note that not all Myriad systems include the capabilities for this option. 
The Schedule Log Import / Export utility is part of the Advanced Tools Pack.

Myriad v3 > Can Edit the ‘On-Air’ Hour from A Different Database

This option allows a User or member of the User Security Group to override 
the Myriad Setting that prevents a non-‘on-air’ workstation from editing the 
currently playing hour in the Schedule Log. It is recommended that this option 
is used for Programme Controllers that want to retain the ability to edit the ‘on-
air’ Schedule Log from any Myriad workstation.
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Myriad Settings

The Myriad Settings option on the Settings Menu offers access to the Myriad 
Settings window which offers a range of general options related to all aspects 
of configuring and using Myriad.

The Myriad Settings window is arranged in a number of tabs each of which 
contains settings that relate to a specific area of Myriad. In brief, the tabs 
options are: 

 Data Locations – Allows you to set the key base location for data 
stored by Myriad.

 General Options – Includes a diverse mix of Myriad settings that 
covers a wide range of aspects.

 Audio Wall – Includes general Audio Wall related settings.
 Station Database Settings – Allows you to configure how Myriad 

selected the Station Database that should be used as well as option 
Station Database related options.

 View Menu- Allows you to configure the options on the View Menu.
 On Air Control – Allows you to select the type of on-air control that 

you wish Myriad to use.
 Other Settings – Includes options for workstation network ID’s and 

also the configuration and management of Commands Log Items 
available on the Log Screen in Myriad.
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 Advanced – Covers a number of more advanced Myriad related 
options that should not be altered under general conditions.

We will now look at the options on these tabs in a bit more detail.

The Data Locations Tab

The only option on the Data Locations tab is the Path option which is used to 
set the base data location for all of the data files and databases that Myriad 
uses in general operation.

To set the Path for the Myriad Data Location, either type the path into the 
provided field, or click on the Change button to browse for the location of your 
new Data Location folder.
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If you click on the Change button, you will first be warned that changes made 
will not take effect until you restart Myriad.

You can then use the Browse For Folder window to select the folder you wish 
to use.

Please note that the Data Locations tab also displays the sub folders used to 
store various database or information types in Myriad.
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This is for information only, you cannot alter anything but the base Data 
Location, Myriad will automatically create all of the sub folders that it needs.

The General Options Tab

The General Options tab is used to set a range of general options for Myriad 
that do not necessarily refer to specific areas of Myriad.
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To set an option in the General Options tab, click on it to ‘tick’ the box.

Myriad Startup Options > Attempt to Login into the Directory with
the Windows Login Name

If this option is ticked, each time Myriad is loaded, it will attempt to 
automatically login to Myriad using Windows™ Login Username and 
Password. If the Windows Login details match that of a User in the P Squared 
Directory Database then they will automatically be logged in to Myriad.

This setting is very closely related to the Automatically Create Users When 
They First Use Directory Enabled Software option on the General Tab of 
Directory Settings which will automatically create a User in the Directory if the 
Windows Login Username is not found.

Login / User Options > If the Log Is Running, Only Allow Myriad to
Be Closed If A User Is Logged In

The caption for this setting says it all really. Basically, if Myriad is in any of the 
Active Playout modes and this option is set then Myriad can only be shut 
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down when a User is logged in to the system. This prevents the system being 
shut down ‘accidentally’ without realising that it is in Active Playout Mode.

Login / User Options > Let Users Customise Myriad for Their Login 
Name

When this option is ticked, the Customise Myriad option becomes available for 
all Users. This allows them to customise certain aspects of Myriad such as the 
size of Carts on the Audio Wall and the way in which Myriad fades Carts when 
ejecting.

If this option is turned off, Users will not have access to the Customise Myriad 
options. 

This option is set by default.

Login / User Options > Allows Users to Login Using Physical 
Security Keys

When this option is set, Myriad will allow Users to log in and out of Myriad by 
inserting or removing a specially set up USB Security Key. 

A Security Key is just a standard USB hard disk (sometimes called a pen or 
key-ring drive) that has special encrypted security information on it that allows 
it to be used to log in to Myriad. These Security Keys are created using the 
Contacts / Users tab in Myriad Manager (see Myriad Manager Documentation
for more details).

Once this option is enabled, a User can log in to Myriad by plugging in a 
Security Key in to the PC’s USB connector. They can also log out by 
unplugging the Security Key.

This option is not set by default.

Audio Wall Options > Start Carts Playing With Only A Single Left 
Mouse Click (i.e. a touch screen)

When this option is ticked, Carts on the Audio Wall will automatically played 
with a single click from the left mouse button.

The primary use for this feature is when you are running Myriad on a touch 
screen enabled system. Typically, a touch screen emulates a mouse so
simply tapping a Cart on the Audio Wall would automatically start playback of 
that Cart with this option set.

You can use this option with a mouse if you prefer.
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This option is not set by default.

Display Options > Display in Dual Screen Mode Even When Only 
On A Single Screen

This option is designed for use with high resolution monitors (1280x1024 for 
example) or wide screen monitors (1280x800 or higher) and is used to make 
Myriad display both the Audio Wall (or Database / Instant Carts) and the Log 
Screen at the same time, just like in a dual screen configuration, but on a 
single screen.

The screen shot above shows Myriad running in this mode on a wide screen 
monitor.

This option is ideal for a show preparation workstation where dragging Carts 
from the Audio Wall into the Schedule Log is desirable but a dual screen 
system may be impractical.

Segue Editor Options > In Mini Mode, Warn the User before Playing 
Carts

When this option is set, If a User clicks on the Play button on the Mini Segue 
Editor to review a segue, Myriad will reserve the Cart Players that it intends to 
use and then warn the User that it is about to start playback by way of a 
message box.
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In this situation, clicking on OK will start playback in the reserved Cart 
Players. Clicking Cancel will abandon the review process.

This option should always be set on any ‘on-air’ workstations to prevent 
accidental playback in a ‘live’ situation.

Other Options > Enable Limited Myriad v2 Keyboard Shortcuts

Due to the many improvements and new features added to Myriad v3, some 
of the keyboard shortcuts used in Myriad v2 had to be changed in order 
accommodate the new options. This unfortunately means that any station that 
upgrades from Myriad v2 to Myriad v3 and has a special Myriad Keyboard 
(K500, K1000 or K2000) will also have to re-program the keyboard to use the 
new Myriad v3 keyboard shortcuts (see Myriad Keyboard Shortcuts section).

The alternative is to enable this option which configures Myriad to use as 
many as possible of the old Myriad v2 shortcuts. Unfortunately, support is 
limited as not all options can be accommodated. 

It is recommended that this option is only used as a short term solution and 
that Myriad v2 keyboards are re-programmed as soon as possible. The 
software needed to re-program the keyboards should have been included with 
your keyboard originally. If not then P Squared should be able to provide you 
with a copy of the software. P Squared can also provide the necessary 
configuration information to allow you to re-program the keyboard. If you do 
not fancy messing around with your keyboard, for a small charge, P Squared 
can re-program your keyboard for you.

The Audio Wall Tab

The Audio Wall tab contains general Audio Wall related options. These 
include the settings that allow you to configure Myriad to visually mark Carts 
that have been played ‘recently’ and also how often Myriad should check for 
changes made to the Audio Wall by other workstations on your system.
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Display an Icon on Carts That Have Been Played Recently

This is an extremely useful option, particularly for stations that use the Audio 
Wall to present ‘live’ shows because if the Schedule Log is not used then a 
presenter would not know what the previous presenter had played.

This option gets around the problem by automatically marking Carts that have 
been played ‘recently’ with a special icon on the Audio Wall.

To enable this feature, tick the ‘Display An Icon On Carts’ option with enables 
the settings section to allow you to configure the amount of time that the 
Recently Played Icon appears on the Carts.
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You have two options when determining how long a Cart on the Audio Wall 
should be marked as being Recently Played.

 For XX:XX:XX (hh:mm:ss) – If this option is selected, you simply set 
the duration in hours, minutes and seconds that you want the Carts to 
be marked for. This duration will then apply to all Carts on the Audio 
Wall.

 Until It Could Have Been Played All The Way Through XX Times –
This option allows you to set the ‘recently played’ duration in terms of a 
multiple of the overall length of the Cart. This is useful because it 
means the time that Carts are marked as recently played will be longer 
on Carts with a longer overall length. Why? Well let’s say that you set 
this to be 30 then a 10 second Cart (like a jingle) would be marked as 
recently played for 5 minutes (10 seconds x 30) where as a 3 minutes 
Cart (like a song) would be marked for 90 minutes.

You can select the method that will suit your station the best. If you are not 
interested in knowing when Carts have been played in the past then this 
option can be disabled altogether by un-ticking the overall option.

Other Settings > Refresh the Audio Wall Every XX Seconds

This setting allows you to set the frequency with which Myriad will rescan the 
Audio Wall and update with any changes or new Carts added by other 
workstations on the network.

The default for this setting is 20 seconds. If you set this too high then Myriad 
will spend all its time checking for changes to the Audio Wall. Set it too low 
and you may have to wait for changes made on other workstations to take 
effect.
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Please note that this setting only really applies when you are looking at one 
single ‘page’ on the Audio Wall without touching it as the act of moving around 
on the Audio Wall forces Myriad to check for changes anyway.

The Station Database Tab

This tab contains general Myriad settings that relate to the Station Database 
being used by Myriad but not specifically the settings in the Station Database 
(that is handled by the Station Database Settings menu option).

You can also set whether you want Users to be able to edit the currently 
playing hour in the Schedule Log on any workstation other than the On-Air 
workstation.

The options on the Station Database tab are examined below.

Do Not Open a Station Database When Loading

When this option is selected, Myriad will not open a Station Database when it 
first loads. Instead, the Log Screen just contains a button to allow you to 
select a Station Database to open.
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Click on the Open Database button to access the Choose Database window.

Highlight the database that you want to open and then click on OK.

Ask Which Database to Open When Loading Myriad

If you select this option then each time that Myriad loads, it will automatically 
display the Choose Database window to allow you to select the Station 
Database that you want to use.

Again, just highlight the Station Database you want to open and click on OK.
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Always Open This Station Database at Startup

This option allows you to set a Station Database to be loaded each time 
Myriad loads. To select the Station Database that Myriad loads, click on the 
Change button and use the Choose Database window to highlight the Station 
Database you want and then click on OK.

The Station Database that will be loaded at startup is displayed on screen.

Please note that the Choose Database window can also be used to add new 
Station Database, copy and rename existing Station Databases and also 
delete Station databases. For more details, please refer to ‘Adding, Copying & 
Deleting Station Databases Using the Choose Database Right Click Menu’ in 
the File Menu section of this Chapter.
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Log-Editing Options > Only Allow the Current Hour to Be Edited If 
On Air

This option allows you to configure Myriad to only allow the workstation that 
has On-Air (Station) control to be able to edit the ‘current’ hour in the 
Schedule Log. All other workstations would be blocked from making changes 
to the Schedule Log between the currently playing Log Item and the Hour 
Start Marker for the next full hour in the Schedule Log. 

This options can be over-ridden on a per User bases (see Settings Menu > P 
Squared Directory Settings > Security Tab Myriad v3 > Can Edit The ‘On-Air’ 
Hour From A Different Database for more details). If this option is not set then 
any workstation can edit the current hour in the Schedule Log.

Play Logs > Create Advert Reconciliation Logs When On Air

This setting is used in conjunction with 3rd party advert scheduling systems 
such as Broadnet™ and is used to set Myriad to automatically create special 
reconciliation log files whenever the workstation has On-Air (Station) control.

These log files can then be imported back in to the advert scheduling system 
to provide ‘full loop reconciliation’. For more details, please consult a P 
Squared technical support engineer or email support@psquared.net.

The View Menu Tab

The View Menu tab is used to add customisable content to the View Menu on 
the main menu system (see The View Menu earlier in this Chapter).
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This basically allows you to add links to HTML pages (either local or web 
based) to the View Menu so that Users can access the information directly 
from the View Menu. 

View Menu Options > Source

This drop down allows you to select whether to use a local View Menu 
configuration or a shared View Menu configuration.

The options are:
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 Store A Local List Of Views On This Computer – The View Menu is 
configured locally and is unique to the workstation you are working on.

 Use A Shared List Of Views Stored In The Main Data Location –
Use a shared View Menu configuration which is stored in the main 
Myriad Data Location (see Data Location tab in this section).

View Menu Options > Views (Customisable View Menu Content)

The Views section allows you to add, edit or remove the customisable content 
from the View Menu as discussed in the View Menu section earlier in this 
Chapter. The diagram below shows the layout of the View Menu tab and the 
role of the buttons available on the tab.

Here we can see that some options on the View menu have already been 
configured in this window. Each option on the View menu corresponds to an 
entry in this table with the Name column being used for the Name on the view 
menu and the Location column being used for the location of a local or web 
based HTML page that the View menu option will open when selected. You 
may also note that the Separator Line entry between the ’What’s On Guide’ 
and the ‘P Squared Website’ causes the line between the options on the View 
menu.
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Let’s say for example that we want to add another option on the View menu 
that links to a ‘weather’ HTML page stored on the local computer and we also 
want to add a separator line between the P Squared Web Site option and the 
new Weather option.

First click on the Add Option button and tick the Separator Line option to add 
the separator line to the list.

Next click on the Add Option button again and this time type in the Name and 
Location of the Weather option we wish to add.
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Note that the HTML file you are linking to is a local or network file then you 
can click on the Select button to browse your local drives and network 
connections. Click on OK once you are done.

Our View Menu settings window now looks like this with the new Weather 
option added to the bottom of the list.
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Click on OK to save the changes. We can now see the end results on the 
View menu.
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And if we click on the Local Weather menu option:
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The On-Air Control Tab

There has been a lot of talk about On-Air (or Station) Control throughout this 
manual. On-Air control changes the way in which the Log Screen works and is 
used by Myriad Manager when compiling copyright reports but what do we 
mean by On-Air control and why is it needed?

What Is On-Air Control And Why Is It Needed?

In most stations, you may have several Myriad workstations but at any one 
time, only one of them can be playing out content that is actually being
broadcast ‘on-air’. Traditionally, you would designate a studio or resource as 
being ‘on-air’ and the output from that studio would be what your station was 
broadcasting. Depending on the station setup, there may actually be more 
than one studio and ‘on-air’ control is switched between studios as 
circumstances dictate. 

The situation is very similar in Myriad. You may have several Myriad 
workstations but if only one is broadcasting On-Air at a time then we need a 
way of telling which one it is. The reasons that we need to know which 
workstation is On-Air are outlined below:

 Accurate Reporting – Myriad tracks all Carts that are playing 
regardless of On-Air status but sometimes we are only interested in the 
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workstation that is On-Air. Copyright reports are a good example. 
When generating reports for the copyright agencies, you usually only 
want to include Carts that were broadcast as you usually have to pay 
for their use. By using On-Air control in Myriad, the generated reports 
can automatically include Carts that were broadcast On-Air only, even 
if you switched studios several times during the reporting period.

 Security – Myriad can be configured so that the only workstation that 
can perform certain tasks is the On-Air workstation. The most obvious 
of these is the ability to limit editing the current hour of the Schedule 
Log to only the On-Air workstation.

 Communication With External Software Applications Such As 
OCP and Myriad STS – If you are using OCP to update a web site or 
DAB broadcast with information about what is being played ‘On-Air’ 
then you need a mechanism to be able to tell OCP which workstation it 
should be ‘listening’ to. The same is true when you are using Myriad 
STS to deliver split broadcasting to different regions or transmission 
methods.

There are three different levels of On-Air control available in Myriad, they are:

 Fixed On-Air Control – The Workstation is set to always have On-Air 
Control or never have On-Air control. If using this method, you should 
set only one workstation to always have On-Air control and then set all 
other workstations to never have control. If you always use the same 
workstation for broadcasting then this method is good because it 
removes the need to have On-Air control options visible on the Log 
Screen.

 Simple On-Air Control – This is the recommended method if you are 
not using OCP or STS. The simple On-Air Control method is a 
simplified model that works on the fact that only one workstation has 
On-Air Control at any one time. If one workstation has On-Air control 
then all the others are Off-Air. You can configure simple On-Air control 
to only allow another workstation to take control when it is released by 
the current On-Air PC.

 Advanced On-Air Control – This is the most advanced option and 
must be used if you want Myriad to work with OCP or STS. In 
Advanced mode, Myriad workstations communicate with each other 
and other external programs (such as OCP and STS) to ‘discuss’ On-
Air control.

We will now see how the options on the On-Air Control tab are used to 
configure one of these three options.

This Computer Will Never Be On-Air

If you set this option then the workstation you are working on will be set to 
never take On-Air control. This means that the On-Air / Off-Air button will be 
disabled on the Log Screen and the PC will be configured as if it were in Off-
Air mode.
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This option should be used for Admin workstation and any other workstation 
that is not going to be needed for On-Air use.

Always Assume That This Computer Is On-Air

If you select this option then the workstation you are working on will be 
assumed to always have On-Air control. The On-Air / Off-Air button will be 
removed from the Log Screen and the system will be configured for On-Air 
mode.

Caution: You should only use this option for one PC in your Myriad network.

Use Simple On-Air Control

Ticking this option will enable Simple On-Air control in Myriad which is a 
simplified On-Air control method which only allows one workstation to have 
On-Air control. The On-Air / Off-Air button will appear on all workstations that 
have this option set and this button can be used to select On-Air control for 
the workstation in question (see Chapter 5 > On-Air / Off-Air Control Button for 
more details).

Ticking this option also enables the Simple On-Air Control options which are 
outlined below:

Lock On-Air Control So That It Can Not Be Taken Without This One 
Releasing It First

If this option is set, when the workstation you are working on has On-Air 
control and another workstation requests it. It will not be transferred unless 
you manually release On-Air control (by clicking on the On-Air / Off Air 
button). If this option is not ticked then On-Air control can be transferred to 
another PC without you releasing it first.

Take Control When Starting the Schedule Log 

If this option is ticked then On-Air control will automatically be taken (or 
attempted to be taken) by the workstation whenever an Active Playout mode 
(Live, Auto or AutoFade) is activated.
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Use Advanced On-Air Control

Selecting this option will enable Advanced On-Air control which must be used 
whenever you want Myriad to communicate with external software 
applications such as OCP and Myriad STS.

Selecting this option will enable the options for Advanced On-Air which are 
outlined below.

When This Computer Has Control and another Requests Control

The ‘When This Computer Has Control and another Requests Control’ option 
is used to determine what to do in Advanced On-Air control when another 
workstation requests On-Air control. The drop down list is used to select the 
action that you want Myriad to take.
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The options are:

 Release Control Immediately – With this option selected, Myriad will 
automatically hand over On-Air control to any PC requesting it. This 
option should be used for automated ‘playout’ PCs that may need to 
hand control to a live studio workstation.

 Never Release Control – If this option is set, Myriad will never 
automatically release On-Air control. You will have to manually release 
control (by clicking on the On-Air / Off-Air button on the Log Screen) in 
order for another workstation to take control.

When the Computer Needs Control This Computer Should

This computer allows you to configure how Myriad acts when you request On-
air control (either automatically or by clicking on the On-Air / Off Air control 
button). The options are available on the drop down list.
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The options are:

 Only Request Control When Told To By The User – With this option 
set, Myriad will only attempt to gain control when told to by the User (by
them clicking on the On-Air / Off-Air button on the Log screen or using 
the On-Air menu option). If this option is selected, when the On-Air / 
Off-Air button is clicked (on the Log Screen), Myriad will request On-Air 
control from the workstation that has it. Whether you get On-Air control 
will depend how the other workstation is configured (see above 
options).

 Constantly Request Control Silently – When this option is selected, 
the workstation will constantly request On-Air control but it will do so 
‘silently’ which means that whilst it requests control every few seconds, 
the workstation that has control does not tell the User. When running in 
this mode, the workstation will take On-Air control as soon as it is 
released by the other workstations. This option is well suited to 
workstations that are used for automated playout as a ‘sustaining’ 
service. This setting is usually coupled with the Release Immediately 
option outlined above.

 Attempt To Gain Control Anyway – This option should be used with 
caution. When selected, if the User clicks on the On-Air / Off Air control 
button to take On-Air control, the Myriad workstation will take On-Air 
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control regardless of what the current On-Air workstation is set to do 
upon a request.

Take Control When Starting the Schedule Log

If this option is ticked then On-Air control will automatically be taken (or 
attempted to be taken) by the workstation whenever an Active Playout mode 
(Live, Auto or AutoFade) is activated.

The Other Settings Tab

The Other Settings tab is primarily used for two things in Myriad Settings;
firstly it allows you to assign workstations in your Myriad network with usable 
names to make them more identifiable. The second major section of the Other 
Settings tab is concerned with Commands but we will get to them in a minute.

Computer Details
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The Computer Details section allows you to add workstation details for all of 
the PCs on your Myriad network. You can then assign a network ID number to 
each workstation.

The reason for doing this is that when you are working with Myriad Manager 
and you wish to generate play logs or copyright reports, it is useful to be able 
to filter the results to include just the workstations that you are interested in. 
By giving each workstation a human readable name, you make this selection 
process a lot simpler.

Add Computer Name

To add a computer name to this list, click on the Add Computer button. You 
will first see a warning message warning you that the changes you have made 
will be applied to the central computer list and asking you whether you wish to 
continue. Click on Yes to continue.
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A ‘New Computer’ entry will then be added to the list of computer names.

Next we need to edit the details.

Edit Computer Name Details

You can access the Computer Name Details window either by highlighting the 
Computer Name you wish to work with and then clicking on the Edit Computer 
Name button, or you can simply double click on the Computer Name in the 
list.
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You can then add a Name for your computer along with the Network Name (if 
known). Click on OK to save the details.

Assigning a Computer Name to the Workstation You Are Working 
On

This is done by placing a tick in the box to the left of the Computer Name you 
wish to assign.
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Please note that each workstation can only be assigned to one Computer 
Name.

Deleting a Computer Name

To delete a Computer Name from the list, highlight it in the list and then click 
on the Delete Computer Name button (see diagram above for button map).

You will then be warned that the action you are taking will affect the central 
computer list, and asked if you wish to continue.

If you wish to delete the Computer Name, click on Yes and it will be removed 
from the list.

Command Information

The Command Information section of the Other Settings tab is used to view 
and manage the Commands that are available within Myriad. Commands are 
a special type of Log Item that can perform range of tasks. This section allows 
you to add and delete Commands from Myriad as well as edit the details on 
existing Commands.

Types of Commands
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There are four main types of Commands, which are:

 External – Used to run an external window program or application. 
When Myriad encounters an External Command in the Schedule Log, it 
runs the external application detailed in the command then moves on 
to the next Log Item in the Schedule Log.

 Myriad Command – Allows you to add a Command Log Item that 
performs one or more tasks in Myriad. The Myriad Command section 
allows you to construct a special script that can be used to perform a 
variety of tasks (more on this in the New Command section).

 TCP/IP – This Command will send a specific message to a specified IP 
address. When Myriad encounters one of these in the Log, it will send 
the specified message to the desired TCP/IP address and then move 
on to the next Log Item.

 Serial (RS232) – This works in the same way as a TCP/IP message. 
When encountered in the Schedule Log, Myriad will send the specified 
message to the selected serial port.

Commands are designed to be general purpose, problem solving additions to 
the standard Myriad Log Items. 

Add a Command

To add a new Command to the list, (and therefore make it available in 
Myriad), click on the Add Command button to open the Command Details 
window.
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At this stage you have to select the type of Command that you wish to add to 
Myriad using the Type drop down list. The main details screen changes for 
each Type of command you can add so we will tackle each one separately.

Adding an External Command

An External Command allows you to run an external Windows™ application 
from within the Log Screen in Myriad.

To add an External Command, follow these steps.

1. Give your Command a unique name by typing it into the Command 
Name Field.

2. Make sure that External is selected from the Type drop down list.
3. Use the Window Style drop down list to select the way in which you 

want Myriad to run the external application. The options are:
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 Normal With Focus – Application opens in normal window with 
mouse focus.

 Normal Without Focus – Application opens in a normal window 
but Myriad retains mouse focus.

 Maximised With Focus – Application opens maximised (full 
screen) with mouse focus.

 Minimised With Focus – Application opens minimised but does 
have mouse focus.

 Minimised Without Focus – Application opens minimised and 
Myriad retains mouse focus.

4. Command – Type in the location of the application program (.exe) that 
you want Myriad to run when the Command is evoked. Remember that 
you can include ‘command line switches’ in this Command field should 
you wish to.

Click on OK to save the Command Details and add the Command to 
the Commands List.

Adding a Myriad Command

A Myriad Command is a specially scripted sequence of events that will 
happen when Myriad executes the Myriad Command. This is done by using a 
simple ‘script’ style language that gives a list of instructions for Myriad to 
complete before moving on to the next Item in the Schedule Log.
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To add a Myriad Command, follow these steps:

1. Type in a name for your Myriad Command using the Command Name 
field.

2. Make sure that the Myriad Command option is selected using the Type 
drop down list.

3. Type the Myriad Command sequence into the Command box paying 
close attention to the syntax as described in the Myriad Command 
Script reference outlined below.

4. When you are happy, click on OK to save your Myriad Command and 
add it to the list.

Myriad Command Script Reference

As detailed above, the Myriad Command is a series of instructions for Myriad 
to carry out as part of the Command Log Item. When creating the Myriad 
Commands, it is important that the syntax of the script language used is exact 
as Myriad will only follow correctly formatted scripts.

The reference guide below details the script commands that are available for 
use in Myriad v3. Myriad Commands are intended to be used by advanced 
users only. Beyond this reference, the Myriad Command script language falls 
outside the scope of this documentation.

Note: Parameters shown surrounded by square brackets - [] are optional

MyriadCommand Reference:

Command | Usage
COMMAND | Run another MyriadCommand sequence

| Example: COMMAND PlayNewsCart
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CART/ | Used to Play, Pause, Cue/Recue, Close/Eject a cart or a 
player

HARDDISK/ | Commands:
HDITEM | PLAY Player[,Reference][,Sync] - Sync is used to wait 
until the cart has finished playing.

| CUE Player[,Reference]
| RECUE Player[,Reference]
| PAUSE Player
| CLOSE Player
| EJECT Player
| Example: PLAY 1,3001,1
|(This will play cart 3001 in player 1 and wait until it 

finishes

INSTANTCART | Used to Play or Cue a specified Instant Cart
| Commands:

            | PLAY Reference[,Sync]
| CUE Reference

            | Example:INSTANTCART PLAY 2,1
| (This will play Instant Cart 2 and wait until it 

finishes

DEBUG/ | Used to change the debugging mode used when diagnosing
problems.

DEBUGMODE/ | Commands:
  OFF/NONE/0 Turn off debugging
  MEDIUM/5 Medium debugging
  ON/HIGH/MAX/10 Full debugging

HARDWARE | Used to Set/Clear/Flash/Pulse a hardware line 
| Example: HARDWARE Pulse 12
| (This will cause line 12 to pulse)

LOG | Used to change the Log mode or move around in the log
QNXT | Commands:

  GO Move on to the next item in the Log
  PRECUE Precues the next log item ready to play
  TOGGLEENDING  Changes the ending of the currently 

playing item

  ITEM Changes to the currently highlighted Item
  PREVIEW Previews the highlighted item 
  TOGGLEDELETE Deletes/Restores the highlighted item
  TOGGLEENDING Toggles the ending of the highlighted item

  VIEW Changes the Log View
  HOME Jump to 'now'
  NEXTHOUR Scroll up to nearest hour start
  PREVHOUR Scroll down to next hour start
  PAGEUP Scroll up one page
  PAGEDOWN Scroll down one page
  SCROLLUP Scroll up one line
  SCROLLDOWN Scroll down one line

  MODE Change QAE's running mode
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  HOURMODE Change to the original play mode for the 
current hour

AUTOFADE Change to AutoFade mode
AUTO/AUTOMATION Change to Auto Mode
LIVE/LIVEASSIST Change to LiveAssist Mode
STANDBY Stop the Log Running

TOGGLE Toggles the mode between Standby and 
the Hour's original mode

ONAIR | Used to Take/Release 'On-air Control'
| Commands:
TAKE/REQUEST Request/Take On-Air control
RELEASE Release On-Air control
MESSAGE Advanced: Sends a formatted network 

message to the On-Air device being Controlled

WAIT | Waits for a number of seconds
| Example: WAIT 5
|(this will wait for 5.5 seconds)

WEB | Opens the Quick web browser and displays a specified 
file or webpage

WEBBROWSER | Parameters: URL,Caption

WEBVIEW | Commands:
| VIEW Display the given URL
| Example: WEB VIEW http://www.psquared.net,P Squared's 

Website

If you can not really work out what this is all about, don’t worry, you will not be 
alone. If you are really stuck then why not email support@psquared.net if you 
need some additional helpful advice.

Adding a Serial Command

A Serial Command is used to send a specific sequence of numbers and 
characters to the computers serial (RS232) port in a specific format. This may 
be controlling external devices or sending commands to remote computer 
systems.
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In order to understand these settings, you will need a fairly good 
understanding of RS232 (serial) communication as the meaning of the various 
protocols used falls outside of the scope of this documentation.

To add a Serial Command, follow these steps:

1. Give your Serial Command a name using the Command Name field.
2. Make sure Serial is selected using the Type drop down.
3. Select the Serial Port that you want using the Serial Port drop down 

list.
4. Check that the Settings are correct. The format for this settings string 

is: baudrate,parity,databits,stopbit so 9600,n,8,1 means 9600 baudrate, 
no parity, 8 data bits, and 1 stop bit. All you really have to do is match 
these settings to the equipment you are sending the Serial Command 
to.

5. Use the Handshaking drop down list to select the handshaking type 
you wish to use. Again, this will depend on what you are connecting to.

6. Type in the actual message that you want to send in the Command 
section.

7. Tick the ‘Leave the Connection Open’ option if you want Myriad to 
leave the serial port open at the end of the message.

8. Tick the ‘Use Existing Connection’ option if you want Myriad to make 
use of an open Com Port if possible.

Adding a TCP/IP Command

The TCP/IP Command option is very similar to the Serial Command in that 
when Myriad encounters one in the Log, it will send the specified message to 
a specified device only instead of using RS232 (serial) it will use TCP/IP to 
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send it over the network. This feature can be used for a wide variety of 
applications such as network monitoring or triggering external events.

Again, it is assumed that an understanding of TCP/IP technology is assumed 
in this section of the documentation.

To add a TCP/IP Command, follow these steps:

1. Give your TCP/IP Command a name using the Command Name field.
2. Make sure TCP/IP is selected from the Type drop down list.
3. Type in the IP address that you want Myriad to send the message to 

using the IP Address field.
4. Type in the Port Number that you want to use via the Port Number 

field.
5. Select either TCP/IP or UDP/IP using the Protocol drop down.
6. Type in the message you want to send using the Command field.
7. Tick the ‘Leave the Connection Open’ option if you want Myriad to 

leave the IP port connection open at the end of the message.
8. Tick the ‘Use Existing Connection’ option if you want Myriad to make 

use of an open IP connection port if available.

When you are happy click on the OK button.

Editing an Existing Command

To edit an existing Command you have two options. You can either highlight 
the Command in the list and the click on the Edit Command button.
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Or you can double click on the Command itself.

In both cases, the Command Details window opens which allows you to alter 
the details for the selected Command.

Deleting an Existing Command

To delete an existing Command, highlight the Command in the list and then 
click on the Delete Command button.

You will be asked to confirm your actions before the Command is deleted. 
Click on Yes to delete the selected Command.

The Advanced Tab

The Advanced tab is home to some of the more advanced Myriad settings 
and as such, you should not really play with the settings in here unless you 
are confident that you know what you are doing. Unlike most of the tabs in 
Myriad Settings, the options on the Advanced Tab are not related to any 
specific areas in Myriad.
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Application Process Priority

This option allows you to alter the processing priority that Windows™ gives 
Myriad in normal operation. Under normal circumstances, Myriad should be 
given Normal Priority but if you are running several other applications on the 
same PC and you want Myriad to take priority over the other applications, it 
might be worth putting Myriad’s priority up a notch.

There are four options in total but you should only alter this setting if directed 
to by a P Squared Technical Support engineer.
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Configuration Profiles > Manage

Configuration Profiles allow you to effectively save the particular setup 
information and configuration options for Myriad to be reloaded at a later date.

In practice, the most common application for this is if you are running several 
different radio stations from a single Myriad system and the different stations 
use totally different Data Locations, Audio Wall File Locations and settings 
etc. In which case you could set up two profiles (one for each) and each time 
you start Myriad, you select the Configuration Profile that you want to use.

Another common use for this is to have a ‘backup’ profile that is configured to 
use audio and data locations on a backup hard drive or backup server.

Profiles are added and managed using the Profile Manager window. To 
access this window, click on the Manage button.

Configuring Myriad to Have Multiple Configuration Profiles

The Profile Manager window is accessed via the Manage button on the 
Advanced tab of Myriad Settings and is used to switch Myriad to using 
multiple Configuration Profiles and to add and remove the available 
Configuration Profiles.

To configure Myriad to use multiple Configuration Profiles, select the ‘Allow P 
Squared Applications to Use Different Configuration Sets (Profiles)’ option. 
This will also enable the main Profile Management window which list available 
profiles and allows you to add and delete Profiles.

To add a new Configuration Profile, click on the Add Profile button.
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You will then be asked to provide a name for your new Profile.

Once you have typed in the new Profile name, click on OK.

You will then be asked to confirm that you want to create the new 
Configuration Profile. Click on Yes to create the new Profile.
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Next time you quit Myriad and then restart it, you will be asked which Profile 
you wish to use.

Once you have loaded Myriad with your new Profile, any changes you make 
to the configuration will be stored in the settings for the selected Configuration 
Profile.

You can switch back to using a single Configuration Profile by selecting the 
‘Only Allow One Set Of Configuration Options’ option (at the top of the 
window). In this case, the highlighted Configuration Profile will be used.

You can edit the description for a Configuration Profile by clicking on the Edit 
Profile button.
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This will then allow you to ‘over type’ your new Profile name.

Finally, you can delete a Configuration Profile by highlighting it and then 
clicking on the Delete Profile button.
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You will then be asked to confirm that you wish to delete the selected Profile.

If you click on Yes, the Configuration Profile will be deleted immediately and 
there is no way to recover deleted Profiles.

Global Settings > Debugging Level

This is a Global Setting and it applies to all Configuration Profiles. 

This setting allows you to set an overall level of debugging mode in Myriad 
which is a special mode where lots of information is logged to a text file that P 
Squared engineers can use to track down system faults.

In general, Myriad should be run with the ‘No Debugging Information Will Be 
Generated’ option selected. In this mode, Myriad does not keep track of 
debugging information and does not generate debug files.

If you are experiencing problems, a P Squared Technical Support Engineer 
may ask you to switch to ‘Create Normal Amounts of Debugging Information’ 
mode where Myriad keeps track of a number of key factors and generates 
modest debug files that can be sent to P Squared in the event of a problem. In 
this mode, Myriad will run fractionally slower but the difference should be 
marginal.

As an additional note, if you are asked to run in debug mode to track a 
particular problem. You should stop Myriad as soon as the problem occurs 
and then copy the entire debug files (found in the root of the C drive and 
called smplayer1.dbg to smplayerX.dgb) to a safe place ready to be sent to P 
Squared. The reason for this is that Myriad over-writes debug files once they 
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reach a certain size so useful information could be lost if you do not copy the 
files as soon as the problem occurs.

The ‘Create Maximum Amounts of Debug Information’ option should only be 
used in extreme circumstances as a great deal of information will be recorded. 
Myriad is not likely to perform to a satisfactory level while in this state.

Automatic Logon Settings (for logging in to Windows™)

Myriad has the ability to configure your overall Windows™ system to 
automatically login to Windows™ using a specific Login Name and Password.

This is important because if you have a Myriad workstation running in 
automation and there is a power cut. Myriad can be configured to 
automatically detect this and restart in automation in the appropriate place in 
the Schedule Log. 

This ability is dependent on two factors however. Firstly, someone or 
something needs to log in to Windows™ in order for any applications to run 
and secondly, Myriad needs to be in the ‘start up group’ so it is automatically 
launched when Windows™ loads. The second is easily achieved by copying 
the Myriad shortcut in to the Start Up section of the Start bar. The first can be 
achieved by using this configuration option to supply Myriad with a username 
and password to automatically log in to Windows™ with.

To set the login name and password you want Myriad to log in to Windows™ 
with, click on the Change button.



902

This will open the Windows Automatic Logon window which allows you to 
enter the Username, Password and Domain that you want to use. To enable 
this option you will also need to tick the Automatically Logon option.

You will see that the Advanced tab is updated to display the information that 
Myriad will use to login to Windows™.

Myriad Will Not Update the Time and Date for the Computer

If this option is set then Myriad will not attempt to update the computer time 
and date and the standard system time and date will be used for displaying 
time and AutoFade Playout Mode by Myriad.

It is recommended that you have a central time and date server (which can be 
any PC) which is either using a radio clock or is getting it’s time from a web 
time server. All of the other PCs can then ‘sync’ their time from that.

An explanation on how to set up a PC as a ‘time server’ and then synchronise 
all the other PCs from that can be found on the P Squared Forums which you 
will find at http://forum.psquared.net

Myriad Should Automatically Update the Date and Time Using: X

This setting should be enabled if you have a P Squared supplied Galleon 
Rugby Radio Clock attached to your system via a serial port. If you have 
purchased one of these radio controlled clocks (or sourced the same model 
from another company) then you should enable this option.
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Once the clock is attached to a valid Com Port, ensure that Galleon PC Serial 
Time / Date is selected from the drop down list and select the correct Com 
Port using the ‘Connected To’ drop down list.

Once you are happy it is all connected and configured correctly, you can test 
that the clock is getting a strong enough signal by clicking on the Test button.

The Test Radio Clock window shows the strength of the radio signal that the 
Radio Clock is receiving. You will need to get a fairly constant 60% or greater 
for the clock to function. When you first open the window, the signal will 
appear erratic. It will take approximately 1 minute to settle down to a valid 
indication of the signal strength. If you are getting less than 60% then you 
should consider repositioning the clock to get a better signal. If the reading 
remains on 0% then check that the batteries in the clock are fitted correctly 
and that you have configured Myriad to use the correct Com Port.

When you are happy with the signal strength, click on OK.

License Details

The License Details option on the Settings Menu offers access to the Myriad 
License Wizard which is used to enter the initial license code for Myriad as 
well as subsequent annual (or more regular) license codes which are issued 
by P Squared as an anti-piracy measure.
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Selecting this option will open the P Squared Software License Wizard which 
will walk you through the process of entering an initial license or renewing an 
existing license.

Myriad v3 uses an advanced licensing system to prevent software piracy and 
to safeguard the future of Myriad™ and other P Squared Ltd products.

The advanced licensing procedure generates a special code (called a 
PSQUISH) that is unique to your computer. The first time that you activate 
Myriad you will need to provide this code to P Squared Ltd in order to 
complete the licensing process. Subsequent codes can be obtained 
automatically (assuming you have web access) but you may have to contact 
P Squared Ltd periodically in the future. 

Manually Obtaining a License Code

The standard licensing procedure for manually obtaining a license code is:

1. Select the License Code option from the Tools menu. The License 
Wizard will run automatically the first time that you run Myriad or if you 
run Myriad once your license has expired,

2. If this is the first time that you have licensed Myriad or you have not 
ticked the option to skip the introduction screen the last time you 
entered a license code, the introduction screen will be displayed.
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3. Read the screen, and then tick the “Skip this screen in the future” 
option unless you want to read this introduction each time. Then click 
on Next.

4. You will then see a summary of the current license status of Myriad. In 
the example below, you can see that we currently have a valid license 
that is not due to expire for some months. If you are entering a license 
for the first time then this information will be blank. If you wish to 
proceed, click on the Next button.
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5. If you do not need to license Myriad, the License Wizard will warn you 
before you proceed to the next screen, if you want to proceed anyway 
then click on OK.

6. The next phase is to enter your registration details. You will only have 
to do this the first time; the information will be loaded automatically on 
subsequent license procedures

The first thing that you have to enter is your P-SQUID or P Squared 
Unique ID which is your P Squared unique customer ID and will be 
provided by P Squared. Your P-SQUID will be at the top of all quotes, 
or purchase orders that you receive from P Squared and should be 
quoted whenever you contact P Squared. To enter or alter your P-
SQUID, click on the Change button and type in the new P-SQUID

Next add in your contact details by clicking on the Change button by 
the contacts summary window.
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You are required to enter your name and a valid email address; these 
details will be used when processing requests for ‘online’ license 
renewals in the future. You may also fill in the additional information if 
you wish. Once you have finished, click on OK to return to the main 
wizard and then click on Next to move on to the next step.

7. The next step in the license wizard allows you to enter the License 
Name and Features Code for the product. Both of these will be 
provided by P Squared with the purchased product or we can give you 
the details over the phone.
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Type in the License Name exactly as it is give to you by P Squared and 
then click on the Set button. Repeat the same procedure for the 
Features Code.

NB: It is possible to obtain a Features Code ‘online’ by clicking on the 

 button. When you select this option, the progress of the ‘online’ 
Features Code generation is shown on screen and if a code is 
successfully generated, it will be added to the Wizard window. Please 
note that this option will generally only be available to existing 
customers who have licensed Myriad previously.
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Once the License Name and Features Code have been set, you can 
alter them by clicking on the appropriate Change button. If you are 
happy, however, click on Next to proceed.

8. The next screen allows you to choose the method that you want to use 
to obtain your Myriad license code.
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Each option is explained on screen as you can see from the image 
above.

In this case, let’s assume that we want to manually enter the code and 
we intend to phone P Squared to give them details needed to activate 
the product. Select ‘Manually Enter a New License Code’ and then 
click on Next.

9. The next screen displays the P-SQUISH code which is a unique code 
that is used to generate your Myriad license. The P-SQUISH is unique 
to your contact, details, the PC you are working on and the time and 
date that you generate it.
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The P-SQUISH is only valid for a few days so you should contact P 
Squared as soon as possible to let them have your P-SQUISH code. 
You can do this by either:

 Telephoning: +44 1482 383700
 Emailing: licenses@psquared.net
 Faxing To: +44 1482 383701

Once P Squared has a valid P-SQUISH code, they will then provide 
you with a License Code that you need to type in to the New License 
Code part of the screen before finally hitting Finish.

10.Clicking on Finish will end the licensing process. A short summary 
screen will be displayed before you can proceed on to using Myriad.
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Automatically Obtaining a License Code

In general, the first license code that you receive will have to be processed 
manually but once all your details are registered with P Squared, subsequent 
licenses can be obtained ‘online’ without the need to contact us. This means 
that you can renew your license at your convenience providing that your PC 
has a web connection. 

To obtain a license code ‘online’, follow these steps.

1. Select the License Code option from the Tools menu.
2. The introduction screen is usually skipped when renewing a license. In 

this case, the first screen you will see is the Current License Details 
screen which shows you when the current license was entered and 
when it is going to expire.
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3. Click on Next to move on to the P-SQUID and Personal Details screen. 
You only need to alter the information on this screen if it has changed. 
If not, click on Next to move on to the next screen.

4. Next you will see the License Details screen. Again, unless you need to 
need to alter any of this information, you can click on the Next button to 
move on to the next window.
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5. The License Method window allows you to select the way in which you 
want to obtain your License Code. In this case, we want to renew the 
license online so we need to make sure ‘Obtain a License Code Online’ 
is ticked and then click on Next.

6. Finally, you will see a brief summary screen before Myriad attempts to 
obtain a license ‘online’. Click on Finish to begin the process.
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At the end of the process, you will be told whether your license code 
was successfully renewed or whether you need to contact P Squared 
to continue the licensing process.

For more information on P Squared product licensing, please refer to 
www.psquared.net/support as well as your P Squared Software 
License Agreement.
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Common Configuration Questions

Whilst we have finished with the Settings Menu as a whole, it may be useful to 
go though a few of the most commonly requested configuration options to 
save you trawling through the menu system to find the one option you want. In 
this section we will cover some of the most common configuration questions 
step by step. It assumed that you have already reviewed the options in the 
Settings menu and are familiar with all the concepts.

The list below is by no means exhaustive but it does cover some of the more 
commonly asked questions regarding configuration of Myriad. Remember, 
you can always visit the P Squared Forum (www.forum.psquared.net) if you 
have a question that you want to ask, but before you do so, please take a few 
minutes to browse the existing posts as it is possible somebody has already 
asked the exact same question and the answer is already waiting for you.

How Do I Change The Cart Size And Text Size On A Per User 
Basis?

1. Click on the Tools Menu and select Customise Myriad.
2. Click on the Audio tab on the vertical tab strip.
3. Click on the Cart Display tab on the horizontal strip.
4. Set the new Maximum Width (in pixels) to change the horizontal width 

of the Carts on the Audio Wall.
5. Set the new Maximum Height (in pixels) to change the vertical height of 

Carts on the Audio Wall.

6. Click on the Cart Font button  to access the Font Selection 
window.

7. Pick a new Font and Font Size and click on OK.
8. Myriad has just been customised to have different size Carts for the 

User logged in.

How Do I Add Custom Options On The View Menu?

1. Click on the Settings Menu and select the Myriad Settings option.
2. Click on the View Menu tab.

3. Click Add View Options button  to open the View Options details 
window.

4. Type in the View Item Name (what will appear on the View Menu).
5. Type in the location of the HTML page you want to be displayed when 

the View Option is selected. It can be a local or remote HTML page.
6. Click on OK. Your option has been added to the View Menu options.



917

How Do I Increase / Decrease The Amount Of Carts On My Audio 
Wall?

1. Click on the Settings Menu and select the Audio Wall File Settings 
option.

2. Next click on the Global Audio Wall Settings button at the bottom of the 
screen. This opens the Global Audio Wall Settings.

3. Make sure you are on the General tab of Global Audio Wall Settings.
4. Click on the Change button for the ‘Number of Carts That Can Be 

Stored on the Audio Wall’ setting and type in the maximum number of 
Carts you want to use.

5. Click on the Set button.
6. The Audio Wall has now bee expanded (or contracted) as per your 

setting.

How Do I Change The Amount Of Cart Players On My System?

1. Click on the Settings Menu and select the Audio Settings option.
2. Make sure that the Cart Players tab is selected.
3. Locate the ‘Number of Cart Players to Use’ option (top option) and click 

on the Change button.
4. Type in the new number of Cart Players that you want to use in the 

provided field.
5. Click on the Set button.
6. You may also wish to manually assign a sound card output channel to 

any new Cart Players; this is done by selecting Manually Assign and 
then using the drop down lists to assign sound card channels to Cart 
Players.

7. When you are done, click on OK.

How Do I Change The Audio Quality & Format For Recording?

1. Click on the Settings Menu and select the Audio Settings option.
2. Select the Recording / Editing tab.
3. Locate the ‘New Audio Will Be Recorded Using the Audio Format’ 

option (at the top of the window) and click on the Choose button to 
change the format.

4. Use the Choose Audio Format window to select the new audio format 
and quality.

5. Click on OK when you are done.

How Do I Change The Range Of Carts That Voice Tracks Are 
Recorded Into?

1. Click on the Settings Menu and select the Station Database Settings 
option.
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2. Make sure that the General tab is selected.
3. Locate the Segue Editor / Voice Link Settings section (in the middle of 

the window).
4. Type in the Cart range that you want to use for Voice Tracks using the 

appropriate fields.
5. You can also alter the audio quality and format of Voice Tracks and the 

audio volume trigger level from this section should you wish to.
6. Click on OK when you have finished.

How Do I Alter The Normalisation Level For Audio Imported Into 
Myriad?

1. Click on the Settings Menu and select the Audio Wall File Locations 
option.

2. Click on the Global Audio Wall Settings button at the bottom of the 
window.

3. Select the Importing Audio tab on the Global Audio Wall Settings 
Window.

4. Alter the ‘Normalise Imported Audio To’ setting in the Other Options 
section towards the bottom of the screen. 

5. You can also configure Myriad to get Title and Artist Information from 
the web on this tab.

6. Click on OK to save your changes.

How Do I Get Carts Played Recently To Be Marked On The Audio 
Wall?

1. Click on the Settings Menu and select the Myriad Settings option.
2. Switch to the Audio Wall tab.
3. Tick the option to ‘Display an Icon on Carts Played Recently’.
4. Type in the duration that you wish Carts to be marked for or 

alternatively, the amount of times that they could have been played.
5. Click on OK to save changes.

How Do I Re-License Myriad?

1. Click on the Settings Menu and select the License Details option.
2. Work through the License Wizard. If you get stuck, refer to the License 

Details section of the documentation but in most cases, reading the 
text on screen will answer your questions.

How Do I Upgrade To A Newer Build Of Myriad?

1. Make sure you are logged in as Administrator.
2. Download the latest version of Myriad.
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3. Shut down Myriad on the workstation you are upgrading.
4. Click on the Start button and select Control Panel.
5. Double click on Add / Remove Programs.
6. Scroll down until you see P Squared Myriad v3 and click on the 

Remove button.
7. Don’t worry, none of your data will be lost, you will not have to re-

configure and your license code details will be retained.
8. Once Myriad has been removed, run the new Myriad installer program.
9. Follow the on screen instructions to complete the installation process.

Myriad Locks Up When Using Cart Players 2 And Above, What Am 
I Doing Wrong?

This is by far the most commonly asked question in technical support and 
sadly it is a fault with the sound card drivers that we sometimes use. If you are 
using either an Echo card (Gina, Darla, Mia or Layla 3G) then the chances are 
that there is a setting incorrectly set in your driver settings that will be causing 
all sorts of playback issues in Myriad. Thankfully the answer is simple and is 
outlined below.

This is caused by a setting called ‘Sync Wave Devices’ being set when it 
should be switched off for Myriad use. To change the setting, load up the 
Echo Audio Console and click on the Options or Settings button (it is different 
for different driver version numbers). Look around for the ‘Sync Wave 
Devices’ option and turn it off. You should find this solves the problem.

The Help Menu

The Help Menu option in Myriad offers access to information about the latest 
updates to Myriad; and also shortcuts to the P Squared websites, discussion 
forums and online technical support resources.

In addition to this, the Help menu offers access to the P Squared Support File 
generator which is a special tool that can be used to compile a report that can 
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be automatically uploaded to P Squared. These support files contain a whole 
host of information about your system and can be used by P Squared 
engineers to help pinpoint problems with your system.

Finally, the Help Menu offers access to a specially formatted version of this 
manual that can be downloaded and added to your system to allow Users to 
browse the documentation while using Myriad.

Myriad Help System

This option is only enabled if you have downloaded the specially formatted 
version of this documentation and copied it to the applicable folder in your 
Myriad Data Location.

If this option is available, click on it to load a PDF version of this manual but 
keep in mind that it is a very big document so it is probably not a good idea to 
be browsing while you are broadcasting ‘live’ from the same workstation.

Create P Squared Support File

Clicking on the Create P Squared Support File option will open the Create P 
Squared Support File window which allows you to add in the all the 
information that you need in order to create a P Squared Support file. Some of 
this information will be supplied by the P Squared Technical Support Engineer 
that requests the file in the first place. The details you need to enter are 
outlined below.
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P Squared Support ID

This is a unique ID number that is assigned by P Squared for the support 
issue that you are currently working on. Every time you contact P Squared 
with a new technical support enquiry, the P Squared support system 
automatically assigns a unique ID number that allows us to track your support 
issue, recall the details if you contact us again and to ensure that we do not 
have issues that go unresolved. 

You will usually be generating a Support File at the request of the Technical 
Support Engineer who is dealing with your enquiry and they should provide 
you with the Support ID for issue you are working on when they request the 
Support File. You will also find the Support ID at the top of all e-mails you 
receive with respect to the issue you are working on. If you do not have a 
Support ID, please contact P Squared prior to generating the Support File.

Send Cart Play Log Files

If you tick this option then Cart Play Log files for the selected dates (see Start 
/ End Date) will be included in the Support File that is generated and sent to P 
Squared. You should include Play Log Files for a day either side of the dates 
that your issue occurred.

Start / End Dates

You can use these settings to set the Start and End Dates for the Play Logs 
that you want to be included in the Support File being generated.

Use the drop down option to select the dates that you want to include.

Send Audio Wall Information

Ticking this option will include the special Cart List files that Myriad uses to 
search and display the Carts on your Audio Wall. It is worth including this 
information in all Support Files generated as they do not make a big 
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difference to the size of the support file but give P Squared a great deal of 
information about your system.

Send P Squared Directory

This option will include the P Squared Directory database as part of the 
Support File being generated. Normally, this option would only need to be 
ticked if your support issue is related to Users or User History but the P 
Squared Directory does contain a great deal of information so under some 
circumstances, the Support Engineer may request that you include it even if 
the link is not apparent.

Send Station Database

This option will be used in the majority of cases - ticking it includes the Station 
Database in the Support File bring generated and as the Station Database 
includes the Schedule Log and a great deal of the settings for Myriad, it will 
normally be essential in tracking down the majority of problems in Myriad. 

When you tick this option, you then have to select the Station Database that 
you wish to send using the Choose button.

Clicking on this button will open the Choose Database window.

Highlight the Station Database that you want to include in the Support File 
and then click on OK.
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Send Cart

This option allows you to specify a specific Cart to be included in the Support 
file being generated. If you are having problem with a specific Cart then it is a 
good idea to include it in the Support File.

Select the option and the type in the Cart Slot Number of the Cart you wish to 
include.

Reason for Sending Support File

This field allows you to type in a brief summary of the reason for generating 
the Support File. Normally, you would be asked to generate a Support File as 
part of an ongoing support issue and the Support ID will identify the support 
issue so P Squared will already know what the support issue is about, but it is 
a good idea to write a quick summary to avoid any confusion.

Edit Personal Details

The Support File generated contains a range of additional information on top 
of the options selected (such as registry keys etc). One of the information 
types included in the Support File are the contact details of the person 
sending the Support File. By default, Myriad will use the Contact Details 
entered when you initially licensed the product but you can alter this 
information by clicking on the Edit Personal Details button.
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When you are happy with the personal details that will be sent, click on the 
OK button.

Make File

The Make File button is used to actually generate the Support File.
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While Myriad is working to generate the Support File, you will see a progress 
bar along the bottom of the screen showing how far there is to go. You can 
click on Stop to abandon the process if you wish. 

Once the process is finished, you will be asked whether you wish to 
automatically upload the Support File to P Squared.

If the workstation you are working on has a web connection then you can click 
on Yes and Myriad will automatically upload the file to the special support FTP 
site. This is then accessed directly by the P Squared internal support system 
and support engineers are alerted to its arrival.

Depending on the size of the Support File, the Station Database and any 
Carts Included, the process can take anything from a few minutes to several 
hours. Progress is displayed along the bottom of the window and you can 
abandon the send process by clicking on Stop if you wish.

Once the Support File has been uploaded, you get a message confirming that 
it was successfully sent.
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If you do not have a web connection on the PC you are working on then you 
need to select No. 

If you select No then you can choose a file name and location for the Support 
File. You can then send it to P Squared as an email or burn nit to disk to be 
sent at your convenience.



927

Support Files are a vital part of the technical support offered by P Squared so 
being familiar with this section of Myriad is a good idea.

Update Information

Each time you install a new version of Myriad, there is an RTF (text) file that is 
installed at the same time that outlines all the changes, new features and bug 
fixes that the new version includes.

The Update Information option provides access to this file from within Myriad. 
Clicking on this option will open the Update Information window.

It is a good idea to read this document each time you install a new version of 
Myriad as it will familiarise you with any new features or facilities included with 
the build and alert you to any bugs that have been fixed.

P Squared on the Web

The P Squared on the Web option expands to offer access to a range of P 
Squared related web sites. To access these sites you will need a web 
connection on the PC you are working on.
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The options are:

 P Squared Forum – Access the online P Squared discussion forum 
where you will find a wealth of information about all P Squared 
products and an opportunity to share your questions / views with other 
P Squared users as well as the P Squared Support Team.

 Online Technical Support – Direct access to the P Squared support 
site which offers product downloads, documentation and general 
support advice.

 Licensing Information – Provides information on P Squared licensing 
policies and procedures.

 P Squared Home Page – Access to the main P Squared web site 
which includes the latest news and product information, pricing and 
access to the support and forum sites.

About Myriad

The About Myriad option on the Help Menu offers access to the About Myriad 
screen which displays a range of information about the build of Myriad that 
you are running on, the PC platform that you are using and license name and 
PSQUID that the product is licensed to.
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The principle reason for accessing this information is to check the Myriad 
version number you are running.

This window also offers access to the P Squared support site and direct email 
access to P Squared Technical Support Engineers.

Click on OK to close the About Myriad window.

Chapter 8 Summary

In this Chapter we have taken an extensive look at the Menu system in 
Myriad. The Menu system covers a side and diverse range of topics and 
options with everything from running the Log Screen through to configuring 
every detail of Myriad included.

The important things to remember from this Chapter include:

 Using the File Menu options to log in and out of Myriad and to switch 
between Station Databases at stations that run more than one radio 
station from a common Myriad system.

 How the Log Screen can be controlled from the Log Menu if needed.
 Customised options on the View Menu provide a way giving your 

presenters direct access to the information you want to use.
 How the Customise Myriad options on the Tools Menu allow Users to 

customise key aspects of Myriad (in particular Cart text and size) on a
per User basis.
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 How the On-Air Control menu can be used to switch simple or 
advanced On-Air control.

 That the Settings Menu offers more configuration options than you can 
shake a stick at and that you should really restrict access to this menu 
to people who know what they are doing.

 The Help Menu is there if you get in trouble or need to send P Squared 
a Support File.

Personally I hope that you have found this documentation useful, informative 
and at times entertaining. It has certainly taken a great deal of time and effort 
to write which I think is testament to the depth and richness of the product 
itself for which I think the Myriad development team. But as with all great 
journeys, the final stage is just about the sweetest portion!

All that remains is to thank you for taking the time to read this documentation, 
whether you have read it ‘cover to cover’ or just dipped in where you need it, I 
sincerely hope you have found the information that you need.

So finally, to quote a great man get out there and do it to them before they do 
it you. Remember, Myriad may be a great tool but it is people that make great 
radio. Have fun!

All P Squared Products and documentation (including online help files) Copyright ©1997 - 2006 P Squared Ltd.
Unauthorised reproduction of these files or any part of them, is expressly forbidden, any such actions may result in 
civil and criminal prosecution to the fullest extent of the appropriate international laws.

P Squared Ltd, Victoria House, 82 Beverley Road, Hull, HU3 1YD. Tel: +44 (0)1482 383 700 Fax: +44 (0)1482 383 
701 Registered in the UK Company No: 3467549 VAT No: GB708688102.
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Trouble Shooting

In this section we will deal with a few of the more common problems people 
have encountered setting up or operating Myriad. Some of the problems 
outlined below are related to hardware issues whilst others are configuration 
options but the end result is the same. If you are having a problem with 
Myriad then maybe this section will help you to resolve the issue.

If you do not find what you are looking for in this section, it is also worth 
checking the How Do I section in Chapter 8 which covers a range of common 
Myriad configuration questions.

Symptom: Myriad Locks Up When Playing Carts in Cart Player 
2 Or Above

This is actually one of the more common problems we see with Myriad 
systems that are using either Layla 3G cards (or the older Echo Audio cards 
such as Gina 24, Darla 24 or Mia sound cards) or a Delta 10 / 10 (or Delta 4/4 
or 10/10 Lite). So basically, this problem can occur if you are using any of the 
sound cards recommended by P Squared in the last five years!

The problem is caused by a mis-configuration of the soundcard drivers 
involving a setting which synchronises the all of the output channels so that 
they all start at the same time. This is ideal for sound recording but not good
for the type of playback that Myriad uses. The result is that when Cart Player 
1 is playing, the other Cart Players are also able to play but when you try to 
play a Cart on a higher numbered Cart Player when Cart Player 1 is not 
playing, the sound card does not respond up which in turn makes Myriad 
appear to ‘lock up’.

Whether you are using an Echo Card (Layla 3G, Layla 24, Gina 24, Darla, 24, 
Mia or Indigo I/O) or a M-Audio Delta card (Delta 10/10, Delta 10/10 Lite, 
Delta 4/4) the cure for the problem is as simple as turning off the appropriate 
option in the drivers.

In theory, Myriad can be used with any multi-channel sound card in which 
each playback channel can be accessed independently (using multi client 
audio protocols) so your Myriad system may not be using one of the sound 
cards listed above. The ‘sync audio devices’ setting is common on all sound 
cards which have been designed with sound recording in mind so there may 
well be an equivalent setting in your sound card driver settings but you will 
need to consult the sound card manufacturers documentation to find out how 
to alter it.

We will now look at how to correct the problem for both Echo Audio and M 
Audio based systems.
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Solving the Problem with Echo Audio Sound Cards (Layla 3G, Gina 
24, Darla 24, Mia and Indigo I/O)

1. Open the Echo Audio Console by going to Start => Programs => Echo 
Digital Audio => Console => Show All Console Windows, or from the 
Windows task bar. 

2. Click on the Settings button to access the Echo Audio card settings.
3. On the Driver tab make sure that the ‘Synchronise Wave Devices’ 

setting is NOT TICKED.

4. You may also want to make sure that the ‘Sample Rate Is Unlocked’ 
option is also selected.

5. Click on OK to close the window. You can now close the Echo Audio 
Console.

6. NB: Some earlier versions of the Echo Audio drivers had a settings 
menu as opposed to the Settings button shown in this example. Either 
way, the Synchronise Wave Devices is the setting you need to make 
sure is not selected.

You may have to restart Myriad but you should find that the playback 
problems all magically clear up.

In the past, we have had reports of this option being re-set without the User 
manually doing so. Although we have not been able to confirm this, it is worth 
checking this option if you see the symptoms outlined above, even if you 
know you have not manually changed the settings and it was working OK 
before.

Please note that there are a number of other settings that you should alter 
from the default Echo Audio installation setup in order to properly configure 
your Echo Audio soundcard. Please refer to the Configuring an Echo Audio 
Sound Card appendix for more details.
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Solving the Problem with an M-Audio Soundcard (Delta 10/10. 
Delta 10/10 Lite, Delta 4/4)

1. Open the M-Audio Console which can be done by either double 
clicking on the M-Audio Console option on your computers Control 
Panel or by double clicking on the M-Audio Console icon on the ‘sys 
tray’ which is the section of your Start Bar to the right of the screen 
beside the clock.

2. Once you have the M-Audio Console open, click on the Hardware 
Settings tab.

3. Now make sure that the Multi Track Driver Devices option is set to 
Independent.

4. You may also need to set the Input levels between +4dB and -10dB but 
that depends on the audio equipment connected to the sound card.

5. When you are done, click on the Done button to close the window.

Please note that there are a few options that need to be changed from the 
default M-Audio installation setup in order for the card to operate correctly 
with Myriad. Please refer to the Configuring a Delta Sound Card appendix for 
more detail.

Symptom: Myriad Is Showing A ‘Database Format Is Not 
Recognised’ Error on Start Up

This error is reported when one of the databases that Myriad uses has been 
damaged or corrupted and is only displayed when Myriad is not able to read 
the database.
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Myriad v3 uses two key databases, the Station Database (which contains 
settings and the Schedule Log) and the P Squared Directory database (which 
contains User settings and information). In both cases, seeing this error will 
be rare as Myriad automatically compacts and validates both databases each 
time it starts up. That said databases can from time to time become damaged 
by a PC not shutting down correctly or even a hardware error or fault.

The important thing to remember is that the damaged database is not the end 
of the world and you should be able to recover the database using the steps 
outlined below.

Repairing a Damaged or Corrupted Database

1. TAKE A BACKUP OF YOUR DATABASE FIRST. It may seem like it 
is a little late but it is better to have a backup of a corrupted database 
that P Squared may be able to repair, than to not have a database at 
all. There are two databases in Myriad v3 that you may have to repair;
they are the Station Database and the P Squared Directory Database. 
The default location for each database is shown below but keep in 
mind that the location of these databases is a configuration option so 
your system may be configured differently.

Database: Station Database - (previously known as Q-NXT) 
Default Folder: D:\Myriad\System\Schedule 
Default File Name: Myriad3.mdb 

Assuming your Myriad Data Location is set to D:\Myriad\System (see 
Settings Menu > Myriad Settings > Data Location

Database: P Squared Contacts and Users Directory (previously Users) 
Default Folder: D:\Directory 
Default File Name: Directory.mdb

Assuming your P Squared Directory Location is set to D:\Directory (see 
Settings Menu > P Squared Directory Settings > Path)

To take a backup of either of these files, use My Computer to browse 
to the appropriate location and then simply copy the .MDB file to a 
backup location just in case something goes wrong.

2. Next you need to make sure that you quit from Myriad on ALL THE 
WORKSTATIONS at your station. This includes all studios, any office 
machines with Myriad installed and playout workstations. If Myriad is 
left running anywhere on your system then the repair will not be able to 
be performed and potentially you could further damage the database 
you are trying to repair. Also, if you are repairing the P Squared 
Directory you will also have to shut down any Scoop workstations 
(including Scoop Cpature) any AutoTrack or AutoTrack Pro 
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workstations and any copies of Powerlog Client that you are running. In 
all cases, you just have to quit the P Squared application, shutting 
down the box will not be necessary.

3. Next, run the Myriad Emergency Recovery Utility (Start > Programs > P 
Squared Myriad v3 > Utilities > Emergency Recovery Utility.

4. You will be warned that you should only use this utility if you are unable 
to use Myriad to make changes to your setup. In this case, the 
corrupted database may well be preventing you from accessing Myriad.

Click on the Yes button to continue to the Emergency Recovery Utility.
5. Next click on the Repair Database button.

6. Use the Browse for File window to browse to the location of the 
database that you want to repair. Once the database you want to repair 
is selected, click on the Open button.
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In this example, we will be repairing the P Squared Directory database.

7. You will be asked to confirm that you want to repair / compact the 
selected database.

Click on Yes to continue.

8. You will next get a warning that applications that use the database 
must not be running on any PC in the building. Remember that the P 
Squared Directory is also used by Scoop, AutoTrack, AutoTrack Pro 
and Powerlog Client so they will all have to be shut down also.
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Click on the Yes button to proceed.

9. Myriad will then compact and repair the selected database. This can 
take anything from a couple of seconds to several minutes during 
which time the computer may appear to have stopped responding. 
Please be patient as Myriad will inform you when process has been 
completed.

Myriad will also create its own backup which you can delete later when 
you are happy that everything is OK but it is better to have your own 
backup anyway.

If Myriad reports a problem with this process then the best thing to do 
is contact P Squared Technical Support (support@psquared.net) as 
soon as possible.

10.  You should now be able to close the Emergency Recovery Utility and 
go back in to Myriad (Scoop, AutoTrack etc) as normal.

Symptom: When Myriad Fades Carts out It Does Not Sound 
Right (fades out quickly at first or slowly at first)

There are two common symptoms that people with relation to fading of Carts 
not sounding right. They are:

 When Myriad fades a Cart, nothing seems to happen for the first 
second or so, and then the Cart fades out really quickly.

 When Myriad fades a Cart out, the volume drops to virtually nothing 
almost immediately but then fades out slowly for the remainder of the 
fade period.
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Both of these symptoms are caused by the way the sound card drivers fade 
change the volume of audio when Myriad instructs it to lower (or raise) the 
playback volume.

Under normal conditions Myriad fades Carts out in a linear fashion so that it 
starts at 100% of full volume, then fades it down steadily to 0% volume. This 
assumes that the sound card performs in the same way but some sound 
cards do what is called logarithmic fading which is where the rate at which the 
audio fades out is not constant across the entire duration of the fade. If this is 
the case then Myriad tells the card to fade to 90% of volume but because the 
drop in volume between 100% an 90% is much greater then the drop in 
volume from 90% to 80% the overall affect is that you get a very fast and 
rough sounding fade out. This is not good for automation because it relies on 
smooth fading to sound ‘live’.

Setting Myriad to Counteract Logarithmic Fades on Sound Cards 

Thankfully, we can alter the way in which Myriad fades out to do the opposite 
to the sound card so you effectively get a linear fade again. To do this, follow 
the steps below.

1. Click on the Settings menu in Myriad and select the Audio Settings 
option to access the Audio Settings window.

2. Click on the Advanced tab.
3. Click on the Advanced SmoothStream Settings button.
4. Click on the OK button when the SmoothStream Settings warning 

window appears. This window warns you that you should not be 
messing around with these settings unless you are sure about what 
you are doing. You are so click on OK.
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5. Use the drop down Fade Mode option to select the Fade Mode that you 
want Myriad to use.

Normal Fading will make Myriad use a standard linear fade and is the 
default. The Start Fading Slowly Then Speed Up option should be 
selected if currently you system fades out Carts almost immediately. 
The Start Fading Quickly Then Slow Down option should be used if 
currently, you system appears not to fade the Carts at all until the very 
end of the fade period.

Select the setting that best suits your problem.

6. Click on the Save Settings button to return to the Audio Settings 
window and then click on OK to return to Myriad. Test out the fading 
and see whether you have set the right option, if not, go back and 
choose the other option.

Symptom > Myriad Has Auto Configured the Cart Players I 
Want To Use Incorrectly

When running Myriad for the first time, the system attempts to auto-configure 
based on information that you give as part of the initial start up process and 
the hardware that is found in your PC.

One of the things that Myriad does automatically is to attempt to ascertain the 
amount of Cart Players that it should set up for use based on the amount of 
valid sound card devices (or playback channels) that it can find. If you are 
using a Card that Myriad knows about (like a Delta 10/10 or a Gina / Layla) 
then Myriad should configure the correct amount of Cart Players and assign a 
playback channel to each Cart Player in turn (so Cart Player 1 uses outputs 1 
& 2 etc).

If, however, you are not using one of the cards mentioned above, or you have 
several cards fitted to your PC, Myriad will attempt to configure your system 
based on ‘best guess’ but you may wish to manually alter the configuration to 
be the way you want it.



940

Manually Setting the Amount of Cart Players & Which Sound Card 
Channels They Use

To manually change the amount of Cart Players that Myriad will display on 
screen, follow these steps.

1. Click on the Setting menu and select the Audio Setting option.
2. Make sure you are on the Cart Players tab.
3. Click on the Change button.

4. Type in the amount of Cart Players that you want to use.
5. Click on the Set button.

Next we will see how to change the sound card channel that the Cart Player 
we have just added will use.

6. Make sure that Manually Assign Each Player A Suitable Device is 
selected in the Allocation Of Sound Devices To Players option.

7. Use the drop down list next to the Cart Player you have just added to 
select the sound device that you wish to use.
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Remember, several Cart Players can be assigned to the same sound 
device but fading will not work correctly (or more accurately, when 
Myriad fades a Cart Player, all other Cart Players sharing the sound 
device will be faded at the same time).

8. When you are happy, click on the OK button to return to Myriad.

Symptom > Data Location XXXX Can Not Be Found Error 
Message on Start Up

If Myriad is unable to locate either the Myriad Data Location folder or any of 
the Audio Wall File Location folders when it starts up, it will inform you via a 
message box.

Check Local Drive & Mapped Network Dives / Locations

If you see this message, it means one of two things has happened.
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1. The local or network drive location is not accessible or is not 
functioning. If it is a local drive, check that the drive is functioning and 
that you can see it in My Computer. If it is a network location, check 
that the network location is accessible (using My Computer) and that 
the mapped network drive exists. If not then you may need to re-map 
the network drive (see below).

2. The other option is that the drive and folder are there but the data that 
Myriad needs is not. If this is the case then you may have to restore 
from your most recent backup. Please note that Myriad does not have 
the ability to delete key information such as the data locations so if 
important data has been deleted, it is most likely to be human error.

Remapping a Network Drive In XP

1. Double click on My Computer.
2. Click on My Network Places.
3. Click On Entire Network.
4. Double click on Window Microsoft Network (assuming you are using a 

Microsoft network).
5. Double click on the network you want to access.
6. Double click on the computer that contains the location you want to 

map to (i.e. the server etc).
7. Right click on the resource you want to map to (usually a folder but can 

be a drive) and select Map Network Drive from the right click menu.

8. Select the drive letter that you wish to use for the mapped network 
drive and ensure that the Reconnect at Logon option is selected.



943

9. Click on the Finish button to complete the procedure.

Mapped network drives are good for humans needing to be able to browse a 
network but they can be unreliable as Windows does seem to occasionally 
‘forget’ that they exist. Another option is to use UNC’s (\\servername\folder) 
which is harder for a person to use but more reliable for Myriad use. For 
details on UNC’s and Mapped Network Drives, please refer to the Mapped 
Drives V’s UNC’s section of Chapter 1.

Remember that the P Squared Forums (www.forum.psquared.net) provides a 
wealth of trouble shooting knowledge and if you cannot find the answer to 
your question listed, you can always post a question and see what answers 
you get. To join the P Squared forum, visit the link above and follow the on 
screen instructions for signing up.
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Glossary Of Terms

In this section we will explore the various terminology and jargon used in this 
manual. Whilst every effort has been made to make this documentation as 
accessible as possible, the technical nature of the products and an assumed 
knowledge of radio industry terms mean that some jargon is inevitable. 
Hopefully this section will help demystify any terms you are not familiar with.

Active Playout Modes – This term refers to the modes on the Log Screen 
when Myriad will actively playout the contents of the Schedule Log.

Audio & Data Logging - In this context, the phrase Audio & Data Logging 
refers to the practice of automatically recording one or more audio inputs for 
long term storage on a computers hard disk. In addition to audio, several 
different additional data sources can also be logged including hardware inputs 
to allow you to monitor when the 'mic' channel on your mixing desk is open, 
serial (RS232), silences and DAB Text. The P Squared product that is used 
for Audio and Data Logging is called Powerlog.

Audio Editing (Audio Editor) - An audio editor provides the means to 
visually view and work with the content of an audio file. By representing the 
audio in a file as a visual wave form, Audio Editors allow you to edit audio in 
an intuitive way. P Squared Audio Editor is called SmoothEdit.

Audio & Data Logging - In this context, the phrase Audio & Data Logging 
refers to the practice of automatically recording one or more audio inputs for 
long term storage on a computers hard disk. In addition to audio, several 
different additional data sources can also be logged including hardware inputs 
to allow you to monitor when the 'mic' channel on your mixing desk is open, 
serial (RS232), silences and DAB Text. The P Squared product that is used 
for Audio and Data Logging is called Powerlog.

Audio Editing (Audio Editor) - An audio editor provides the means to 
visually view and work with the content of an audio file. By representing the 
audio in a file as a visual wave form, Audio Editors allow you to edit audio in 
an intuitive way. P Squared Audio Editor is called SmoothEdit.

Audio Wall – A numerically ordered list of Carts available to the Myriad 
system.

Automation - Automation broadly means things happening automatically but 
in radio terms, it refers to the playback of pre-recorded or pre-prepared radio 
shows without the need for human intervention. Typically, and automated 
show consists of a list of songs, jingles, adverts and other events that has be 
pre-prepared and the Playout system will automatically play each of the items 
in the show in sequence. Automation allows a radio station to run for 
extended periods without anyone being in front of the PC.
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Auto Playout Mode – This is an active playout mode where Myriad will play 
all the Log Items in the Schedule Log ‘back to back’ but will not take account 
of Time Markers and will not run to time.

AutoFade Mode – An active playout mode where Myriad will play all of the 
Log Items in the Schedule Log ‘back to back’ as well taking Time Markers in 
to account to all for running to time.

AutoTrack & AutoTrack Pro - Music and link scheduling system used for 
producing -pre-prepared shows for Myriad or other playout systems. 
AutoTrack is part of the standard Myriad package and AutoTrack Pro offers a 
range of powerful enhancements to provide you with greater flexibility and 
control.

Cart – A single piece of audio stored on the Audio Wall. Carts can be 
anything from short jingles to long recording but in general a Cart will be an 
individual jingle, song or advert. Carts are arrange numerically on the Audio 
Wall and are central to all Myriad operations.

Cart Player – Small audio playback device located along the top or bottom of 
the Myriad screen and used to play the audio contained in Carts.

Contact Manager - Allows you to access and manage a central contacts 
database for all your stations contacts needs.

The Database Screen – The Database screen is used to access a list of 
Songs and Links that are stored in your AutoTrack or AutoTrack Pro music 
scheduling system.

Information Hub - A central system for managing information from a diverse 
range of sources. Nexus is P Squared information hub.

Instant Carts – Effectively short cuts or ‘hot keys’ to your favorite Carts on 
the Audio Wall. Each Instant Cart is assigned a Cart and pressing the 
corresponding number key on the keyboard to trigger the Instant Cart.

Myriad - P Squared Playout and Automation system. A Suite of programs that 
allow for the live or automated playout of audio content and additional items 
that make up the output of your radio station.

Music & Link Scheduling - This refers to the process of scheduling music, 
links and other events in to pre-prepared programs to be passed to the 
playout system for live or automated playout. Typically, a scheduling system 
consists of a database of songs and links (or jingles) as well a frameworks for 
shows (which are known as Clocks). The job of the scheduling system is to 
use the Clocks along with a range of rules to produce your station output. 

Multimedia Broadcasting - The practice of broadcasting additional non 
audio content that compliments the audio broadcast, to digital platforms such 
as DAB radios or web sites. Typically this can include text about the audio 
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that is playing, hyperlinks to more information, pictures and the ability to 'click 
to buy' the currently playing item. P Squared's product that allows this to 
happen is called OCP (Online Content Processor).

Newsroom System - The term Newsroom system refers to a system that can 
capture incoming audio and text based news from a variety of sources, help 
journalists to collate, adding and edit these news items and finally present 
them 'live on air' or publish them to a web site. The P Squared newsroom 
system is called Scoop.

Nexus - The information super hub, collates information from a range of 
diverse sources on to a single screen.

OCP (Online Content Processor) - Adds the ability to broadcast additional 
text, data and picture information to digital platforms such as DAB Digital 
Radio or web pages.

Playout & Automation System - Common term for a software system used 
to play music, jingles and other elements that make up a radio program. 
Playout systems normally store audio on local or central storage and can 
normally be used for assisting with presenting live shows (live assist) or run 
fully automated to allow the radio station to run even if no presenter is 
present. P Squared's playout system is called Myriad.

Pad – The Pad is a cut down automation tool located on the Audio Wall and 
used to play out a list of Carts in order. The Pad can also be used to export a 
‘run’ of Carts to a single Cart on the Audio Wall or to save a list of Carts for 
future use.

Powerlog - A audio and data logging system that allows you to automatically 
record and store your stations audio output along with a range of additional 
data criteria, for a present period of time.

Remote Voice Tracking - Adds the ability to record Voice Tracks from a 
remote site of a VPN connection or the web.

Segue - A segue is term used to describe the transition from one audio item 
to the next. This may also be known as a mix or a cross fade. Segues can be 
either manual (the presenter does them manually) or automated (the 
computer does them automatically).

Voice Tracking - Voice Tracking is a radio industry term for the practice of pre-
recording voice links in automated shows such that the playout system will 
play them out so that they sound like the presenter is in presenting a live 
show even when it is automated. The Voice Tracking process in Myriad is 
accessed via the Voice / Segue Editor button or remotely using Remote Voice 
Tracker.

Split Transmission - This is the practice of splitting the output of your radio 
station so that different geographical regions or alternate transmission 
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mediums receive slightly different versions of the same broadcast. Typically 
this would include localised advert breaks and possibly alternative jingles etc. 
Myriad STS is the split transmission solution from P Squared.

Scoop (Capture & Edit) - A newsroom system that is split in to two parts. 
Scoop Capture automatically captures or download audio and text content 
from a range of news sources and manages a central news database for your 
station. Scoop Edit is used by journalists to view and edit the audio and text, 
add new (local) stories and prepare bulletins. Scoop Edit also has a playout 
mode to help journalists present news bulletins 'live on air' and also upload 
bulletins to the station web site.

SmoothEdit - P Squared's audio editor program, used for editing audio. In 
Myriad, the SmoothEdit screen is used to edit the details of a Cart such as 
title and timing information as well as copyright details and notes. You can 
also edit the audio for a Cart if you wish.
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Appendix A – Myriad And Daylight Savings (GMT –
BST)

Introduction

If you are using Myriad in a country that operates different time standards in 
Summer and Winter, then twice a year the clocks will either jump forward by 
an hour or repeat the same hour twice to switch between the two time 
standards. 

In the UK, the winter months are covered by GMT while the summer months 
use BST which is an hour ahead of GMT. In practice this means that at the 
end of each March, the clocks jump from 1am to 2am on the last Sunday of 
the month and repeat the 1am hour on the last Sunday of October to switch 
back to GMT. 

This has a number of implications for any station using Myriad to run 
automated programs particularly if the automated programming includes 
running to time for external events such as satellite news. Unfortunately, there 
are a number of factors that can influence when your Windows actually 
changes the time on your PC which means that it is very hard to predict the 
exact sequence of events and plan accordingly. Before you get started, 
double click on the clock in the bottom right hand corner of the Windows Start 
bar (or sys tray), click on the Time Zones tab and un-tick Automatically Adjust 
Clock for Daylight Saving.

The best thing to do in both of the time switches is to not attempt to run to 
time or take any external timed events such as news for a couple of hours 
either side of the switch. That way, should Windows, the Atomic Clock (a 
radio controlled clock used for accurately setting time) or the system bios 
disagree on exactly when to change the time or cause the time to jump 
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around for a while (both of which we have seen in the past), Myriad should be 
just fine if you follow the following instructions.

Obviously, depending on whether the clocks are going forwards or backwards 
will determine how you deal with the situation. Both scenarios are outlined 
below.

GMT To BST (End of March) – Clocks Go Forward

At the end of March, the time will jump forward by an hour at 1(ish) am 
effectively meaning that an hour of automated programming will be missed. 

Of the two time changes, the clocks’ going forward is least likely to have a 
serious affect on your automated output. If no action is taken, the system will 
run normally to around 1am and then the clock will jump forward to 2am. At 
this point, Myriad will believe that it is overrunning by 1 hour and will proceed 
to drop all the songs from the 1-2am hour. It cannot drop jingles, promos, 
voice links or protected songs however, so these will play ensuring that the 
next news break is also missed.

The best way around this is to schedule as normal but once your log has been 
‘pushed’ to Myriad, go into the Schedule Log on the Log Screen and go to 
1am on the morning of the time change.

Find the Hour Start marker for the 1am hour and right click on it. Expand the 
Change Hour Mode option and select Full Automation (not Full Automation, 
Run to Time) from the list.

This tells Myriad not to attempt to back time this hour of automation.

Next click on the Next Hour button which will jump you on to the next Hour 
Start marker (2am) and repeat the above process to switch that hour to Full 
Automation mode also. Also remember to remove any commands that 
automatically activate a news service such as IRN and wait for 3 minutes etc. 
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Repeat one more time with the 3am hour just in case your radio clock takes 
some time to update.

Myriad will now not attempt to ‘run to time’ between 1am and 4am which 
should easily cover the time change. But the commands to switch IRN are still 
in the log so unless we take them out, the news will still be switched on but at 
the wrong time. Go back to the start of the 1am hour and then go back into 
the end of the 12am hour and find the hardware event that switches on the 
news. Right click on this item and select Delete > Permanently Delete from 
the menu. If you do not do this then the news will be switched on at the end of 
the 12am hour and not switched off again until 4am.

Now scroll down the hardware event at the beginning of the 1am hour and 
remove it in the same way. Repeat for all the hardware events between 1am 
and 4am to ensure that during this time, Myriad does not attempt to switch 
any external hardware.

Tip: Use the Start Hour / Next Hour buttons to jump to the Hour Start markers 
for each hour.

We should now not have any hardware events from just before 1am through 
until 4am and Myriad will not attempt to alter these hours to run to time, but
we still have an hours extra programming so the final thing that we need to do 
is to go the start of the 1am hour and remove all of the music, jingles, voice 
links and promos for the hour. You can do this by right clicking on each item in 
the hour and selecting Delete from the right click menu. You could also click 
on the item type icon (left hand side picture icon) for each item to soft delete it 
(a red cross appear through the icon and the item turns grey) but the simplest 
way is to right click on the Hour Start marker for 1am and select Soft Delete 
All Items In Hour from the menu.
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This will soft delete each item in the 1am to 2am hour.

That’s it; you are now ready for the clocks going forward. It is a bit of work but 
at least it only happens twice a year.  You could also achieve the above by 
adjusting the clocks in AutoTrack™ or Selector™ accordingly but then you 
would have to make sure that you altered them back before the following 
weekend.

If you do not take an automated news feed overnight then you may prefer to 
switch off daylight savings in Windows™, unplug your radio clock and let 
Myriad run normally, blissfully unaware of the injustices of a world where you 
get an hour less in bed just so the farmers can get the tractors out on the 
roads extra early to hold up even more people.

BST to GMT (End of October) – Clocks Go Back

As the autumn nights pull in and the leaves start to fall from the trees, the 
demise of summer is sweetened a little by the magic weekend at the end of 
October where BST switches back to GMT and you get a full extra hour in 
bed. 

But, the cosmos must balance. For every right there is a wrong, for every 
ying, there is a yang and while you are tucked up in bed dreaming of a 
Utopian society where dog and sheep work hand in hand and marmalade is 
freely available on the NHS, your poor Myriad system has had it’s hardest 
night of the year and without your help, may be on the verge of a nervous 
break down. 

You see; the clocks going back is the hardest situation for Myriad to deal with 
effectively so it is best for us to make it as easy on the system as possible by 
taking the following steps. 

As with the change from GMT to BST (above) it is not really practical to take 
external news feeds during the time change period as Windows™, the PC 
bios and Atomic Clocks do not always agree on when exactly the time change 
occurs so it is best to give it a wide berth and assume that you will not take 
news from 1am to 4am. That way you can be sure that all the changes have 
occurred and the system is back on track by the time your early shift arrives.

The first thing to do is to go to the Hour Start marker for each hour (1am –
3am) and use the right click menu to change the Playout Mode to Full 
Automation (not Full Automation, Run To Time). This tells Myriad to ignore the 
time markers in each hour. The reason we only do 1am, 2am and 3am is that 
this will take us to 3:59am and the 4 am hour wants to run normally so we 
leave it alone.
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TIP: You can use the Start Hour / Next Hour buttons to jump to the next Hour 
Start marker without having to scroll through the log.

The next thing that we need to do is to remove the Hardware Events between 
1am and 4am to stop Myriad switching any external sources such as satellite 
news. To do this, go back to the 1am Hour Start marker and then scroll back 
in to the end of the 12am hour and right click on the Hardware Event that 
switches the news on just before 1 o’clock. Select Delete Permanently from 
the right click menu to remove the hardware item. This is important because if 
you remove the Hardware Event that turns that news off after the 1 o’clock 
break but do not remove the Hardware Item that turns it on then the news 
may well be stock on for several hours.  You need to remove all of the 
hardware events between 1am and 3:59am to in the same way to ensure 
Myriad does not switch any external sources during the time change.

Finally, we need to add around 15 extra songs to the 2am hour to effectively 
make it a 2-hour show. This simplest way to do this is to find the 2am hour in 
the Schedule Log and drag some songs in from the Audio Wall in to the log. If 
you do not have a dual screen system then clicking on the Carts button on 
Log Screen will open the Cart Browser which can be used to drag songs from 
the Audio Wall to the Schedule Log.

TIP: There is an upper limit to how many items can be inserted in to a single 
slot in the Schedule Log so you may find it better to spread the load a little by 
dragging 2-4 items in to one place in the log, then moving down a couple of 
songs and doing it again.

Once you are happy that your 2am hour has sufficient program content to 
have a total running duration of 2 hours then you are ready. Because Myriad 
is not running to time, it will play all of the items in the log regardless of 
whether the show over runs so it does not matter if the actual time change 
happens at 2am (as it is supposed to) or 3am because overall the system will 
just play songs and jingles until 4am by which time, everything should be back 
on track and ready to run as normal. 

If you do not fancy messing around in the Schedule Log then you can always 
change the clocks in either AutoTrack or Selector™ to achieve the same net 
result but you would have to remember to alter them back before the next 
weekend. Alternatively, you could disable the running to time and the 
Hardware Events, then turn of daylight savings in Windows and unplug your 
Atomic clock and just let Myriad run through the night and deal with it in the 
morning! 

The above examples are based on the UK daylight savings model but the 
same method is applicable to any time changes, regardless of when they 
occur.
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Appendix B – Configuring A Delta 10/10 (or Delta 10/10 
Lite) Sound Card

In this section we will briefly review the procedure for installing a M-Audio 
Delta 10/10 sound card and configuring it for use with Myriad. This 
documentation is intended as a guide only. Please refer to the manufacturers 
instructions for full details. 

To install the Delta 10/10, fit the Delta 10/10 sound card to the PC and 
attached the 19” breakout box via the provided data cable. Ensure the 19” 
breakout box is connected and powered up before turning on the PC. 

Once the PC has booted up, either use the drives provided with the sound 
card or download the recommended sound card drivers from the web.

TIP: An up to date list of recommended drivers for use with P Squared 
products can be found at:

http://support.psquared.net/products/drivers_utilities/default.htm

Once you have installed the M Audio Delta 10/10 soundcard in a machine or 
need to reinstall the drivers, you will need to make a slight change from the 
default configuration for correct operation with P Squared products. 

Open the M Audio Console from Control Panel or the icon in the Windows 
task bar, then select the Hardware Settings tab. Make sure that the MultiTrack 
Driver Device option is set to Independent. 
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With a Delta 4/4 you may also need to adjust the settings for the input and 
output levels to allow for connection to different equipment.

For more details on the M-Audio Console configuration, please refer to M-
Audios documentation.
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Appendix C – Configuring an Echo Audio Gina 24

The Echo Audio Gina 24 was the standard sound card supplied with Myriad 
systems for several years and whilst it has now been superseded by the Layla 
3G, many Myriad systems still make use of this sound card.

To install a Gina 24, physically install the card in to a free PCI slot and boot up 
the PC. Once booted, install the appropriate sound card drivers by using the 
provided CD or downloading them from the web.

TIP: An up to date list of recommended drivers for use with P Squared 
products can be found at:

http://support.psquared.net/products/drivers_utilities/default.htm

If you are installing an Echo Gina soundcard in a machine or need to reinstall 
the drivers, you will need to make slight changes from the default 
configuration for correct operation with P Squared products. 

Open the Gina Console by going to Start => Programs => Echo Digital Audio 
=> Console => Show All Console Windows, or from the Windows task bar. 

First you may need to mute the loop inputs so that you do not get feedback 
when you are playing out and recording with the PC at the same time. Click 
the A1-2 button on the right, then make sure that the Analogue In and Digital 
In are both muted. Repeat this for the A3-4, A5-6 and A7-8 buttons 
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You will then need to click the settings button and check that the Synchronise 
Wave Devices option is not ticked. You may also want to make sure that the 
sample rate is not locked 
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Finally, you may need to adjust the levels for the inputs and outputs. On the 
main Console window, select the appropriate output (such as A1-2) then 
select from +4dB or -10dB on the main VU bar on the right. For the expected 
input level, change the settings for the Analogue In in the top left.

For more details on the Echo Gina 24 sound card settings, please refer to the 
Gina documentation or visit www.echoaudio.com.
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Appendix D – Configuring an Echo Layla 3G Sound 
Card

To install a Layla 3G, physically install the card in to a free PCI slot and 
connect the 19” breakout box before booting up the PC. Once booted, install 
the appropriate sound card drivers by using the provided CD or downloading
them from the web.

TIP: An up to date list of recommended drivers for use with P Squared 
products can be found at:

http://support.psquared.net/products/drivers_utilities/default.htm

If you are installing an Echo Layla 3G soundcard in a machine or need to 
reinstall the drivers, you will need to make slight changes from the default 
configuration for correct operation with P Squared products. 

Open the Layla Console by going to Start => Programs => Echo Digital Audio 
=> Console => Show All Console Windows, or from the Windows task bar. 

First you may need to mute the loop inputs so that you do not get feedback 
when you are playing out and recording with the PC at the same time. There 
are 8 analogue inputs and 2 digital inputs but you will normally only use inputs 
1 and 2. Even so, it is a good idea to mute all of these inputs just in case. 
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You will need to mute all the inputs for each of the output channels (A1-2 to 
A7-8). To do this, use the A1-2 to A7-8 buttons on the right hand side of the 
console to select the output channel and then mute all the inputs for that 
channel. In the example below, A3-4 has been selected and all the inputs 
have been muted.
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You will then need to click the settings button and check that the Synchronise 
Wave Devices option is not ticked. You may also want to make sure that the 
sample rate is not locked. 
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Now click the Advanced button and check that all inputs and outputs are set 
to Purewave mode not WDM mode. 

Please note that whilst Purewave mode is the recommended playout mode, 
some advanced Myriad features such as the Hook Player will not be available 
in this mode. If you want to use the Hook Playing in Myriad then you will need 
to switch all outputs to WDM mode but you need to be using Echo Mia driver 
version 6.08 in order for this to work reliably.
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Finally, you may need to adjust the levels for the inputs and outputs. You can 
use the -10 / +4 buttons on the Inputs and Outputs to select either -10dB or 
+4dB depending on the equipment being connected to the sound card.

Again, use the A1-2 to A7-8 buttons to switch between the available audio 
outputs.

For more details on setting up the Echo Layla 3G, please refer to the Echo 
Layla 3G documentation or visit the www.echoaudio.com web site for the 
latest information.
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Appendix E – Configuring an Echo Mia Sound Card

To install a Mia, physically install the card in to a free PCI slot and boot up the 
PC. Once booted, install the appropriate sound card drivers by using the 
provided CD or downloading them from the web.

TIP: An up to date list of recommended drivers for use with P Squared 
products can be found at:

http://support.psquared.net/products/drivers_utilities/default.htm

If you are installing an Echo Mia soundcard in a machine or need to reinstall 
the drivers, you will need to make slight changes from the default 
configuration for correct operation with P Squared products. 

Open the Mia Console by going to Start => Programs => Echo Digital Audio 
=> Console => Show All Console Windows, or from the Windows task bar. 

First you may need to mute the loop inputs so that you do not get feedback 
when you are playing out and recording with the PC at the same time. Make 
sure that the Analogue In and Digital In at the left are both muted. 
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You will then need to click the settings button and check that the Synchronise 
Wave Devices option is not ticked. You may also want to make sure that the 
sample rate is not locked. 
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Now click the Advanced button and check that all inputs and outputs are set 
to Purewave mode not WDM mode. 

Please note that whilst Purewave mode is the recommended playout mode, 
some advanced Myriad features such as the Hook Player will not be available 
in this mode. If you want to use the Hook Playing in Myriad then you will need 
to switch all outputs to WDM mode but you need to be using Echo Mia driver 
version 6.08 in order for this to work reliably.

Finally, you may need to adjust the levels for the inputs and outputs. To adjust 
the output level, select from +4dB or -10dB on the main VU bar on the right. 
For the expected input level, change the settings for the “Analogue In” in the 
top left. 
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Appendix F – Installing A PCI 1750 Hardware I/O Card

Installing the PCI1750 is a little tricky which is why we have put together this 
quick reference guide. Basically you need to physically install the card first of 
all. When your PC boots up, Windows will automatically attempt to install the 
drivers. Cancel this process as Windows will not be able to do it.

In order to install the PCI 1750 correctly on Windows XP you will need to have 
the Advantech Device Manager installer and the PCI1750 Driver installer 
which are available from the P Squared web site 
(http://support.psquared.net/products/drivers_utilities/default.htm) or possible 
from the disk supplied (but you should check the disk has the correct driver 
versions by visiting the link above).

TIP: An up to date list of recommended drivers for use with P Squared 
products can be found at:

http://support.psquared.net/products/drivers_utilities/default.htm

First run the Advantech Device Manager installer, following the on screen 
instruction which will walk you through the Device Manager installation 
process.
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Once finished, run the PCI1750 Driver installer, again following on screen 
instructions. 
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Once you have installed both of these items, you are ready to actually install 
the card. To do this, click on the Start button and then right click on My 
Computer and select Manage from the list of options.

This will open the Computer Management window. Click on the Device option 
and you should see an ‘Unknown PCI Device’ listed, this should be the 
PCI1750. Right click on this item and select Update Driver from the right click 
menu.
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When prompted, select the ‘Install The Software Automatically’ option and 
then click on Next. Windows should now install the correct PCI1750 drives 
that we installed at the beginning of the installation process.
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Windows should now install the drivers as normal.
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After the driver install finishes, you should see the PCI1750 listed in the 
Device Manager under an Advantech section.

You should now be able to run Start > Programs > Advantech Automation > 
Device Manager > Advantech Device Manager to see that the card is installed 
and recognised. 
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That should be it. All you have to do now is configure Myriad to use the 
PCI1750 card in the normal way. This is covered in the Hardware Card 
Settings section of Chapter 8.
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Appendix G – Myriad Keyboard Shortcuts Reference

The following table show a list of the keyboard shortcuts that are available in 
Myriad and when and where they apply.

NB: Many of these combinations may seem cumbersome but that is because 
unique combinations are needed for each function. Most of these 
combinations can be programmed on to the special Myriad keyboards to 
make life as easy as possible for the presenters.

 Keyboard Shortcuts  Description
 
 Global Keys
 These keys no mater which section or window in Myriad is active or has 

focus.

 Number Keys 0-9  Instant Carts 1 – 10
 <Shift> + Number Keys 0-9  Instant Carts 11 – 20
 <Ctrl> + 1  Switch to the Audio Wall tab
 <Ctrl> + 2  Switch to the Instant Carts tab
 <Ctrl> + 3  Switch to the Database tab
 <Ctrl> + 4  Switch to the Log Screen tab
 <Ctrl> + 5  Switch to the SmoothEdit tab
 Pause/Break  Toggle Log Playback Mode (the Power 

button on Log screen)
 <Ctrl>+<Insert>  Record into highlighted cart on Audio

Wall
 <Ctrl>+<Shift>+<Insert>  Record into first available cart in 

personal area
 <Ctrl>+<Home>  Jump 'Home' on the Log Display 

screen
 <Ctrl>+<Backspace>  Toggle the Stop/Go at the end of the 

currently playing Log Item
 <Ctrl>+<Up>  Scroll up the Station Log 1 item
 <Ctrl>+<Down>  Scroll down the Station Log 1 item
 <Ctrl>+<PageUp>  Scroll up the Station Log 1 page of 

items
 <Ctrl>+<PageDown>  Scroll down the Station Log 1 page of 

items
 <Ctrl>+<Shift>+<PageUp>  Scroll up to the previous hour start in 

the Scheduled Log
 <Ctrl>+<Shift>+<PageDown>  Scroll down to the next hour start in the 

Scheduled Log
 <Ctrl>+<Space>  If in SegEdit mode, do the highlighted 

action in the Segue Editor
 <Ctrl>+F  Open/Close the Find window on the 
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Audio Wall
 <Ctrl>+J  Open the Jump to Cart window for the 

Audio Wall
 <Ctrl>+L  Play the highlighted cart on the Audio

Wall
 <Ctrl>+Q  Starts the Next item in the Station Log 

('Go')
 <Ctrl>+<Shift>+Q  Pre-Cue the next item in the Station 

Log
 <Ctrl>+<Shift>+<Alt>+Q  Preview the next item in the Station 

Log in the Preview Player
 <Alt>+Q  Display the Q-Audio Engine for the 

Station Log
 <Ctrl>+S  Show/Hide the Segue Editor
 <Ctrl>+U  Cue the highlighted cart on the Audio

Wall in the first available player
 <F1> to <F4>  Controls Cart Player 1 (See Notes 

below)
 <F5> to <F8>  Controls Cart Player 2 (See Notes 

below)
 <F9> to <F12>  Controls Cart Player 3 (See Notes 

below)
 <Shift>+<F1> to <F4>  Controls Cart Player 4 (See Notes 

below)
 <Shift>+<F5> to <F8>  Controls Cart Player 5 (See Notes 

below)
 <Shift>+<F5> to <F12>  Controls Cart Player 6 / Cart Recorder 

(See Notes below)
 <Ctrl>+<Shift>+<Up Cursor 

Key>
 Move highlight up one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Down 

Cursor Key>
 Move highlight down one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Left Cursor 

Key>
 Move highlight left one Cart on the 

Audio Wall.
 <Ctrl>+<Shift>+<Right 

Cursor Key>
 Move highlight right one Cart on the 

Audio Wall.
 Notes: The keys for each cart player are: Play, Pause, Cue, Eject - i.e. 

<F2> is the Pause key for Cart Player 1 and <Shift>+<F7> is the Cue key 
for Cart Player5.

 Holding down the <Ctrl> key while pressing the Play key for a Cart Player 
rewinds that player by 5 seconds

 Holding down the <Ctrl> key while pressing the Cue key for a Cart Player 
rewinds that player back to the start 

 Holding down the <Ctrl> key while pressing the Eject key for a Cart Player 
forward winds that player by 5 seconds

 Holding down the <Alt> key while pressing the Play or Cue keys for a Cart 
Player will Play or cue the highlighted cart in the active window in that cart 
player, ejecting what is already in that player.

 If you have less than 6 Cart Players, the controls for cart player 6 are used 
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for the Cart Recorder instead.

 <Shift>+<F9>  Start recording
 <Shift>+<F10>  Pause recording
 <Shift>+<F12>  Stop recording and prompt for further 

action
 <Shift>+<Ctrl>+<F12>  Stop and save the current recording 

immediately
 <Shift>+<Alt>+<F12>  Stop and abandon the current 

recording
 
 Audio Wall Only Keys
 These keys only apply to the Audio Wall screen when it is active or has 

focus.

 <A>  Add the highlighted item to the Pad
 <C>  Copy the highlighted item to another 

Cart
 <Ctrl>+E  Export the highlighted Cart to a WAV 

File
 <Ctrl>+<Shift>+E  Export the highlighted Cart to a 

Transport File
 <Ctrl>+H  Play the hook of the highlighted Cart in 

the Hook Player
 <Ctrl>+<Shift>+H  Cue the hook of the highlighted Cart in 

the Hook Player
 <Ctrl>+I  Import a WAV File into the highlighted 

Cart
 <Alt>+I  Display extended information about the 

highlighted Cart
 <M>  Move the highlighted item to another 

Cart
 <Insert>  Edit the highlighted Cart
 <Ctrl>+<Insert>  Record into the highlighted Cart
 <Ctrl>+<Delete>  Delete the highlighted Cart
 <Return>/<Enter>  Cue the highlighted item in the first 

available player
 
 Log Screen 
 These keys apply only when the Log screen is active and has focus.

 <Space>  In SegEdit mode, do the highlighted 

action in the Segue Editor
 In normal mode, Starts the next item in 

the Station Log (Go)
 <Home>  Jumps 'Home'
 <Delete>  Soft Deletes/Restores the highlighted 

log item
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 SmoothEdit Display keys
 These keys only apply when the SmoothEdit screen is active and has 

focus.

 <Ctrl>+C  Copies the selected audio/text to the 

clipboard
 <Ctrl>+V  Pastes the audio/text from the 

clipboard
 <Ctrl>+X  Cuts the selected audio/text to the 

clipboard
 <Delete>  Deletes the selected audio/text
 <Left>  Rewinds the audio by 1 second
 <Ctrl>+<Left>  Rewinds the audio by 1/4 of a second
 <Shift>+<Left>  Rewinds the audio by 5 seconds
 <Right>  Forward winds the audio by 1 second
 <Ctrl>+<Right>  Forward winds the audio by 1/4 of a 

second
 <Shift>+<Right>  Forward winds the audio by 5 seconds
 <Insert>  Edit the audio with an external audio 

editor
 <Space>  Starts/Stops the audio playing

 Note: This only works when the 
waveform editor has 'focus'

Please note that when you have configured Myriad to operate in Limited 
Myriad v2 Keyboard Support mode, some of the keyboard shortcuts outlined 
above are replaced with the keyboard shortcuts from Myriad v2.
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Appendix H – The Emergency Recovery Utility

CAUTION: The Emergency Recovery Utility should only be used in an 
emergency (hence the name). The Emergency Recovery Utility (ERU) allows 
you to alter Myriad’s settings without actually being able to run Myriad. Unlike 
previous versions of Myriad, Myriad v3 does not have a separate 
configuration tool but rather, the settings are available via the Settings menu. 
This means that for the first time, you can control who has access to the 
settings on a per User basis. The problem is that if you had a problem such as 
a corrupted Windows registry then you may get in to the situation where 
Myriad will not actual run and you can not reconfigure it because it has to be 
running before you can change the settings.

In this situation, your only recourse is to use the ERU to reconfigure Myriad to 
get it in a position where Myriad will run again.

The reason that you should not run the ERU unless you have to is that when 
Myriad changes settings, it does so in such a way that is will not cause a 
problem to the system. The ERU on the other hand, is designed to force the 
changes to the settings so using it should be a last resort. 

The other reason that the function of the ERU should not be widely known in 
your station is that it offers access to the Myriad Settings without the need to 
have the correct User level of access.

The Functions of the ERU
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The ERU allows you to perform a number of tasks and alter a number of key 
settings in Myriad. The primary functions of the ERU are listed below.

 Change The Myriad Data Locations – You can alter the folder 
location of the core data Myriad Data Location. This folder is used to 
store all the databases and data files that Myriad uses.

 Change The P Squared Directory Location – Allows you to change
the location of the P Squared Directory database file which contains all 
the User information about the Users of your system including access 
rights etc.

 License Details – Allows you to update or renew your Myriad license 
code even if you are not able to run Myriad.

 Repair Database – The Repair Database function does two things, 
firstly it will repair a database that has been damaged or corrupted in 
some way. The second function is to compact a database which 
effectively removes ‘holes’ in the data tables which can reduce the size 
of your database and also speed up database oriented operations.

 Access The Myriad Settings Window – This provides access to the 
Myriad Settings window which offers a diverse range of configuration 
options relating to Myriad as a whole. The function of the Myriad 
Settings window is covered in depth in Chapter 8.

 Access To The P Squared Directory Settings Window – Provides a 
number of Directory related settings for Myriad. These settings are 
covered in detail in the Directory Settings section of Chapter 8.

In the next section, we will review how to use the ERU to perform the most 
likely tasks you will be called upon to do. We will not cover the function of the 
settings available on the Myriad Settings or Directory Settings window as
these are covered in detail in the main documentation.

Changing the Myriad Data Location

To change the Myriad Data Location, you can either type in the new folder 
location in to the Path box or click on the Browse button and use the Choose 
Folder window to browse to the location you wish to use.
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You can also alter the Myriad Settings via the Myriad Settings window by 
clicking on the Settings button in the File Locations section.

For details on the Myriad Data Locations, please refer to the Settings Menu > 
Myriad Settings > Data Locations tab section in Chapter 8.

Change the P Squared Directory Location

You can alter the location of the P Squared Directory database by either 
typing in to the Path box or by clicking on the Browse button and then using 
the Choose Folder window to browse to the location you want to use.
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You can also access the P Squared Directory Settings window by clicking on 
the Settings button in this section. The configuration options on the Directory 
Settings window are covered in the Directory Settings section of Chapter 8.
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Updating License Details

The License Details button in the Other Settings section offers access to the P 
Squared Product License Wizard which is used to initially enter the License 
Code for your P Squared product (Myriad in this case) and to periodically 
enter license updates that are issued as part of P Squareds ongoing anti-
piracy measures.

To launch the License Wizard, click on the License Details button.

For details on the P Squared License Wizard and how to update your License 
Code, please refer to the Licensing Myriad section in Chapter 1 or Appendix I 
– The License Wizard.

Repair Database

The Repair Database button on the ERU is used to the access the Repair / 
Compact Database function for repairing damaged or corrupted Myriad 
databases.
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As a general rule, Myriad maintains it’s own databases, check each database 
as it starts up and alerting you to any potential problems. That said, things can 
happen and if you every start Myriad to discover an error saying ‘Database 
Format Not Recognised’ then the chances are that the database in question 
has been damaged or corrupted in some way and Myriad is no longer able to 
access it.

First – Don’t panic!

The Repair Database option on the ERU is designed to help you out in exactly 
this situation, but first, take a copy of the database that you are going to 
repair. This may seem odd but having a backup of a damaged database is 
better than having no database and P Squared engineers may be able to 
recover it if all else is lost.

There are two databases in Myriad v3 that you may have to repair, they are 
the Station Database and the P Squared Directory Database. The default 
location for each database is shown below but keep in mind that the location
of these databases is a configuration option so your system may be 
configured differently.

Database: Station Database - (previously known as Q-NXT) 
Default Folder: D:\Myriad\System\Schedule 
Default File Name: Myriad3.mdb 

Assuming your Myriad Data Location is set to D:\Myriad\System (see Settings 
Menu > Myriad Settings > Data Location
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Database: P Squared Contacts and Users Directory (previously Users) 
Default Folder: D:\Directory 
Default File Name: Directory.mdb

Assuming your P Squared Directory Location is set to D:\Directory (see 
Settings Menu > P Squared Directory Settings > Path)

To take a backup of either of these files, use My Computer to browse to the 
appropriate location and then simply copy the .MDB file to a backup location 
just in case something goes wrong.

Before clicking on the Repair Database button you need to QUIT MYRIAD ON 
ALL PCs and if you are repairing a P Squared Directory Database you will 
also need to quit Scoop Edit, Scoop Playout, Scoop Capture & PowerLog 
Client (but not PowerLog Capture) as they also all use the Directory 
Database. This is essential as the database will not be repairable while an 
application is still using it and it may further damage the database you are 
trying to repair.

Once you have clicked on the Repair Database button and confirmed that you 
wish to proceed, use the Browse For File window to browse to the location of 
the database that you want to repair. Once the database you want to repair is 
selected, click on the Open button.

In this example, we will be repairing the P Squared Directory database.
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You will be asked to confirm that you want to repair / compact the selected 
database.

Click on Yes to continue.

You will next get a warning that applications that use the database must not 
be running on any PC in the building. Remember that the P Squared Directory 
is also used by Scoop, AutoTrack, AutoTrack Pro and Powerlog Client so they 
will all have to be shut down also.

Click on the Yes button to proceed.

Myriad will then compact and repair the selected database. This can take 
anything from a couple of seconds to several minutes during which time the 
computer may appear to have stopped responding. Please be patient as 
Myriad will inform you when process has been completed.

Myriad will also create it’s own backup which you can delete later when you 
are happy that everything is OK but it is better to have your own backup 
anyway.

If Myriad reports a problem with this process then the best thing to do is 
contact P Squared Technical Support (support@psquared.net) as soon as 
possible.
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Please note that the Repair Database function is also available via the 
Compact / Repair A Database option on the ERU’s Tools menu.

For a more details ‘walk through’ on how to use the Repair Database function, 
please refer to the ‘Myriad Is Showing A Databases Format Not Recognised 
Error On Startup’ section in the Trouble Shooting section of this manual.

The File Menu

The File Menu allows you to save the changes you have made to your Myriad 
settings as well as exit the ERU.

The options are:

 Save Settings – Saves the changes you have made to your Myriad 
Settings without quitting the ERU.

 Exit – Closes the ERU without saving the changes you have made.

The Tools Menu

The Tools Menu provides access to the Compact / Repair Database functions 
outlined above.
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The Help Menu

This provides access to the About screen which shows you the exact version 
number of the Myriad software that you are using.

Appendix I – The License Wizard

Although this procedure has been covered in Chapter 1 of the main Myriad 
Manual, we will review the procedure here to act as a quick reference for 
future use. 

Myriad v3 uses an advanced licensing system to prevent software piracy and 
to safeguard the future of Myriad™ and other P Squared Ltd products.

The advanced licensing procedure generates a special code (called a 
PSQUISH) that is unique to your computer. The first time that you activate 
Myriad you will need to provide this code to P Squared Ltd in order to 
complete the licensing process. Subsequent codes can be obtained 
automatically (assuming you have web access) but you may have to contact 
P Squared Ltd periodically in the future. 

Manually Obtaining a License Code

The standard licensing procedure for manually obtaining a license code is:

1. Select the License Code option from the Tools menu. The License 
Wizard will run automatically the first time that you run Myriad or if you 
run Myriad once your license has expired. 

2. If this is the first time that you have licensed Myriad or you have not 
ticked the option to skip the introduction screen the last time you 
entered a license code, the introduction screen will be displayed.
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3. Read the screen and then tick the “Skip this screen in the future” option 
unless you want to read this introduction each time. The click on Next.

4. You will then see a summary of the current license status of Myriad. In 
the example below, you can see that we currently have a valid license 
that is not due to expire until March 2005. If you are entering a license 
for the first time then this information will be blank. If you wish to 
proceed, click on the Next button.
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5. If you do not need to license Myriad, the License Wizard will warning 
you before you proceed to the next screen, if you want to proceed 
anyway then click on OK.

6. The next phase is to enter your registration details. You will only have 
to do this the first time; the information will be loaded automatically on 
subsequent license procedures

The first thing that you have to enter is your P-SQUID or P Squared 
Unique ID which is your P Squared unique customer ID and will be 
provided by P Squared. Your P-SQUID will be at the top of all quotes, 
or purchase orders that you receive from P Squared and should be 
quoted whenever you contact P Squared. To enter or alter your P-
SQUID, click on the Change button and type in the new P-SQUID

Next add in your contact details by clicking on the Change button by 
the contacts summary window.
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You are required to enter your name and a valid email address; these 
details will be used when processing requests for ‘online’ license 
renewals in the future. You may also fill in the additional information if 
you wish. Once you have finished, click on OK to return to the main 
wizard and then click on Next to move on to the next step.

7. The next step in the license wizard allows you to enter the License 
Name and Features Code for the product. Both of these will be 
provided by P Squared with the purchased product or we can give you
the details over the phone.
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Type in the License Name exactly as it is give to you by P Squared and 
then click on the Set button. Repeat the same procedure for the 
Features Code.

NB: It is possible to obtain a Features Code ‘online’ by clicking on the

 button. When you select this option, the progress of the ‘online’ 
Features Code generation is shown on screen and if a code is 
successfully generated, it will be added to the Wizard window. Please 
note that this option will generally only be available to existing 
customers who have licensed Myriad previously.
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Once the License Name and Features Code have been set, you can 
alter them by clicking on the appropriate Change button. If you are 
happy, however, click on Next to proceed.

8. The next screen allows you to choose the method that you want to use 
to obtain your Myriad license code.
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Each option is explained on screen as you can see from the image 
above.

In this case, let’s assume that we want to manually enter the code and 
we intend to phone P Squared to give them details needed to activate 
the product. Select ‘Manually Enter A New License Code’ and then 
click on Next.

9. The next screen displays the P-SQUISH code which is a unique code 
that is used to generate your Myriad license. The P-SQUISH is unique 
to your contact, details, the PC you are working on and the time and 
date that you generate it.



994

The P-SQUISH is only valid for a few days so you should contact P 
Squared as soon as possible to let them have your P-SQUISH code. 
You can do this be either:

 Telephoning: +44 1482 383700
 Emailing: licenses@psquared.net
 Faxing To: +44 1482 383701

Once P Squared have a valid P-SQUISH code, they will then provide 
you with a License Code that you need to type in to the New License 
Code part of the screen before finally hitting Finish.

10.Clicking on Finish will end the licensing process. A short summary 
screen will be displayed before you can proceed on to using Myriad.
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Automatically Obtaining a License Code

In general, the first license code that you receive will have to be processed 
manually but once all your details are registered with P Square, subsequent 
licenses can be obtained ‘online’ without the need to contact us. This means 
that you can renew your license at your convenience providing that your PC 
has a web connection. 

To obtain a license code ‘online’, follow these steps.

1. Select the License Code option from the Tools menu.
2. The introduction screen is usually skipped when renewing a license. In 

this case, the first screen you will see is the Current License Details 
screen which shows you when the current license was entered and 
when it is going to expire.
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3. Click on Next to move on to the P-SQUID and Personal Details screen. 
You only need to alter the information on this screen if it has changed. 
If not, click on Next to move on to the next screen.

4. Next you will see the License Details screen. Again, unless you need to 
need to alter any of this information, you can click on the Next button to 
move on to the next window.
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5. The License Method window allows you to select the way in which you 
want to obtain your License Code. In this case, we want to renew the 
license online so we need to make sure ‘Obtain A License Code 
Online’ is ticked and then click on Next.

6. Finally, you will see a brief summary screen before Myriad attempts to 
obtain a license ‘online’. Click on Finish to begin the process.
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At the end of the process, you will be told whether your license code 
was successfully renewed or whether you need to contact P Squared 
to continue the licensing process.

For more information on P Squared product licensing, please refer to 
www.psquared.net/support as well as your P Squared Software 
License Agreement.


